
Startup Guide
QuickBooks Basic for Windows

QuickBooks Pro for Windows

QuickBooks Premier for Windows



ii

Copyright

STATEMENTS IN THIS DOCUMENT REGARDING THIRD-PARTY STANDARDS OR 
SOFTWARE ARE BASED ON INFORMATION MADE AVAILABLE BY THIRD PARTIES. 
INTUIT AND ITS AFFILIATES ARE NOT THE SOURCE OF SUCH INFORMATION AND 
HAVE NOT INDEPENDENTLY VERIFIED SUCH INFORMATION. THE INFORMATION IN 
THIS DOCUMENT IS SUBJECT TO CHANGE WITHOUT NOTICE.

Trademarks and Patents

Intuit, the Intuit logo, QuickBooks, QuickBase, Quicken, TurboTax, QuickTax, ProSeries, 
WillExpert, Lacerte, EasyStep, and QuickZoom, among others, are registered trademarks 
and/or registered service marks of Intuit Inc. in the United States and other countries. 
Other parties’ trademarks or service marks are the property of their respective owners and 
should be treated as such. Various QuickBooks products and services are protected by one 
or more of the following U.S. patents: 5134564, 5423033, 5842185, 5903881.

Important

Terms, conditions, features, service offerings, prices, and hours referenced in this 
document are subject to change without notice. We at Intuit are committed to bringing 
you great online services through QuickBooks. Occasionally, we may decide to update our 
selection and change our service offerings, so please check www.quickbooks.ca for the 
latest information, including pricing and availability, on our products and services.

My QuickBooks account details:

QuickBooks License Key: ______________________________________________

QuickBooks Customer Number: ______________________________________________

Installation Key Code (IKC) : ______________________________________________

Copyright © 2003 Intuit Inc. 
All rights reserved.
First printing, November 2003

Intuit Canada
Box 4182
Edmonton, Alberta T6E 4T2



iii



iv



Contents v

Contents

Chapter 1 System requirements and installation,  1
Hardware and software requirements,  2

Network requirements for multiple-user networking,  3

Installing QuickBooks,  3
If upgrading from QuickBooks 2003,  3
Installing QuickBooks,  5
If you need to reinstall QuickBooks,  7
Installing the QuickBooks Timer from CD-ROM,  8
What’s Next after you’ve installed QuickBooks,  8

If you are updating to QuickBook 2004,  9
Updating your company files,  9
Updating your backup files,  11
If an update problem occurs,  11

Activating QuickBooks,  13
Activation using the Internet,  13
Activation using the telephone,  14
What’s next after you’ve activated QuickBooks,  15

Working with multiple users,  16
Setting up multiple-user networking (QuickBooks Pro and Premier only),  16

Chapter 2 Setting up a new company,  19
Decisions to make before you start,  20

Locating an advisor to help you with QuickBooks,  20
How many companies should you set up?,  21
What accounting method should I use?,  22
What accounting do I need to know?,  23
What’s the best way to track my type of detail?,  26
Reports to measure profitability,  31

Setting up your company in QuickBooks,  34
Determining a start date,  34
Information to collect,  35
Starting the EasyStep Interview,  38

Should I track customers and jobs?,  40
What does QuickBooks mean by a customer?,  40
What does QuickBooks mean by a job?,  40
Changing the opening balance for a customer or job,  41



vi Contents

Why you probably need to set up items,  42
Items for what you sell,  42
Items for services or products you purchase,  43
Deciding how items should affect accounts,  44
How many different items do you need?,  45

Setting up items,  46
Where to find information about your items,  46
Types of QuickBooks items,  47
Adding items to your Item or Fixed Asset Item list,  50
Items for reimbursable costs in QuickBooks Pro and Premier Editions,  53

Working with items,  55
Using items, saving time,  55
Using items to subtotal on sales forms,  57
Showing partial payments received at the time of sale,  59
Changing prices or rates,  60
Editing item information,  61

Final steps to complete your setup,  62
Fine-tune your accounts,  62
Enter your company’s historical transactions,  64
Complete your customer, vendor, and item information,  65
Adjusting opening balances for balance sheet accounts,  66
Setting up accounts to track equity details,  68

Things to think about after you’re finished,  69
Create reports to check your setup,  69
Maintain your previous accounting system,  69
Set up other company files, if you need them,  70

Connect QuickBooks to the Internet,  70

Update QuickBooks to the latest release,  72
Set number, currency, time, and date formats in QuickBooks,  75

Chapter 3 Importing and exporting data,  77
Converting data from Quicken,  78

Preparing your Quicken data for conversion,  78
Converting your Quicken file to QuickBooks,  80
Fine-tuning your data after converting to QuickBooks,  81
How QuickBooks converts accounts receivable transactions,  84
Changing to QuickBooks accounts payable,  85
Comparing QuickBooks and Quicken,  87
New and renamed balance sheet accounts,  88
When you convert from Quicken,  89
Should you continue using Quicken for some things?,  89



Contents vii

Converting data from MYOB,  90
What’s Next after conversion,  91
Setting up your payroll in QuickBooks,  92

Importing from / exporting to other software,  100
Importing from other software,  100

Exporting to other software,  101
Give your accountant permission to access your QuickBooks file remotely,  102
Exporting data for your accountant (Accountant’s Review),  102

Chapter 4 QuickBooks basics,  105
Getting around in QuickBooks,  106

Learn basic features in minutes,  106
Understanding QuickBooks file types,  106
About the Getting Started window,  106
Navigating in the working area,  107
Using lists, forms, and registers,  108

Where to learn more about using QuickBooks,  110
Finding step-by-step instructions,  110
Finding industry-specific information,  110
Exploring QuickBooks with a sample company,  110
Getting information through the Internet,  111

Getting information about your company,  111
Creating reports,  112

Customizing a form’s content,  115

Backing up your company data,  117
Recommended backup routine,  118
Backing up to a CD-R or CD-RW,  119
Backing up to a Zip drive,  120
Backing up to a tape,  120
Backing up to a 3.5 floppy disk,  121
Using the QuickBooks Backup Service,  123
Searching for your backup file,  123
Restoring company data,  124

Condensing your company file,  124

Reconciling bank and credit card accounts,  128
Matching bank deposits and credit card deposits (QuickBooks Credit Card Service 

users),  129

Setting up online banking (account access and payment),  130
Going online for the first time,  131
Reconciling online accounts,  131



viii Contents

Working with multiple users,  132
Setting up users and passwords,  133
Recording who changed what,  136

Gathering income tax information,  137
How QuickBooks tracks tax information,  137
Reporting income tax information,  140

Solving printing problems,  142
When should I reinstall my printer driver?,  142
Nothing happens when you try to print,  142
The form is clipped on the top, bottom, left, or right,  143
Dates and the bottoms of letters are clipped on forms,  146
Printing is slow,  146

Chapter 5 Tracking and paying sales taxes,  147
Does your business need to be registered?,  148

How QuickBooks calculates the GST and PST,  148

Setting up sales taxes,  149

Determining your sales tax liabilities,  154
Remitting your tax liability to the government,  154
Adjusting your GST Payable or PST Payable account,  156
Locking older transactions after paying your GST/PST liabilities,  156
Sales tax tracking,  158

Chapter 6 Doing business internationally,  161
Multicurrency: an overview,  162

Setting up multicurrency,  162
Using the currency list,  167
Using the currency calculator,  169

Exchange rates and how they affect your transactions,  169
Unrealized gains and losses,  169
Realized gains and losses,  171

Dealing with foreign customers,  172
Creating invoices for foreign customers,  172
Receiving payments from foreign customers,  173

Dealing with foreign vendors,  174
Creating purchase orders for a foreign vendor,  174
Paying bills from foreign vendors,  175

Transferring foreign funds,  176



Contents ix

Chapter 7 Payroll and employees,  177
Payroll: before you begin...,  178

Membership in the QuickBooks Payroll Service,  178
If you don’t use the payroll feature in QuickBooks,  178

Setting up payroll: an overview,  179
Collecting the information you’ll need,  180

Payroll expense and liability accounts,  182
Customizing payroll accounts,  182

Setting up your payroll items,  183
The importance of payroll items,  183
About the default payroll items,  183
Creating new payroll items,  184

Setting up employees,  191
Employee defaults: entering common employee information,  191
Setting up employees,  192

Summarizing amounts for this year to date,  197
Entering year-to-date summaries for each employee,  197
Entering year-to-date summaries of liability payments,  201
Making sure your payroll data is complete,  202

Managing payroll and employee information,  203
Changing payroll item information,  203
Changing employee information,  204

Running payroll and paying taxes,  208
Selecting employees to pay,  208
Previewing, adjusting, and creating pay cheques,  209
Printing pay cheques and pay stubs,  211

Paying payroll liabilities and filing payroll forms,  212

Creating year-end T4 and Relevé 1 slips,  216
Preparing year-end payroll forms,  216

Getting information about your payroll,  220
QuickBooks Payroll Reports,  220

Chapter 8 Time and cost tracking,  223
Should I track time?,  224

Should I make time billable?,  224
Should I track time for subcontractors?,  225
How much detail should I track for time activities?,  225

Setting up QuickBooks to track time,  227
Setting up to use time tracking with payroll,  228
Viewing, editing, and printing time data,  228



x Contents

Setting up and using the Timer,  229
How the Timer works with QuickBooks,  229
Setting up the Timer,  230
Using the Timer,  231
Importing Timer data into QuickBooks,  234

Using the Stopwatch to time an activity,  235
Entering time manually into QuickBooks,  236

Paying for time worked,  237

Charging customers for time worked and other costs,  240

Pro or Premier Timer Reference Sheet,  246

Chapter 9 Information for upgraders,  249
What’s new in QuickBooks,  250

QuickBooks Basic,  250
QuickBooks Pro,  252
QuickBooks Premier,  253
QuickBooks Premier: custom editions,  253

QuickBooks Basic,  254
Payroll improvements,  254
Printing features and improvements,  255

QuickBooks Pro,  256
Print packing slips,  256
Easier time tracking,  257

QuickBooks Premier,  257
Sales Order improvements,  257

Glossary of terms,  261

Appendix A Contacting Intuit,  265
Intuit Product Support,  266

Web-based support,  266
Telephone support,  266
Data recovery,  266
Password removal,  266
Solving problems on your own,  266
If the program “hangs” or locks up on you,  267
Using the QuickBooks utilities,  268
Speaking with a Product Support Representative,  268



Contents xi

Contacting Intuit,  269
Ordering QuickBooks products and services,  269
QuickBooks activation,  269
QuickBooks delivery, billing, and account inquiries,  269
QuickBooks product support,  270

Index,  271



xii Contents



C h a p t e r  1

1

Welcome to QuickBooks! This chapter helps you 

install and activate your new software on your 

computer and start using it. Chapter 1

The Startup Guide covers QuickBooks Basic, QuickBooks Pro, and QuickBooks 
Premier. When the name QuickBooks is used, it usually means any of these 
programs. When there is an important distinction between QuickBooks Basic, Pro, 
and Premier, it is noted in the text.

If you’ve been using Quicken as your accounting software, turn to 
“Converting data from Quicken” on page 78.

System 
requirements 
and installation

How do I install 
and activate 
QuickBooks 2004

Hardware and 
software 
requirements

2

Installing 
QuickBooks

3

If you are 
updating to 
QuickBook 2004

9
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13

Working with 
multiple users

16
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Hardware and software requirements

To use QuickBooks 2004, you need the following:

� An IBM-compatible computer with a Pentium or compatible processor. A 200 MHz 
(megahertz) Intel Pentium or better is required; a 350 MHz Pentium II is recommended.

� A minimum of 64 MB (megabytes) of RAM (random access memory); 96 MB or more is 
recommended. 

� A hard disk with this much free disk space:

� A 2X (double-speed) or faster CD-ROM drive.

� A sound card, if you want to use the sound features.

� A VGA (or better) video card and monitor; a display system capable of at least 256 
colours with a screen resolution of 800 x 600 (while using the Small Fonts option in 
your Display control panel) is highly recommended.

� Either Windows 98, Me, 2000, or XP.

If you are using Windows 2000 and more than one person will be using QuickBooks, 
all Windows users must be set to Standard Users (Power Users Group) or above, or 
QuickBooks will not run properly.

� A printer supported by your operating system, if you plan to print from QuickBooks.

� Microsoft® Word 97, 2000, 2002 or 2003 or Microsoft® Excel 97, 2000, 2002, or 2003, 
if you plan to use the features that integrate with Microsoft Word or Microsoft Excel. 
(Having more RAM is strongly recommended.)

� Microsoft® Outlook 97, 98, 2000 or 2002; ACT! version 3.08 or 4.02; or Interact 2000, 
if you plan to synchronize QuickBooks Pro or QuickBooks Premier with your contact 
manager. (Having more RAM is strongly recommended.)

Software Component Minimum Free Disk Space

QuickBooks Basic 230 MB

QuickBooks Pro 2 250 MB

QuickBooks Premier editions 400 MB

QuickBooks Enterprise editions 450 MB

Microsoft Internet Explorer 6.0 70 MB

Additional for Timer (Pro only) (not avail-
able for QuickBooks Basic)

9 MB
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� An Internet connection of at least 56 Kbps and an account with an Internet Service 
Provider (ISP), if you plan to use QuickBooks’ online features or download updates or 
payroll tax tables.

� AMAPI-compliant e-mail program (such as Microsoft Outlook but not Microsoft 
Outlook Express) if you plan to e-mail sales forms to your customers. (Having more 
RAM is strongly recommended.)

Network requirements for multiple-user networking

QuickBooks 2004 Pro and Premier editions only 

Before installing QuickBooks Pro or QuickBooks Premier, be sure your computers are 
properly networked and that your networking software is up to date.

To share company files across a network, the network must meet the following minimum 
requirements:

� Windows 2000 Server or Windows Server 2003 for client-server networks. 

� Windows 98, 2000, Me, or XP for peer-to-peer networks.

Installing QuickBooks

If upgrading from QuickBooks 2003

If you are new to QuickBooks, skip this section and continue to the section, “Installing 
QuickBooks” on page 3.

Complete these steps before you install QuickBooks 2004. 

1 Back up your company file to a set of new floppy disks (or your usual backup media). 
Ensure that all disks are labelled correctly and kept in a safe place in case you need them 
later. Do not overwrite this backup.

For instructions on making a backup, see the instructions that came with your older 
version of QuickBooks.

Intuit recommends you have the latest Service Pack or update for your 
operating system or network software.

If you are uncertain whether you have the latest Service Pack or update, contact 
Microsoft, Novell, or your network administrator.



4 Chapter 1   System requirements and installation

2 Verify your company file.

To verify data in most versions of QuickBooks, from the File menu, select Utilities, then 
Verify Data. In early versions of QuickBooks, see your documentation for instructions.

3 Create and print a Trial Balance for your company. For instructions on printing a Trial 
Balance, see the instructions that came with your earlier version of QuickBooks.

When you have installed QuickBooks 2004, create and print a second Trial Balance. 
Compare the two reports to confirm that all your accounts converted correctly.

What happens when you upgrade to QuickBooks 
2004

If you upgrade your current copy of QuickBooks to QuickBooks 2004, the Installer searches 
for an older version of QuickBooks on your hard disk. If it finds one, the directory 
containing the older version becomes the directory for your new software unless you 
change it.

QuickBooks 2004 will replace your older version of QuickBooks unless you specify a 
different directory during the installation.

If you previously had uncategorized amounts, these transactions will automatically be 
updated when you install QuickBooks 2004. Before you install QuickBooks 2004, you’ll 
need to know the ending dates of your GST/HST return and/or your PST/QST return you 
last filed.

Not sure what the ending date is? If today were February 15, 2004 and the last return 
that was filed for GST/HST was for the period October 1, 2003 to December 31, 2003, 
then the ending date of your last filed GST/HST return would be December 31, 2003.

What will happen to uncategorized amounts?

QuickBooks will take the ending date you enter and marks all uncategorized amounts 
on or before that date as filed so they won’t affect your sales tax liability. Uncategorized 
amounts after the ending date will be categorized as sales or purchases so that they cor-
rectly affect your sales tax liability account. The next time you file a sales tax return, 
QuickBooks will include these newly categorized transactions properly with all other 
unfiled-transactions.

If you had uncategorized amounts in earlier versions of QuickBooks and didn’t adjust 
your GST/PST returns for them, consult your accountant to see if you should file an 
adjustment now.
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Installing QuickBooks
1 Shut down all running programs and any virus protection software you may have. 

(Some virus protection software can interfere with the Installer.)

2 Insert the QuickBooks Installation CD into your computer’s CD-ROM drive. The 
Installer should start by itself in a few moments.

� If the Installer doesn’t start automatically, from the Windows Start menu, select 
Run. Type the drive letter associated with your CD-ROM drive, then type 
:\autorun.exe and click OK (for example, d:\autorun.exe).

3 You’re asked if you want to install QuickBooks now, click Yes. 

4 Enter your Installation Key Code (IKC), then click Next.

Depending on how you purchased QuickBooks, you’ll find your IKC in one of the 
following places:

� If you purchased QuickBooks from a retail store, you’ll find your IKC on the 
QuickBooks Installation CD case.

� If you purchased QuickBooks by calling Intuit Canada’s Customer Service 
Department, the sales representative would have provided you with your IKC. If 
you provided an email address at the time of purchase, you also would have 
received your IKC in a confirmation email.

� If you purchased QuickBooks from Intuit Canada’s online store at www.intuit.ca, 
you would have received your IKC on the receipt that came with your software.

� If you purchased QuickBooks by calling Intuit Canada’s Customer Service 
Department, your IKC will appear on the packing slip that came with your 
software.

� If you were a QuickBooks Service Plan customer at the end of 2003, Intuit Canada 
would have sent you a QuickBooks Service Plan - Upgrade Letter in November 
2003. This letter contains your IKC and a Customer Number. The IKC is required 
to install QuickBooks and your customer number is needed to activate your version 
of QuickBooks.

� If your IKC or Customer Number is missing, call Intuit Direct Sales (see page 269 
for contact information). To replace your IKC, you will need to provide proof of 
purchase.

Tip: Write down your IKC and store it somewhere safe. We’ve provided a space at the front of the 
guide for you to record your IKC. You’ll need your IKC if you have to reinstall QuickBooks at some 
time. For information on reinstalling QuickBooks see “If you need to reinstall QuickBooks” on 
page 7.
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5 In the Language Preferences window, select which language you want to view the 
License Agreement in, then click Next. The License Agreement window appears.

6 Read the License Agreement, then click Next. Click Accept to agree to the terms of the 
license agreement. You cannot install QuickBooks unless you accept these terms.

7 On the Multi-User message, click OK after reading the message.

8 On the Install Options Window, select from the following options, then click Next.

9 The Transfer Existing Settings window appears. Keep all the defaults selected and click 
Next.

10 The Select Program Folder window appears. Select a folder, then click Next.

By default, QuickBooks creates a folder called QuickBooks under the Program Folder. If 
you want to install QuickBooks under a different folder, select the folder you want from 
the Existing Folders list.

If you have purchased several copies of QuickBooks Pro or Premier product 
to network together, you must install each with its own unique Installation 
Key Code.

If you purchased a 5-user QuickBooks Pro or Premier product, a single Installation Key 
Code is required for all five copies.

For instructions on setting up multiple-user networks, see “Setting up multiple-user 
networking (QuickBooks Pro and Premier only)” on page 16.

Install Location:

The installer selects an 
install location based on...

� If a new user, this option 
is selected by default. To 
install QuickBooks to a 
different folder than the 
default one, click the 
Change new directory 
button.

� If an existing user, this 
option is selected by 
default. This installs 
QuickBooks 2004 over 
top of the existing copy 
of QuickBooks on your 
computer. Refer to 
“What happens when 
you upgrade to 
QuickBooks 2004” on 
page 4 for more 
information.

If the installer detects that Internet Explorer (IE) 6.0 is not installed on 
your computer, this checkbox is selected. Don’t clear this checkbox if it 
is selected! IE 6.0 is needed for QuickBooks to run properly. 

Install Options:

Select to create a 
shortcut to QuickBooks 
on your desktop.

Select to copy the 
tutorial program to 
your computer. If you 
are short on disk space, 
don’t select this option. 
The tutorial can be run 
directly from the CD-
ROM. You can open it 
from the Help menu.
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11 The QuickBooks Anonymous Usage Survey window appears.

� I agree to send anonymous usage statistics to Intuit: Select to help us improve our 
help system by allowing us to track the help topics you open while working in 
QuickBooks. The help tracking system does not track or collect any personal 
data from your company file.

12 Click Next. The Start Copying Files window appears. This window lists all the selections 
you made for your QuickBooks Installation. Review them now for accuracy. Select Back 
if you need to change your options.

13 Click Next. The Installer starts installing QuickBooks. 

14 When QuickBooks has been installed, you’re prompted to restart your computer. Click 
Restart. 

When your computer has restarted, you can install other components like the Timer (a 
program included with QuickBooks Pro or QuickBooks Premier to track employee and 
subcontractor time). See “Installing the QuickBooks Timer from CD-ROM” on page 8 
for more information.

Tip: To start QuickBooks, double-click the QuickBooks icon on your desktop, or, from the Start menu, 
choose the QuickBooks program group, then QuickBooks. If you didn’t install QuickBooks in the 
default folder, QuickBooks may not appear under the Start menu. Look for it under the folder you 
chose to install to.

If you need to reinstall QuickBooks

Reinstalling QuickBooks does not affect your company data in any way.

Reinstall QuickBooks the same way you originally installed it (see “Installing QuickBooks” 
on page 5). When the Installer asks for your Installation Key Code, enter the same code you 
used to install QuickBooks the first time. You do not need to activate your license key for 
QuickBooks again unless you’ve moved it to a different computer.

When the Installer finishes, QuickBooks looks for data files in its own directory. If your data 
files are in a different place, use the Open Company command to tell QuickBooks where to 
find your data.

Note: If you subscribe to a Service Plan, you may receive maintenance releases throughout the year. 
If you need to reinstall QuickBooks, you must also reinstall each maintenance release that you 
installed throughout the year before you can open your company file.
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Installing the QuickBooks Timer from CD-ROM

The QuickBooks Pro Timer is designed to track and record time data that you can then 
import in to QuickBooks Pro and QuickBooks Premier. Use it when you want to gather time 
data from people who don’t have access to QuickBooks. The timer can run on any computer 
with a Windows operation system. You can install the timer from the QuickBooks 
Installation CD.

1 Insert the CD-ROM in your CD-ROM drive. If you are asked if you want to install 
QuickBooks, click No. 

2 Open the Timer Installer. From the Windows menu, select Run. Type the drive 
letter associated with your CD-ROM drive, then type :\qbtimer\install.exe and click OK 
(for example, d:\qbtimer\install.exe).

3 Follow the instructions on your screen.

For more information about the QuickBooks Pro Timer, see “Setting up and using the 
Timer” on page 229.

What’s Next after you’ve installed QuickBooks

Now that you’ve installed QuickBooks, you’ll need to do the following depending on what 
type of user you are.

� If you are a new user of QuickBooks:

You can skip the next section “If you are updating to QuickBook 2004” and continue 
to the section “Activating QuickBooks” on page 13.

� If you are a Quicken user and need to convert your Quicken file to 

QuickBooks:

To better prepare your Quicken file for conversion to QuickBooks, see “Converting data 
from Quicken” on page 16. After you’ve converted your Quicken file to QuickBooks, 
you must activate QuickBooks. See “Activating QuickBooks” on page 13 for more infor-
mation.

� If you are an existing user of QuickBooks:

If you are upgrading to QuickBooks 2004, you now need to update each company file 
to the 2004 format so that QuickBooks 2004 can open your files. See the next section 
“If you are updating to QuickBook 2004” once QuickBooks has been successfully 
installed. 
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If you are updating to QuickBooks 2004
If you are a new user, you do not need to read this section. This section is intended for 
existing users of QuickBooks who are updating their software to QuickBooks 2004.

If you owned an earlier version of QuickBooks and installed QuickBooks 2004, you’ll need 
to update each company file and backup file to the 2004 format so that it can be opened in 
QuickBooks 2004. 

Updating your company files

QuickBooks 2004 can directly update company files created with QuickBooks 6.0 or later. 
If you have several copies of QuickBooks Pro or QuickBooks Premier networked, you’ll need 
to upgrade each copy of QuickBooks to QuickBooks 2004. See “Working with multiple 
users” on page 16 for more information on networking.

QuickBooks 2004 Pro or QuickBooks 2004 Premier can read and update all data created with 
earlier versions of QuickBooks Basic. However, QuickBooks 2004 Basic cannot read some 
QuickBooks Pro-only or QuickBooks Premier-only data (such as estimates and progress 
invoices) that were created in earlier versions of QuickBooks Pro or QuickBooks Premier.

To update a company file to the QuickBooks 2004 format:
1 Once QuickBooks 2004 has been successfully installed, open QuickBooks 2004 by 

double-clicking the QuickBooks icon on your desktop.

2 QuickBooks 2004 looks for an existing company file to open. By default, QuickBooks 
tries to open the last company file you had open.

� If QuickBooks can’t find a company file, you can open one by selecting Open an 
existing company on the Welcome window. Then, navigate to your company file, 
select it, and click Open.

� If your company file is password protected, you’ll need the Administrator’s 
password in order to open the company file.

� If you don’t remember where your company file is located on your computer, see 
“Can’t find your company file?” on page 10.

3 The Update utility is opened. In the Update Company File to New Version window, 
type Yes and click OK.

Some company files may require rebuilding of the data after updating to QuickBooks 
2004. It can take more than 30 minutes, depending on the size of your company file.

4 Before QuickBooks updates your file, you are prompted to back up your company file 
again. Fill in the appropriate backup information, then click OK.

� In the Filename field, keep the default name or type a new name for the backup 
file.

� For this backup file, choose a different location than the location you backed up 
your file to before installing QuickBooks. Click Browse to navigate to another 
location.
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QuickBooks backs up your company file, then begins to update it. If you have a large 
company file, the update process may take some time. During this time, it may seem 
like QuickBooks is not responding or is “frozen”. This is usually not the case. A good 
rule of thumb is if you see this cursor ( ) and/or the hard drive light on your computer 
is flickering, then QuickBooks is not frozen. Don’t attempt to close QuickBooks or shut 
down your computer while your company file is being updated as your file could be 
damaged!

If the update process fails, try the procedure on page page 11 to correct the problem, or 
contact Technical Support (see page 270) for assistance.

5 Do the following in the Important Changes to Sales Tax Tracking dialog box: 

� Enter the ending date from your last GST/HST return that you filed.

� Enter the ending date from your last PST/QST return that you filed, then click Next.

Note: If you chose to click Cancel, you can access this dialogue box again from within QuickBooks. On 
the Vendors menu, select Sales Tax, then choose File Sales Tax.

6 When the update finishes, click OK. The Update Utility closes.

7 You may want to verify your data:

� From the Window menu, select Close All.

� From the File menu, select Utilities, then Verify Data. 

� If verifying detects a problem, follow the onscreen instructions or contact 
Technical Support (see page 270).

If you created any backups of your company file, you’ll need to update the format of the 
backup files as well. See “Updating your backup files” on page 11.

Can’t find your company file?

If for some reason you can’t find your company file (.QBW), use the Windows’ search 
feature to help you locate it on your computer.

To search for your company file:
1 From the Windows button, select Search, then choose For Files or Folders. 

2 In the Search Results window, type *.QBW in the “Search for files named” field.

The asterisk symbol acts as a substitute for zero or more characters.

3 Choose a drive or folder in the “Look in” field.

4 Click Search Now.
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Updating your backup files

Backup files that your created must also be updated to the 2004 format so that QuickBooks 
2004 is able to open them.

To update a backup file to QuickBooks 2004 format:

1 Open QuickBooks 2004 if it isn’t already.

2 From the File menu, click Restore. The Restore Company Backup window appears.

3 Make any necessary changes, then click Restore. When the file is restored, the Quick-
Books Update Utility launches.

4 In the Update File to New Version window, type Yes and click OK to begin the process 
of updating your company file to QuickBooks 2004.

QuickBooks begins updating your company file. If you have a large company file, this 
process may take some time. Don’t interrupt QuickBooks or shut down your computer 
until the process is complete. Doing so can corrupt your company file.

If the update process fails, try the procedure on page page 11 to correct the problem, or 
contact Technical Support (see page 270) for assistance.

5 When the update finishes, click OK. The Update Utility closes.

6 You may want to verify your data:

� From the Window menu, select Close All.

� From the File menu, select Utilities, then choose Verify Data. 

� If verifying detects a problem, follow the onscreen instructions or contact 
Technical Support (see page 270).

For more information on how to back up your company file and restore it, see “Backing up 
your company data” on page 117. 

If an update problem occurs

If your attempt to update your company file from an older version of QuickBooks fails, this 
procedure may correct the problem. If it is not successful, contact Technical Support (see 
page 270).

1 Reinstall your older version of QuickBooks into a completely new directory.

2 Install any maintenance release(s) for the older version of QuickBooks in the same 
order they became available to you.

3 Start the older version of QuickBooks, then restore the backup you made of your 
company file while attempting to update to your new version of QuickBooks. (See the 
documentation that came with your older version of QuickBooks for instructions on 
restoring a backup.)

4 From the Window menu, select Close All.

5 Start the Rebuild utility. (In many versions of QuickBooks, from the File menu, select 
Utilities, then Rebuild Data to start the Rebuild utility. In early versions of QuickBooks, 
see your documentation for instructions.)
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6 When the rebuild completes successfully, back up the rebuilt file.

7 Exit from the older version of QuickBooks. (You can uninstall the older version of 
QuickBooks now, if you want.)

8 Reinstall QuickBooks 2004 into the directory where you originally installed it.

9 When the Installer finishes, open QuickBooks 2004 by double-clicking the QuickBooks 
icon on your desktop. 

10 From the File menu, choose Restore.

11 Navigate to the backup of the rebuilt company file (the file you created in Step 5). Select 
it, then click Restore.

12 Follow the instructions on your screen to restore and update your company file. If you 
are still having difficulties, call Technical Support (see page 270).

To check which version of QuickBooks you have:
1 Start QuickBooks and open your company file. 

2 Press and hold the CTRL key, then also press 1 (the “1” above the letter “Q” on your 
keyboard, not the “1” on the keypad on the right).

3 The Product line tells you what version of the product you have, what release you have 
(“R”), and whether you have a Canadian version (“C”).

You’ll be asked to create several backups in this process. Do not overwrite 
the existing backup you used in Step 3!

Instead, use a new set of floppy disks for each backup (if you are backing up to your 
floppy drive) or give each backup a different name that you will remember (if you are 
backing up to your hard drive).
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Activating QuickBooks
The first time you open a company file, you’re prompted to activate QuickBooks. If you 
purchased QuickBooks in the past, you’ll find that activation is very similar to registration. 
Activation validates you as a licensed user of your copy of QuickBooks. Depending on 
which QuickBooks product you have, you may need to activate QuickBooks multiple times.

� If you purchased QuickBooks from a retail store, you’ll only have to activate 
QuickBooks once. 

� If you are a QuickBooks Service Plan customer, you’ll have to activate or “refresh” 
again when your subscription expires. This will be faster after the first activation 
because we’ll have your information on file, unless your information has changed.

Refreshing is simply re-activating QuickBooks when your service plan expires.

You can use QuickBooks as many as 10 times without having to activate. After your 10th 
use, you must activate QuickBooks to continue to edit your company file. If you don’t 
activate QuickBooks by the 10th use, you will only be able to print or view information in 
your company file. You won’t be able to create any new transaction or make any edits to 
your company file. 

We encourage you to activate QuickBooks early. Activating QuickBooks entitles you to lots 
of benefits like updates and special offers.

Until you activate, QuickBooks will remind you to activate occasionally as you work. If you 
decide not to activate QuickBooks when you get the License Activation message, click 
Close. You can activate later via the Internet or by telephone using the instructions 
following.

Activation using the Internet

If you have Internet access, you can activate QuickBooks online any time during the day or 
night. 

Note: If you were a QuickBooks Service Plan customer at the end of 2003, Intuit Canada would have 
sent you a QuickBooks Service Plan - Upgrade Letter in November 2003. This letter contained 
your Customer Number. The Customer Number is required to activate QuickBooks.

To activate QuickBooks via the Internet:
1 Start up QuickBooks and open your company file.

2 If this is not the first time you’ve started QuickBooks after installation, choose Activate 
QuickBooks from the File menu. The Privacy Policy Message appears. 

This window includes information about the privacy policy.

3 Scroll down in the window and read the information.

4 (Optional) If you want to see the Privacy Policy, select Intuit Canada’s Privacy Policy.

When you’re finished reading the information, click Next. The QuickBooks Online 
Activation form appears.
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5 Enter your personal information, then click Next. The Confirm your entry information 
window appears. 

6 Do one of the following:

� If your information is correct, click Next. 

� If you need to make changes, click the Back button in the browser tool bar. 

When you’ve confirmed that everything is correct and clicked Next, the survey form 
appears.

7 (Optional) Complete the survey, then click Next. The My License Information page 
appears.

This page shows your product information, license information, and if you subscribed 
to the QuickBooks Payroll Service, your payroll information.

If you need or want to see this information again, select My License Information from 
the Help menu.

8 Click Close. The “QuickBooks has been successfully activated” window appears.

9 Click Close. 

Activation using the telephone

If you don’t have Internet access, you can activate by telephone. You need to call during 
normal business hour, between 7:00 am and 6:00 pm, Mountain Standard Time, Monday 
through Friday. 

During the activation process, a toll-free number will be displayed for you to call. You can 
also see “Intuit Product Support” on page 266 for more contact information.

Note: If you were a QuickBooks Service Plan customer at the end of 2003, Intuit Canada would have 
sent you a QuickBooks Service Plan - Upgrade Letter in November 2003. This letter contained 
your Customer Number. The Customer Number is required to activate QuickBooks.

To activate QuickBooks by telephone:
1 Start up QuickBooks and open your company file.

2 If this is not the first time you’ve started QuickBooks after installation, choose Activate 
QuickBooks from the File menu.

3 Click Next. The Privacy Policy Message appears. This window includes information 
about the privacy policy.

4 Scroll down in the window and read the information.

5 (Optional) If you want to see the Privacy Policy, select Intuit Canada’s Privacy Policy.

When you’re finished reading the information, click Next. The License Activation 
window appears.
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6 Call Intuit Canada at the number that appears in the window. Telephone activation 
can be performed during the hours between 7:00 am and 6:00 pm, Mountain Standard 
Time, Monday through Friday.

The service representative will ask you for your product key. If you were a QuickBooks 
Service Plan customer at the end of 2003, the representative will also ask you for your 
customer number. 

7 The service representative will give you a License Key number to enter and will walk 
you through the remaining steps to activate QuickBooks.

Tip: Write down your License Key and keep it in a safe place. You will need it if you call technical 
support or if you apply for the QuickBooks Payroll Service. If you should lose your license key 
number, you can view it anytime by choosing My License Information from the Help menu.

If you’re using several copies of QuickBooks Pro or QuickBooks Premier on a network, you 
must activate each copy separately each with a unique license key.

What’s next after you’ve activated QuickBooks

After installing the software, you’re ready to set your company up in QuickBooks. The 
EasyStep Interview asks you simple questions about how your business works to walk you 
through the setup process. To determine what information you need to collect and start the 
EasyStep Interview, turn to “Setting up a new company” on page 19.

To learn more about setting up and using important features of QuickBooks, turn to 
“QuickBooks basics” on page 105.

There is also information about the new features in QuickBooks 2004. See “What’s new in 
QuickBooks” on page 250.
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Working with multiple users
In QuickBooks Pro or QuickBooks Premier (only), several people can work with your 
company file at the same time over a computer network. You can also set up your company 
file so that different users have different access to features. For more information on this, 
see “Setting up users and passwords” on page 99.

Setting up multiple-user networking (QuickBooks Pro and 
Premier only)

Each computer on your network that will have QuickBooks Pro or QuickBooks Premier 
installed on it must have a unique copy with its own installation key code and license key 
numbers.

Note: If you are administering a peer-to-peer network and installing QuickBooks for other users in your 
company, be sure that Windows XP users have at least Standard user rights and that Windows 
2000 users have Power Users Group rights. Users who are granted Restricted user (Users 
Group) access do not have the operating system rights to write to the registry keys and will not 
be able to use QuickBooks.

Tip: If your QuickBooks CD is mounted on a shared CD-ROM drive, you can install from the mounted 
CD, but you cannot install across the network to a remote computer. That is, you must be sitting 
at the computer you’re installing to. (You must still store the company file on the shared 
resource.)

Peer-to-peer networks

Peer-to-peer networks are ones that do not use a dedicated file server. All the computers on 
it have the option to share their resources and there is no single machine that is used only 
to allow other computers to share files.

Note: Some peer-to-peer networking systems meant for home users may be too slow for QuickBooks 
Pro or QuickBooks Premier to operate properly. If QuickBooks Pro or QuickBooks Premier “time 
out” often on your network, consider moving to a faster networking system.

In the diagram, there are three computers on a peer-to-peer network. Each computer has 
one user (Jack, Amy, and Sarah). Each of the users has a unique copy of QuickBooks Pro or 

If you used the multiuser feature in an earlier version of QuickBooks Pro or 
QuickBooks Premier and you want to continue using them, you must replace 
each copy of your earlier software with a unique copy of QuickBooks 2004 
Pro or QuickBooks 2004 Premier.

Because company files updated by QuickBooks 2004 Pro or QuickBooks 2004 Premier 
cannot be read by any earlier version of QuickBooks, back up your company file before 
you install your new software.
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QuickBooks Premier installed with a unique Installation Key Code. The QuickBooks 
company file is located on Sarah’s computer.

It is important to choose one location for your company file. The location should be 
accessible to all of the computers that need to use QuickBooks. You may want to put the 
company file on the computer of the person who uses QuickBooks the most, which allows 
that person to have the fastest access to it.

Client-server networks

Client-server networks are ones in which there is at least one computer dedicated to sharing 
files, printers, and other resources. This computer is usually not used by individuals to do 
their daily work.

In the diagram below, there are three computers for three users (Jack, Sarah, and Amy), 
plus the file server. You will likely want to put the company file on the server, where it’s 
accessible to all of the computers that need to use it.

Since Jack, Sarah, and Amy all need to use QuickBooks, all have their own copy of 
QuickBooks Pro or QuickBooks Premier installed with a unique Installation Key Code. The 
file server; however, does not need to have QuickBooks installed.

QuickBooks Pro installed and
company file (company.qbw)

QuickBooks*
installed

QuickBooks*
installed
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Setting up multiple-user networking

Ensure QuickBooks Pro or QuickBooks Premier is installed on each computer that’s going 
to use your company file (see “Installing QuickBooks” on page 3). Each copy must have a 
unique Installation Key Code.

Note: Your networked computers must all use the exact same version of QuickBooks 2004 Pro or 
QuickBooks 2004 Premier. That means that if you install an update to QuickBooks Pro or Quick-
Books Premier on one computer, you must install it on all your computers.

Setting up the Administrator and other users

Once you have installed QuickBooks Pro or QuickBooks Premier, the Administrator should 
set up the all the users who will share the company file (see “Setting up users and 
passwords” on page 133).

Note: You can set up as many users as you want in QuickBooks Pro or QuickBooks Premier. However, 
only five can access the company file simultaneously.

Activating each copy of QuickBooks 

Open your shared company file in each copy of QuickBooks Pro or QuickBooks Premier 
before you activate the license key for it. This allows you to properly activate the license key 
for your different copies. For more information about how activation, see “QuickBooks 
activation” on page 269.

To learn about… Search the Help index for…

Adding users users, adding

Setting up preferences preferences, general
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Decisions to make before you start
In QuickBooks, a "company file" contains all the financial records for a single business. 
Before you can use QuickBooks, you need to tell QuickBooks about your business so that it 
can set up your company file.

Locating an advisor to help you with QuickBooks

Tip: Professional accountants and consultants can help set up your company file for you. To help 
small businesses find these professionals, Intuit Canada manages a referral service through the 
IntuitAdvisor program. The referral service connects small businesses working with QuickBooks 
with accountants or consultants who are knowledgeable in QuickBooks. The service is free - you 
simply pay the advisors’ fee for specific services you need.

These accountants and consultants possess the tools, resources, and knowledge to help you 
set up and maintain, and optimize QuickBooks so that you can manage your business 
better.

You can locate a QuickBooks IntuitAdvisor in your area by using our no-cost online referral 
service on the QuickBooks.ca web site (http://www.quickbooks.ca/). We suggest that you 
select two or three advisors and contact each to determine who would be right for your 
business. The advisor you select will provide you with information about his or her fees.

Becoming an IntuitAdvisor

If you are an accountant, bookkeeper, or computer consultant who supports small to 
medium business clients, you may want to consider becoming a member of this unique 
community. The program is intended to provide additional support to those people who 
service the needs of small business clients. It’s a great way to learn more about QuickBooks 
as well as help you build your business.

By joining the program, you will receive the latest version of QuickBooks plus all updates 
for it and payroll changes, additional training materials, invitations to training courses, 
informational emails, access to an online forum, and referral programs. If you like, you can 
also have your name listed on our Web site to attract new QuickBooks clients. To become 
an IntuitAdvisor or find one near you, visit the QuickBooks.ca Web site 
(http://www.quickbooks.ca/). 
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How many companies should you set up?

The Canada Customs and Revenue Agency (formerly called Revenue Canada) requires that 
for each business you have, you clearly show its income and expenses. For tax purposes, it’s 
usually best to set up a separate QuickBooks company for each business that files its own 
tax return.

For example, if you have two shops and file one tax return for each, you need to set up two 
company files in QuickBooks. However, if you have a farm that grows wheat and raises pigs 
and you file only one tax return for the entire operation, you only need one company file 
in QuickBooks.

If you have one business but need to track different segments of it, set up one company file 
in QuickBooks and use classes. These are a way of categorizing income or expenses within 
income or expense accounts. For example:

You can set up subclasses of existing classes if you need to subtotal information about 
classes on reports.

Use classes to track the following Industry examples

Account executives Advertising, Consulting

Partners Law firms, Consultants

Construction industry standard categories (General, 
Site Work, Concrete, Masonry, and so on)

Construction contractors

Departments Businesses that budget by 
department, Retailers

Funds (General, Building, Outreach, and so on) 
You could start with two main classes for restricted 
and unrestricted funds, and then make each fund a 
subclass of a main class.

Nonprofit organizations, 
Religious groups

Locations (if the business has more than one) Restaurants, Retailers, 
Service businesses 

Manufacturers or Product lines Distributors, Manufacturing 
reps, Sales agents

To learn about… Search the Help index for…

Turning on the preference for 
using classes

classes, turning on in QuickBooks

Adding classes and subclasses classes, adding
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What accounting method should I use?

Cash versus accrual bookkeeping

There are two common methods of bookkeeping: cash and accrual. Your method 
determines how you report income and expenses on your tax forms. When you begin 
your business, you need to decide which bookkeeping method to use.

It’s best not to switch to a different accounting system after you’ve selected one. However, 
you can switch between cash and accrual reports in QuickBooks at any time, without 
affecting your accounting records. By default, QuickBooks creates reports on an accrual 
basis. To change reports (except a transaction report) to cash basis, search the Help index 
for "Reports: cash vs. accrual."

Cash basis

Some small businesses record income when they receive the money and expenses when 
they pay the bills. This method is known as bookkeeping on a cash basis. If you’ve been 
recording deposits of your customers’ payments but haven’t been including the money 
customers owe you as part of your income, you’ve been using cash basis accounting. 
Similarly, if you’ve been tracking expenses at the time you pay them, rather than at the time 
you first receive the bills, you’ve been using cash basis accounting.

Accrual basis

In accrual-basis bookkeeping, you record income at the time you make the sale, not at the 
time you receive the payment from the customer. Similarly, you enter expenses when you 
receive the bill, not when you pay it. Most accountants feel that the accrual method gives 
you a truer picture of your business’s finances.

How your bookkeeping method affects QuickBooks

QuickBooks allows you to enter your transactions the same way no matter which method 
you use for taxes. When you first install QuickBooks; however, it uses accrual-basis 
accounting by default. For example, it shows income on a profit and loss statement for 
invoices as soon as you record them, even if you haven’t yet received payment. It shows 
expenses as soon as you record bills, even if they are unpaid.

You can see any report (except transaction reports) on a cash basis by changing the 
reporting preference. (For more information, search the Help index for “Reports: cash vs. 
accrual.”)

The Canada Customs and Revenue Agency (CCRA) requires accrual-based 
bookkeeping for businesses that collect GST except for farmers, fishers, and 
a few other specified businesses.

Check with your accountant or the CCRA before you make your choice.
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What accounting do I need to know?

Using QuickBooks requires very little accounting knowledge. You need to understand a 
chart of accounts and the different types of accounts on it. You don’t have to know about 
debits and credit, journal entries, or closing periods.

Your company’s chart of accounts

When you keep books for a business or organization, you want to track where your income 
comes from, where you put it, what your expenses are for, and how you pay them. You track 
this flow of money through a list of accounts called the chart of accounts. Your QuickBooks 
chart of accounts can have:

� Balance sheet accounts

� Income accounts

� Expense accounts

� Cost of goods sold accounts

� Non-posting accounts (includes purchase orders and estimates, which don’t appear on 
your balance sheet)

Some of these accounts are created for you automatically. For example, the first time you 
create an invoice or statement charge, QuickBooks automatically creates an accounts 
receivable (A/R) account. You’ll add other accounts, such as your chequing account, during 
setup using the EasyStep Interview. You can create and modify your accounts as needed at 
any time.

Types of accounts

Balance sheet accounts

Your chart of accounts includes balance sheet accounts. These accounts track the following:

� What you have (assets)

� What people owe you (accounts receivable)

� What your company owes to other people (accounts payable and other liabilities)

� The net worth of your company (equity)
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The following table describes the various types of QuickBooks balance sheet accounts.

Balance sheet 
account type

QuickBooks 
account type

Use to track

Asset What you have and what people owe you

Bank Transactions in chequing, savings, and money 
market accounts. You can also use this type of 
account for petty cash.

Accounts Receivable 
(A/R)

Transactions between you and your customers, 
including invoices, statement charges, pay-
ments from customers, deposits of customer 
payments, refunds, and credit memos. 
QuickBooks automatically creates an A/R 
account when you first create an invoice or 
statement charge.

Other Current Asset Assets that are likely to be converted to cash or 
used up within one year, such as the value of 
your inventory on hand, notes receivable due 
within a year, prepaid expenses, and security 
deposits.

Fixed Asset Depreciable assets your business owns that 
aren’t liquid (not likely to be converted into cash 
within a year), such as equipment, furniture, or 
a building.

Other Asset Any asset that is neither a current asset nor a 
fixed asset, such as long-term notes receivable.

Liability What your company owes to other people

Accounts Payable (A/P) Outstanding bills. When you first enter a bill, 
QuickBooks automatically creates an A/P 
account.

Credit Card Credit card transactions for your business 
expenses. One account per credit card.

Other Current Liability Liabilities that are scheduled to be paid within 
one year, such as sales tax, payroll taxes, 
accrued or deferred salaries, and short-term 
loans. Some businesses include the current por-
tion of long-term liabilities in this kind of 
account. 

Long-Term Liability Liabilities such as loans or mortgages sched-
uled to be paid over periods longer than one 
year.
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Balances for balance sheet accounts

The Chart of Accounts window shows a balance for each balance sheet account (except for 
the special equity account, Retained Earnings).

Income and expense accounts

Income and expense accounts track the sources of your income and the purpose of each 
expense. When you record transactions in a balance sheet account, you usually assign the 
amount of the transaction to one or more income or expense accounts. For example, you 
not only record that you took money out of your chequing account, but you keep track of 
what you spent the money on, such as utilities, advertising, or office supplies.

There are no registers for income and expense accounts, but you can create reports to show 
totals for these accounts over a period of time.

Equity Net worth of your company 

(equity = assets – liabilities)

Equity A company builds equity from three sources:
� Investment of capital in the business by the 

owners
� Net profit from operating the business during 

the current accounting period
� Retained earnings, or net profits from earlier 

periods that are carried forward into the cur-
rent fiscal year and that have not been distrib-
uted to the owners

Balance sheet 
account type

QuickBooks 
account type

Use to track

One of the first things you 
should do when you open a 
business is open a business 
chequing account.



26 Chapter 2   Setting up a new company

Cost of goods sold (COGS) account

Many businesses that track inventory have one cost of goods sold account, which is similar 
to an expense account. A COGS account contains the cost of inventory you have sold.

What’s the best way to track my type of detail?

The following table describes situations that require a business to track a particular type of 
detail. The table suggests the best way to track this detail in QuickBooks.

Situation
How to record in 
QuickBooks

Comments For more...

You need to track details 
of services you’re pro-
viding or products 
you’re selling.

Set up items on the Item list 
for your services and prod-
ucts.
Record the sale, using the 
appropriate items. On sales 
forms you can edit the item 
descriptions to add detail 
you want the customer or cli-
ent to see.

You can get reports 
about the items for 
services and products 
that you have sold, 
including quantities and 
dollar amounts by item. 

search the Help 
index for:
items, Items are 
important for 
every business

You need to track multi-
ple jobs for the same 
customer.

Set up jobs for the customer 
on your Customer:Job list. 
When entering any sales for 
a job, enter both the job and 
customer name in the Cus-
tomer:Job field.

Reports by customer or 
by job give subtotals by 
job and then a total of 
jobs for the customer.

search the Help 
index for:
jobs, setting up

You need to track 
expenses by customer 
or job.

If you don’t have 
QuickBooks Pro or Premier, 
turn on the preference for 
tracking expenses by job.
When entering any expenses 
for a customer or job, enter 
the customer name or the job 
and customer name in the 
Customer:Job field.

You can track expenses 
by customer alone if 
you don’t use jobs. 
The profit & loss by job 
report lists both income 
and expenses with a 
separate column for 
each customer and job.

search the Help 
index for:
customers, add-
ing new

profit and loss 
reports

You need to track 
income and expenses 
by fund, location, 
department, or busi-
ness segment.
Examples: Religious and 
arts organizations, retail 
stores with multiple 
locations

Turn on class tracking, and 
set up a class on your Class 
list for each fund.
On every transaction, enter a 
class as well as an account 
(where appropriate).

The profit & loss by 
class statement has a 
column for each fund 
(class), so you can see 
income and expenses 
by fund.

search the Help 
index for:
classes, turning 
on in Quick-
Books
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You have employees 
and need to see detail 
about payroll taxes and 
other payroll expenses.
Example: Any company 
with employees

Use the QuickBooks payroll 
feature to track your payroll.

The payroll reports 
show all your payroll 
information.

see “Setting up 
payroll: an over-
view” on 
page 179

You need to track cer-
tain details about your 
customers and vendors.
Example: Payment 
terms, customer’s sales 
tax, customer’s “ship 
to” address, T4-A infor-
mation, your account 
number with a vendor

Find and fill in the appropri-
ate field in the New or Edit 
Customer window or the 
New or Edit Vendor window. 
The field you want may be 
on the Additional Info tab.

If you set up customers 
and vendors by using 
the QuickAdd option, 
go back later, to add 
missing information.

search the Help 
index for:
customers, add-
ing new
customers, edit-
ing information 
for

vendors, adding, 
adding a vendor

vendors, editing 
information for

You want to see reports 
for a particular group of 
customers, jobs, or ven-
dors.
Examples: Residential 
vs. commercial custom-
ers; remodeling jobs vs. 
new construction; ven-
dors that sell materials 
vs. subcontractors 

When setting up a customer, 
job, or vendor, assign a type. 
(Job types are available only 
in QuickBooks Pro and Quick-
Books Premier.)

You can filter a rele-
vant report to limit the 
transactions to those 
for customers, job, or 
vendors of the type (or 
types) you specify.
You can filter a report 
of your Customer:Job 
list or Vendor list to 
limit the names to those 
for the type (or types) 
you specify.

search the Help 
index for:
customer types

job types

vendors, adding

report customi-
zation

On your Item list, you 
want to group similar 
items together.
Example: A school store 
wants to group clothing 
items and also group 
book items

Set up a main, or parent, 
item (for example, clothing). 
Then set up subitems of the 
parent item (for example, T-
shirt, cap).
Use the appropriate subitem 
when entering a sale or pur-
chase of items.

On reports that summa-
rize amounts by item, 
QuickBooks provides an 
amount for each sub-
item, and then a subto-
tal for all subitems of 
the same item.

search the Help 
index for:
subtotals, on 
sales forms

Situation
How to record in 
QuickBooks

Comments For more...
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Tracking income and expenses with classes

Do you need to track income and expenses for separate parts of your business or 
organization? The following table has examples of what you can track by using classes in 
QuickBooks. (The word class has nothing to do with teaching or learning—instead, it is a 
way of classifying income or expenses in addition to assigning an income or expense 
account.)

You want to track infor-
mation that QuickBooks 
doesn’t already track for 
customers, vendors, 
employees, or the items 
you sell.
Examples: Patient’s 
insurance company, 
item size or colour

Set up a custom field for 
tracking the particular kind of 
information.
Fill in the custom field, where 
relevant, for new and exist-
ing customers, vendors, 
employees, or items.
To display and print the cus-
tom field on sales forms or 
purchase orders, customize 
the form to add the new field.

You can use the same 
custom field for cus-
tomers, vendors, and 
employees if you 
choose.
Custom fields for items 
are only for items you 
sell or purchase (ser-
vices, parts, and other 
charges).
You can filter a rele-
vant report to limit the 
transactions to forms 
that have specific text in 
a custom field.

search the Help 
index for:
custom fields, 
about

estimates, cus-
tomizing

On your profit and loss 
statement, you want to 
see subtotals for 
accounts that have 
something in common.
Example: A construction 
company wants a subto-
tal for construction 
income for labour, 
materials, and subcon-
tractors

Set up a main, or parent, 
account for the subtotal (for 
example, construction 
income). Then set up subac-
counts of the parent account 
(for example, labour, materi-
als, subcontractors). 
Use the appropriate subac-
count when QuickBooks 
requires you to specify an 
account.

On reports that summa-
rize amounts by 
account, QuickBooks 
provides an amount for 
each subaccount and 
then a subtotal for all 
subaccounts of the 
same account.

search the Help 
index for:
subaccounts, 
then click the 
link “Why use 
subaccounts?”

Situation
How to record in 
QuickBooks

Comments For more...

Use classes to track the following Industry examples

Account executives (particularly useful if you plan on using an 
employee incentive program linked to the employee’s business 
goals and profitability)

� Advertising 
� PR
� Consulting

Construction industry standard categories (General, Site Work, 
Concrete, Masonry, and so on)

� Construction contractors
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After you set up classes, you can enter them on any income or expense transaction 
including payroll transactions.

You can’t assign classes to transactions that involve only balance sheet accounts (for 
example, transfers from chequing to savings, setup of inventory, setup of fixed assets).

You can set up subclasses of existing classes if you need to subtotal information about 
classes on reports.

Departments � Businesses that budget by 
department

� Retailers

Funds (General, Building, Outreach, and so on) 
You could start with two main classes for restricted and unre-
stricted funds, and then make each fund a subclass of a main class.

� Nonprofit organizations
� Religious groups

Locations (if the business has more than one) � Restaurants
� Retailers
� Service businesses 

Manufacturers � Distributors
� Manufacturing reps

Partners � Law firms
� Consulting
� Any other partnerships

Product lines � Distributors
� Manufacturing reps
� Sales agents

Use classes to track the following Industry examples

To learn about… Search the Help index for…

Turning on the preference for 
using classes

classes, turning on in QuickBooks

Entering a class on a transaction classes, assigning to a transaction

Adding classes and subclasses classes, adding
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Should I use classes, jobs, or types?

Ask yourself: Am I trying to track income or expense activity associated with a particular 
customer or group of customers or group of jobs? 

If your answer is Yes, then you use jobs, customer types, or job types or track expenses by 
job. The following table shows what you can do with each of these.

If you are tracking a segment of your business that is independent of your customers and 
jobs, set up a class for the particular business segment. Then enter the class name in the 
Class field of every income or expense transaction for that segment.

To do the following…
Do this in 
QuickBooks…

Examples of reports to 
use

Keep track of sales for separate jobs or 
projects for one customer.

Set up and use jobs for 
the customer on the Cus-
tomer:Job list.

Sales by customer summary 
(which shows each job sepa-
rately)

See income or expenses for one type of 
customer, as distinguished from 
another type.
Example: A PR writer wants to compare 
a restaurant with retail clients.

When entering or editing 
a customer, assign a cus-
tomer type.

Sales by customer summary, fil-
tered for one customer type
Profit & loss by job, filtered for 
one customer type

(QuickBooks Pro and Premier only) See 
income or expenses for one type of job, 
as distinguished from another type. 
(Jobs of the same type can be for differ-
ent customers.)
Example: A construction contractor 
wants to compare kitchen remodels 
with office remodels.

When entering or editing 
a job, assign a job type.

Sales by customer summary, fil-
tered for one job type
Profit & loss by job, filtered for 
one job type

Assign expenses to a customer (or to a 
particular job for a customer).

On every expense trans-
action for that customer 
or job, enter the customer 
name (or the customer 
and job name) in the Cus-
tomer:Job field.

The following reports always 
break down amounts by cus-
tomer. If you have jobs, they 
also break down amounts by 
job.
Profit & loss by job
Job profitability (QuickBooks 
Pro and Premier only)
Profit & loss budget vs. actual
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Reports to measure profitability

The value and performance of your company can be summarized by two reports: the 
balance sheet and the profit and loss statement. How you set up your accounts will greatly 
influence the level of detail you can get on these reports. You may also want to create the 
statement of cash flows report, which details the net change in your cash during a period.

The balance sheet

A balance sheet is a financial snapshot of your company on one given date. This report is 
useful when applying for a business loan or at year-end to get an account of your company’s 
equity, assets, and liabilities.

Rock Castle Construction
Balance Sheet

As of March 31, 2004
                                   
                                                    
ASSETS

Current Assets
Chequing/Savings 29,454.55
Accounts Receivable 94,246.05
Other Current Assets 93.19

Total Current Assets 123,793.79

Fixed Assets 43,900.00
TOTAL ASSETS 167,693.79

LIABILITIES & EQUITY
Liabilities
Current Liabilities
Accounts Payable 44,118.16
Credit Cards 1,129.36
Other Current
Liabilities 2,655.72

Total Current 
Liabilities 47,903.24

Long Term Liabilities 8,470.96
Total Liabilities 56,374.20

Equity 111,319.59
TOTAL LIABILITIES & EQUITY 167,693.79

Assets include what you have and what 
people owe you. Examples include: 
� cash on hand
� money in your chequing account
� money you are owed
� furniture
� vehicles

total assets = total liabilities + equity

Liabilities include what your company 
owes to other people or your company 
debts. Examples include: 
� unpaid bills
� money you owe on credit cards
� loans
� sales tax you owe

Equity is the net worth of your company:

equity = assets - liabilities
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The profit and loss statement

A profit and loss statement, also called an income statement, shows your income and 
expenses over a period of time.

Page 2

Your cost of goods sold account always 
appears after income accounts and before 

Net income = income - expenses
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The statement of cash flows report

The statement of cash flows summarizes your sources (inflows) and uses (outflows) of cash. 
From the report, you can see how your cash position changed over a period of time.

Note: QuickBooks also has the capability to display investing activities, which show you how much was 
invested in assets such as equipment and furniture.

This shows how 
much cash was 
provided by 
profit-making 
activities.

This shows how 
much cash was 
provided by 
long-term 
liabilities and 
equity.

QuickBooks also has the capability to display 
investing activities, which show you how much was 
invested in assets such as equipment and furniture.



34 Chapter 2   Setting up a new company

Setting up your company in QuickBooks

Determining a start date

New Business

If your business has no financial transactions yet (that is, you are starting up your business 
at the same time you are setting it up in QuickBooks), your start date is today. You can go 
on to “Information to collect” on page 35.

Existing Business

Your start date is the date on which you begin managing your business finances in 
QuickBooks. It determines what information you need to enter in the Interview and 
afterwards.

For example, you could choose today as your start date, in which case you will need to enter 
how much money you have in each of your accounts and the amounts that your customers 
owe you and you owe your suppliers. Or, you could choose an earlier date, in which case 
you’ll also need to enter all the business transactions you’ve made between your start date 
and today.

The advantage of choosing today as your start date is that you don’t need to enter many 
historical transactions, which saves you time. The advantage of choosing an earlier date 
(and entering your business’ historical transactions) is that you’ll be able to see a lot more 
detail in your business reports.

To choose a start date that’s best for your company, consider these questions:

� When does your company’s fiscal year start?

� How close is today to the end of your fiscal year?

� Do you have an accurate balance sheet for your current fiscal year?

� Do you have an accurate profit and loss statement (also called an income statement) 
for your current fiscal year?

� How far back in time are you willing to enter historical transactions (old invoices, bills, 
bank account transactions)

� Will you be tracking payroll in QuickBooks?

Note: Although you can change your start date later, your start date determines much of your setup. 
It’s much easier to decide on the best start date now than change it later.

If it’s almost the end of your company’s fiscal year, consider finishing it using your old 
system of bookkeeping. Then set up your company in QuickBooks with a start date of your 
fiscal year-end so you can use QuickBooks for the new fiscal year. You’ll have the detail for 
each fiscal year, and you won’t have to do a lot of work setting up.



Setting up your company in QuickBooks 35

If it is not near the beginning of your fiscal year, decide which is more important to you:

� Do you want to have full detail in QuickBooks for the current fiscal year?

OR

� Do you want to enter relatively few historical transactions (covering the period 
between your start date and today)? If you’re not going to enter your historical infor-
mation for the full fiscal year, you may want to choose a start date at the beginning of 
a calendar quarter, especially if you’re going to use QuickBooks payroll.

If your business generates a lot of invoices, bills, or cheques, you probably don’t want to 
enter more than three months of historical transactions. On the other hand, if your 
business has relatively few transactions, you may be willing to enter several months of 
historical detail.

Information to collect

Who owns your business?

First, determine how your business is owned. Is it a sole proprietorship, a partnership, or a 
corporation? The differences include the tax form you file (T1 or T2), your income tax filing 
deadlines, and how your profits are apportioned.

� Sole proprietorships: A sole proprietorship is an unincorporated company owned by 
one person.

� Partnerships: A partnership is an unincorporated business owned by two or more 
persons. In a partnership, each partner owns a share of all assets and liabilities. Each 
partner may have invested in the partnership, and each receives a specified share of 
profits. Partners do not receive salaries, but they may withdraw money against their 
share of profits.

� Corporations: A corporation is owned by its stockholders. Unlike a sole proprietorship 
or a partnership, a corporation can pay a working owner a salary.

Are you registered to collect sales taxes?

Although very small businesses are exempt, the Canada Customs and Revenue Agency 
(CCRA) recommends that all businesses register to collect the GST. When your company’s 
sales exceed a certain level, the CCRA requires you to register. Check with your local CCRA 
office about whether your company needs to be registered, and if so, how to go about it.

Registered businesses track the GST (or HST) paid on purchases for the business and 
collected from customers on sales. Usually, the business owner collects more sales tax 
than he or she pays out and remits the difference to the CCRA.

Many provincial governments also require businesses to register to collect a provincial sales 
tax (PST or QST). Check with your province’s Minister of Finance for the requirements for 
your business.
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Other important information you’ll need

This table lists the information you’ll need to complete the EasyStep Interview and where 
to find it. You’ll enter most of this information in the Interview, but some you’ll need after 
you finish the Interview and are completing your company setup.

Information you need Where to find it �

Company legal name and address Owner, your accountant, or tax 
forms.

❏

Federal business number. You must have a business 
number if you
� collect the GST, or
� pay wages to employees.

Canada Customs and Revenue 
Agency (CCRA), formerly Revenue 
Canada.

❏

The dates of your accounting period: 
� first month of your fiscal year
� first month of your income tax year, and
� your QuickBooks start date

Your records or accountant. ❏

Income tax form your business will file
Tip: When the EasyStep Interview asks you, select the 
income tax form your company uses. QuickBooks uses 
this information to associate accounts with tax form 
lines and create tax reports.

Your accountant, CCRA, or 
tax forms.

❏

Chart of accounts for your business
Tip: If you do not have an existing chart of accounts, 
don’t worry. The EasyStep Interview helps you choose 
an appropriate chart of accounts for your industry.

Your accountant or previous book-
keeping method.

❏

Names of the people in your company who will use 
QuickBooks, and which areas of your financial records 
you want them to have access to.

See “Working with multiple users” 
on page 132.

❏

Balances for these accounts:
� Credit card
� Line-of-credit
� Loan
� Bank

� Statements covering your start 
date up to today for all bank 
accounts, including chequing, 
savings, and GICs.

� All uncleared cheques, deposits, 
or other items (credit card 
receipts, for example).

� Balance sheet prepared by your 
accountant.

❏

How much GST/PST you owe. Accountant, CCRA, or provincial 
Minister of Finance

❏
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List of types of items you sell (products and services), 
including:
� Item number or name
� Current sales price or hourly rates
� The tax code that is usually associated with the item
� Income account for tracking sales of the item
For inventory only:

� Purchasing cost
� Quantity in inventory
� Total value of inventory for the item

Your company records. ❏

List of customers, including:
� Addresses
� Contact names
� Phone numbers
� Outstanding invoices

Your company records. ❏

List of vendors, including:
� Addresses
� Contact names
� Phone numbers
� Outstanding bills

Your company records. ❏

Value of your assets
For fixed assets, you also need the original cost and 
accumulated depreciation.

Balance sheet prepared by your 
accountant.

❏

Equity information
All the money you have put into the company, plus the 
sum of the retained earnings (the net profit or loss) for 
each year your company has been operating.

Your accountant. ❏

Payroll information See “Setting up payroll: an over-
view” on page 179 for details.

❏

Information you need Where to find it �
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Starting the EasyStep Interview

The EasyStep Interview walks you through the process of setting up your entire business in 
QuickBooks. It takes about an hour to complete, but if for some reason you need to exit the 
interview, you can click Leave at any time. 

Tip: For a list of the questions that appear in the Interview, see the EasyStep.txt file in your 
QuickBooks directory. You can use this list to organize your information for the Interview.

Starting the Interview the first time you start QuickBooks:
� The first time you start QuickBooks, it displays a window with several options. One is 

to create a new company. Choose this option to start the EasyStep Interview. You can 
also start the EasyStep Interview by choosing New Company from the File menu.

QuickBooks displays the EasyStep Interview window.

Opening the EasyStep Interview at other times:
� With your company file open, choose EasyStep Interview from the File menu. The 

interview picks up where you left it and you can continue on.

The following custom editions of QuickBooks Premier come with company 
files that are partially set up based on a specific industry; therefore, the 
EasyStep Interview is not available.

� Premier: Contractor

� Premier: Professional Services

� Premier: Property Management

� Premier: Association & Nonprofit

� Premier: Retail & Repair

� Premier: Manufacturing & Wholesale

For information on creating your company file in a custom edition of QuickBooks Pre-
mier, refer to the Right for My Business guide. Refer to this guide for more information 
on how best to set up your company in QuickBooks once it is created.

You can’t change information by returning to the EasyStep Interview and 
answering the questions differently.

If you need to change information you entered in the EasyStep Interview, change it 
directly in QuickBooks. The EasyStep Interview is designed to help you with the initial 
set up of your company file, not for editing it.
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Getting around in the EasyStep Interview

The EasyStep Interview is broken into six sections. After you complete all the sections, your 
company file contains basic information about your business.

� General: Lets you enter company information, choose a chart of accounts appropriate 
for your business, decide on QuickBooks preferences, and specify a business start date.

� Income & Expenses: Lets you review the income and expense accounts on your 
business’s chart of accounts and create new accounts, if needed.

� Income Details: Lets you specify whether your business income is from services and/or 
products you sell. Based on the information provided, QuickBooks determines which 
income tracking and accounts receivable features you need.

� Opening Balances: Lets you enter information about the customers who owe you 
money as of your start date, vendors to whom you owe money as of your start date, and 
balances in your balance sheet accounts as of your start date.

� Payroll: Lets you enter information like Social Insurance Number and birth date for 
your employees, set how often you will pay them, and set up payroll items (which you 
use to assign rates of pay, income taxes, and other deductions and additions to pay 
cheques for employees).

� What’s Next: Describes some common tasks in QuickBooks that you may want to 
complete after you have finished the Interview.

Complete the General section of the Interview before going on to other areas.
QuickBooks won’t know enough about your company to ask the rest of the Interview 
questions unless you fill in your basic company information and start date first.

Some questions ask you to make a decision that is not easily reversed.

When this is the case, you’ll see a warning symbol: 



40 Chapter 2   Setting up a new company

Should I track customers and jobs?

What does QuickBooks mean by a customer?

In QuickBooks, a customer can be any of the following:

� A person or company that buys products from your retail business

� A company that buys products from your wholesale business

� A client of your consultant business or law firm

� A patient of your medical or dental practice

� A homeowner who buys your home repair or remodeling services

� A condominium owner who pays fees to your condo association

� A renter who pays rent to your real-estate management firm

Some businesses don’t need to keep track of the names of customers. An example is a retail 
store or service business that always receives payment with the sale or service. 

However, here are some situations in which you would want to track of customer names:

� Customers receive your goods or services and then pay you later.

� Customers are supposed to pay a regular monthly fee, and you want to track who has 
paid and who hasn’t.

� You want to track income (and perhaps expenses as well) by customer.

If you’re using QuickBooks for an organization that receives money but doesn’t really sell 
anything, you likely don’t need to set up customers. For example, a nonprofit or religious 
organization with members making contributions or paying dues can track the deposits 
without making the members customers. Specialized membership software can keep track 
of membership details such as pledges, contribution history, and names of family members.

Recently, Intuit Canada has released a version of QuickBooks for this type of business. 
QuickBooks Premier 2004 Association and Nonprofit Edition is designed to help you get the 
most out of your programs in achieving your organization’s goals.

For more information about this and other business-specific QuickBooks Editions, see 
“Ordering QuickBooks products and services” on page 269.

What does QuickBooks mean by a job?

In QuickBooks, a job is a project done for a particular customer. You must always associate 
a job with a customer. Use jobs if you do (or expect to do) more than one job for the same 
customer. For example, Jan does freelance writing for a large company that supplies a 
separate purchase order for each job. Hank’s plumbing business has to keep track of the 
separate jobs it does for a general contractor.



Should I track customers and jobs? 41

On the other hand, if your company never does more than one job per customer, or you do 
not want to track individual jobs, you don’t have to enter job names. For example, Doug’s 
printing company refers to each customer order as a “job.” However, even though Doug 
gets repeat business from customers, all he cares about is whether the customer has paid, so 
he doesn’t need to set up jobs for his customers.

Besides using projects for jobs, you can be creative. For example:

� If you manage several apartment buildings, set up the building addresses as customers 
and the individual apartments as jobs.

� If you invoice against purchase orders, set up each purchase order number as a job.

� If you have a practice or organization that sends one statement to a family to cover 
individual members of the family, set up the family members as jobs. 

� If you have multiple estimates per customer, search the help index for “estimates, by 
job”.

� QuickBooks reports about jobs apply to customers as well. You don’t have to set up jobs 
in order to use these reports. For example, the profit and loss by job report actually 
applies to both customers and jobs. If you have customers but not jobs, you will still 
see information about your customers. 

Changing the opening balance for a customer or job

When you first set up a customer or job, you have a chance to enter the opening (unpaid) 
balance for the customer or job as of a specific date. The date should be your QuickBooks 
start date (that is, the date when you enter opening balances for all accounts, customers, 
and vendors).

When you enter the customer’s opening balance (in the EasyStep Interview or New 
Customer window), QuickBooks creates an invoice for the amount and date you specify. 
This invoice is probably the first transaction in the customer register. (There should not be 
any opening balance transaction if the customer had no unpaid balance as of the start date.)

You can change the customer’s opening balance invoice by finding it in the customer’s 
register and then editing it.

If you failed to enter an opening balance but want to create one now, enter an invoice dated 
on or before your start date. To summarize the amount owed as of your start date, enter on 
the invoice an item set up as a nontaxable other charge, and assign the account 
Uncategorized Income.

To learn about… Search the Help index for…

Displaying a customer’s register customers, registers for

Editing a transaction in a register registers, editing entries

Entering an invoice invoices, creating

Setting up an other charge type of 
item

other charge items
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Why you probably need to set up items

Items for what you sell

If your business provides a service—writing, haircutting, consulting, legal advice, house 
painting, or any other service—you may charge by the hour and list the number of hours 
and your rate on your sales forms. Or, you may simply charge a flat rate for the service.

If your business sells products or parts, you probably list them on sales forms that you give 
your customers.

In QuickBooks, both kinds of businesses—service and product—can benefit by setting up 
items to track the services they provide or the products they sell to customers.

Note: In QuickBooks, “sales” is a broad term.

It refers to any business action that generates income in exchange for services or products, even 
if you don’t think of what you do as selling. For example, a psychologist with patients, a graphic 
designer with clients, and a roofing contractor with customers all would set up items in Quick-
Books for what they sell.

Benefits of setting up items

Here are some specific benefits of setting up items: 

� You can use sales forms in QuickBooks to track the details of how your business earns 
its income. Estimates and all sales forms—invoices, sales receipts, credit memos—
require items. So do QuickBooks statement charges, which print on statements. 

(If you’re a professional, you may not think of your statements as sales forms, but they 
are.)

� You can fill out sales forms or enter statement charges quickly. QuickBooks automati-
cally enters the description and rate or price you entered in the item’s setup window. 
When you enter a quantity, QuickBooks calculates the amount.

� When you record a sale (remember, it can be for a service), QuickBooks automatically 
tracks the income in the appropriate income account. You can fill out a sales form (or 
enter a statement charge), keep track of your sales, and keep track of income—all in one 
step.

� You can create reports that show total units of each service or product sold as well as 
dollar amount totals.
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If you’re still not sure you need items

Here are some examples of businesses or organizations that use items:

� Rebecca is the bookkeeper for a country club where members sign for meals, drinks, and 
fees and receive a statement at the end of the month. Rebecca uses items in QuickBooks 
for each of these. She uses the items to enter statement charges for each member and 
create monthly statements.

� Mario is a dentist. He has items set up for the various services he provides to his 
patients: cleaning, x-rays, filling cavities, and so on.

In contrast, some businesses or organizations probably don’t need items. Here are some 
examples:

� John is keeping the books for his church. The church has members who pledge and 
contribute money, but the church doesn’t sell anything or charge for specific services, 
so John doesn’t need to create any sales forms.

� Marina does facials in her home evenings and weekends. Her clients pay at the time of 
their visit. Marina simply wants to track the income received. She doesn’t care to track 
in QuickBooks how many facials she gives or to whom.

� Rick is a commissioned sales representative. He takes orders for a manufacturer that 
then invoices the customers directly. Rick tracks the orders in a spreadsheet, not Quick-
Books, because the sales are income for the manufacturer, not Rick. When Rick receives 
a commission cheque, he enters it in QuickBooks as a deposit.

Items for services or products you purchase

Once you’ve decided to set up items for the services or products you sell, you might want 
to use items for the services and products you purchase.

If you purchase services or products for a specific customer or job, QuickBooks Pro and 
Premier allow you to set up items that you can use for both purchases and sales. See “Items 
for reimbursable costs in QuickBooks Pro and Premier Editions” on page 53.

On the other hand, if you don’t have QuickBooks Pro or Premier and you don’t track 
inventory, you should not use the same items for both purchases and sales. Instead, use 
items for entering sales only.

If you purchase property such as buildings, vehicles, computers, or heavy machinery that 
will contribute to the operating capacity of your company for several years, QuickBooks Pro 
and Premier enable you to set up items that can help you track their depreciation. You need 
to track the depreciation of such fixed assets both for tax purposes and to get an accurate 
accounting of the worth of your business. Your accountant can give you more information 
about using fixed asset items to record purchases and subsequent sales of fixed assets.
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Deciding how items should affect accounts

When you set up most items, you must specify which account it should affect when you 
use the item on a sale or purchase. Then, when you record the sale or purchase, each item 
on it affects the appropriate account.

In other words, while you are recording the items on a sale or purchase, QuickBooks is 
adjusting all the right accounts behind the scenes.

Which are the right accounts? If you sell an item (service, non-inventory, and other 
charges), you normally associate an income account with it. If you purchase the same item, 
QuickBooks Pro or Premier provides a way to associate a second account, usually an expense 
account, to be used on purchases. See “Items for reimbursable costs in QuickBooks Pro and 
Premier Editions” on page 53. 

If you purchase a fixed asset, you normally associate a fixed asset account with it. When 
you sell a fixed asset, you normally associate a fixed asset account with the asset.

Before you set up your items, you have to decide how much detail from your sales and 
purchases needs to show up in reports about your accounts. (The profit and loss statement, 
for example, is a report on your income and expense accounts.)

You can see details of your sales (such as number of units and dollar amount of each item 
sold) on the QuickBooks sales reports. You don’t need to have the same level of detail on 
your profit and loss statement. For example: 

� Cynthia has a single income account for all sales income. She doesn’t want to see any 
further breakdown on her profit and loss statement, and she doesn’t need it for her tax 
returns.

� Derek, on the other hand, wants to split up income from services and income from 
materials he buys for a job and then puts on the customer’s invoice. Thus, he uses one 
income account for all his service items and a second income account for all his non-
inventory part items (for his materials). Like Cynthia, he has far more items than 
income accounts. 

To learn about… Search the Help index for…

accounts for tracking inventory inventory, accounts
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How many different items do you need?

Every business is different, but knowing how QuickBooks works can help you decide how 
specific your items should be.

First, once you use an item in a transaction, you can never delete the item unless you delete 
the transaction or condense your file to remove old transactions and old items. Fixed asset 
items are not condensed. Thus, if you sell unique items or a rapidly changing assortment of 
items, you probably want to use more general items. If the prices vary, you can enter prices 
on the sales form.

For example, Tomas has a men’s clothing store. Because his inventory of styles changes so 
much, he doesn’t use QuickBooks to track inventory. To track his sales, he has more general 
items such as Suit, Sports Jacket, Dress Shirt.

On the other hand, if you have two standard services or products that are similar except for 
their rate or price, you can save time recording sales by having a separate item for each. 
Then QuickBooks can fill in the correct rate or price on the sales form.

For example, Mali employs three stylists in her beauty salon. When she cuts a client’s hair, 
she charges more than the rate for a haircut by one of the employees. So she has two 
separate items for haircuts.

You can change the rate or price of any item at any time. You don’t have to create a new 
item in order to raise your prices.

In QuickBooks Pro and Premier, you can create price levels to increase or decrease 
inventory, noninventory, and service item prices. Use them on sales forms to automatically 
adjust the price of an item. Price levels can be created for any customer with whom you 
have a special relationship.

Finally, if there are items you purchase but never sell but that are not fixed assets (supplies 
for your office, for example), you probably shouldn’t bother to put them on your Item lists. 
They will lengthen your list, and you’ll find it harder to pick out the items that you do sell. 
However, if you plan on using QuickBooks purchase orders, you’ll need to set up the items 
you purchase, even though they are only for your office use.
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Setting up items
This section is about adding items to QuickBooks. You can add items at any time—as part 
of setting up QuickBooks or whenever you think of an item you need to use.

Remember, items are for the services or items you buy and sell. You also may need special 
calculating items that calculate subtotals and discounts, and that apply specific sales tax 
rates.

The EasyStep Interview helps you set up a few items, so you may already have some items. 
Fixed asset items are not set up in the EasyStep Interview.

Where to find information about your items

When you set up an item, you enter information you can use over and over again without 
retyping, such as the following:

� Name or code

� Description

� Price per unit or rate per hour, if applicable

� For items you sell, the income account to assign income from the sale; for items you 
purchase, the expense account for purchases of the item

QuickBooks stores information about your items on the Item list.

On the Item list, items are 
in order of item type. 

Within the same item 
type, they are usually in 
alphabetical (or 
numerical) order, but you 
can change this order.

Subitems are indented 
under the parent item.

Use the menu buttons to 
add, edit, sort, or perform 
other activities on items.
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Information about fixed assets is available in the Fixed Asset Item List. The Fixed Asset Item 
List is only available in QuickBooks Pro and Premier.

Types of QuickBooks items

In addition to items for services or products, QuickBooks has several other types of items. 
This section explains what each type of QuickBooks item is designed to do.

Tip: Use one of the Part item types for any product, not just a part of another product. If you decide 
to use QuickBooks inventory to track your products, set up inventory parts for them. Otherwise, 
set up non-inventory parts for your products.

This list shows the 
fixed asset items 
you've set up to track 
your fixed assets. You 
can use this list to track 
all transactions having 
to do with your fixed 
assets, including any 
repairs or 
improvements, 
damage—anything 
that can affect their 
value and amount of 
depreciation.

To learn about… Search the Help index for…

Price levels (Pro and Premier only) price levels

Displaying the Item or Fixed Asset 
Item list

items, list of

Sorting the Item list (and other 
lists)

sorting, list entries

Moving items (and other list 
entries)

lists, reorganizing entries

Item type Use for…
Usual effect 
on accounts

Comments

Service Services you charge for or 
services you purchase
Examples: professional 
fees, labour

On sale: Increases 
income. 
On purchase: 
Increases 
expenses.

In QuickBooks Pro and Premier, 
you can set up a service item so 
that it can affect either income 
or expenses, depending on 
where you use it. Price levels 
can be used on service items
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Inventory Part Products you purchase, 
track as inventory, then 
resell
Examples: Electrical outlets, 
T-shirts

On sale: Increases 
income, increases 
cost of goods sold, 
and decreases 
inventory assets.
On purchase: 
Increases inventory 
assets.

Available only if the inventory 
feature is turned on. Search the 
help index for inventory, turn-
ing on.
Price levels can be used with 
inventory parts. Search the help 
index for price levels.

Inventory 
Assembly

Assembled products you 
purchase or create and 
build, track as inventory, 
then resell
Examples: Gift baskets, 
Soaker hose starter kits

On sale: Increases 
income, increases 
cost of goods sold, 
and decreases 
inventory assets.
On purchase: 
increases inventory 
assets.

QuickBooks Pro and Premier 
Edition(s) required to create and 
build inventory assemblies. 
Available only if the inventory 
feature is turned on. Appropri-
ate for “light” assembled items; 
QuickBooks does not track 
inventory through the manufac-
turing process. Price levels can 
be used with inventory assem-
blies.

Non-inven-
tory Part

Products you sell but don’t 
purchase; items you pur-
chase and resell but do not 
track as inventory; items 
you enter on purchase 
orders
Examples: Custom-made 
slipcovers

On sale: Increases 
income. 
On purchase: 
Increases 
expenses.

In QuickBooks Pro and Premier 
you can set up a non-inventory 
part item so that it can affect 
either income or expenses, 
depending on where you use it. 
Price levels can be used with 
non-inventory parts.

Fixed Asset Property that will contribute 
to the operating capacity of 
your company for several 
years
Examples: Vehicles, Com-
puters, Heavy machinery

On sale: Decreases 
assets. 
On purchase: 
Increases assets.

In QuickBooks Pro and Premier 
you can create fixed asset 
items; in QuickBooks Basic you 
can view fixed asset items in 
the Item list and edit or delete 
transactions in which they’re 
found, but you can’t create 
them.

Other Charge Other charges on a sale or a 
purchase
Examples: Shipping charge, 
delivery charge, finance 
charge

On sale: Increases 
income. 
On purchase: 
Increases 
expenses.

In QuickBooks Pro and Premier 
you can set up an other charge 
item so that it can affect either 
income or expenses, depending 
on where you use it.
Can be either a percentage or a 
flat amount.

 
(continued

Use for…
Usual effect 
on accounts

Comments
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Items that calculate

The table of items includes some items used to perform a calculation on one or more lines 
above it on a sales form.

For example, if you need to subtotal on sales forms, then you need a subtotal item. A 
subtotal item adds the amounts of the items above it on the sales form and enters the 
subtotal on the form. 

Finally, there are some items that can be set up either as percentages or with flat amounts, 
depending on what you need. For example, Carol adds a 10 % service charge to her invoices. 
She has set up an other charge item with a rate of 10 %. She uses a subtotal item before the 
service charge, so that the 10 % will be based on the subtotal amount.

Steve gives a 15 % discount to certain customers. He has set up a discount item with a rate 
of 15 %. He must use a subtotal item, because the discount is based on the entire amount.

For examples of how to use items that calculate, see page 57 for subtotals, page 58 for 
discounts, and page 147 for sales tax.

Subtotal Calculating and printing a 
subtotal on sales forms

Subtotal items 
have no effect on 
accounts. 

On sales forms, if you want to 
apply a discount or add a per-
centage charge to several items 
at once, subtotal first.

Group Fast entry of a group of indi-
vidual items already on the 
list 
Example: A group of ser-
vices and food items pro-
vided by a caterer.

Each item in the 
group affects the 
same account it 
affects when used 
by itself.

Available for either sales or pur-
chases.

Discount Calculating an amount to be 
subtracted from a total or 
subtotal
Example: A 10% discount 
given to nonprofit organiza-
tions.

Either decreases 
income or 
increases expenses 
(depending on item 
setup).

Available for sales forms only; 
not available for statement 
charges or purchase forms.

Payment On invoices: Payment 
received at the time of 
invoicing, so that amount 
owed on invoice is reduced
On sales receipts summa-
ries: To show totals for each 
type of payment (cash, 
cheques, credit card 
charges)

Increases the bal-
ance of either a 
specific chequing 
account or the 
account for unde-
posited funds 
(depending on item 
setup).

Available for sales forms only; 
not available for statement 
charges or purchase forms.

 
(continued

Use for…
Usual effect 
on accounts

Comments
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Subitems vs. group and inventory assembly items

Just as you can set up an account with related subaccounts under it on your chart of 
accounts, you can have an item with related subitems. For example, Cherril keeps the books 
for her symphony association’s gift shop, which sells T-shirts and other items. She has an 
item called T-shirts and subitems called Adult and Child, each with its own price. 

Subitems enable you to put similar items together on your Item list, so you can locate them 
easily on the drop-down list in any Item field. Each subitem can have its own rate or price 
and its own description. Each subitem can even have its own account, although you would 
probably assign the same account to all subitems of the same parent item.

On sales forms, you use subitems the same way you use other items. On reports based on 
items, QuickBooks subtotals each group of subitems. 

Group and inventory assembly items have a completely different purpose from subitems. 
Group and assembly items allow you to enter a group of items—that is, several different 
items—at once on a sale or purchase. Group items are appropriate for combining several 
types of items, such as catering services and food items, on one line in a sales receipt. For 
an example of entering a group of items, see page 57. Assembly items, available in 
QuickBooks Pro and Premier Edition(s), are appropriate for indicating products you 
combine and sell as a unit, such as a gift basket containing one wicker basket and three jars 
of homemade jam.

You can’t group fixed assets or make them subitems of other items.

Adding items to your Item or Fixed Asset Item list

As the table starting on page 47 shows, QuickBooks has several different item types. Here is 
some general information about what to enter for most types of items when adding a new 
item to your Item or Fixed Asset Item list.

In this example, 
Hardware is a 
parent item with 
two subitems 
under it.
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Information to 
enter

How QuickBooks uses this information

Type of item After you choose the item type, QuickBooks requests only the information it 
requires for that particular item type. (Note: You cannot create fixed asset 
items from the Item list. Use the Fixed Asset Item list to do so.)
After you set up an item, depending on the type, you may not be able to 
change it to a different type.

Item name or code Displays this name or number on reports of items and in the drop-down list 
in the Item field (for example, on sales forms).

Item description 
(optional on all but fixed 
assets)

Prefills the entire description in the Description field of sales or purchase 
forms.
Displays the beginning of the description in the drop-down list in the Item 
field. 
You can set up some types of items to have separate descriptions for sales 
and for purchases.

Rate or price (optional) Prefills the rate or price in the Rate or Price fields of sales or purchase forms.
Some types of items can have a rate that is a percentage.
You can set up some types of items to have separate rates or prices for sales 
and for purchases.

Account or accounts Profit and loss statements report on the income or expense account associ-
ated with items used in transactions.
You can set up some types of items to have separate accounts for sales and 
for purchases.
Some types of items (for example, payment items) require a balance sheet 
account instead of an income or expense account. Inventory items require 
three separate accounts.

Default Tax code QuickBooks applies GST/PST to the item based upon the rate(s) defined in 
the Tax Code list. You can override this Tax Code on the sales form.

Subitem status If this field appears, you can make an item a subitem of an existing item. 
QuickBooks displays subitems of the same item together. 

Custom fields (optional) You can set up custom fields that fill your company’s needs (for example, 
size or unit of measure). You can also customize sales and purchase forms 
to display a column for a custom field. Then QuickBooks prefills the column 
with the custom field information for the item.
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To learn about… Search the Help index for…

Adding a new item for one of the 
following:
� A service
� An assembled product that you 

purchase or build yourself
� A product or part that is not 

held in inventory
� A fixed asset
� A miscellaneous charge

� items, services
� items, inventory assembly

� items, non-inventory parts

� items, fixed assets
� items, miscellaneous charges

Adding a new item for a product 
or part held in inventory

items, inventory

Adding a new item that puts a 
group of several items on a sales 
or purchase form

items, grouped together

Adding a new item that calculates 
a subtotal

items, subtotal types

Adding a new item that calculates 
a discount on a sales form

items, discount types

Adding a new item that records a 
customer payment or deposit 
received at the time of sale

items, payment types

Adding a new item that calculates 
a sales tax

items, sales tax

Adding a new item that calculates 
the total sales tax for a combina-
tion of sales tax rates

items, subitems

Creating subitems of another item items, subitems

Creating custom fields for items items, custom fields on

Turning sales tax on sales tax, setting up
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Items for reimbursable costs in QuickBooks Pro and Premier 
Editions

Perhaps your business purchases services or products for specific customers or jobs, then 
invoices the customer for the items (with or without markup). For example, Frank is a 
general contractor who uses subcontractors and invoices for their costs at a higher rate than 
what they charge him. Tina is an interior designer who buys furniture at wholesale and sells 
it to the client at retail. 

In QuickBooks Pro and Premier Editions only, service items, non-inventory parts, and other 
charge items each have a check box that allows you to pass through their costs at a markup 
and track costs and revenues in separate accounts. 

Then you can track both the expenses and the income for these items for a particular job. 
(For example, the checkbox for a non-inventory part is “This item is purchased for and sold 
to a specific customer:job.”)

Note: If you don’t have QuickBooks Pro or Premier, use expense accounts, not items, for reimbursable 
costs. 

There are several advantages to using items for reimbursable costs in QuickBooks Pro or 
Premier Editions:

� It is easy to associate the cost of an item with an expense account and the income with 
a separate income account when you set up the item. 

� You can track the number of units or hours purchased or sold. 

� You can use items on estimates and purchase orders.

� If you write a purchase order for an item, you can create a bill from the purchase order 
and assign a job. Then you can invoice the customer for the item. 

� When you enter a bill, cheque, or credit card charge, QuickBooks Pro and Premier 
Editions fill in the description of the item and the unit cost after you choose the item 
from the drop-down list on the Items tab.

� When you invoice the customer for the cost of the item, 
QuickBooks Pro and Premier Editions fill in the sales description of the item and the 
sales price.

� You can create reports that compare costs to revenues for each item. 

To learn about… Search the Help index for…

using expense accounts for reim-
bursable costs

reimbursable expenses, assigning to 
a customer or job

To learn about… Search the Help index for…

invoicing for reimbursable time 
and costs

reimbursable expenses, assigning to 
a customer or job
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Services performed by subcontractors or owners

If you charge for services performed by outside subcontractors or you pay owners (or 
partners) for time worked, set up a service item for each type of service. Be sure to select the 
checkbox “This service is performed by a subcontractor, owner, or partner.” Then you can 
designate separate income and expense (or equity) accounts, and separate descriptions for 
sales and purchases.

You can enter different hourly rates for your cost and the sales price to your customer. If 
you write cheques based on time tracked or enter the item on a purchase order, purchase, 
or estimate, QuickBooks fills in the rate from the Cost field. If you enter the item on a sales 
form, QuickBooks fills in the rate from the Sales Price field. However, if the subcontracted 
service is usually billed as a flat fee, and the fee varies, leave the Cost and Sales Price fields 
0.00 when you set up the item.

If you pay owners (or partners) and vendors for the same service, you need separate service 
items because the accounts for the costs must be different. 

Products and materials purchased for a job

If you invoice for actual costs of products and materials purchased for a specific customer 
or job, set up a non-inventory part item for each type of product or service. Be sure to select 
the checkbox for “This item is purchased for and sold to a specific customer:job.” Then 
you can designate separate income and expense accounts, and separate descriptions for 
sales and purchases.

Tip: To further aid in tracking the item, you can also specify the customer and job on the purchase 
order. When you receive the item, this information prefills on the item receipt or bill. Use the open 
purchase orders by job report to find out which items are still on order for your customers.

To learn about… Search the Help index for…

separate service items service items, creating items for ser-
vices you sell or buy

You can enter different 
rates for your cost and 
the sales price to your 
customer. However, if 
the cost of the product or 
material varies, leave the 
Cost and Sales Price 
fields 0.00 when you set 
up the non-inventory 
part item. 
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Miscellaneous charges you pass on

If you invoice for miscellaneous charges incurred on a job, you can set up an other charge 
item for each type of miscellaneous charge. For example, Frank has an other charge item 
called Equipment Rental. Be sure to select the checkbox for “This is a reimbursable charge.” 
Then you can designate separate income and expense accounts, and separate descriptions 
for sales and purchases.

As with products and materials, you can enter different cost and sales prices or leave the 
fields 0.00 when you set up the other charge item.

Working with items
After you have set up items, use them to enter estimates, sales, purchase orders, sales orders, 
actual purchases, and disposition of fixed assets. Remember, QuickBooks uses the term sales 
broadly; it can mean the performance of services or the assessment of fees as well as the sale 
of products. 

You can enter all item types listed in the table on page 47 on any sales form. You can enter 
all but payment items on estimates and sales orders. However, you can’t enter the following 
item types on purchase orders or purchases (on the Items tab of bills, cheques, and credit 
card charges):

� Other charge items set up as a percentage

� Discount items

� Payment items

Using items, saving time

When you fill out a sales form, you list each service, product, or fixed asset you’re selling 
on its own line of the invoice or sales receipt, along with the amount the customer owes for 
that item. Similarly, when you write a purchase order or receive a bill, each service, product, 
or fixed asset is listed on its own line.

To learn about… Search the Help index for…

Recording discounts from ven-
dors

discounts, from vendors

Entering payments to vendors vendors, paying (then Paying bills)
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Because information about individual items is listed on separate lines, the items are called 
“line items”. In QuickBooks, you enter line items by choosing from the drop-down list in 
the Item field of a sales or purchase form. You can also type in the Item field and let 
QuickBooks fill in the rest of the item’s name.

Each item on the Item list can contain all the information you need to fill in one line. You 
can always change the information, such as the description and rate, as you’re filling in a 
form.

When you enter a quantity, QuickBooks automatically calculates the amount for you.

You’ll have separate items not only for each service rendered and each product sold, but 
also for discounts, markups, sales taxes, and subtotals. If the customer makes a partial 
payment at the time of the sale, you can add an item for the payment.

Enter an item in 
the Item field by 
typing or by 
choosing from 
the drop-down 
list.

When you enter 
items, QuickBooks 
keeps track of how 
much of each item 
you sell and to 
whom.

Each item that you 
sell is associated 
with an income 
account.

This association 
allows QuickBooks to 
provide useful sales 
and income reports.

The Item column lists the item 
name you entered when you 
created the item.

QuickBooks multiplies the Quantity by 
the Rate to calculate the Amount.
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Using items to subtotal on sales forms

The subtotal item adds up the amounts of the items above it, up to the last subtotal.

You’ll need a subtotal item if you ever want to apply a percentage discount or surcharge to 
several items. Because QuickBooks calculates percentages on the line above, you’ll need to 
subtotal the items before entering the percentage line item.

If you use two subtotals in a row, the last subtotal will add up all the previous subtotals on 
the form.

Entering a group of items

The group item allows you to enter several items all at once on a sales form, estimate, 
purchase order, cheque, or bill. If you often sell the same group of items together, using a 
group item saves you the trouble of entering the same set of line items again and again.

When you use a group item, you can enter a quantity for the group that affects the quantity 
and amount of each item in the group. You can also edit the individual quantity of each 
item in the group, and edit descriptions and rates. 

Using a group item to hide details on a sales form

The more detailed you are in tracking items, the more information you can get from 
reports. The QuickBooks group item allows you to be very detailed in tracking the items you 
sell without showing all that detail to your customers. When you set up a group item, you 
specify whether to print each item or just the group item. (Of course, if you use a group item 
on a purchase order, you must show the detail to the vendor so the vendor will know what 
you want.)

The first subtotal line shows a 
total for all materials. 

The second subtotal shows a 
total for all labour.

The second subtotal also 
makes the third subtotal 
include all amounts on the 
invoice, so a percentage 
markup can apply to the total 
sale.

The third subtotal 
line adds up the 
two previous 
subtotals, so that a 
markup can be 
applied to the 
entire sale.
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For example, Frank has a construction company that sends invoices for full jobs, such as 
complete remodels. If he used one general service item called “Remodel”, a sales report 
would show his income from remodels.

However, Frank uses more detailed items, so he can learn more from his sales reports. Frank 
breaks down the remodel cost and uses items such as “Lumber”, “Hardware”, “Markup”, 
“Carpentry Hours”, and “Labourer Hours”.

He groups these items under one item called “Remodel”. Even though he chooses not to 
print the items in the group on the invoice for his customers to see, he still has those details 
on his sales reports.

Applying a discount to one or more items

To apply a discount, you have to enter a discount item. If the discount item’s rate is a 
percentage, the item reduces the amount due by a percentage of the line above it. 

To take a percentage off several items at once, you must first subtotal the items. On the 
other hand, if you want to discount one particular item you’ve sold and not the entire sale, 
add a discount item directly beneath the one discounted item.

If you use very 
general items, 
like this one, 
your reports 
won’t be as 
useful as if you 
used detailed 
items grouped 
together.

QuickBooks 
shows you the 
items in the 
group onscreen, 
whether you 
choose to print 
them or not. 

The first line shows a 
total for all materials.

The third subtotal 
line adds up the two 
previous subtotals, 
so that a markup can 
be applied to the 
entire sale.

The second subtotal 
also makes the third 
subtotal include the 
amounts on the 
invoice, so a 
percentage markup 
can apply to the total 
sale.

The second subtotal 
shows a total for all 
labour.
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If you give discounts of different percentages, you can either set up a separate discount item 
for each percentage or edit the amount right on the sales form.

Showing partial payments received at the time of sale

If you receive a partial payment toward the amount of an invoice at the time you create the 
invoice, you’ll need to enter a payment item. 

The payment item tells QuickBooks to subtract the amount of the payment from the total 
invoice amount. To record the payment on the invoice, enter a payment item for the 
amount you’ve received after you’ve entered all the items sold. 

You can set up a payment item so that it automatically deposits the payment directly to a 
chequing or other account. Alternatively, you can set it up so that QuickBooks 
automatically puts the payment amount into your Undeposited Funds account so you can 
deposit it with other funds. 

If you need to track the payment method (cheque, cash, credit card charge), you can have 
different payment items for different methods of payment.

Using a payment item is not the only way to record a payment. For some types of payment, 
you should use a different method:

Don’t use a discount item for discounts that you give for early payment.

Enter discounts for early payment through the Receive Payments window. Search the 
help index for receiving “payments, about”.

Use a payment 
item when you 
receive a partial 
payment at or 
before the time 
you create the 

QuickBooks subtracts a 
payment item amount 
from the invoice total.

To learn about… Search the Help index for…

Receiving and depositing pay-
ments

receiving payments, Receiving pay-
ments toward a statement

Type of payment How to record in QuickBooks

Partial payment received at time of 
sale

Enter payment item on invoice.

Full payment received at time of 
sale

Use sales receipt, not invoice. No payment item is necessary, 
because QuickBooks assumes sale is fully paid.
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Changing prices or rates

You can change the prices or rates of many items at one time through the Change Item 
Prices window. In this window, you can tell QuickBooks to raise (or lower) prices or rates 
by a specified amount or percentage. You can change prices or rates for items individually, 
or have QuickBooks calculate new prices or rates on several or all items of the same type at 
once.

If you want to automatically apply an increase or decrease to inventory, non-inventory, and 
service items, you can use price levels. Price levels allow you to automatically adjust, up or 
down, the amount charged to customers with whom you have a special relationship. When 
you apply a price level to an item, QuickBooks calculates the rate to reflect the increase or 
decrease.

Summary of payments, by method, 
for daily sales summary

Use sales receipt to summarize the daily sales. Enter a different 
payment item for the summary of each payment method.

Payment from customer to pay out-
standing invoice or statement

Enter payment in Receive Payments window. Indicate which 
invoices or statement charges have been paid by the payment.

Advance payment from customer 
before work is done or sale is made.

Use one of the following options:
� Enter payment in Receive Payments window.
� Enter payment item on a credit memo.
� Record a retainer. See the QuickBooks and Your Industry help 

for law firms, or Look in the Help Index for retainers.

Type of payment How to record in QuickBooks

Avoid entering double payments.
If you receive payment before the sale and record a deposit before you record the 
invoice, do not also enter a payment item on the invoice or you will record a double 
payment.

To learn about… Search the Help index for…

Changing prices or rates of items items, prices

Price levels price levels
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Editing item information

After you’ve created an item, you can edit information about it at any time, subject to 
certain restrictions. 

Changing item type

In QuickBooks Basic, Pro, and Premier, you can change a non-inventory part or other 
charge item to a service, non-inventory part, inventory part, or other charge item. However, 
you cannot change the item type of any other type of item.

Hiding and redisplaying items on lists

You can hide an item on the Item or Fixed Asset Item list without deleting it by making the 
item inactive. For example, you may have an inventory item on your Item list that you have 
not stocked in the last six months, but which you may want to stock in the future. 

When you make an item inactive, QuickBooks keeps the information associated with that 
item, but hides the item on the Item list and removes it from any drop-down lists that use 
items. You do not need to change or delete any transaction that uses the item. If you start 
to use the item again, you can make it active at any time.

You can display all your items, including the inactive ones, on the Item list by selecting 
Show All. (Inactive items still appear on reports, but never display on drop-down lists.)

Deleting items

You can delete an item only if it is not used in any transaction or group item. To locate all 
transactions that use a given item, create a QuickReport for the item for all dates. 

If you condense your QuickBooks data through a specified date (to reduce the file size and 
remove detail), you can also remove items that are not used after that date. Fixed asset items 
are not condensed.

To learn about… Search the Help index for…

Changing item types items, changing type of

Changing information about an 
item

items, editing information

Hiding and showing items on the 
Item list and drop-down lists in 
Item fields

items, hiding and showing

Making hidden items visible on 
the Item list as well as on drop-
down lists

lists, hiding and showing

Deleting items items, deleting
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Final steps to complete your setup

Fine-tune your accounts

QuickBooks sets up a chart of accounts for you during the Interview. Before you begin 
entering transactions, make sure your chart of accounts is complete and that it accurately 
represents how your business works.

Change account names and edit, delete, or add accounts to make your chart of accounts 
reflect your company’s financial activity, if you have to.

Tip: You can adjust the opening balances of the accounts in your Chart of Accounts, too. For more 
information, see “Adjusting opening balances for balance sheet accounts” on page 66.

You can fine-tune your chart of accounts at any time by doing the following:

� Add new accounts or subaccounts.

You can add subaccounts to balance sheet accounts (for example, fixed asset accounts) 
as well as to income and expense accounts.

� Turn on and use account numbers.

QuickBooks has an option for specifying account numbers in addition to names. If the 
account is one that QuickBooks added for you, it already has a number but you can 
change it. 

� Change the name or number of an existing account.

� Enter or edit an opening balance for a balance sheet account if the original opening 
balance is incorrect.

� Arrange accounts of the same type in alphabetical order (or numerical order if account 
numbers are turned on).

� Rearrange the order of accounts within the same account type.

� Make one existing account the subaccount of another (or, conversely, move a subac-
count to a higher level).

You can drag accounts to a new position on the chart of accounts. When your accounts are 
not in alphabetical or numerical order, and you add a new account, QuickBooks places the 
new account above the other accounts of the same type.

It’s important to decide on an account structure that meets your needs now.

Although you can edit your chart of accounts later if you need to, it’s much easier to 
make changes before you start entering transactions.
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To set up account numbers:

Develop and follow consistent account naming and numbering conventions. For example, 
some accountants like you to add a numbering scheme to your accounts:

1000-1999 - Assets
2000-2999 - Liabilities
3000-3999 - Equity
4000-4999 - Income
5000-5999 - Expenses
6000-6999 - Other income and expenses

Adding numbers can help you identify the type of accounts, thereby speeding up your 
account selection on various forms. 

To learn about… Search the Help index for…

Adding new accounts or subac-
counts

accounts (managing), adding

Turning on account numbers accounts (managing), numbering

Changing account names or num-
bers

accounts (managing), editing

Changing or entering an opening 
balance for a balance sheet 
account

� opening balances, changing for 
existing accounts

� opening balances, entering for 
existing accounts

Arranging accounts (and other 
lists) in alphabetical or numerical 
order

lists, sorting entries

Reorganizing accounts within the 
same account type; also, reorga-
nizing other lists that allow suben-
tries (for example, customer:Job 
list)

lists, reorganizing entries

Remove accounts from your chart 
of accounts

accounts, deleting

To learn about… Search the Help index for…

Changing your chart of accounts � accounts, adding
� accounts, editing
� accounts, deleting
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Enter your company’s historical transactions

If you’ve decided on a start date that is before today’s date, you’ll need to enter past trans-
actions to have complete financial records from your start date forward. Then your Quick-
Books records will be as complete as if you had started using the program on your start date.

Enter historical transactions in this order:

1 Invoices you’ve sent out since your start date

2 Purchase orders you’ve issued since your start date that have not been received in full

3 Cash or cheques you’ve received since your start date

4 Bills you’ve received since your start date

5 Bills you’ve paid since your start date

6 Deposits you’ve made to any of your accounts since your start date

7 Any other cheques you’ve written (for things other than bills) since your start date

Enter transactions in your bank account last, because your accounts payable and accounts 
receivable affect your bank account. By the time you enter all of your historical 
transactions, your cheque register will be mostly up-to-date.

Entering current transactions with historical ones

You don’t have to enter all your historical transactions before you start using QuickBooks 
for your current ones. Enter current transactions as they occur so you don’t get behind. 
Then catch up with historical transactions when you can. Remember, though, that your 
account balances will be off until you’ve entered all the past transactions.

If current and historical transactions are related, enter the earlier one first. For example, if 
you receive a payment today for an invoice you have not yet entered, enter the invoice first, 
then use QuickBooks to record the payment. That way, QuickBooks links your transactions 
correctly to each other.

Entering historical payroll information

If you are going to use QuickBooks payroll, enter historical payroll information so 
QuickBooks has complete year-to-date records of wages and salaries you’ve paid. 
QuickBooks needs this information to compute accurate tax information and payroll 
reports. See “Setting up payroll: an overview” on page 179 for more information.

The order you enter historical transactions is important.

For example, QuickBooks won’t know how to credit a customer payment unless you’ve 
previously recorded the invoice to that customer.

To learn about… Search the Help index for…

Entering historical information historical transactions
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.

Entering bank account information

If you entered all your historical transactions, your chequing account or savings account 
register already contains entries reflecting bills you’ve paid, cheques you’ve written for 
other purposes, and deposits you’ve received. But there are other transactions that you must 
enter to make your account registers complete:

� Cheques or other payments you created before your start date but weren’t cashed until 
after your start date (for example, cheques written a few months ago but not cashed 
until recently).

� Deposits you made before your start date, but which didn’t appear on statements until 
after your start date.

� Cheques or other payments you made after your start date that were not for bills or 
accounts payable (credit card payments, for example).

� Deposits made after your start date that were not customer payments.

� Bank charges, fees, or interest paid to your account.

Complete your customer, vendor, and item information

During the Interview, you entered information about customer and vendor open balances. 
Now you need to enter more information, such as addresses, phone numbers, and credit 
limits—though it’s not necessary to enter this information for all customers and vendors at 
once.

Note: If you use QuickBooks Pro or QuickBooks Premier and Symantec ACT! or Microsoft Outlook, you 
can synchronize information about customers and vendors, such as addresses and phone 
numbers, from your contact manager so that you don’t have to re-enter it. To learn about 
synchronizing contact information, search the Help index for “contact management, synchro-
nizing”.

Items are the goods, services, and other things you buy and sell. QuickBooks starts a list of 
items when you go through the Interview, but you’ll want to add to this list and refine the 
information you’ve already entered.

To learn about… Search the Help index for…

Entering historical payroll 
information

payroll setup, year-to-date amounts

To learn about… Search the Help index for…

Entering information in account 
registers

registers, entering transactions in
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Adjusting opening balances for balance sheet accounts

After creating your company in the Interview, you may need to enter additional opening 
balances or make adjustments to the account balances you’ve entered.

To adjust an opening balance for an account:
1 From the Lists menu, choose Chart of Accounts.

2 Double-click the account that should have an opening balance.

3 Click anywhere in the blank entry at the end of the register.

4 Change today’s date to your QuickBooks start date.

5 Leave the Number and Payee fields blank.

6 Enter the opening balance amount.

� For bank accounts, enter the amount in the Deposit column.

� For asset, liability or equity accounts, enter the amount in the Increase column.

� For credit card accounts, enter the amount in the Charge column.

7 In the Account field, choose Opening Bal Equity from the drop-down list.

Note: If you have not entered an opening balance for any of your accounts, you will have to create an 
Opening Bal Equity account.

8 Click Record.

These accounts may also need adjusting:

� If you collect GST or PST, record the amount you owe as of your start date.

If you have entered your historical invoices and purchases, do not include the amount 
you owe since your start date (as the GST and PST you collected is included on them).

Instead, check whether you owe more than the invoices cover, and if so, adjust your 
GST or PST liability accordingly. Select GST/PST Activities from the Vendors menu, 
then GST or PST Adjustment. For more information, see “Gathering income tax infor-
mation” on page 137.

To learn about… Search the Help index for…

Adding a new customer customers, adding

Adding a new vendor vendors, adding

Item types and uses items, about

To learn about… Search the Help index for…

Recording the GST or PST you 
owed as of your start date

GST, historical data
PST, historical data
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� Adjust the Uncategorized Income and Uncategorized Expenses accounts (if you’re 
using accrual-basis accounting).

When you enter unpaid opening balances for customers, QuickBooks assigns the 
income to an account called Uncategorized Income. Similarly, when you enter unpaid 
balances owing for vendors, QuickBooks assigns the expenses to the Uncategorized 
Expenses account.

- If you keep your books on a cash basis (you record income when you receive 
payment), QuickBooks does not show these two accounts on your profit and loss 
statement until a customer makes a payment, which is the expected behavior. You 
do not need to make any adjustments.

- If you keep your books on an accrual basis (you record the transaction when you 
make a sale or incur an expense), QuickBooks does show these two accounts on 
your profit and loss statement as of your start date. Your accountant may want you 
to make an adjustment so that the income from all invoices and the expenses from 
all bills before the start date are also tracked on an accrual basis, regardless of 
whether payment has occurred. Ask your accountant whether this situation 
applies to you.

� Adjust for current income and expenses if your start date is not at the beginning of your 
fiscal year.

If you set up your company in QuickBooks with a midyear start date and you know 
what your income and expenses are from the beginning of your fiscal year to your start 
date, you can enter adjustments for them. Then, when you create a profit and loss 
statement in QuickBooks, it will be accurate from the beginning of the fiscal year to any 
date after your start date.

To get this information, have your accountant create a year-to-date profit and loss 
statement (also called an income statement) for your current fiscal year through your 
start date.

Adjusting your GST or PST 
liability

GST, adjusting
PST, adjusting

To learn about… Search the Help index for…

Adjusting for Uncategorized 
Income and Uncategorized 
Expenses

� Uncategorized Expense account
� Uncategorized Income account

To learn about… Search the Help index for…

Adjusting income and expenses 
for midyear setup

adjustments, income and expenses 

To learn about… Search the Help index for…
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� Distribute earnings and equity before your start date.

After you have entered all of your opening balances and made other adjustments, you 
may want to distribute the amount in your Opening Bal Equity account to other equity 
accounts if you want to identify retained earnings or the equity of several owners.

Setting up accounts to track equity details

Your company’s equity comes from two sources:

� Money invested in your company (capital investments)

� Profits of your company

Of course, the owner can also take money out of the company. Such withdrawals, called 
owner’s draws, reduce the company equity.

QuickBooks sets up two equity accounts automatically: 

� Opening Bal Equity

For every balance sheet account you set up with an opening balance, QuickBooks 
records the amount of the opening balance in the Opening Bal Equity account. (Asset 
account opening balances increase the equity; liability account opening balances 
decrease the equity.)

� Retained Earnings

If you have data for more than one fiscal year, the QuickBooks balance sheet has a 
balance for the Retained Earnings account equal to the net profit from prior fiscal years. 
The balance for the Retained Earnings account does not display on the chart of 
accounts.

Some people like to track owner investments, owner’s draws, and retained earnings prior to 
the QuickBooks start date by putting them in separate equity accounts. If you decide to add 
additional equity accounts, QuickBooks still adds the Retained Earnings and Net Income 
lines on your balance sheet.

To learn about… Search the Help index for…

Distributing earnings and equity 
from before your start date

Opening Bal Equity account

Equity carried over from previous 
fiscal periods

equity, retained earnings from

Moving the amount in the 
Opening Bal Equity account to 
other equity accounts

equity, transferring from Opening 
Bal Equity
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Equity accounts for sole proprietorships

Because all equity of a sole proprietorship company belongs to one person, tracking equity 
can be very simple. 

As of your QuickBooks start date, all equity is in the Opening Bal Equity account. You have 
several options:

� Keep the equity in this account and perhaps rename the account to something such as 
Owner’s Equity.

� Transfer all the equity out of Opening Bal Equity into Retained Earnings. 

This action is appropriate for companies that have built up assets as a result of earnings 
prior to the QuickBooks start date. From now on, you can take owner’s draws out of the 
Retained Earnings account. 

� Set up additional accounts (or subaccounts) to track owner’s investments, owner’s 
draws, and earnings before your QuickBooks start date. 

Tip: When setting up a new account for owner’s draws, enter a negative opening balance to show the 
total draws prior to the QuickBooks start date. The negative opening balance indicates that the 
draws have reduced the company’s equity. (Or, enter a zero opening balance and simply record 
draws from now on.)

Things to think about after you’re finished

Create reports to check your setup

After you’ve finished setting up your company in QuickBooks and making any 
adjustments, create reports to check that QuickBooks has the right numbers.

In both QuickBooks and your former accounting system, create a profit and loss statement 
and a balance sheet. Each report should cover the beginning of your fiscal year through to 
your QuickBooks start date. For example, if your fiscal year began on July 1 and your start 
date was September 1, create reports that cover July 1 to September 1.

Both reports should show the same balances for your accounts.

Maintain your previous accounting system

If your business existed before you began to use QuickBooks, make sure you keep your 
previous accounting system complete in case Canada Customs and Revenue requires 
information from your previous years of business.

You should keep any software and the hardware your former accounting system requires —
or have printouts of all the information and accounting reports.
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Set up other company files, if you need them

If you use QuickBooks with more than one company, and therefore have more than one 
company file, you should keep them all in the same directory.

If you update QuickBooks, download tax tables, receive tax alerts, and so forth, you may 
have to download multiple copies of the new information if the company files are in 
different directories.

Connect QuickBooks to the Internet

What you need

Your PC must be connected to the Internet through an Internet Service Provider (ISP). Your 
work PC may be connected through a local area network (LAN). If you can read e-mail or 
browse the Web, you are connected to the Internet. 

Why connect QuickBooks to the Internet?

You don’t need Internet access to use QuickBooks, but the ability to “go online” can easily 
double the power and flexibility of your software. It allows you to take advantage of 
Internet-only features in QuickBooks. 

Consider these additional possibilities:

� Explore other opportunities with QuickBooks’ connected services
From the Company menu, select Business Services Navigator.

� Receive QuickBooks updates 
Download and install QuickBooks software updates as they become available.

� Download tax table information
If you’ve signed up for the Payroll Service, you can download the latest tax tables.

If you are a new user

After you install QuickBooks, you are prompted to activate QuickBooks, and if you choose 
to do so online, QuickBooks helps you set up your Internet connection. It’s a good idea to 
activate as soon as you can so that you can begin using all of the QuickBooks online 
features.

Note: If you did not activate your copy of QuickBooks immediately after installation, you can do so at 
any time by choosing Activate QuickBooks from the File menu. (If you do not see Activate 
QuickBooks under the File menu, you have already activated QuickBooks.) 
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If you are an upgrader

After you install QuickBooks, you’re prompted to activate QuickBooks. It’s a good idea to 
activate as soon as you can so that you can begin using all of the QuickBooks online 
features.

If you owned a previous version of QuickBooks, QuickBooks 2004 uses the same Internet 
settings as your previous version. If you have changed your Internet Service Provider 
between then and now, or switched from using a modem to using a direct connection (for 
example, cable or DSL), you can change your settings manually. 

To set up an Internet connection:
1 From the Help menu, choose Internet Connection Setup.

If you have not used QuickBooks on your computer before, then the first time you go 
online (for example, to activate your software), QuickBooks automatically launches the 
Internet Connection Setup wizard.

2 Follow the onscreen instructions. Click Next to move through the screens. If you need 
help at any time, click Help.

3 Click Done.

Changing an Internet connection

If you already have a connection to the Internet, you can modify the connection settings. 
You can also set up other ways QuickBooks can connect to the Internet. Doing so gives you 
an alternate way to connect to the Internet if your regular connection is down for some 
reason. 

To change your Internet connection:
1 From the QuickBooks Help menu, choose Internet Connection Setup. The Internet 

Connection Setup displays.

2 Select Use my computer’s Internet connection settings to establish a connection 
when this application accesses the Internet.

3 Click Next.

4 In the Connection Setting window, click Advanced Connection Settings. The Internet 
Properties dialogue box appears.

5 To create a new dial-up networking connection, click Add.

Follow the onscreen instructions; click Next to move through the screens. 

Each Internet connection profile you create, is listed on the first screen of the Internet 
Connection Setup. 

If QuickBooks doesn’t detect your Internet connection (for example, you’re using certain 
versions of AOL or CompuServe), try the following:

� Close QuickBooks, then connect to your Internet Service Provider (ISP).

� When you have successfully connected to the Internet, reopen QuickBooks.
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� Go to the Internet Connection Setup, and on the “How do you want to connect to 
the Internet? screen, select Use my computer’s Internet connection settings to 
establish a connection when this application accesses the Internet.

Once you have told QuickBooks that you have a direct connection, you should be able to 
access QuickBooks’ Internet features by connecting to your ISP before opening QuickBooks.

Update QuickBooks to the latest release
From time to time, Intuit provides updates to QuickBooks that are available for 
downloading from the Internet. These updates might be:

� A maintenance release, which Intuit creates when a problem is discovered and fixed 
after QuickBooks is delivered to customers.

� A new feature or service.

� Timely information that is relevant to your business.

Tip: If you do not have a company file available, but want to update QuickBooks, open one of the 
sample data files included with QuickBooks, then update the software as you normally would.

If you signed up for the QuickBooks Payroll Service, QuickBooks checks for new tax tables 
whenever you check for other updates to your software.

Getting updates from the Internet

In QuickBooks, the Update QuickBooks window gives you a convenient way to download 
updates from the Intuit server to your computer.

To download an update, you need to have set up QuickBooks to work with an Internet 
connection (see “Connect QuickBooks to the Internet” on page 70).

There are several ways to update your version of QuickBooks through the Internet:

� Automatic Update: This option prompts you when a new release is available for your 
version of QuickBooks. If you choose to update when prompted, QuickBooks down-
loads the necessary files to your computer via the Internet in the background, with 
little impact on your computer’s performance.

� Manual Download: With this method, you decide when to download an update via 
the Internet to your computer. You can use this method at any time—even if your 
computer is set up to download updates automatically.

� From QuickBooks.ca: You can visit our Web site to download the latest release for 
your version.

� Multiuser Update: When updating multiple users, the new update is downloaded via 
the Internet to a local server for each user to then download to their computer.



Update QuickBooks to the latest release 73

Automatic updates

By default, QuickBooks is set to receive updates automatically. QuickBooks periodically 
checks the Intuit server for new updates, and downloads the information gradually at times 
when your open Internet connection is not being used by another process or application.

Some of the advantages of this method include the following:

� You can download updates without interrupting a QuickBooks session or other tasks 
you perform with your computer.

� You can download updates whether or not QuickBooks is running (as long as your 
computer is connected to the Internet).

� You can disconnect from the Internet at any time. When you reconnect to the Internet, 
QuickBooks resumes downloading at the point it was previously halted.

To turn off Automatic Update:
1 On the File menu, select Update QuickBooks.

2 Click Options.

3 Click Off for the Automatic Update option.

4 Click Save.

5 Close the Update QuickBooks window.

Manual updates

If you choose to manually update QuickBooks, you should check for updates about once a 
month. With this method, QuickBooks only begins the downloading process once you click 
Get Updates in the Update QuickBooks window.

Download times for updates vary depending on the speed of your Internet connection, the 
size of the update file(s), and the amount of traffic on the Internet. After QuickBooks 
downloads an update, the program installs the necessary files to the correct directories or 
folders on your computer. 

To perform a manual update:
1 From the File menu, choose Update QuickBooks.

2 Click Update.

3 Select the updates you want to download by clicking the checkbox next to the update 
name. (A check mark means the update is selected.)

4 Click Get Updates.

Note: Manual updates can also be performed when the Automatic Update option is turned on.

Once the download process is complete, QuickBooks displays the date and time of the 
download in the Last Checked column. In the File Received column, QuickBooks displays 
the status of the download. Click the text in the Files Received column for additional details 
about the download.
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Updates from QuickBooks.ca

Visit the QuickBooks web site at http://www.QuickBooks.ca/ to download updates. At the 
site, under Quick Find, click Product Update, then see the QuickBooks Product Updates 
section. There you’ll find a list updates for the various versions.

Before installing the update from QuickBooks.ca:
1 Write down your QuickBooks license key in case you need it later.

� To find it, select About QuickBooks from the Help menu.

2 Back up your company file(s).

To update from QuickBooks.ca:
1 From the Product Updates page, click the update link for the version you are using.

The File Download window opens.

By default, the “Save this program to disk” option is selected. This option saves a copy 
of the update to your computer for you to later install.

2 Click OK. The Save As window appears.

3 Navigate to a folder to save the update file to or keep the default.

4 Click Save.

5 When the download is complete, the WinZip Self-Extractor opens. (If it does not start 
automatically, double-click the file you downloaded.) Extract the files to a temporary 
folder where you can find them again easily.

6 Shut down all open programs, including QuickBooks and any virus protection software 
you may have. Some virus protection programs can interfere with the installation.

7 Using Window Explorer, open the folder you specified in Step 5.

8 Double-click the Setup.exe file and follow the instructions on your screen.

Sharing updates among multiple users

If you use QuickBooks Pro or QuickBooks Premier in multi-user mode, you need to install 
maintenance releases on each computer that has QuickBooks Pro or QuickBooks Premier 
installed on it.

You can either connect to the Internet from each computer that has QuickBooks installed 
on it, or else download the update to one computer on your network and share it (for 
example, if one or more users doesn’t have Internet access).

QuickBooks sets up a shared location to which updates are downloaded. Then, if any user 
in a multi-user environment downloads and installs an update, QuickBooks detects it and 
prompts each of the users—as they open the program—to install the new version. 

To share updates, you need to be sure that all your users can access the location on your 
networks where the updates are downloaded:

� All of the QuickBooks computers must be properly networked.

� Each computer must be configured to share files across the network.
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Finally, all QuickBooks Pro or QuickBooks Premier users on your network must complete 
the following steps:

To change the download location:
1 Open the shared company file.

2 From the File menu, choose Update QuickBooks.

3 Click Options.

4 In the Options windows, click ON for the Share Download option, then click Save.

Updates from a CD-ROM

If you don’t have Internet access, you can have an update mailed to you on a CD-ROM (fees 
may apply). For more information, contact Customer Service (see page 269).

When you receive the CD, install the update as you would install any other software.

Before installing from a CD...
1 Write down your QuickBooks license key in case you need it later.

� To find it, select About QuickBooks from the Help menu.

2 Back up your company file(s).

To install your QuickBooks update:
1 Shut down all open programs, including QuickBooks and any virus protection software 

you may have. Some virus protection programs can interfere with the installation.

2 Insert the CD-ROM in your computer’s CD-ROM drive.

3 Open Windows Explorer and select the correct CD-ROM drive.

4 Open the folder containing the installer for your version of QuickBooks.

5 Double-click Setup.exe and follow the instructions on your screen.

6 Review the Readme.txt file on your CD-ROM. It contains important information about 
how your software is affected by this update, and what you should do next.

Set number, currency, time, and date formats in QuickBooks

Your settings in the Regional Options of Microsoft Windows affect how QuickBooks 
displays numbers, currency, time, and dates.

To check your Windows Regional Options settings:
1 From the Windows Start button, select Control Panel.

2 Choose Regional Options or Regional Settings, depending on the version of Windows 
you’re using.
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Converting data from Quicken
This section explains how to convert your Quicken data to QuickBooks data and some of 
the differences between the two programs. After you finish converting, you’ll want to make 
some adjustments to your new QuickBooks company to take advantage of the QuickBooks 
features that Quicken does not offer.

Note: Do not uninstall Quicken before installing QuickBooks and converting to it.

Preparing your Quicken data for conversion

To make the transition to QuickBooks as smooth as possible, you may need to make some 
changes to your:

Convert only the accounts you want to use in 
QuickBooks

Before you convert to QuickBooks, delete all accounts in Quicken that you know you won’t 
want in QuickBooks. (In QuickBooks, you can’t delete accounts that have transactions, but 
you can in Quicken. So it’s easier to delete the accounts you know you won’t want before 
you move to QuickBooks.)

Note: All transfers to and from the deleted accounts will be converted as transactions to your opening 
balance equity account to ensure that your accounts balance.

You might want to delete accounts from your Quicken file in these situations:

� You have personal accounts as well as business accounts in your Quicken file.

� You have investment accounts in your Quicken file. 

If you do not delete your investment accounts, they will be converted to QuickBooks 
Other Current Asset accounts (because QuickBooks doesn’t track investments like 
Quicken does). You can either:

Before you convert to QuickBooks, back up your Quicken data file.

If you plan to continue using Quicken with this data (for example, if you have both busi-
ness and personal data in your Quicken file), make a copy of the Quicken file before you 
make changes. For instructions on backing up a Quicken file, see the documentation 
that came with your software.

QuickBooks data files are not compatible with and cannot be converted back to Quicken 
data files.

� Quicken Account list

� Memorized Transaction list

� Online banking accounts

� Names of customers on accounts 
receivable transactions
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� Keep the QuickBooks Other Current Asset accounts as a way to include the value 
of your investments in your QuickBooks balance sheet. In this case, you should 
continue tracking your investments in Quicken and update the balance of your 
QuickBooks Other Current Asset accounts periodically.

� Or, delete the investment accounts from your Quicken file (so they are not brought 
into QuickBooks at all) and continue to track the investments in Quicken. (The 
investments still appear in the copy you made of your Quicken data.)

Review your memorized and your scheduled 
transactions

If the QuickFill option for memorizing all transactions is turned off in Quicken, QuickBooks 
converts both your memorized transactions and your scheduled transactions.

On the other hand, if the option is turned on, QuickBooks converts only scheduled 
transactions and your transaction groups. It does not convert stand-alone memorized 
transactions.

So, if you have memorized transactions in Quicken that you’d rather not retype in 
QuickBooks, you need to do one of two things:

� Turn off the QuickFill option for memorizing all transactions in Quicken. If your list of 
memorized transactions is very long, you may want to delete the ones you won’t need 
in QuickBooks, or

� Put these transactions into a transaction group in Quicken. QuickBooks always 
converts transaction groups. After the conversion is complete, you can remove the 
memorized transactions from the group and use them as you did in Quicken. 

For information about transaction groups in Quicken, look in your Quicken 
documentation.

Note: Memorized transactions from Quicken accounts payable will not work properly in QuickBooks 
accounts payable. You should delete these before you convert your data.

If you have overdue scheduled transactions in your Quicken file, record them 
before converting.

For example, print any cheques you have pending.

To learn about… Search the Help index for…

Transactions group in QuickBooks memorized transactions, grouping 
together
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Make customer names consistent

When you convert to QuickBooks, the names in your accounts receivable register become 
customers, and transactions become invoices and payments. If you accidentally used 
different names for the same customer in Quicken, QuickBooks can’t link the customer’s 
invoices and payments correctly.

For example, if you have a customer listed as Dan Miller, D. Miller, and Daniel Miller, you 
should edit these names before you convert so that the customer goes by only one name.

If you use online banking

You can bank online with participating financial institutions through QuickBooks just as 
you can in Quicken. However, not all institutions that work with Quicken also work with 
QuickBooks. Contact your financial institution before converting to confirm that it 
supports QuickBooks. If it does not, an online account in Quicken will not remain an online 
account after the conversion to QuickBooks.

Tip: To see the current list of financial institutions that support online account access in QuickBooks, 
choose Set Up Online from the Banking menu in QuickBooks, then choose Online Financial 
Institutions List.

 

Converting your Quicken file to QuickBooks

When QuickBooks converts a Quicken data file, it doesn’t change it in any way. Also, 
QuickBooks does not create any sort of link between your Quicken data and your new 
QuickBooks company. Instead, QuickBooks creates a completely new set of data files for 
you to use.

� If you’ve been using Quicken for Windows 5.0 or earlier, Quicken for DOS, or Quicken 
for Macintosh, call Technical Support for instructions (see page 270).

Your financial 
institution...

Comments What to do

Supports online account 
access in both Quicken 
and QuickBooks

You will need to re-enable 
your online accounts in 
QuickBooks after conver-
sion. See “Re-enable your 
online banking accounts” 
on page 83.

Supports online account 
access in Quicken, but 
not in QuickBooks

You are not able to use 
online account access in 
QuickBooks for this account. 
You could continue to use 
online account access in 
Quicken.

Select between the two 
choices described in “If 
your financial institution 
does not work online with 
QuickBooks” on page 84.
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Quicken XG, 2003, 2002, 2001, 2000, 98, and 6.0 for 
Windows

QuickBooks can directly convert data from these products.

1 Install QuickBooks according to the instructions on page 3.

2 Make sure that Quicken is not running.

3 Double-click the QuickBooks icon on your desktop to start your new software.

4 From the File menu, select Import, then Convert from Quicken. The Important Docu-
mentation window appears.

5 Click View Help for information about converting from Quicken.

6 Close the help window, then click OK.

7 Choose the Quicken file you want to convert, then click Open.

8 Follow the instructions on your screen to convert your file.

� If your Quicken file is protected with a password, QuickBooks prompts you to enter 
it. You then have to remove the Quicken password.

Fine-tuning your data after converting to QuickBooks

After you convert your data from Quicken, you may need to make some additional 
adjustments to it before you start using QuickBooks.

Edit your Other Names list

At the end of the Quicken conversion, you are asked to choose which account you used for 
Accounts Receivable (A/R). (QuickBooks automatically recognizes the A/R account in 
Quicken.)

As the conversion finishes, QuickBooks gives you a list of names to which you made 
payments but which you have not used in your accounts receivable account. This list may 
contain not only the names of customers, vendors, and employees, but also descriptions 
such as “Deposit,” “Transfer,” and “Interest.”

You should change the names on the list to the correct type. (If you don’t change them 
now, they remain on your Other Names list so you can change them later, but you’ll have 
to do it one name at a time.)

If you want to use QuickBooks account payable, be sure to move your Quicken payees 
(other than employees) from the Other Names list to the Vendor list. For more information, 
see “Changing to QuickBooks accounts payable” on page 85.

Once you change the type for a name, you cannot undo it.

You can move names from the Other Names list to the Vendor, Customer:Job, or 
Employee lists. However, once moved, you cannot move a name again.
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To change types for names:
� In the Change Name Types window, click the corresponding column for each name 

you want to move. When all the names are marked correctly, click OK.

If you have different versions of one name

If you have slightly different versions of the same name (for example, Mike Rhymes, 
Michael Rhymes, and Michael P. Rhymes), QuickBooks puts each version of the name in 
the Other Names list.

In QuickBooks, you can’t delete any name used in a transaction. However, you can merge 
the names to shorten the Other Names list.

Fill in your company information

From the Company menu, choose Company Info, and fill in your company information. If 
you want QuickBooks to track tax information for you, you must also select the tax form 
you file from the drop-down menu.

To restore all the 
check marks to the 
Other Name column, 
click Revert.

To learn about… Search the Help index for…

Changing the name type to a cus-
tomer, vendor, or employee

other names, list of

Merging similar names merging, list entries



Converting data from Quicken 83

Turn on the QuickBooks features you plan to use

In QuickBooks, from the Edit menu, choose Preferences. Now you can customize 
QuickBooks for your needs.

� If you collect sales taxes from customers (such as GST, HST, PST, or QST), turn on the 
GST/PST tracking preferences. For more information about tracking GST or PST, see 
“Gathering income tax information” on page 137.

� If you track inventory or write purchase orders, turn on the preferences for inventory 
and purchase orders. 

� If you plan to use QuickBooks to pay your employees, you must sign up for the 
QuickBooks Payroll Service. To learn more about payroll, see “Setting up payroll: an 
overview” on page 179.

 

Re-enable your online banking accounts

If you use online banking, you’ll need to re-enable your online accounts after you import 
them into QuickBooks.

To re-enable your online accounts:
1 From the Lists menu in QuickBooks, choose Chart of Accounts.

2 Select your online account. Then click the Account menu button at the bottom of the 
window and choose Edit.

3 In the Edit Account window, click the Account Details tab.

If the account has no Account Details tab in the Edit Account window, it is not online 
in QuickBooks. An account that was online in Quicken will not be online in Quick-
Books if the financial institution does not work online with QuickBooks. 

� Select Online Account Access, then click OK.

To learn about… Search the Help index for…

Settings preferences

To learn about… Search the Help index for…

Enabling accounts for online 
banking

online banking, enabling accounts
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If your financial institution does not work online with 
QuickBooks

If your financial institution does not work online with QuickBooks, your online accounts 
are converted to standard (not online) accounts.

� Notify the financial institution that you will no longer be using its online services.

� Alternatively, you could open an account with a financial institution that does work 
online with QuickBooks.

Adjust your Opening Bal Equity account

QuickBooks automatically creates an Opening Bal Equity account for you. When you create 
a new account and enter its opening balance, QuickBooks enters that amount in the 
Opening Bal Equity account, so that your accounts balance. You can leave the Opening Bal 
Equity total alone, or you can distribute amounts from it to other equity accounts.

How QuickBooks converts accounts receivable transactions

If you answered “Yes” to converting your Quicken asset accounts to QuickBooks A/R 
accounts, QuickBooks converted the transactions as follows:

To learn about… Search the Help index for…

Distributing equity from before 
your start date

Opening Bal Equity account

Moving the amount in the Open-
ing Bal Equity account to other 
equity accounts

equity, transferring from Opening 
Bal Equity

This item in your Quicken A/R 
account...

...is converted to this in 
QuickBooks:

Each transaction that increases your A/R 
balance

An invoice to a customer

Each transaction that decreases your A/R 
balance and has only one split line

A payment from a customer

Each transaction that decreases your A/R 
balance and has more than one split line

A credit memo to a customer

Each payee A customer on your QuickBooks 
Customer:Job list

Each category Both an item on your Item list and an 
income account on your Chart of 
Accounts
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QuickBooks applies payments in Quicken to a customer’s oldest outstanding invoice first.

The conversion saves you the time of typing in all your accounts receivable transactions, 
but you’ll probably want to make some changes to the converted data. For example, if the 
category you used in most A/R transactions was “Sales income,” you’ll want to change the 
name of the converted invoice item from “Sales income” to the product or service you 
actually sell, such as “Consulting hours.” The income account; however, may be just fine 
as “Sales income.” 

You don’t have to make these changes now. QuickBooks makes it easy to make changes at 
any time.

Changing to QuickBooks accounts payable

You may have had an Accounts Payable (A/P) account in Quicken. QuickBooks converts the 
transactions in this account into historical transactions in your journal, which indicate 
what you owe and to whom. The transactions do not appear in your QuickBooks A/P 
account.

� In this case, track payments of outstanding bills only the same way you did in Quicken. 
However, enter any new bills with the Enter Bills window (QuickBooks creates a new 
A/P account for you the first time you enter a bill).

If you didn’t use an accounts payable account, the documentation explains how to set 
Quicken up for cash-basis accounts payable and for accrual-basis accounts payable. For a 
cash-basis system, Quicken recommends using a Bank account and simply postdating 
cheques. For an accrual-basis system, Quicken recommends using an Other Liability 
account.

The transition to QuickBooks accounts payable is the same for either system.

� If you used postdated cheques to track your bills, treat cheques you’ve already entered 
the same way you did in Quicken.

� If you had an Other Liability account in Quicken for accounts payable, it is now an 
Other Current Liability account in QuickBooks.

No matter which method you were using in Quicken, from now on, use the Enter Bills 
window to track your bills. The Enter Bills window tracks your bills in the Accounts Payable 
account. To create this account, you can either:

� Use the Other Current Liability account only for currently outstanding bills and let 
QuickBooks create a new Accounts Payable account for you the first time you use the 
Enter Bills window. 

� Or, you can move the transactions in your Other Current Liability account to an 
Accounts Payable account (see below).
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To move your Other Current Liability transactions to the Accounts 
Payable account:
1 In Quicken, create a report that gives you the total balance you owe each of your 

vendors. Make sure the date range is set to Include all dates, then print the report for 
reference.

2 Start QuickBooks.

3 From the Banking menu, choose Make Journal Entry.

4 On the first line:

� In the Account field, choose Accounts Payable from the drop-down list.

� In the Name field, choose the vendor’s name.

� In the Credit field, type the open balance (you’ll need to do this for each vendor).

5 On the second line:

� In the Account field, choose the Other Current Liability account from the drop-
down list.

� In the Debit field, type the same amount that you entered in the Credit field of the 
first line.

6 Click Save & New.

Changing your payees to QuickBooks vendors

If you haven’t already, you need to move your Quicken payees from the Other Names list 
to the Vendor list. See “Edit your Other Names list” on page 81.

If a Quicken payee had a balance that you converted to QuickBooks, use Write Cheques 
until the balance of your old Quicken A/P account equals zero (you’ve paid off all your bills 
for that vendor). Enter any new bills into QuickBooks accounts payable.

You also need to delete and re-enter any memorized transactions that QuickBooks 
converted for you from Quicken accounts payable, as they will not work properly in 
QuickBooks accounts payable.

To learn about… Search the Help index for…

Deleting memorized transactions memorized transactions, deleting

QuickBooks accounts payable accounts payable
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Comparing QuickBooks and Quicken

Once you understand the few terminology and feature differences between the programs, 
QuickBooks will feel very familiar.

Terminology differences

Quicken uses terms familiar to anyone who has used a cheque book. QuickBooks uses a few 
terms that are standard in business bookkeeping and that reflect the increased power and 
convenience of QuickBooks for business.

This table lists the most important differences in terms. It does not list the many completely 
new QuickBooks features and terms.

 

Feature differences

The following table lists features that exist in both Quicken and QuickBooks, but that work 
differently in QuickBooks than in Quicken.

Quicken
term

QuickBooks
term

Definition

Account Balance sheet account A grouping of records related to one kind of 
asset, liability, or equity. 
These accounts appear on a balance sheet.

Category Income or expense 
account

A grouping of transactions related to one 
kind of income or expense. 
These accounts appear on a profit and loss 
statement (income statement).

Category and 
Transfer List
plus
Account List

Chart of Accounts The QuickBooks Chart of Accounts is like 
the Quicken Account list (balance sheet 
accounts) plus the Quicken Category list 
(income and expense accounts). 

Feature Quicken QuickBooks

Entering 
transactions

Enters most transactions in 
registers.

Enters most transactions in 
forms (cheque window, 
invoice window, and so on).

Write Cheques Displays a cheque that looks 
like a paper cheque.

Displays a business cheque 
with voucher area (so the 
“split” is part of the cheque 
form).
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New and renamed balance sheet accounts

QuickBooks and Quicken have similar kinds of balance sheet accounts, but QuickBooks 
adds some types and uses different names for others. When you convert a Quicken file, the 
program automatically creates QuickBooks accounts most like your Quicken accounts.

� In some cases, you may not want to use the account that QuickBooks automatically 
creates. For example, Quicken sometimes uses liability accounts instead of equity 
accounts. In QuickBooks, you can make them equity accounts.

� QuickBooks changes your Quicken categories and subcategories into income and 
expense accounts with subaccounts.

Classes Uses a slash (/) to separate a 
category from a class in trans-
actions.

Enters classes in separate 
fields. No need for a slash (/) as 
a separator. 
In QuickBooks, projects or jobs 
can be linked to customers as 
part of the Customer:Job list, 
so you can use classes for dif-
ferent kinds of classification.

Transfers Uses brackets [ ] to indicate a 
transfer to another balance 
sheet account.

No need to use brackets. 
QuickBooks handles transfers 
like any other transaction.

Passwords One password for entering and 
viewing data.

Customizable password and 
permission access for each 
person in your company.

Subaccounts Categories can have subcate-
gories, but accounts cannot 
have subaccounts.

Most accounts, even balance 
sheet accounts, can have sub-
accounts.

Payroll accounts 
(if you set up your 
accounts as 
described in the 
Quicken manual)

A separate liability account for 
each tax withheld and for 
every other payroll liability.

You can continue using your 
old liability accounts. How-
ever, by using payroll items, 
you can put all your payroll lia-
bilities into a single account.

Feature Quicken QuickBooks

Quicken 
account type

Converted to QuickBooks account 
type

Chequing Bank

Credit Card Credit Card

Cash Bank
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When you convert from Quicken

After you have converted your Quicken data file to QuickBooks, you’ll notice the following 
changes:

� The Invoice Items list is converted to the QuickBooks Items list.

� Each existing Invoice/Receivables account is converted to a QuickBooks Accounts 
Receivable account of the same name.

� Existing invoices are converted to QuickBooks invoices. However, they will appear in 
chronological order.

� Transactions linked to a customer remain linked.

Should you continue using Quicken for some things?

QuickBooks does not change your original Quicken file in any way as it imports 
information from it, nor does it create any connection between it and your new 
QuickBooks company. You can continue to use your original file with Quicken.

Once you’re using QuickBooks for your business, you’ll probably want to continue using 
Quicken for your personal finance and investment accounts.

Asset Other Current Asset

Liability Other Current Liability

Investment Other Current Asset

Quicken 
account type

Converted to QuickBooks account 
type

About payments, credit memos, and refunds.

Converted Quicken payments are always applied to the customer’s oldest outstanding 
invoice, so the payment links to invoices may be different after conversion. 

Credit memos and refund cheques, like payments, are also applied in chronological 
order based on invoice dates, so their links may also be different after conversion.

Do not use online banking for the same account in both programs.

If you track the same account in both Quicken and QuickBooks, you can only use online 
banking in one program. If you try to use online banking for the same account in two 
different programs, it will not work correctly.
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Here are some personal-finance activities you can perform only with Quicken:

� Track investments

Quicken includes investment tracking and reporting. Quicken updates the market 
values when you enter the latest share prices, and it reports on average annual total 
return, capital gains, and investment income.

� Amortize mortgage loans

Each time you record a payment on a loan, Quicken updates the number of payments 
made and calculates the amount credited to principal and interest.

� Create reports for personal finances

Quicken has many preset reports designed for personal use. 

Converting data from MYOB
This section explains how to convert your MYOB data to QuickBooks data, set up your 
payroll, and goes over some of the differences between the two programs. After you have 
finished converting, some adjustments may need to be made to your new QuickBooks 
company to take advantage of the QuickBooks features that MYOB does not offer.

To convert MYOB data to QuickBooks:
1 Install QuickBooks. Refer to “Installing QuickBooks” on page 3.

Note: Before converting, verify and optimize your MYOB company file to ensure that there are no data 
integrity issues with your data. If there are data integrity issues, the need to be resolved before 
you can convert to QuickBooks.

2 Open QuickBooks. The Welcome to QuickBooks window appears. 

3 Click the Convert from button, then select MYOB. The MYOB to QuickBooks Assistant 
appears.

4 Follow the onscreen instructions to convert the data in your MYOB file.

The assistant does not change anything in your original MYOB company file; it only 
reads the data from your MYOB file.

The conversion process may take some time depending on the size of your company 
file. When the assistant is done converting your data, the “Congratulations” window 
is displayed. At this time, you can view the log file to see the results of the conversion. 
Click the Finish button to close the assistant and start using QuickBooks.
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What’s Next after conversion

Note: If you want to set up your payroll in QuickBooks, refer to “Setting up your payroll in QuickBooks” 
on page 92. You’ll also need to read Chapter 7, Payroll and employees, beginning on page 177.

When the conversion is done, a new QuickBooks company file is open containing your 
MYOB data and is ready for you to begin using. To help familiarize yourself with 
QuickBooks, here are some things that we suggest you do.

� Read the remainder of this guide. You’ll learn the concepts of QuickBooks and what 
you need to know about critical features such as collecting sales tax, working in 
different currencies, and setting up a payroll system. 

� Complete the step-by-step lessons-based Learning Guide. It comes with two exercise 
company files you can use to practice entering transactions.

� Complete the QuickBooks tutorial. To open it, go to the Help menu and select Quick-
Books Coach. This interactive tutorial lets you practice common tasks without 
affecting any data in your company file. You can complete it in 15 minutes. You may 
have to insert the QuickBooks CD in your CD-ROM drive to access the tutorial.

� Look at the help for MYOB users. From the Help menu, select Help for MYOB Users. 
Here you can learn how to do, in QuickBooks, the same accounting tasks that you 
preformed through the MYOB Command Centres.

� Look at your Chart of Accounts (this is referred to as Accounts List in MYOB). From the 
Company navigator, click Chart of Accounts.

� If the "conversion date" you chose in the wizard is earlier than the day that the 
conversion was performed, the balances in the QuickBooks Chart of Accounts may be 
different than those balances from your MYOB Accounts List. This is because the 
account balances in your MYOB file may include transactions that were entered after 
the chosen "conversion date".



92 Chapter 3   Importing and exporting data

� Check your customers’ and vendors’ profiles. Customers and vendors are added to 
QuickBooks lists. Think of these lists as the Cards List in MYOB. To see your customer 
list, open the Customers navigator and click Customers. To see a list of your vendors, 
open the Vendors navigator and click Vendors. 

� Check out the QuickBooks navigators. Navigators gather information from your data 
and display it in one location so you can manage your business more effectively. Navi-
gators are to QuickBooks what Command Centres are to MYOB. The tasks that you 
accessed from Command Centres in MYOB, similarly, can be accessed from Quick-
Books navigators. 

Setting up your payroll in QuickBooks

Because of security reasons, accounting software restricts access to various components of 
your accounting data. Payroll data is one such component. As a result, QuickBooks can 
convert some of your payroll data, but not enough of it to continue dispersing payroll to 
your employees. Before you can pay your employees using QuickBooks, you need to 
complete the following steps to set up the payroll system to fit your needs, and transfer your 
payroll data (such as employees’ year-to-date summaries) from MYOB so that your payroll 
tax information remains up to date. 

These steps teach you how to quickly set up your employees in QuickBooks. For details on 
how to use QuickBooks payroll features, read Chapter 7, Payroll and employees, beginning 
on page 177 We recommend that you read this chapter in its entirety before you remit your 
first payroll cheque. You can open the manual from under the Help menu. You can also 
search the Help index, or click F1 on any window in QuickBooks for context-sensitive help.

The navigators are 
listed here. To open a 
navigator, click the 
name of the navigator 
in this list. 

In this area, QuickBooks 
provides suggestions for 
working with your 
customers.

Here, you have easy access to reports 
related to customer activities. You can 
also customize this by adding reports 
that you’ve memorized.

The QuickBooks 
Customers navigator, 
shown here, is similar 
to the Sales Command 
Centre in MYOB. The 
flow chart depicts 
activities related to 
dealing with customers.
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1 Gather payroll information that QuickBooks needs from your MYOB company file.

When you convert your MYOB data to QuickBooks, the information displayed on each 
employee’s Profile tab is copied into QuickBooks. General payroll information, such as 
the province in which your company operates, and your business number are also 
converted to QuickBooks.

Before you can start paying your employees; however, QuickBooks requires additional 
data about your payroll in order to keep your payroll tax information correct. You can 
get this data from the following MYOB reports. (Print these reports as you’ll need them 
when you complete your employee set up in step 5.) 

� Employee Payroll List–report listing employee information, tax status, and pay basis

From the Index to Reports window, click the Payroll tab, select Payroll List, then click 
Display. 

� Payroll Register (Detail)–report listing the year-to-date amounts for each employee

From the Index to Reports window, click the Payroll tab, select Register Detail, then 
click Customize. In the Period field of the Report Customization window, select Year-
to-date, ensure the date range is from the beginning of the payroll year to the date you 
started using QuickBooks, then click Display. 

� Employer Accrual Expense Balance (detail)–report totalling expenses, such as vacation 
pay, that the employer has yet to pay out to his or her employees

From the Index to Reports window, click the Payroll tab, and under Employer Accruals, 
select Accrual Balance Detail, then click Customize. In the Period field of the Report 
Customization window, select Lifetime, and click Display. The amount on this report 
shows the outstanding accrual balances for each employee.

Each employee in MYOB is 
added to the Employee List 
in QuickBooks.
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2 Turn on the payroll feature.

Open the newly-converted QuickBooks company file (if it isn’t already), and from the 
Edit menu, select Preferences. In the Preferences window, click Payroll & Employees 
from the scroll bar on the left, click the Company Preferences tab, then select Full 
payroll features. Click OK. All QuickBooks payroll features are now visible.

3 Compare QuickBooks’ payroll items to MYOB payroll categories to ensure they fit 
with your payroll system.

MYOB payroll categories are similar to payroll items in QuickBooks. Payroll items are 
the building blocks of the QuickBooks payroll system. QuickBooks creates some 
standard payroll items in the Payroll Item list when you first turn on the payroll 
feature. 

Compare these default payroll items in QuickBooks to your MYOB payroll categories. 
You may need to create new payroll items to match the way you paid your employees 
in MYOB. For example, if you paid your employees hourly, you need to create an 
hourly wage payroll item. 

Note: For more information on how to do this, refer “Setting up your payroll items” on page 183.

4 Merge MYOB payroll withholdings and payroll expense accounts with QuickBooks 
default payroll accounts.

When the payroll feature in QuickBooks is turned on, two accounts are added to the 
Chart of Accounts: Payroll Expenses, and Payroll Liabilities. QuickBooks uses these 
payroll accounts to track payroll transactions. In order for the MYOB payroll liability 
(withholdings) and expense balances that were brought over during conversion to be 
tracked using the QuickBooks’ payroll accounts, all the MYOB payroll liability (with-
holdings) accounts must be merged with the QuickBooks “Payroll Liabilities” account, 
and all MYOB payroll expense accounts must be merged with the QuickBooks “Payroll 
Expenses” account. If you are not clear on what MYOB payroll liability and expense 
accounts that you need to merge, talk to your accountant. 

5 Complete your employee set up

You’ll need the reports that you printed in Step 1 to help with the set up of your 
employees.

Set up employee defaults (optional)

On the employee defaults window, you can set up payroll information that most or all 
of your employees have in common, such as life or dental insurance benefits or union 
dues. These defaults will then show up on every new employee’s payroll profile, thus 
removing the need to enter the same data over and over again for each employee. 

To learn about… Search the Help index for…

Merging accounts merging, accounts
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� Display the Employee List (from the Employees menu, select Employee List). 

� On the Employee List window, click the Employee button and select Employee 
Defaults. 

� On the Employee Defaults window, in the “Additions, deductions, and company 
contributions” box, enter additional adjustments you make to the gross or net pay 
that apply to most of your employees. Employee defaults for payroll taxes, accrual 
hours or vacation pay will not be applied to your existing MYOB employees that 
were brought over during the conversion. These properties must be set up when 
you customize each employee.

Enter employee year-to-date amounts

For each employee (both current and former) that you paid during the current payroll 
year, you must enter a summary of his or her earnings, income taxes, and other 
amounts from January 1 to your QuickBooks start date, otherwise your employee’s T4 
amounts will be incorrect. Year-to-date amounts for your MYOB employees are 
available from an employee’s last payroll stub, or from the Payroll Register (detail) 
report that you printed in step 1. 

Note: For more information on year-to-date amounts, refer to the section “Summarizing amounts for 
this year to date” on page 197. 

� Open the Set Up YTD Amounts wizard (from the Employees menu, select Set Up 
YTD Amounts).

� Click the Next button. On the following two windows, enter the dates as 
appropriate. You should be entering the date that you converted to QuickBooks.

� When you get to the Employee summary information window, select the 
employee whose year-to-date summaries you want to add, and click Enter 
Summary. (If a message pops up asking if you want to set up sick hours accrued, 
click Later. You’ll be setting this up when you customize each employee’s profile.) 

To learn about… Search the Help index for…

Setting employee defaults employee defaults, creating
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� On the 2003 YTD Adjustment window, enter the employee’s year-to-date amounts 
using the totals from each employee’s last payroll stub, or the Payroll Register 
(detail) report (as shown in the example below) with the exception of accrued 
vacation pay (see the step below for instructions on vacation pay). 

� If you still owe vacation pay that an employee has accrued, you need to add this 
outstanding balance to the “VacPay-Accrued” payroll item. Look to the Employer 

Each employee’s year-to-date amounts are 
totalled on this MYOB report. Enter the totals 
you see on this report into QuickBooks. For 
details on how to generate this report, refer to 
step 1. Year-to-date amounts can also be 
retrieved from the last payroll stub that you 
printed for an employee.

The date range should be 
from the beginning of the 
payroll year to the date you 
converted to QuickBooks.



Converting data from MYOB 97

Accrual Expense Balance (detail) report that you printed in step 1 to determine 
how much accrued vacation pay that you still owe an employee, 

� When you’ve entered year-to-date summaries for all your employees, click Next.

� On the Enter prior payments window, click Create Payment, and enter the total 
liability payments that you made in this payroll year for each liability item. There 
are many ways to retrieve the total liability payments you’ve made thus far from 
your accounting records. 

In this example, we created a Tax Liabilities report covering the period of time 
when we remitted our tax liability payments to the government. You could also 
get this information from your PD7A forms. If you are not sure where to get the 
payroll liability payment amounts you’ve remitted so far, contact your accountant. 
Don’t forget to include non-tax payroll liability payments, such as union dues. 

This employee has $234 of accrued 
vacation pay still owing to her at the time 
of the conversion. An employee’s 
outstanding accrued vacation pay must be 
added to the Set Up YTD Amounts wizard. 

Do not use the accrued vacation pay 
amount shown in the Payroll Register 
(detail) report as this amount does not 

include any 
outstanding 
accrued vacation 
pay carried 
forward from 
previous payroll 
years. 

Click OK when you’re done entering year-
to-date summaries for this employee.
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When all the liability payments have been entered, click the Accounts Affected 
button, and select Do not affect accounts., click OK, then click Done.

� On the last window, click Finish.

Customize payroll information for each employee.

� Display the Employee List (from the Employees menu, select Employee List). 

� For each employee, double-click their name on the list to open the Edit Employee 
window. On the Address Info tab, enter their date of birth in the DOB field, their 
SIN., and other information as required. This information is available from the 
Employee Payroll List report in MYOB. 

This report represents the total amount of tax 
liability payments you’ve remitted to the 
government so far this payroll year (be sure to 
check these totals with your accounting records). 
These payments, in addition to other non-tax 
payroll liability payments, must be entered into 
QuickBooks.

Employee Payroll List report from MYOB
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� On the Payroll Info tab, in the Earnings box, select how this employee is paid 
(salary or hourly for example) and then enter the annual rate if the employee is on 
a salary, or an hourly rate if paid on an hourly basis. In the Pay Period field, select 
how often you issue pay cheques to the employee. This information is available 
from the Employee Payroll List report.

� To adjust the payroll tax information for this employee, click the Payroll Taxes 
button. Click OK when you’re done.

� To set up how your employee will accrue time for such things as sick days or time 
off in lieu of overtime, click Accrual Hours. 

� You do not need to add accrued vacation pay because you’ve already added 
vacation pay accruals in the Set Up YTD Amounts wizard. 

QuickBooks now has all the information it needs to continue paying your employees 
through to the end of this payroll year. To ensure that you entered your payroll data 
accurately, refer to the checklist in the section “Making sure your payroll data is complete” 
on page 202.

Enter additional adjustments you make to the gross or net pay 
here, with the exception of tax adjustments. Such 
adjustments can include payments to a retirement plan, or 
union dues, company contributions for dental or life 
insurance to 
name a few. If 
you set up 
employee 
defaults, 
these 
adjustments 
may already 
be set.
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Importing from / exporting to other software

Importing from other software

QuickBooks can import information directly from some bookkeeping packages. To start the 
import wizard, from the File menu, select Utilities, then Import, then the software you are 
importing from. For help, click the Help button in the wizard.

If you use QuickBooks Pro or QuickBooks Premier, with a few clicks, you can import your 
contacts from Microsoft Outlook or Symantec ACT! (see page 101).

For all other software, QuickBooks imports data in a format called IIF (Intuit Interchange 
Format), a special type of ASCII text file with headings to tell QuickBooks the type of 
information it contains. (This format is different from .QIF, used by Quicken.)

If you want to import data from other software programs, you need to create an IIF file from 
it or reformat data you already use to conform to IIF standards.

Note: Creating an IIF file from scratch or changing data from another accounting program into an IIF 
file is not recommended unless you have programming experience. However, you do not need 
to learn about the IIF format to export lists and import them back into QuickBooks (see below).

Transferring lists between QuickBooks companies

You can transfer a list (like the Customer:Job list) from one QuickBooks company to 
another by exporting it to an IIF file, then importing it into the new company.

Note: When you import a list into an existing QuickBooks company, QuickBooks replaces any duplicate 
entries with ones from the import file.

If you import customers or vendors from an IIF file, you’ll need to edit each one to add 
information such as payment terms. Also, if you have unpaid balances for a customer or 
vendor, you must enter an invoice or bill that at least tells the total amount owed.

To learn about… Search the Help index for…

Creating an IIF file importing data



Exporting to other software 101

Exporting to other software
When you export a list from QuickBooks, it is automatically formatted as an IIF file. You 
can then import the IIF file into spreadsheets, word processors, database programs, or other 
QuickBooks companies. You can’t export transactions from QuickBooks, but you can 
create a report based on transactions and print it to a file that another program can import.

Transferring information to Microsoft Word, Excel, 
Outlook, or Symantec ACT!

If you use QuickBooks Pro or QuickBooks Premier, you can easily export data to Microsoft 
Word or Excel and synchronize your contacts with Microsoft Outlook or Symantec ACT!

� If you use Microsoft Word as your word processor, you can use customer, vendor, 
employee, and other names in letters.

� If you use Microsoft Excel, you can export your QuickBooks report data to Excel for 
further customization and filtering.

� If you use Outlook or ACT!, you can synchronize your contact information with Quick-
Books.

Method What it does Advantages Disadvantages

Print to disk Makes a copy of a list 
or report in a format 
common to other soft-
ware programs

You can import the file 
into a spreadsheet or 
word-processing program.

Only lists and reports can 
be printed to disk.
QuickBooks cannot read 
files printed to disk.

Export Puts lists into a file in 
IIF format, with one 
record per line and one 
column for each field

Share lists with other com-
pany files or databases, word 
processor, or spreadsheets. 
Add to the list, then import it 
back into QuickBooks.

QuickBooks can export 
only lists, not transactions 
or reports.

To learn about… Search the Help index for…

Exporting lists to another Quick-
Books company

exporting data

To learn about… Search the Help index for…

Writing letters letters

Exporting data to Excel reports, exporting to Microsoft Excel

Synchronizing contact informa-
tion

contact management, synchroniz-
ing with a contact manager
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Give your accountant permission to access your QuickBooks 
file remotely

If your accountant has QuickBooks Premier: Accountant Edition, they can use the 
QuickBooks Remote Access to work with your file directly from their computer. This can 
save your accountant the time and expense of a visit to your site, and you don’t have to 
worry about preparing a disk for your accountant.

To work this way, set up a time with your accountant to start the session. Your accountant 
gives you an Internet address and license key. When you go to the address and enter the 
number, your accountant can begin the remote access session.

During the session, your accountant controls QuickBooks on your computer. Every action 
your accountant takes is shown in real time on your screen. Your accountant has access 
only to your QuickBooks software and programs that integrate with it.

Exporting data for your accountant (Accountant’s Review)

The Accountant’s Review™ feature allows an accountant to make certain kinds of changes 
in a special copy of your company file. Meanwhile, you can continue to enter daily 
transactions in the original (master) company file. After the accountant has made the 
changes, you merge them into the master company file.

What can and can’t be changed

The Accountant’s Review feature may not be right for everyone. The accountant can make 
some kinds of changes but not others. The advantage of using the Accountant’s Review 
feature is that you can continue to work normally with your master company file (that is, 
the regular company file from which you make the Accountant’s Review copy). After the 
accountant has made changes, you can merge the changes into your master file.

Note: If you have set up users for your company (see “Working with multiple users” on page 132), your 
accountant will need the user name and password of the QuickBooks Administrator.

You

Your
accountant

Start by creating an 
Accountant’s 

Review copy of your 
data for your 
accountant.

Continue using your 
company file for day-

to-day business 
tasks.

Merge your 
accountant’s 

adjustments into 
your QuickBooks 

company file.

Opens the 
Accountant’s 

Review copy in 
QuickBooks.

Reviews your data 
and makes 

adjustments.

Saves the 
adjustments to one 

or more disks.
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The table shows what an accountant can and can’t do while using an Accountant’s Review 
copy of your file, and any restrictions on you while this copy is out.

Your accountant 
can...

Your accountant 
cannot...

You cannot...

� View all existing
transactions and lists

� Add new items to the 
Chart of Accounts, Item 
list, To Do Notes list, and 
Memorized Transaction 
list (general journal 
transactions only)

� Enter transactions other 
than general journal
transactions

� Add new items to the 
Payroll Item list 

� Memorize transactions 
other than general jour-
nal transactions

� Delete any items 
from lists

� Reorganize lists 
(move items, make 
one item a subitem 
of another)

� Create, edit, and print 
PD7A, T4, and Relevé 1 
forms

� Edit existing account 
names and numbers

� Edit account and tax 
information for existing 
items on the Item list

� Enter general journal 
transactions

� Reconcile new trans-
actions

� Adjust inventory values or 
quantities

� Create reports
� Change preferences 

temporarily
� Print T4A report

� Edit existing payroll items
� Edit or delete existing 

transactions, including 
pay cheques

� Reorganize lists (move 
items, make one item a 
subitem of another)

� Rename accounts or items
� Make items inactive
� Edit names of existing 

items on Item list
� Adjust payroll liabilities
� Enter or edit employee 

YTD payroll setup trans-
actions

� Export changes to prefer-
ences

� Memorize reports
� Change a non-inventory 

part type to an inventory 
part type

� Merge new inventory part 
items with previous, exist-
ing inventory part items

To learn about… Search the Help index for…

Setting up your accountant as a 
user with all privileges (if you 
have set up users)

permissions
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For accountants only:
working with an Accountant’s Review copy

The Accountant’s Review copy of a company file (which your client should create from his 
or her master company file) is a compressed, special type of company file. It has a .QBX 
extension instead of the usual .QBW or .QBB. When you start working with these files for 
the first time, QuickBooks decompresses them to a .QBA file.

Note: If your client has set up users and passwords, you’ll need to find out the user name and password 
assigned to you or the QuickBooks administrator.

Once you have opened an Accountant’s Review copy, it remains the current QuickBooks 
company unless you open a different company or you close the company. If you try to 
record a change that is not allowed, QuickBooks tells you that it cannot record the change 
in an Accountant’s Review copy.

When you export your work from an Accountant’s Review copy, the changes to his or her 
company file are saved in a .AIF file. You should return this file to your client as soon as 
possible so it can be reintegrated with his or her .QBW file.

Creating an Accountant’s Review 
copy of your current company file

accountant’s review copy

Merging the accountant’s file into 
the master company file

accountant’s review copy

Making the accountant’s revised 
copy your master company file

restoring data

Cancelling an Accountant’s 
Review copy

accountant’s review copy

To learn about… Search the Help index for…

If your computer’s system date and time is earlier than the date and time that 
your client created the Accountant’s Review copy, you will not be able to 
open that copy.

To correct the problem you’ll need to determine which computer has the incorrect date 
and time, change the date and time, and try to reopen the copy. You may need to have 
your client cancel the first review copy and create another one for you.

To learn about… Search the Help index for…

Creating a file to give to your 
client

accountant’s review copy
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This chapter explains the basics of using QuickBooks, 

so you can get up and running quickly. Once you 

know how to get around in QuickBooks and where to 

go for more information, you’ll learn about the 

options you have and how to use the features of 

QuickBooks that require additional setup, like 

backing up and restoring data, allowing different 

users to access your company file, and linking your 

company accounts to your income tax return.Chapter 4
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Getting around in QuickBooks

QuickBooks gives you many ways to get to the information or feature you want.

Learn basic features in minutes

The fastest way to get started in QuickBooks is to practice with the QuickBooks Coach. 

This interactive tutorial lets you practice common tasks without affecting the data in your 
company file. You can complete it in 15 minutes, and when you do, you’ll be able to 
navigate in QuickBooks, set up customers and items, make sales, and receive money.

To start the QuickBooks Coach, select QuickBooks Coach from the Help menu.

Understanding QuickBooks file types

QuickBooks uses several types of files. Here are some of the more common ones:

� .QBW: Your company file. This contains your company set-up, and all the information 
you enter (customers, vendors, transactions, etc.) for your company.

� .QBB: A compressed backup of your company file.

� .QBX: A compressed version of an Accountant’s Review copy of your company file. See 
“Exporting data for your accountant (Accountant’s Review)” on page 102.

� .QBA: An Accountant’s Review copy of your company file that’s not compressed (that 
is, what your accountant gets when he or she opens the .QBX file you provided).

� .AIF: A special file containing the changes your accountant made to your company’s 
books in the .QBX file you provided. You merge the information from this file back into 
your regular company file (.QBW).

About the Getting Started window

When you first open QuickBooks, the QuickBooks Getting Started window appears. It lists 
the steps you need to complete to finish setting up your new company file, tells you how 
to find the information you’ll need while you’re working, and gives you some useful tips 
on managing your business.

QuickBooks also provides information about resources for your business, product news, and 
how to get help, if you need it. Look under the Help menu for these options.
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Navigating in the working area

QuickBooks makes it easy to access the feature or information you want. There are several 
ways to get around in most areas of QuickBooks — just choose the one that best fits your 
work style. Also, many parts of QuickBooks, such as the Icon bar, are customizable to fit the 
needs of your business.

Moving between windows

Tip: If you’d like to be able to see multiple windows open at the same time, from the View menu, select 
Multiple Windows.

QuickBooks maximizes your workspace by displaying one window at a time at its full size. 
Because QuickBooks keeps a list of the windows you have open, you can quickly switch 
between windows as you work.

The customizable Icon 
bar gives you one-click 
access to the features 
you use most.

Navigators are 
an easy way to 
work in one 
area of 
QuickBooks.

As you use 
QuickBooks, the 
Open Window 
list keeps a list 
of the areas 
you’ve worked 
in.

Each Navigator shows 
the tasks for one area of 
your business.

The Customer 
Navigator, shown here, 
contains customer-
specific tasks like 
creating an invoice. 

For more on the 
Navigators see “Getting 
information about your 
company” on page 111.

To learn about… Search the Help index for…

Customizing and using the Icon 
bar

Icon Bar

Displaying the navigators navigators

Displaying and using the Open 
Window list

windows, list of open

Showing, hiding, or customizing 
items on the QuickBooks desktop

desktop
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Using lists, forms, and registers

When you’re working in QuickBooks, you’ll spend most of your time using a form, a list, 
or a register. Since these are so basic to QuickBooks, take a few minutes to become familiar 
with them.

Using lists

Lists store information about customers, vendors, employees, items or services you sell, and 
so on. They save you time and help you enter information consistently and correctly.

You fill out most QuickBooks forms by selecting entries from a list. For example, when 
you’re filling out an invoice form, you select a customer name from the Customer:Job list. 
QuickBooks then fills in the customer’s name, address, payment terms, and other 
information.

Using forms

You record most of your daily business transactions on a QuickBooks form, which looks just 
like the paper forms you’re used to. After you fill it in, QuickBooks does the accounting.

This list includes 
each customer 
and job and their 
outstanding 
balances.

An “X” beside a 
name shows it’s 
inactive.

You can create notes on many 
lists.

Use the menu 
buttons at the 
bottom of lists 
for a variety of 
tasks: creating new entries, editing existing ones, 
creating reports about items on the list, and 
using them in transactions.

To re-sort the list by name, click 
the column header.

To show the items marked 
“inactive,” select Show All. To 
hide these items, clear the 
checkbox.
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Using registers

Just as you use the paper register that comes with your cheques to record the transactions 
in your chequing account—cheques you’ve written, withdrawals you’ve made, and 
deposits—QuickBooks uses electronic registers to record the activity in its accounts. The 
register shows every transaction for that account, as well as the account balance.

Although you usually would use forms for entering and viewing transactions, you can also 
do so directly in registers. Here’s an example of the register for an accounts receivable 
account.

When you record a bill and then 
write a cheque (using the Pay Bills 
window) to pay for the business 
expense, QuickBooks enters 
transactions in your accounts 
payable register to show the 
expense you incurred and the 
payment you made.

It also records the cheque in your 
chequing account, keeping your 
records up to date and providing a 
running balance of what you owe at 
any time.

It also shows payments 
you’ve received against 
your invoices.

At the bottom-right of 
the register, you see a 
running balance, or 
ending balance as it is 
referred to in 
QuickBooks, of all your 
accounts receivable, so 
you always know how 
much you’re owed.

The register 
shows 
information 
about invoices 
written to 
customers — 
the date of the 
invoice, the 
date it’s due, 
the name of the 
customer, and 
the amount.
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Where to learn more about using QuickBooks
QuickBooks provides a variety of ways for you to obtain useful information and answers to 
your questions. If you are having a specific problem and prefer person-to-person assistance, 
see “QuickBooks product support” on page 270.

Finding step-by-step instructions

How do I? menus

Throughout QuickBooks, you’ll find windows with a How Do I? drop-down menu in the 
upper-right corner. These menus provide quick access to information and instructions for 
the window you’re working in.

On-screen help

To get explanations about features of the window you’re working in, press F1 or the Help 
key on your keyboard or choose Help on this window from the Help menu.

To find instructions on a particular subject, choose Help Index from the Help menu and type 
the subject you want to find.

Finding industry-specific information

QuickBooks comes with a collection of information that’s customized for various 
industries. In it, you’ll find specific information about how to set up and best use 
QuickBooks for your type of business.

To view the industry-specific information:
1 From the Help menu, choose Using QuickBooks for Your Type of Business.

2 Click an industry name in the window that appears.

3 Click the topic that interests you.

4 To print a topic, click Print.

Exploring QuickBooks with a sample company

Use the sample company that comes with QuickBooks to get familiar with the software: 
explore the features, enter test data, and run reports.

To view the sample company
1 From the File menu, choose Open Company.

2 In the Open a Company window, choose sample.qbw.



Getting information about your company 111

Getting information through the Internet

You can use the QuickBooks.ca Web site (http://www.quickbooks.ca) to browse for answers 
to questions about QuickBooks or Intuit Canada.

To get to QuickBooks.ca from within QuickBooks (using the built-in Web browser), select 
it from the Help menu.

Getting information about your company
Navigators are the best starting point to see how your company is doing at a glance. They 
gather information from your QuickBooks data and display it in one location so you can 
manage your business more effectively. There are eight navigators: Company, Business 
Services, Customers, Vendors, Employees, Banking, Reports, and Help & Support. 

The flowchart 
shows activities 
for dealing with 
one customer. 

Click the icons 
for quick access. 

Click these icons for quick 
access to features you use 
to manage all your 
customers.

Use this drop-down list for 
convenient access to 
reports you’ve added to 
the memorized reports list.

In this area, 
QuickBooks 
provides you 
with suggestions 
for working with 
your customers.

To learn about… Search the Help index for…

Using the Company Centre Company Centre

Using other QuickBooks centres centres

Decision Tools decision tools
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Creating reports

QuickBooks provides a wide variety of preset reports and graphs designed to give you quick 
and easy access to your company’s information. In addition, you can create your own 
customized reports that have a different look and layout as well as scope of information.

Finding the right report

With the Report Finder, you can quickly review and choose among the many preset reports 
that QuickBooks provides. To help you choose an appropriate report, the Report Finder 
displays a sample of each report, as well as a summary of what the report conveys about 
your business. 

Choose a report 
category and 
view a general 
description of 
your choice.

The specific 
reports available 
in the category 
you selected are 
listed here.

View a 
thumbnail 
picture with 
sample data to 
get an idea of a 
report’s 
content. You 
can customize 
a report before 
or after you 
generate it.

QuickBooks provides details about a report’s content to help 
you decide whether the report is appropriate for your needs.

To learn about… Search the Help index for…

Finding a report reports, finding

Creating a report reports, creating

Preset reports report types, all
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Customizing the look of a report

Most reports can be customized for unique presentation of your data. For example, you can 
do the following:

� Change the typeface (font) and how numbers display

� Add or remove columns and adjust their width

� Create or change subtotal groupings

� Change the sort order of transactions

After you have customized a report, you can save the settings for future use. Saving report 
settings is called memorizing. The next time you run the report, QuickBooks recreates the 
format of the report, but uses your latest financial data.

When you memorize a report, QuickBooks adds it to the Memorized Report List. To display 
this list, from the Reports menu, choose Memorized Reports, then choose Memorized Report 
List.

Click Modify Report 
to customize a report 
for your needs.

Each tab covers 
different aspects 
of the report. For 
example, this 
tab allows you 
to choose the 
columns you 
want to display.

If you’re using QuickBooks Pro or 
QuickBooks Premier and Microsoft 
Office, you can export reports to a 
Microsoft Excel spreadsheet.
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Changing the scope of the information in a report

Creating your own version of an existing report can also include filtering, or changing the 
scope of the information that displays on a preset report. 

We encourage you to explore 
the extensive list of filters.

Your options here will include 
filtering for data you entered in 
your custom fields.

To learn about… Search the Help index for…

Changing date ranges reports, dates in

Customizing a report report customization

Adjusting, adding, or deleting 
columns on a report

report customization, columns

Tailoring the data in the report 
(filtering)

reports, changing the scope of

Changing headers and footers report customization, headers
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What does “Other” refer to on reports?

If you use subaccounts, subitems, or jobs, then sooner or later you will see the word “Other” 
on a report:

QuickBooks shows the word “Other” when you create a report for an account that has 
subaccounts (or items that have subitems, customers that have jobs, and so on) and there 
is a transaction associated with the main account. Generally, if you are using subaccounts 
(or subitems or jobs), you should associate transactions only with the subaccounts instead 
of the master account.

Tip: To remove the “Other” line or column on a report, double-click its dollar amount to see the 
transaction and adjust it. When QuickBooks displays a report listing one or more transactions, 
double-click each one in turn. In the transaction itself, replace the problem name with the correct 
subaccount, subitem, or job.

Customizing a form’s content
You can customize any template form and create any number of versions. 

Tip: If you plan to print your invoices or statements on preprinted forms from Intuit, you should make 
only minor adjustments to the Intuit templates. For example, adding a logo, adding your 
company name and address, or changing fonts still allows you to use preprinted forms and 
double-window envelopes you purchase from Intuit. You can’t; however, add, change, delete, or 
move columns unless you have purchased custom designed forms.

For each form you customize, you decide which fields (including custom fields) and 
columns to include, what they are labelled, and where to place them. 

Once you’ve created your forms, you can save them to use whenever you want and modify 
them whenever you want. You can also purchase custom forms to match.

Note: To purchase custom forms, see “Ordering QuickBooks products and services” on page 269.

The $18.45 expense for Automobile-Other is 
for the Automobile main account and not 
for either of the subaccounts.
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The following diagram shows the areas of the form that you can change using various tabs 
of the Customize window.

Format

Use the Format tab to add your 
logo and to change fonts, 
including font style (italic, bold, 
etc.) and size.

Columns

Use the Columns tab to change 
the order in which columns 
display. The Amount column 
always displays furthest to the 
right. 

You can also rename, add, or 
delete columns.

Printer

Use the Printer tab to 
change the page 
orientation.

Header

Use the Header tab to 
change the title of a 
form or other 
information in this part 
of the form.

Fields

Use the Fields tab to 
change the information 
shown on this part of 
the form. 

Footer

You can enter up to 
1,000 characters in the 
Long text area on the 
Footer tab to print on 
your custom form. 

This information could 
include legal 
disclaimers or warranty 
information.

To learn about… Search the Help index for…

Creating custom business forms customizing forms, about
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Backing up your company data
Your data is valuable! No recovery technique can repair all possible file damage or protect 
against theft or natural disasters.

To guard against and minimize data loss, you should make regular backup copies of your 
QuickBooks company (or companies). In the event of data loss, you can restore your data 
from the backup.

When it comes to backing up your company file, you have several options. You can backup 
to

Note: QuickBooks Backup Service is an online backup through the Internet. It’s fast and convenient, 
and stores a copy of your company file on secure, third-party server away from the physical 
location of your company.

The QuickBooks Backup command doesn’t just copy your company data file. Instead, it 
compresses the data into a compact backup file which only QuickBooks can open. You can 
give the backup file any name you want. QuickBooks automatically gives your backed file 
the extension .QBB. 

Note: For a description of the various file types QuickBooks creates for your company file, see “Under-
standing QuickBooks file types” on page 106.

It’s a good idea to store at least one recent backup off-site. That way, in case of theft or 
natural disaster, you’ll have a copy of your company data in a safe place. 

� your hard drive � tape

� 3.5 floppy disks � a secure server on the Internet, if 
you subscribe to the QuickBooks 
Backup Service.� CD-R or CD-RW

� Zip disk

You must be in single-user mode to backup your company file.

In single-user mode, only one person at a time can access and work with your company 
file. If you have QuickBooks Basic (not QuickBooks Pro or Premier), you are always 
working in single-user mode and do not need to worry about switching.

� If other people are working with the company file, ask them either to close the file 
or exit QuickBooks.

� From the File menu, choose Switch To Single-User Mode.
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Recommended backup routine

If you use QuickBooks Pro or QuickBooks Premier in multi-user mode, you must switch to 
single-user mode to create a backup. For more information on single-user mode, see 
“Working with multiple users” on page 132.

� Prepare several sets of backup media. 

If you’re using 3.5 floppy disks to backup, you may require multiple disks, depending 
on the size of your company file.

� Label the backup media “QuickBooks Backup Monday,” “QuickBooks Backup 
Tuesday,” etc. 

If you’re using 3.5 floppy disks to backup and you require more than one disk, label the 
disks “Monday, Disk 1,” “Monday, Disk 2,” and so on.)

By having one set of backup disks for each business day, you likely won’t lose more 
than one day’s records if a disaster strikes.

� Each day, back up onto that day’s disks and keep them in your office.

� At least once a week, make a second backup to keep off your premises.

Alternate between two sets of media for your weekly off-set backup. If a disaster strikes 
your office, you’ll want a reliable record of your data to fall back on.

� Periodically, replace your backup media with new media on your machine.

� At the end of the fiscal year, make an archive copy of your data to keep off your 
premises.

If backup your company file to a floppy disk, you should be aware that there 
are risks involved in this type of data storage.

Not all floppy disks are created equally. Some disks can be re-used several times and 
retain their integrity for a long period of time. While others can be re-used only a few 
times and can become corrupt for no obvious reason. Because of the volatility of floppy 
disks, we least recommend this type of data storage.

To learn about… Search the Help index for…

Backing up your company data backups
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Backing up to a CD-R or CD-RW

To backup to a CD-R or CD-RW:
1 Insert the CD into your CD-R drive.

2 From the File menu, choose Back Up and ensure the Back Up Company File tab is 
selected. 

3 Click Browse.

4 Navigate to a place on your hard drive that you can easily find again. 

� QuickBooks may warn you that you are backing your data up to your hard disk.

5 In the File name field, type a name for your backup.

Tip: We recommend that you give a new name for each backup, for example, the date of this backup. 
This prevents you from overwriting the previous backup should there be a problem during the 
backup process (for example, a power failure).

6 Click Save.

7 (Optional) Select the backup options you want: 

� Verify data integrity: Select to verify your data before backing up. 

� Set Defaults: Click to specify the defaults for backing up manually. 

8 Click OK. QuickBooks creates a backup file of your company data.

9 Start your CD writing software and use it to copy the backup file from the location you 
saved it to your CD.

For those users who are very comfortable working around the limitation in Windows XP’s 
built-in CD writing software, the help file includes information about setting up Windows 
XP so that you can back up your company files directly from QuickBooks to a CD. 

Although Windows XP can write data directly to a CD-R or CD-RW, we 
strongly recommend that you use third-party CD writing software to back 
up your company file instead.

Because of a limitation in the CD writing program that comes with Windows XP, it may 
not allow QuickBooks to back up directly to a CD. Instead, it may display an error 
message such as "Unable to access the disk." Also, if Windows XP does allow Quick-
Books to access the CD, Windows XP may not transfer your company file backup from 
the CD Writing Tasks area to your CD properly.

Instead, you should first save the backup to your hard drive, then copy it to your CD with 
reliable third-party software.

To learn about… Search the Help index for…

Setting up Windows XP so you 
can back up to CDs directly from 
QuickBooks

backups, CD using Windows XP
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Backing up to a Zip drive

To backup to a Zip disk:
1 Insert the Zip disk into your Zip drive.

2 From the File menu, choose Back Up and make sure the Back Up Company File tab is 
selected. 

3 Click Browse.

4 Navigate to your Zip drive.

5 In the File name field, type a name for your backup.

Tip: We recommend that you give a new name for each backup, for example, the date of this backup. 
This prevents you from overwriting the previous backup should there be a problem during the 
backup process (for example, a power failure).

6 Click Save.

7 (Optional) Select the backup options you want: 

� Verify data integrity: Select to verify your data before backing up. 

� Set Defaults: Click to specify the defaults for backing up manually. 

8 Click OK. QuickBooks creates a backup file of your company data.

Backing up to a tape

To backup to a tape:
1 Insert the tape into your tape drive.

2 From the File menu, choose Back Up and make sure the Back Up Company File tab is 
selected. 

3 Click Browse.

4 Navigate to your tape drive.

5 In the File name field, type a name for your backup.

Tip: We recommend that you give a new name for each backup, for example, the date of this backup. 
This prevents you from overwriting the previous backup should there be a problem during the 
backup process (for example, a power failure).

6 Click Save.

7 (Optional) Select the backup options you want: 

� Verify data integrity: Select to verify your data before backing up. 

� Set Defaults: Click to specify the defaults for backing up manually. 

8 Click OK. QuickBooks creates a backup file of your company data.
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Backing up to a 3.5 floppy disk

Formatting your floppy disk

Formatting removes any old data that may be on the disk and prepares the disk to receive 
new data. Even if the disk is labelled as preformatted, it's a good idea to fully format a new 
disk before using it. Sometimes new disks can be stripped of their formatting during 
shipping.

For your convenience, QuickBooks can format disks during the backup process.

Tip: We recommend you keep multiple backups on different sets of disks and that you periodically 
replace the disks with new disks.

To backup to a 3.5 floppy disk:
1 Insert a disk into your floppy disk drive. 

2 From the File menu, choose Back Up and ensure the Back Up Company File tab is 
selected.

3 Click Browse.

4 Navigate to your floppy disk drive.

5 In the File name field, type a name for your backup.

Tip: We recommend that you give a new name for each backup. For example, the date of this backup. 
This prevents you from overwriting the previous backup should there be a problem during the 
backup process (for example, a power failure).

6 (Optional) Select the backup options you want: 

� Verify data integrity: Select to verify your data before backing up. 

� Set Defaults: Click to specify the defaults for backing up manually. 

7 Select Format each floppy disk during backup. 

8 Click OK. QuickBooks prepares to format the floppy disk. The format dialog box 
appears.

9 Click Start. A warning appears that all the data on the floppy disk first be erased.

10 Click OK. The floppy disk is formatted.

11 When formatting is complete, click OK, then click Close to close the Format dialog box.

QuickBooks begins to backup your company file to the floppy disk(s).

If you decide to backup your company file to a floppy disk, you should be 
aware that there are risks involved in this type of data storage.

Not all floppy disks are created equally. Some disks can be re-used several times and 
retain their integrity for a long period of time. While others can be re-used only a few 
times and can become corrupt for no obvious reason. Because of the volatility of floppy 
disks, we least recommend this type of data storage.
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Note: If you need more than one disk, QuickBooks asks you to insert an additional disk as each disk 
fills up. Label the disks so that you'll know which one was first, which was second, and so on. 
This will help you if you ever need to restore the data from the disks. 

If you selected to format before backing up the disk, QuickBooks formats sequential disks as you 
place them into the drive.

Testing your backup

Due to the volatility of floppy disks, we recommend that your test the data that you’ve 
stored on your floppy disk. 

You’ll use the Restore feature to test your backup. This procedure uncompresses your 
backup file and creates a new company file using the data from the backup. 

To test the data you’ve backed up:
1 Insert the 3.5" floppy disk that contains your backup file, or if you’re restoring from 

multiple disks, insert the first disk.

2 From the File menu, choose Restore. 

3 In the Get Company Backup From section, select Disk; then click Browse to navigate to 
the file on your floppy disk drive and click Open. 

4 In the Restore Company Backup To section, click Browse and navigate to a folder where 
you can store the restored file temporarily. Don’t save the restored file in the same 
folder where you normally store your company file. For example, navigate to the 
Windows temp folder.

5 In the File name field, type a name for the restored file. For example, test.

6 Click Save. 

7 Click Restore.

If you’re restoring from multiple disks, QuickBooks prompts you to insert the 
sequential disks as QuickBooks extracts the compressed data. 

8 QuickBooks lets you know if the restore was successful. Click OK. QuickBooks opens 
your restored company file.

Unfortunately, testing the backup data doesn’t ensure the integrity of your 
floppy disk. 

There is still a risk of your backed up data becoming corrupt. Corruption can occur due 
to age, environmental changes, over-use, or for reasons beyond your control.

The next time you open QuickBooks, ensure that you’re opening your main 
company file and not your this restored file.

By default QuickBooks remembers the last file you worked on. 



Backing up your company data 123

Using the QuickBooks Backup Service

The QuickBooks Backup Service is a scheduled backup service. You don’t have to do 
anything once you’ve set everything up. Although, if you do want to do a backup manually, 
you still can by simply launching the QuickBooks Backup Service software.

Before you can use the QuickBooks Backup Service, you’ll need to sign up for it. An Internet 
connection is required to use the QuickBooks Backup Service.

To sign up for the QuickBooks Backup Service:
1 From the File menu, choose Back Up and ensure the Back Up Company File tab is 

selected. 

2 Select Online, then click Tell me more. The QuickBooks Backup Service overview opens.

3 Click Get Started Now. The QuickBooks Backup Service Web site opens.

4 In Service Level Options table, click Download Now for the level of service you want: 

� QuickBooks File Backup: Select to protect up to 100 MB of data, including your 
QuickBooks files, with this low cost backup solution. Your QuickBooks files will 
automatically be selected for backup. Additional individual files can be selected 
manually. 

� Premium Data Backup: Select to protect all of the data files on your PC, up to 4 GB.

� Premium Plus System Backup: Select to protect all files and software applications 
on your PC and automatically heal your PC from virus attacks, corrupted applica-
tions or files, up to 10 GB. 

You’re prompted to open the installation file.

5 Click Open, then click Install. The installation begins.

6 Follow the prompts as they appear. Once you’ve signed up, you’re prompted to start 
the backup process.

When the backup is complete, you’ll receive a report about the backup and if there were 
any problems. The QuickBooks Backup Service also displays your next scheduled 
backup.

To perform a backup manually, click the  icon on your desktop to launch the Quick-
Books Backup Service software.

Searching for your backup file

If for some reason you can’t locate your backup file (.QBB), you can use the Windows’ 
search feature to help you find it.

To search for the backup file:
1 From the Windows Start button, select Search, then choose For Files or Folders. 

2 In the Search Results window, type *.QBB in the “Search for files named” field.

The asterisk symbol acts as a substitute for zero or more characters.

3 Choose a drive or folder in the “Look in” field.

4 Click Search Now.
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Restoring company data

If you need to restore your company file from a backup, use the Restore command. Because 
QuickBooks backup files are compressed, simply copying the backup file to your 
QuickBooks directory won’t give you access to your data.

Note: If QuickBooks locates a company file with a name that is the same as the one you’re restoring, 
QuickBooks asks you whether you want to replace the existing file. 

If you answer “No,” QuickBooks returns you to the Restore window. You must then give a 
different name to the restored file, and when the process is finished, you will have two different 
versions of your company data.

If you are restoring your company file because your computer or hard drive malfunctioned, 
we recommend that after the hardware repairs are done, you reinstall QuickBooks and any 
updates, before you proceed.

Condensing your company file
If your company file has grown very large, you can reduce its size by condensing the older 
transactions that you no longer need much detail about.

For example, you might want to condense the transactions your company completed two 
years ago or more, especially if your company file has grown quite large (more than 75 MB). 
Condensing large company files can sometimes improve the performance of QuickBooks.

When you condense data, you can specify an ending date for the period of time you want 
to condense. Transactions dated after your selected ending date are not affected. For 
example, if your ending date is 12/31/02, all transactions dated 01/01/03 and later remain 
intact in your company file.

When you condense your company file based on transactions as of a specific date, 
QuickBooks deletes only closed transactions. Open transactions are retained. Therefore, to 
condense the most possible transactions, try to complete any unpaid bills or uncleared 

Because your backup copy is in a compressed file format, you must use the 
Restore command to bring the data back into QuickBooks. Do not use the 
Copy command from Windows Explorer or the DOS prompt. 

If your hard disk has malfunctioned, you first need to reinstall QuickBooks on the 
repaired or new hard disk. For instructions, see “If you need to reinstall QuickBooks” on 
page 7. 

To learn about… Search the Help index for…

Restoring your company data restoring from a backup
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transactions you have before starting. It is best to choose an end date that is six months or 
more in the past. 

If you select Remove ALL transactions, QuickBooks deletes all transaction regardless of 
dates.

If you use payroll

If you use QuickBooks to pay your employees, QuickBooks will not condense payroll data 
for the current payroll year or the previous one.

For example, if you choose to condense your company file in March, 2004, QuickBooks 
would not condense payroll data from 2004 or 2003. It would condense payroll 
transactions from the date you started using QuickBooks through to December 31, 2002. 

Examples of transactions that would be deleted
� If an invoice has been paid in full, QuickBooks deletes the details and includes the 

amount in a summary transaction showing income accounts. Neither the customer 
name nor the items sold are retained. However, if an invoice is not printed, unpaid, 
partially paid, or marked as pending, QuickBooks leaves the invoice in your file so you 
can apply payments to the invoice.

� If you have QuickBooks Pro or QuickBooks Premier, condensing deletes only those esti-
mates that are dated on or before the ending date and that have a job status of Closed. 
If an estimate has any other job status (Pending, Awarded, In Progress, Not Awarded, 
or None), QuickBooks retains the estimate regardless of its date.

� Only if you choose the option in the Condense preferences: if you have paid a bill for 
a reimbursable expense, QuickBooks deletes a bill regardless of whether you have 
invoiced the customer for the expense. 

If you report financial information to the Québec Minister of Revenue (MRQ), 
you must keep the archive file the Condense function creates in case you 
need to refer to it during an audit.

Doing so helps you comply with legislation from the MRQ. The legislation states that 
your accounting software cannot allow you to modify or delete data without keeping a 
record of the original data.

You must keep the archive file the Condense function creates in case you 
need to refer to your payroll transactions during an audit.

The Canada Customs and Revenue Agency (CCRA) requires that you keep your payroll 
transactions for seven years. Since an archive file contains your payroll transactions for 
a given period, you must keep it.

Also, you should make sure you have printed records of your most important payroll 
transactions before you condense your data and create an archive.
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Examples of transactions that would be retained

The following table gives examples of the situations that cause QuickBooks to retain 
transactions dated on or before your specified ending date.

When you follow the steps in the Archive & Condense Data wizard, you’ll have an 
opportunity to remove old transactions and unused items to further reduce the size of your 
data file. However, QuickBooks always retains transactions that meet the following criteria.

Summary transactions

The summary transactions that QuickBooks creates appear in the registers of your balance 
sheet accounts (Bank, Accounts Receivable, Accounts Payable, and so on).

Each balance sheet account has one GENJRNL summary transaction for each month in 
which QuickBooks deleted transactions. The transaction amount is the total of the 
transactions that QuickBooks deleted for the month. 

For a given month, the register may also show other transactions that QuickBooks did not 
delete. These are transactions that could be affected by transactions you have yet to enter.

When opening a register, you can spot the summary transactions by looking for GENJRNL 
in the Type field.

To view a breakdown of amounts by account, select a GENJRNL transaction and click Edit. 
The General Journal Entry window shows the breakdown of amounts by account for all 
summarized transactions for this month.

Note: You cannot edit or delete a GENJRNL summary transaction.

When QuickBooks retains a 
transaction with earlier date

Example of retained transaction

The transaction is linked to another 
transaction that has an opening 
balance.

An undeposited customer payment that 
you applied to an invoice. Even though the 
invoice is paid, QuickBooks retains the 
invoice because it has a link to an open 
transaction (the undeposited payment).

The transaction is linked to a 
transaction after the condense date.
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How condensing data affects your reports

Account balances

After you condense your data, you can still create reports that summarize financial activity 
for the period of time you condensed. For example, if you condense last fiscal year’s data, 
you can still create profit and loss reports that compare last year’s results to this year’s. This 
is because QuickBooks adds summary transactions to your company file to preserve 
monthly account balances.

Transaction detail

After you condense your data, you won’t be able to create reports that show daily detail for 
the period of time you condensed. This is because QuickBooks has deleted the individual 
transactions that would have provided the detail. In addition, you won’t be able to create 
reports that show balances for individual customers or vendors over that period of time.

As a result, the totals for sales revenue on GST/PST liability reports will be incorrect. As a 
precaution, QuickBooks creates a backup file in case you need access to the deleted 
transactions later.

Cash basis reports

After you condense your data, you won’t get an accurate cash basis report for data that 
includes a condensed time period. This is because QuickBooks has deleted the individual 
transactions that would have provided the information about whether transactions were 
paid. As a result, the totals will be incorrect.

To learn about… Search the Help index for…

Condensing your QuickBooks 
company file

condensing data

Restrictions for condensing data if 
you’re using the QuickBooks Payroll 
Service

condensing data
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Reconciling bank and credit card accounts
You should plan to reconcile your bank (chequing, savings, and money market accounts) 
and credit card statements on a regular basis to make sure your records and the bank’s agree.

When you reconcile, be sure to add any bank service charges, interest earned, and finance 
charges.

Situation What to do in QuickBooks

You haven’t reconciled 
these accounts for a 
month or more.

Reconcile each month you skipped. Balance each month separately, starting 
with your earliest statement since you’ve been using QuickBooks, through 
your most recent statement.

You added earlier trans-
actions in QuickBooks.

After you add earlier transactions, and you want to reconcile past months, 
you should reconcile month by month only if you’ve never used the Quick-
Books reconcile feature.
However, if you’ve already reconciled one or more months, you should rec-
oncile forward only, that is, reconcile months after your start date. Use the 
previous months’ data for reporting only. You need to mark all older trans-
actions as cleared to reconcile future months.

You are reconciling for 
the first time.

Enter all uncleared transactions in your account.
Update the Opening Balance transaction to reflect the amount actually in 
your account when you began using QuickBooks.

You cancel in the mid-
dle of reconciling.

QuickBooks keeps track of the items you’ve marked as cleared with an aster-
isk (*) in the cleared column of the account’s register. This indicates that the 
items are still pending and reconciliation wasn’t complete.
When you start reconciling again, you’ll need to re-enter your ending bal-
ance and your service charges and interest earned. You’ll also need to check 
off additional payments and deposits.

To learn about… Search the Help index for…

Reconciling a bank account reconciling, bank statements

Reconciling a credit card account reconciling, credit card statements

Adjusting for differences reconciling, adjusting for differences
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Matching bank deposits and credit card deposits (QuickBooks 
Credit Card Service users) 

As a QuickBooks Credit Card Service user, you can use QuickBooks to help match your 
customers' credit card payments with the lump sum deposit on your bank statement, as well 
as account for banking fees.

To do this, in the Receive Payments or Enter Sales Receipts window, select the “Group with 
other undeposited funds” option. 

In the Make Deposits window, you can display credit card payments views grouped by 
credit card type, which lets you see the individual credit card transactions that make up 
each lump sum deposit. 

Often, the bank deposit total is less than the payments you received from individual 
customers due to credit card transaction fees. QuickBooks calculates the difference for you 
automatically and lets you assign the transaction fee to an expense account. 
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Setting up online banking (account access and 
payment)

QuickBooks online banking encompasses account access. Before you can start using the 
online banking feature, there a few things you’ll need to do. We’ve compiled a list for your 
convenience.

To start using online banking in QuickBooks:
1 From your bank’s Web site, select the "Download to QuickBooks" option. (This option 

looks different for each bank.)

2 Choose Create a new QuickBooks account, and type the name of your account in the 
field provided, then select Continue.

What to set up Comments
Look in the Help Index 
for...

Internet access through an ISP if you 
haven’t already set this up for 
another QuickBooks feature

Choose Internet Connec-
tion Setup from the Help 
menu.

Internet connections

If you don’t already have an account 
(chequing, savings, money market, 
credit card) at a financial institution 
that provides online banking 
through QuickBooks, you’ll need to 
open one.

online banking, financial institu-
tions

Submit an application for online 
banking to your financial institution.

Application information 
can be accessed over the 
Internet or contact your 
institution directly. There 
may be a waiting period 
until you get confirmation.

online banking, setting up 

Select an online service for setup, by 
completing the “apply Now” section 
of the Online Banking Setup inter-
view

Enables you to submit an 
application for online bank-
ing at your financial institu-
tion.

online banking, setting up

When you receive your confirmation 
and a PIN/password from your 
financial institution, complete the 
“Enable Accounts” section of the 
Online Banking Setup interview. 

Verify that the information 
sent to you by the financial 
institution is correct.

online banking, enabling a Quick-
Books account
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Going online for the first time

You should use online banking within the first month of enrolling for online services. The 
first time you go online, we recommend that you download the most recent transactions 
that have cleared at your financial institution. 

Financial institutions use WebConnect for online banking connections. WebConnect offers 
online integration through the financial institution’s Web site (accessible from QuickBooks or any 
browser). With WebConnect, you can go directly to your bank’s Web site for online banking 
services.

Reconciling online accounts

Reconciling your online accounts is a three-phase process. 

1 To download your transactions, go to the Online Banking Centre, select your financial 
institution from the drop-down list, and Click “Go Online.” 

2 Match transactions.

View a QuickStatement for the account. The QuickStatement includes all transactions 
that have cleared your financial institution since the last time you downloaded, 
including deposits, cheques, transfers, and ABM withdrawals, as well as any transac-
tions that were downloaded previously but not been matched.

When you click Match, QuickBooks automatically matches downloaded transactions to 
those in your account register. For the unmatched transactions, select one of the trans-
actions from the downloaded statement, click Add to Register, and follow the onscreen 
prompts until the transaction appears in the register. Assign an account from the 
Account Drop Down list and click Record to enter the transaction in the register.

3 When you receive your bank statement for the account, use the Reconcile window.
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Note: With QuickBooks, you can reconcile only to the paper statement you receive from your financial 
institution. With Quicken, you can reconcile to either the online or paper statement.

Working with multiple users
In QuickBooks, you can set up your company file so that different users have different 
access to features (see “Setting up users and passwords” on page 133).

In QuickBooks Pro or QuickBooks Premier (only), several people can work with your 
company file at the same time, over a computer network.

Sharing QuickBooks Pro or QuickBooks Premier 
company files

Using QuickBooks Pro or QuickBooks Premier on a network is basically the same as using it 
on a single computer. For most of your day-to-day tasks, up to five users can access the 
company file at the same time. When several users are allowed to work in the company file 
simultaneously, the file is in multi-user mode.

However, for some activities, only one person at a time can use the company file. The other 
users must log off, close the company file, or exit QuickBooks Pro or QuickBooks Premier. 
Then the person who wants to perform the activity must switch the file to single-user mode. 
After finishing the activity, the person can switch back to multi-user mode, and the others 
can log back on or open the company file again.

Single-mode activities include:

� File operations such as backing up, condensing, or exporting data

� Some types of changes to lists

� Adjusting inventory

� Activities involving an Accountant’s Review copy

There is also a third category of activities. Although all the networked QuickBooks users 
(with the correct permissions!) have access to these features, only one person at a time can 
use them. (For information about restricting access to features, see “Setting up the 
Administrator and users” on page 134).

To learn about… Search the Help index for…

Downloading and matching online 
transactions

transactions, online

Account reconciliation � reconciling, bank statements
� reconciling, credit card statements
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Feature-locked activities include:

� Paying bills

� Running payroll

� Setting up new users or maintaining existing ones

Refreshing after entering data

If you are creating reports while others are working in the company file, you can use the 
Refresh button to make sure you have the most current information on your reports. The 
Refresh button updates your screen with the information that others have entered into 
QuickBooks Pro or QuickBooks Premier since you started the report.

You can refresh lists or forms as you work by pressing F5 on your keyboard or right-clicking 
the item and selecting Refresh.

Setting up users and passwords

Some parts of your company’s data are more sensitive than others. You can use passwords 
to make sure that each employee you have can only access those parts of QuickBooks you 
want him or her to use.

Areas you can protect include sales and accounts receivable, purchases and accounts 
payable, chequing and credit cards, inventory, time tracking, payroll, sensitive accounting 
activities, and sensitive financial reports.

In this way, you maintain the security of your business data even when several people 
access your company file simultaneously. Until you set up users (and passwords) in your 
QuickBooks company file, any person who accesses the file will have full access to all 
features of the program.

To learn about… Search the Help index for…

Switching between modes multi-user mode
single-user mode

Your refresh options Refresh button

The QuickBooks password feature provides a basic degree of protection for 
your data, but it is not a complete security system.

For example, it will not prevent someone using Windows Explorer from deleting your 
company file.
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Setting up the Administrator and users

About the QuickBooks Administrator

When you create a QuickBooks company file, QuickBooks creates a user called “Admin”. 
This user is the QuickBooks Administrator for the company file.You can set up a password 
for the Administrator. When you assign a password to the Administrator, QuickBooks 
prompts you to log on when you open the company file.

The QuickBooks Administrator has unlimited access to the entire company file and is the 
only person who can add additional users and change access privileges. For each user he or 
she sets up, the Administrator designates:

� A password. The password can contain up to 16 letters and numbers and is not case 
sensitive. The user can change the password later, but the Administrator will still be 
able to make changes to the user’s access privileges and can assign the user a new 
password, if necessary.

� Full access, selective access, or no access to each area of QuickBooks.

Setting up and customizing users

After you’ve set up the Administrator, you can add new users. Use the New User Setup 
Wizard to select the parts of QuickBooks you want the new user to use.

� From the Company menu, choose Set up Users.

You can set up as many users as you want. However, only five users can access the company 
file simultaneously in QuickBooks Pro or QuickBooks Premier. 

Note: In Windows 2000, using the Users and Passwords control panel, you can set up each of your 
employees with a log-in profile. All the people who will use QuickBooks must be set to Standard 
User (Power Users Group) or higher, not Restricted User (Users Group). Otherwise, QuickBooks 
will not run properly.

Do not forget the Administrator’s password. Once you’ve decided on a 
password for the Administrator, write it down and store it in a safe place.

An Administrator’s password, if forgotten, cannot be recovered. If you forget this pass-
word, you’ll have to send your company file to Intuit (there is a fee associated with this 
service). 
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When the Wizard finishes, a summary screen for all your users appears:

Using permissions to close an accounting period

Unlike most other accounting systems, QuickBooks does not require you to “close the 
books” at the end of an accounting period. Closing books is often a complicated process 
that involves transferring information from one ledger to another and summarizing it. You 
can ask QuickBooks for reports at any time, not just at the end of a period.

However, you may want to restrict access to the transactions of prior accounting periods to 
be sure the transactions are not changed without your knowledge. By requiring permission 
to delete, add, or edit any transaction before a chosen date, you can discourage accidental 
or casual changes to “closed” periods, but still make corrections in them when necessary. 
For example, you may want to prevent your staff from making changes to old transactions 
after you‘ve paid the GST or PST liabilities for them.

You can grant or deny access to older 
transactions when you set up a user. To 
deny users access to “closed” periods, do 
not grant them permission to Change or 
Delete Transactions recorded before the 
closing date. 

To learn about… Search the Help index for…

The different access areas of 
QuickBooks

passwords, access areas

The role of the QuickBooks 
Administrator

admin

Setting up users with passwords 
and access

users, adding

Changing passwords passwords, changing

Deleting passwords passwords, deleting
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Then enter the closing date in the User List window (from the Company menu, select Set 
Up Users).

Recording who changed what

QuickBooks can record all changes made to transactions and the name of the user who 
made the changes. Then you can review the changes in the Audit Trail report.

To keep an ongoing record of changes to transactions, you must make sure the audit trail is 
turned on and keep it on. If the preference is turned off for a period of time, QuickBooks 
does not keep a record of changes, if any, to the transactions in that period.

If your computer is older or you make a lot of changes to existing transactions, QuickBooks 
may slow down slightly when the Audit Trail is on. Also, the size of your company file may 
increase more rapidly than it has in the past.

To learn about… Search the Help index for…

Using permissions to “close” 
your books

closing periods

Choose the date 
range you want to 
see on the report.The “Current 

Transaction” 
entry shows 
what the 
transaction is 
like now; the 
“Previous 
Transaction” 
shows what it 
was like before 
the change.

You can also 
see who made 
the change and 
when.

If you report financial information to the Québec Minister of Revenue (MRQ), 
we strongly recommend that you turn on the Audit Trail feature permanently.

Doing so helps you comply with legislation from the MRQ.The legislation states that 
your accounting software cannot allow you to modify or delete data without keeping a 
record of the original data.

To turn on the Audit Trail permanently, install QuickBooks according to the instructions 
on page 3. Then, when you start QuickBooks, click Yes when QuickBooks asks if you 
report any information to the MRQ.
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These changes occur because instead of writing over transactions you change, QuickBooks 
records both the original transaction and all changes to it. However, for most users, the 
performance of QuickBooks should not change.

Gathering income tax information

How QuickBooks tracks tax information

As you set up your company in QuickBooks, you select which tax form your business uses:

� The T1 General form, for individuals, unincorporated businesses, and partnerships; or

� The T2 form, for incorporated businesses.

Later, you choose the type of industry your business falls into. When you do, QuickBooks 
sets up a suggested Chart of Accounts for your company and maps the accounts in it to the 
most appropriate lines of your tax form.

To learn about… Search the Help index for…

Using the audit trail feature audit trail

You are responsible for consulting a tax advisor or the Canada Customs and 
Revenue Agency about your tax circumstances.

Tax laws change often, and their application can vary based on the specific facts of your 
business. This information is not intended to be exhaustive.

If you change your tax form (for example, from T1 to T2), all the mapping 
between your accounts and tax lines is lost.

You’ll need to reassign the appropriate tax lines to your accounts. It’s best to select the 
correct form as you set up your company.

You can select a tax form either in the EasyStep 
Interview (as you set up your company) or in the 
Company Information window (from the 
Company menu, choose Company Information).

It’s important to select the correct tax form for 
your business as you set it up in QuickBooks — 
changing it later can be very time consuming.
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QuickBooks uses CCRA standards to map the accounts in your Chart of Accounts to the best 
tax line on your return. If you select the T2 tax form, QuickBooks uses the General Index of 
Financial Information (GIFI). GIFI is a “standardized” financial statement that allows the 
CCRA to compare industries more easily. It simply classifies the accounts you use (and that 
you list on the financial statement you file along with your tax return each year — usually, 
a balance sheet, a statement of retained earnings, and an income statement).

You may have noticed that, as you choose an industry type 
for your business in the EasyStep Interview, QuickBooks 
lists “GIFI for Small Business Corp.” as an option. If you 
choose it, your business’ Chart of Accounts will contain 
most of the GIFI accounts that the CCRA specifies, and you 
can delete the ones you don’t need. However, no matter 
what type of industry you choose in the EasyStep Interview, QuickBooks uses GIFI to match 
the accounts for that industry to your T2 tax form.

As you create new accounts, you must manually map them to the correct tax line. 
Otherwise, your income tax data will not be correct. If you are unsure about what tax 
line you should map an account to, consult a tax professional or the CCRA for advice.

As well as letting you export tax data to Intuit Canada’s tax products, mapping your 
accounts properly lets you generate accurate tax reports, which keep you informed about 
your tax situation and help you prepare your income taxes.

After your accounts are mapped to the correct tax lines, QuickBooks tracks tax-related 
transactions as you enter them. At any time, you can create reports and financial statements 
that show your company’s tax status and meet the requirements of the CCRA.

The choices that appear in the Tax 
Line menu as you edit an account 
depend on which tax form you 
select for your company.

To learn about… Search the Help index for…

Setting up accounts to track tax-
related income and expenses

income taxes, setting up for
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What QuickBooks can track for you

QuickBooks can track information for various tax forms and schedules:

Setting up income tax tracking

Use this checklist to make sure income tax tracking is set up properly. You may have set up 
some parts of income tax tracking when you created your company, but not others.

QuickBooks tracks Output created

Income tax information, including infor-
mation for the T1 General, T2 for Incorpo-
rated Businesses, Schedule 3, Schedule 
4, T777, T2124, T2124C, T2032, T2042, 
T2121, Rental, and Medical Expenses.
This list is not exhaustive. Your options 
will vary depending on your business.

A report detailing the amounts to be 
recorded on each line of the tax form you 
chose when you set up your company.
Much of this information can also be 
imported into QuickTax® and ProFileTM.

Task Comments
Search in the 
Help Index for...

�

Check that the first month 
of your company’s income 
tax year is set properly.

Likely, you or your accountant will 
have determined the best income tax 
year for your business before you set 
up your company in QuickBooks. If 
you are not sure what your tax year 
is, check last year’s return.
You can use either the calendar year 
or a fiscal year as your income tax 
year, but you must be consistent from 
year to year.

company, changing 
information about ❏

Check that the income tax 
form for your company is 
set properly:
� Use the T1 for individu-

als, unincorporated 
businesses, and partner-
ships.

� Use the T2 for incorpo-
rated businesses.

Important: If you change the tax form 
you use, all associations between 
accounts and tax lines are reset to 
<unassigned>. You’ll need to reas-
sign the appropriate tax line to each 
of your accounts.

� company, changing 
the tax form you file

� accounts, tax lines

❏

Choose a tax line for each 
account in your Chart of 
Accounts.

You may want to add or edit your 
accounts to more closely match your 
tax forms.

� accounts, tax lines
� accounts, adding to 

your chart of accounts

❏
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Reporting income tax information

 Once you’ve assigned tax lines to your accounts, QuickBooks tracks tax-related income and 
expenses automatically throughout the year. To check your business’ tax situation at any 
time, use QuickBooks’ income tax reports. These reports show your accounts, the tax lines 
you’ve associated with them, and the amount to be recorded on your tax form, and can be 
printed for later reference.

Use the Report Finder (under the Reports menu) to create income tax reports. In the Report 
Finder, select Accountant and Taxes from the drop-down menu, then choose the income tax 
report you want from the list. Remember that the “To” and “From” dates must cover your 
last income tax year correctly!

To make completing your income tax return even simpler, you can transfer your tax 
information from QuickBooks to one of Intuit Canada’s tax products (see “Transferring tax 
information to Intuit tax products” on page 141).

Getting the numbers you need to file your income 
taxes

Whether you fill out your income tax forms by hand, pass your company’s tax information 
on to your accountant, or transfer your tax data from QuickBooks to one of Intuit Canada’s 
tax products, complete the following steps to make sure your numbers are correct.

� Check the tax line assignments for your accounts. The accuracy of your tax reports 
depends on each tax-related account being assigned to the correct tax line (see “How 
QuickBooks tracks tax information” on page 137).

An easy way to check that all your accounts are assigned to the proper tax lines is to 
create an Income Tax Preparation report. It lists the accounts in your Chart of Accounts 
and which tax lines are assigned to them.

Check your tax situation 
with income tax reports 
and transfer your tax data 
to QuickTax.

For more information on 
this step, see “Reporting 
income tax information” 
(following).

Create an Income Tax Detail or 
Income Tax Summary report (see 
“Reporting income tax information” 
on page 140). Be sure that the “To” 
and “From” dates cover your last 
income tax year correctly.

Follow the instructions that came 
with QuickTax to import data from 
QuickBooks. 
(Note that QuickTax imports data 
from the last company file you 
opened with QuickBooks.)

� report finder
� QuickTax ❏

Task Comments
Search in the 
Help Index for...

�
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� Check that the amounts in your Income Tax Summary report are correct.

One way to check is to compare your Income Tax Summary report to your Trial Balance 
(make sure they cover the same period of time!). Check that the account totals (Trial 
Balance) are the same as the matching tax line totals (Income Tax Summary report). If 
they’re not, an account may not be mapped properly to a tax line. (Remember, too, that 
you may have more than one account mapped to a tax line. If so, the sum of the 
account totals should be the same as the tax line total.)

Income Tax Summary report

The Income Tax Summary report shows the amount associated with each tax line for the 
tax form you specified during setup.

Income Tax Detail report

The Income Tax Detail report shows the amount associated with each tax line for the tax 
form you specified during setup, and includes individual transactions.

Many businesses find this level of detail is the most convenient for filling out income tax 
forms.

Income Tax Preparation report

The Income Tax Preparation report shows the accounts in your Chart of Accounts and 
which tax lines are assigned to them.

Transferring tax information to Intuit tax products

If you use a current version of QuickTax or another Intuit tax product to prepare your tax 
return, you can transfer your tax data from QuickBooks directly into it in a few minutes.

Note: QuickBooks 2004 only exports information to Intuit tax products. For more information about 
these products, visit http://www.intuit.com/canada/ or http://www.QuickenStore.ca/

To learn about… Search the Help index for…

Checking tax line assignments to 
ensure the accuracy of your 
income tax summary report

income taxes, filling out tax forms

Checking the amounts distributed 
to various accounts

income taxes, filling out tax forms

Make sure the reporting preference is set to the accounting method you use 
for tax reporting: Accrual or Cash.

From the Edit menu, choose Preferences, then Reports & Graphs, and then click the 
Company Preferences tab. 
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Your Intuit Canada tax product will have instructions on transferring information from 
QuickBooks. It will import data from the last company file you opened with QuickBooks.

Solving printing problems
If you’re having trouble printing, try checking these areas before you call technical support. 
You can also visit http://www.quickbooks.ca/ for information about specific printers.

When should I reinstall my printer driver?

If your printer has any of these problems, you may have to reinstall your printer driver in 
Microsoft® Windows or contact the printer’s manufacturer for assistance:

� Your printer isn’t printing at all, from any program.

� Your printer prints “garbage” from any program.

� Your printer won’t feed paper correctly.

Nothing happens when you try to print

There are several things you can try:

� Make sure the printer is turned on and is online.

� Try printing from another application to verify that Windows can still communicate 
with the printer.

� Check for stalled printing jobs on your printer:

a From the Start menu, select Settings, then Printers.

b In the list, double-click the printer you’re using. 

c Select the stalled print job in the list.

d From the Document menu, select Cancel.

To learn about… Search the Help index for…

Transferring tax information from 
QuickBooks to your tax software

� QuickTax
� ProFile
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The form is clipped on the top, bottom, left, or right

Likely, you only need to adjust the form’s margins and alignment. However, some printers 
can’t print the entire width needed for the standard forms that come with QuickBooks. In 
this case, you’ll need to customize the form in QuickBooks to have larger margins.

To adjust the margins for forms:
1 In QuickBooks, from the File menu, choose Printer Setup.

2 Choose the form you want from the Form Name drop-down list.

3 Click the Margins tab.

� If there is no Margin tab, you need to adjust the form’s alignment instead. See “To 
adjust the alignment of forms:” on page 143.

4 Set the margin you want in the Left, Right, Top, and Bottom fields.

QuickBooks displays the margins in inches, but you can enter margin sizes in inches 
(in), millimetres (mm), centimetres (cm), points (pt), or picas (pi).

If you find that QuickBooks leaves larger margins than you entered, your printer may 
be unable to print outside a specific area. Most printers cannot print with margins 
smaller than .25 inches. Many require margins no smaller than .5 or .67 inches. Check 
your printer manual or contact the printer manufacturer if you have such a problem.

If you’re using a continuous printer, you may have to slide the paper clamps over to get 
the printer to start at the position you want.

5 Click OK to save the changes.

To adjust the alignment of forms:

Coarse alignments:

This adjustment is only needed for continuous-feed (dot matrix) printers. Use it when the 
printing on your forms is off vertically by more than a line or two.

1 Make sure your printer is turned on and is online, with blanks of the forms you want 
to print inserted to the printer’s paper feeder.

2 From the File menu, choose Printer Setup.

3 Choose the form you want from the Form Name drop-down list.

4 Click Align. (If the Align button is not available, that form cannot be aligned.)

5 If a list of templates appears, select the one you want and click OK.

QuickBooks displays a window where you can choose coarse or fine adjustments.

6 Click Coarse.

7 Click OK to print a sample form.

8 Look at the pointer line that QuickBooks prints across the middle of the sample form. 
Determine the number that it points to. Do not adjust your printer at this time.
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9 Type the number in the Pointer Line Position field in the window that appears, then 
click OK.

If necessary, QuickBooks advances the paper in the printer to correct the alignment, 
and then prints another sample.

10 Note the correct position of the form for future positioning.

Visually line up part of your printer, such as the sprocket cover or print head, with one 
of the position numbers along the edge of the form. Make a note of this spot, so you 
can use it in the future as an alignment cue to position your forms visually.

Even if your printer has an “autoload” or “park” feature (the printer puts the paper in 
the same place each time you load it), you need to manually line up your forms for 
coarse alignment using a visual cue. QuickBooks cannot remember placement relative 
to your printer’s autoload point.

11 (Optional) In the Align window, click Fine to make further adjustments, then go on to 
Step 5 of the Fine-alignment process (below).

Fine-alignment adjustments:

This method of adjustment is available for all type of printers.

1 Make sure your printer is turned on and is online, with blanks of the forms you want 
to print inserted to the printer’s paper feeder.

2 From the File menu, choose Printer Setup.

If the text does not 
line up properly on 
the form, determine 
the closest number 
to the pointer line, 
rounding up. 

In this example, 
you’d enter 81.
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3 Choose the form you want from the Form Name drop-down list.

4 Click Align. (If the Align button is not available, that form cannot be aligned.)

5 If a list of templates appears, select the one you want and click OK.

6 If you are using a continuous-feed (dot-matrix) printer, QuickBooks displays a window 
where you can choose coarse or fine adjustments. Click Fine.

7 Click Print Sample.

QuickBooks prints the form with a small alignment grid (1/10 inch squares) on it.

8 Check the horizontal and vertical alignment of the text in the alignment grid.

9 Enter amounts in the Vertical and Horizontal fields to move the printed text to align 
it. (The alignment values are in hundredths of an inch. For example, 25 means 0.25 of 
an inch.)

� For continuous-feed printers, if the printing is off to the left or right by a large 
amount, move the form over in the printer to correct the problem. Use the Fine 
Alignment window for changes of less than 0.25 inch only.

10 Click Print Sample to see if the form is now aligned correctly.

11 When you are finished making adjustments, click OK.

QuickBooks saves the horizontal and vertical alignment adjustments.

12 Click OK in the Printer Setup window.

Problem Solution

The text prints too 
high.

Decrease the number in the Vertical field. For example, if the 
text is printing 2 squares (that is, 0.2”) too high, type -20 in the 
Vertical field.

The text prints too 
low.

Increase the number in the Vertical field. For example, if the text 
is printing 1 1/2 squares (that is, 0.15”) too low, type 15 in the 
Vertical field. 

The text prints too 
far to the left.

Increase the number in the Horizontal field. For example, if the 
text is printing a 1/2 square (that is, 0.05”) too far to the left, type 
5 in the Horizontal field.

The text prints too 
far to the right.

Decrease the number in the Horizontal field. For example, if the 
text is printing 1 square (that is, 0.1”) too far to the right, type -10 
in the Horizontal field.
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Dates and the bottoms of letters are clipped on forms

The font you‘re using may be too large. In the Printer Setup window, click Font. Try a font 
size of 10 points or less.

Changing fonts
1 From the File menu, choose Printer Setup.

2 Choose the form you want from the Form Name drop-down list.

Note: You can’t change the fonts on some forms here. You can change the fonts on these forms by 
selecting Templates on the forms and customizing them.

3 Click the Fonts tab and then the Font button.

4 Choose the font you want.

Note: Not all options are available for all fonts.

5 Click OK in the Select Font window and the Printer Setup window to save the changes.

Printing is slow

There are several things you can try:

� Lower the print resolution for your laser printer: In the Settings tab of the QuickBooks 
Printer Setup window, click Options. Then click the Graphics tab and set a smaller 
number of dots per inch. 

� If you’re printing on blank paper or letterhead, do not choose to print lines around 
each field. In the Settings tab of the QuickBooks Printer Setup window, clear the Print 
Lines checkbox.

� Make more computer memory (RAM) available by closing down programs you don’t 
need.

You can change to italic, bold, 
or a combination.

Choose a point size. Most 
people prefer a size between 9 
and 12 points. 

A description for the selected 
font type appears here.

Choose the font.

You can see what the font 
looks like here. 

Select one or both of these 
checkboxes to strikeout 
and underline text.

Choose a colour (not 
available for cheques).
If you have a colour 
printer, you can print 
any other form in colour.
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There are several types of sales tax in Canada: the 

Goods and Services Tax (GST), the Harmonized Sales 

Tax (HST), and provincial sales taxes. The sales tax 

feature of QuickBooks handles all of these. It helps 

you determine how much sales tax to collect on the 

sales you make, how to record the sales tax you pay 

on business purchases, and how to pay what you owe 

when it is due. Chapter 5

You are responsible for consulting a tax advisor about the sales taxes 
that apply to your business.

For information about the GST and HST, contact the CCRA. For information 
about your provincial sales taxes, contact your provincial Minister of Finance.

Tracking and 
paying sales 
taxes

How to collect 
and pay the right 
amount of GST 
and PST

Does your 
business need to 
be registered?

148

Setting up sales 
taxes

149

Determining your 
sales tax 
liabilities

154

Remitting your 
tax liability to the 
government

154

Locking older 
transactions 
after paying your 
GST/PST 
liabilities

156
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Does your business need to be registered?
Although very small businesses are exempt, the Canada Customs and Revenue Agency 
(CCRA) recommends that all businesses register to collect the Goods and Services Tax (GST) 
or, in provinces where the provincial sales tax has been combined with the GST, the 
Harmonized Sales Tax (HST).

Registered businesses track the GST or HST collected from customers on sales and paid on 
purchases for the business. Usually, you collect more sales tax than you pay out and must 
remit the difference to the CCRA. (Occasionally, you may pay out more than you collect 
and claim a refund.)

Many provincial governments also require you to register to collect a provincial sales tax 
(PST or, in Québec, QST). In most provinces, for provincial sales taxes, you track only the 
amount you collect (instead of the amount you collect and the amount you pay) and remit 
that amount to the government.

In Québec; however, the QST works much the same way as the GST: businesses may be able 
to deduct the amount of QST paid on business-related purchases from the amount of QST 
collected from customers, then remit the difference.

Check with the CCRA, your province’s Ministry of Finance, or your accountant about how 
your business should handle federal and provincial sales taxes.

How QuickBooks calculates the GST and PST

QuickBooks uses your company address to determine what rates of GST and PST apply in 
your province and assigns these rates to default sales tax codes.

It then calculates the GST and PST separately for each item on sales or purchase forms 
according to the sales tax code you assign to it. QuickBooks displays the GST and PST totals 
in boxes at the bottom of the form, then adds these amounts to the total. The HST is 
calculated as one rate in the GST field.

Tax amounts are tracked in your GST Payable and PST Payable liability accounts. When you 
make a sale, QuickBooks records the GST on the transaction as an increase in your GST 
liability because you must remit the amount of tax to the government. When you make a 
purchase, the GST on the transaction is a decrease in your GST liability because you can 
claim the expense as an input tax credit.

Similarly, the PST on sales is recorded as an increase in your PST liability. However, whether 
you record the PST you pay on purchases as a decrease in your PST liability depends on 
whether your provincial government allows you to claim input tax credits for it.

At regular intervals, you must file GST and PST returns and create cheques to remit the 
amount you owe to the federal and provincial governments. As your business grows, you 
have to file GST/PST returns more often. Once a sales tax entry is included on a GST or PST 
return that you’ve filed, it is marked as reported. If you enter a transaction from a previous 
reporting period after you’ve already sent your return, it will automatically be included in 
the next return you send.
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Setting up sales taxes

Turning on the sales tax 
1 From the Edit menu, select Preferences.

2 Select GST/PST from the scroll box, then click the Company Preferences tab.

3 Set the preferences according to your business needs, then click OK.

Federal and provincial sales tax preferences

One of QuickBooks’ very useful features is its ability to track the GST (or HST) and your 
province’s sales tax, if it has one. After you turn on sales tax tracking, QuickBooks 
automatically applies the correct taxes to sales and purchases and records the tax in the 
appropriate accounts.

In QuickBooks, it’s possible to assign a tax code to a customer that will override the tax 
codes you assign to the items or services you sell. For example, if you sell to a branch of the 
government that is exempt from all sales taxes, you can assign it an “E” (for exempt) tax 
code. The “E” tax code then appears on all invoices you create for this customer, for all the 
items it buys, instead of the tax codes you assigned to the items or services you sell.

If your province 
uses the 
Harmonized 
Sales Tax (HST), 
only track the 
GST. You do not 
need to track 
PST as well.

You can enter the 
business numbers 
that are assigned 
to you by the CCRA 
and your 
provincial Minister 
of Finance here.

If you have 
customers with 
special tax 
status, check 
this box. You 
will then be able 
to assign a tax 
code to his or her customer profile. On sales forms, the tax 
code you assign to customers overrides the tax codes you 
assign to items.

This code is 
assigned to all 
new items by 
default.

If you use sales tax tracking, after completing the Interview, turn to 
“Tracking and paying sales taxes” on page 147 for important information 
about using this feature.
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If you have customers who have special tax status, you can turn on customer tax codes. 
Then you can assign each customer a tax code as you set him or her up. If you have many 
customers who have the same special tax status, you can set a default tax code that applies 
to all new customers you create. However, except for this specific case, it’s usually best to 
leave this option off.

Should I track my provincial sales tax separately?

When you buy an item for your business, in most provinces, you are either exempt from 
paying the PST on it if the item is to resell or else you cannot claim the PST you paid on it 
as an input tax credit (unlike the GST). That means that, for accounting purposes, you can 
consider the PST on an item you buy as part of its cost and not bother tracking it separately.

However, if you can claim back the PST you pay on items for your business (as in Québec) 
or want to record the amount of PST you pay for your own information, you can track the 
PST separately. In the first case, the PST you pay is assigned to your PST Payable account to 
reduce your PST liability to the government; in the second case, the PST you pay is assigned 
to a PST expense account for your information only.

Entering sales tax liabilities as of your start date

If your business collected the GST or your provincial sales tax before you began using 
QuickBooks, you need to enter the amount you owe the government for each tax (that is, 
your sales tax liabilities) as of your QuickBooks start date.

1 From the Vendors menu, select Sales Tax, then choose Adjust Sales Tax Due. The Sales 
Tax Adjustment window appears.

2 In the date field, type your QuickBooks start date or click  to select it from the Quick-
Books calendar.

3 (Optional) You can keep track of this adjustment by entering a number in the Entry 
No. field.

4 Select the vendor (government agency) that you are adjusting for, from the Sales Tax 
Vendor list.

5 Select whether this is a tax transaction on items bought or items sold.

6 Enter the Adjustment Amount:

� If you owe sales tax, enter the amount as a negative number. Your Sales Tax 
Account (for example, GST Payable) will record the amount under the Increase 
column.

� If you’re entitled to a refund, enter the amount as a positive number. Your Sales 
Tax Account (for example, GST Payable) will record the amount under the 
Decrease column.

7 Select Opening Bal Equity from the Adjustment Account drop-down list.

8 (Optional) 

9 Click OK.
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Changing the default tax codes

In rare cases, you may need to adjust the default sales taxes that QuickBooks sets up. 
For example, if your province charges an increased amount of sales tax on an item your 
business sells, you may want to set up a new sales tax code for the higher rate.

To create a new tax code:
1 From the Lists menu, choose Tax Codes List.

2 Click the Tax Code menu button, then choose New.

3 Fill in the information for your new tax code.

4  Click OK.

A check mark in this column means 
that the PST is calculated on the 
sale price after the GST has been 
added to it (“piggybacked on the 
GST”). 

If the column is clear, the PST is 
calculated on the sale price 
independently of the GST.

Enter the GST 
and PST 
percentages for 
this tax code.

Enter a unique 
letter or number 
to identify this 
tax code and a 
description.

If the PST is to be calculated “on top of” the GST (that is, the GST is calculated 
on the sale, added to the total, and the PST is then calculated on this new 
total), select the Calculate Provincial Tax on GST (Piggyback) checkbox.

If either the GST or PST does not apply 
to a new tax code you’re setting up, 
select its Tax Exempt box.

Note that selecting this box is not the 
same as leaving the percentage at 
zero. (See “What the Zero Rated (Z) tax 
code is for” following.)
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What the Zero Rated (Z) tax code is for

Under the GST, certain goods and services are taxed at a rate of 0% instead of the usual 7%. 
These items are called Zero Rated.

(To see whether the items you sell are Zero Rated, you should check with the CCRA or your 
accountant. Some examples are basic groceries such as milk, bread, and vegetables; 
agricultural products such as grain, raw wool, and fish for human consumption; 
prescription drugs and medical devices; and items manufactured for export.)

Note: Zero Rated items are not tax exempt, and should not be assigned the Exempt tax code (E).

If you sell a Zero Rated item, you charge your customers 0% GST on it. This means that you 
do not collect any GST to remit to the government. However, because the item is taxable, 
you can claim input tax credits (the GST you paid on the materials you needed to produce 
the item) for it. When you file your GST return, you receive a refund based on these credits.

Assigning tax codes to items

To let QuickBooks know how to tax the items or services you sell and purchase for your 
business, assign each a tax code as you set it up in the Item List.

Once you have done so, QuickBooks applies the correct sales taxes to them on sales and 
purchase forms. (If you are unsure of what taxes apply to your business, check with the 
CCRA, your provincial Ministry of Finance, or your accountant.)

Assigning tax codes to customers 

If you have regular customers who have special tax status (for example, who are exempt 
from paying the GST or PST), you can assign them customer tax codes that override item 
sales tax codes on all forms.

First, ensure the Allow customer tax codes is selected in the GST/PST preferences. Then you 
can add the tax code to the customers’ profile in the Customer:Job list.

To learn about… Search the Help index for…

Assigning tax codes to items items, assigning tax codes to

To learn about… Search the Help index for…

Turning on the Customer Tax 
Codes 

tax codes, turning on

Setting up customers customers, adding new
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Using tax codes on sales and purchases

Once you have assigned tax codes to the items you sell and buy and assigned customer tax 
codes to customers with special tax status, QuickBooks automatically applies the correct 
taxes as you fill in forms. The tax code appears to the right of the Amount column and the 
amount of tax above the total.

If you need to apply a different tax code to an item, you can change the item’s tax code 
from the form. In the rare event that you need to adjust the amount of tax on a transaction 
manually, adjust the amount directly in the GST or PST box.

The tax code that is being applied to this item 
is shown in the TAX column. QuickBooks gets 
this tax code from the Item List where you 
assign a default tax code to items. 

These fields can be edited, 
so you can manually 
change the amount of tax 
that QuickBooks calculates 
for you.

If you need to create a 
new tax code, you can do 
so from the Tax Codes 
List under the Lists menu.

To learn about… Search the Help index for…

Using a tax code on a form tax codes, changing on forms
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Determining your sales tax liabilities
If you collect sales tax from customers, you also have to make periodic payments of it to the 
government. You can check what your sales tax liability is to the CCRA and your provincial 
Ministry of Finance by creating GST and PST Liability reports.

Creating GST and PST Liability reports

These reports provide complete information about the sales tax your company has collected 
on sales, paid out on business-related purchases (where applicable), and owes to (or will be 
reimbursed from) the government for a particular period.

The CCRA requires businesses to report the GST on an accrual basis, so the GST Liability 
Report isn’t affected if you change your accounting basis to Cash in the Reports and Graphs 
preferences window.

You create GST and PST Liability reports the same way. Provinces that use the HST only 
need to create GST reports as their provincial sales tax is included in it.

� From the Reports menu, choose Vendors & Payables, then GST Liability or PST Liability. 
Make sure the date accurately reflect the end of the reporting period.

This report includes the following information for the Goods and Services Tax Return you 
file at regular intervals:

� Total sales and other revenue not including GST or PST (Line 101: Sales & Other 
Revenue).

� Total purchases, which is subtracted from Sales & Other Revenue to calculate your Net 
Sales.

� Total GST collected and collectible on sales (Line 103: GST Collected and Collectible).

Canada Customs and Revenue considers invoices due on the date you issue them. So, 
for any given reporting period, unpaid invoices with GST must still be included in the 
GST “collected and collectible” for that period.

� Total input tax credits (Line 106: Input tax credits).

Remitting your tax liability to the government

Use the File Sales Tax function to create cheques for the sales tax you’ve collected, which 
you can then print and send in to the CCRA or your provincial Minister of Finance, along 
with your return.

You must file a return for each reporting period, even if you do not owe money or expect a 
refund. For reporting periods with no business transactions, file a nil return.

1 From the Vendors menu, choose Sales Tax, then File Sales Tax.

QuickBooks displays the File Sales Tax window.

2 Select which tax agencies (Vendors) to pay, by clicking in the Pay column.
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Note: The Payment Account field shows your chequing account.

To draw the cheque on a different account, just select it from the drop-down menu.

3 If you want QuickBooks to print a cheque, select To be printed. If you are writing a 
cheque by hand, select Assign cheque no.

4 Click Next.

5 QuickBooks displays your tax return. You can make adjustments directly on the form, 
with the exception of lines 103 and 106. To adjust the amounts on these lines, click the 
Adjust button beside the line, then click OK.

6 Click Next.

QuickBooks displays the tax return, after any adjustments, ready for printing.

7 Click Print.

QuickBooks creates and records the cheque to the Receiver General or Minister of 
Finance. You can now print the cheques, by choosing Print Forms from the File menu, 
then choosing Cheques. It also updates your Liability reports and Payable registers to 
show that you’ve made a payment. 

If you receive a Sales Tax refund

You create and file a sales tax return the same way in QuickBooks, regardless of whether you 
have to remit tax or you have a refund due. Either way, you use the File Sales Tax feature, 
as described in the instructions above. Once you’ve created your return with a refund 
owing, QuickBooks enters the refund amount into an invoice, using the preset Receiver 
General - Receivable customer item. When you receive the refund, enter the amount as a 
payment received against this invoice.

Note: If the preset Receiver General - Receivable customer item does not appear in the Customer:Job 
dropdown list, it may be set to "inactive".

To make an inactive item active:
1 On the Customers menu, select Customer:Job List.

2 At the bottom of the Customer:Job List window, select Show All.

3 Find the Receiver General - Receivable entry.

4 To the left of the entry, click the . The entry is no longer inactive.
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Adjusting your GST Payable or PST Payable account

From time to time, you may need to make adjustments to your GST Payable or PST Payable 
account, either increasing or decreasing the amount you must remit. 

These adjustments may include writing off the GST amount of a bad debt. For example:

Taxable items on invoice $200.00
GST due 14.00
PST due 18.00
Total $232.00
GST reported in the 4/1/2002 - 6/30/2002 reporting period
PST reported in the 4/1/2002 - 6/30/2002 reporting period
No payment received on invoice in 2002
Write off bad debt in 2002
Claim a GST adjustment of 7/107 x $214 = $14
Claim a PST adjustment of 7/107 x $218 = $18 

To adjust your GST Payable or PST Payable account:
1 From the Vendors menu, choose Sales Tax, then choose Adjust Sales Tax Due.

2 Type the transaction date and an entry number.

3 In the detail area, verify the GST Payable or PST Payable account.

4 Continue by entering the appropriate account, such as Bad Debt and enter the 
adjustment amount. Select Tax

If you don’t have a Bad Debt account, you can add one as you go. Choose Expense or 
Other Expense for its account type.

5 (Optional) Type a memo for this transaction.

6 Click OK.

Locking older transactions after paying your GST/PST liabilities

After you’ve paid your GST and PST liabilities for a given period, you won’t want your 
employees to change any of the transactions that affected your payment. QuickBooks lets 
you restrict access to these older transactions to be sure they are not changed without your 
knowledge. By requiring permission to delete, add, or edit transactions before a chosen 
date, you can discourage changes to these “closed” accounting periods, but still make 
corrections when necessary.

To deny users access to “closed” periods, when you set up user names and passwords for 
your staff, do not grant them permission to Change or Delete Transactions recorded before 
your closing date. Then enter a closing date that is later than the date of your payment. For 
more information about setting up user names and passwords, see “Setting up users and 
passwords” on page 133.
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To lock older transactions after paying sales tax liabilities:
1 To set up or edit user names for your staff, from the Company menu, select Set Up 

Users.

2 Do one of the following:

� Select an existing user name from the list, then click Edit User, or

� Click Add User to create a new user name.

3 If you do not want this user to have access to your historical transactions, give him or 
her access only to “Selected areas of QuickBooks” when the wizard prompts you.

4 Work through the wizard until you reach the Changing or Deleting Transactions 
screen.

5 Select No to the question, “Should this user also have the ability to change or delete 
transactions that were recorded before the closing date?”

6 Work through the rest of the wizard for this user, then any other users in your user list 
or that you are adding.

7 At the bottom of the user list, click Closing Date.

� If you closed the user list, from the Company menu, select Set Up Users.

8 Type the date up to which your books are closed, then click OK.

9 Click Close to close the user list.

To learn about… Search the Help index for…

Using permissions to “close” 
your books

closing, books
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Sales tax tracking

Unfiled transactions

QuickBooks has improved the way sales tax is reported. Previously, in order to prepare a 
sales tax return, you needed to generate a GST/PST Summary report. Now, QuickBooks 
automatically calculates the due or refundable tax and generates a tax return based on these 
amounts. The due or refundable sales tax is calculated based on unfiled transactions. All un 
filed transactions will now be included in the current period’s tax return. 

Updating from versions previous to QuickBooks 2004

If you previously had unfiled sales tax transactions, QuickBooks will now correctly calculate 
the amount of tax that is due or refundable for the next reporting period. Before you install 
QuickBooks 2004, you’ll need to know the ending dates of your GST/HST return and/or 
your PST/QST return you last filed.

Not sure what the ending date is? If today were February 15, 2004 and the last return that 
was filed for GST/HST was for the period October 1, 2003 to December 31, 2003, then the 
ending date of your last filed GST/HST return would be December 31, 2003.

What will happen to unfiled entries?

QuickBooks takes the ending date you enter and marks all entries as filed that were made 
on or before that date. Then when you need to file your sales tax return for the current 
period, open the Files Sales Tax window to see a summary of all entries to the sales tax 
accounts that haven’t yet been filed. This prevents any missed entries in your sales tax 
returns.

To view the filing status of the entries by looking in the register of the sales tax account. 
Filed transactions are marked with an ’F’.

Uncategorized transactions

Previously, amounts could appear as uncategorized in GST/PST reports and in the File Sales 
Tax window. QuickBooks labelled some transactions as uncategorized because some forms 
were used for purposes other than what they were originally created. For example, the Make 
Deposits window was used to enter a cash sale instead of using a sales receipt. This type of 
transaction entry would result in an uncategorized amount.

Now, QuickBooks categorizes all transactions affecting your sales tax liability account. This 
means:

� you’ll no longer have to manually categorize these types of transactions,

� when you generate GST/PST reports, your sales tax liability amount will now be 
accurate, and

� uncategorized amounts will no longer appear in the File Sales Tax window or in your 
GST/PST reports.
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Updating from QuickBooks 2003

If you previously had uncategorized amounts, these transactions will automatically be 
updated when you install QuickBooks 2004. Before you install QuickBooks 2004, you’ll 
need to know the ending dates of your GST/HST return and/or your PST/QST return you 
last filed.

Not sure what the ending date is? If today were February 15, 2004 and the last return that 
was filed for GST/HST was for the period October 1, 2003 to December 31, 2003, then the 
ending date of your last filed GST/HST return would be December 31, 2003.

What will happen to uncategorized amounts?

QuickBooks will take the ending date you enter and marks all uncategorized amounts on or 
before that date as filed so they won’t affect your sales tax liability. Uncategorized amounts 
after the ending date will be categorized as sales or purchases so that they correctly affect 
your sales tax liability account. The next time you file a sales tax return, QuickBooks will 
include these newly categorized transactions properly with all other unfiled-transactions.

If you had uncategorized amounts in earlier versions of QuickBooks and didn’t adjust your 
GST/PST returns for them, consult your accountant to see if you should file an adjustment 
now.



160 Chapter 5   Tracking and paying sales taxes



C h a p t e r  6

161

If you do business outside of Canada, you can set

up QuickBooks to easily handle foreign-currency 

transactions. At the conclusion of this chapter, you’ll 

know how to set up prices in foreign currencies for 

items you sell internationally, enter information for 

foreign customers and vendors, and deal with the 

exchange rates of the foreign currencies you use. 
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Multicurrency: an overview
In QuickBooks Pro or QuickBooks Premier, you can record transactions in currencies other 
than the Canadian dollar. With the multicurrency feature turned on, QuickBooks tracks 
foreign transactions and accounts for them correctly, regardless of the currency you use. For 
example, if you sell goods to the United States, you might enter some transactions in US 
dollars and others in Canadian dollars. Tracking these foreign-currency transactions is as 
easy as selecting the foreign customer or vendor from your customer:job list; QuickBooks 
takes care of everything else.

With multicurrency, you can also set up a fixed foreign price for items, or enter prices in 
your home currency and then have QuickBooks calculate the foreign price based on the 
current exchange rate. See “Set up foreign prices for items” on page 166 for more 
information on setting up foreign prices.

The home currency refers to the currency that is used in the country in which your business 
is located. QuickBooks selects the Canada Dollar as the home currency by default. In 
registers and forms, home-currency transactions are displayed in the home currency, 
whereas foreign transactions are displayed in their foreign currency. On most reports; 
however, foreign balances are converted into the home currency.

Note: Once multicurrency is turned on, you cannot turn it off. We recommend that you make a backup 
of your company’s file before turning multicurrency on. For more information, see “Backing up 
your company data” on page 117.

A note about exchange rates

Exchange rates of currencies change daily, and these fluctuations can generate a gain or loss 
in your books. QuickBooks accounts for these gains and losses by tracking them in the 
Exchange Gain/Loss expense account which is created automatically when multicurrency 
is turned on (see “Exchange rates and how they affect your transactions” on page 169 for 
more information.)

Setting up multicurrency
If you deal in a currency other than the Canadian dollar, you need to turn on the 
multicurrency feature. This feature is turned off by default, as many businesses deal only 
with Canadians using Canadian dollars.

After multicurrency is turned on, you will need to assign a currency to each of the 
customers and vendors with whom you deal on an international basis. Customers and 
vendors that were created before you turned on the multicurrency feature are automatically 
assigned your home currency (by default, "Canada Dollars"). The home currency is used to 
determine the value of all other currencies, and its exchange value is fixed at 1. Once a 
home currency is selected and you have recorded a transaction, it cannot be changed, 
unless you delete the associated transactions and edit the associated customers.
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Each foreign currency you deal in must have a matching Accounts Receivable or Accounts 
Payable account in the same currency. This allows you to track transactions specific to each 
currency that you set up in QuickBooks. You can also set up foreign-currency Bank and 
Credit Card accounts. 

To setup multicurrency, you need to complete these tasks:
1 “Turn on the multicurrency” on page 163.

2 “Set up foreign accounts” on page 164.

3 “Create foreign customers and vendors” on page 165.

4 (Optional) “Set up foreign prices for items” on page 166.

Turn on the multicurrency 

If you invoice, receive payments or pay bills in a currency other than the Canadian Dollar, 
you should turn on the multicurrency feature. You can do so in one of two ways: in the 
EasyStep Interview as you create a new company, or in the Preferences window.

Once multicurrency is turned on, you cannot turn it off. We recommend that you back up 
your company file before turning multicurrency on. That way, you can go back to the way 
your company was, if for some reason you don’t want to use the multicurrency feature 
anymore.

To turn on multicurrency from the Preferences window:
1 From the Edit menu, choose Preferences.

2 From the scroll box on the left, select Accounting.

3 In the Company Preferences tab, select Use multicurrency.

4 Click OK. Multicurrency is now turned on, and the home currency is set to "Canada 
Dollar". 

1
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You can now:

� Assign a foreign currency to a customer and vendor.

� Use a currency list which includes many common currencies and the latest 
exchange rates as of QuickBooks’ release.

� Generate a report to calculate unrealized and realized gains and losses.

� Quickly convert foreign dollars to Canadian dollars or Canadian to foreign dollars 
with the Currency Calculator.

� Use the "Exchange Gain & Loss" expense account to track gains and losses due to 
fluctuations in exchange rates.

� Set a foreign price for items you sell frequently to foreign customers.

� Locate multicurrency transactions with two new filters in the "find" function. 

Set up foreign accounts

You can choose a foreign currency for Bank, Credit Card, Accounts Receivable (A/R) and 
Accounts Payable-type (A/P) accounts.

You do not need to set up foreign Bank and Credit Card accounts to track foreign 
transactions. However, for each foreign currency you deal in, you must create an A/R 
account (if you have customers), an A/P account (if you have vendors), or both in that 
currency. For example, if you have customers in the USA and England, you’ll need two 
additional A/R accounts: one in US Dollars and the other in UK Pounds. You cannot use 
the same A/R and A/P accounts you use for your Canadian-dollar transactions because 
the Canadian dollar and other currencies rarely trade as equals.

Note: Once a transaction is recorded in an account, the account’s currency cannot be changed.

To set up a foreign account:
1 From the Company menu, select Chart of Accounts. The Chart of Accounts appears.

2 On the Chart of Accounts window, click the Account menu button, and choose New.

3 Create an A/R or A/P account for each currency in which you want to deal. See the 
online help for information on how to set up a new account.

When you select a currency, the Exchange field shows its exchange rate. If you want to 
update the exchange rate, do it from the Currency List. See “Using the currency list” on 
page 167 for more information.
 

2

To learn about… Search the Help index for…

Setting up accounts accounts
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Create foreign customers and vendors

After you’ve set up foreign A/R and A/P accounts, you can set up the foreign customers or 
vendors who will be using these accounts. To do so, create the customer or vendor as you 
normally would and choose the correct currency from the drop-down list in his or her 
profile. Once a currency is assigned to a customer or vendor, all future transactions 
involving him or her are recorded in the currency you assigned, with the exception of bill 
and credit card payments (in this situation, the account you use to pay determines the 
currency of the transaction).

Existing customers or vendors (that is, ones you set up before turning on the multicurrency 
feature) are automatically assigned the Canadian-dollar currency. If you want to use a 
different currency for these individuals, you’ll need to create new customer or vendor 
profiles in the correct currency.

Note: Once a transaction has been recorded for a foreign customer or vendor, you cannot change the 
currency assigned to him or her. You cannot assign a foreign currency to the Receiver General 
and Minister of Finance vendors.

To create a new foreign Customer, Vendor, or Other Name:

Open a new profile and fill it in as you normally would with the following exceptions noted 
on the graphic below.

Only one currency can be associated with a Customer, Vendor, or Other Name. If you deal 
with a customer or vendor in more than one currency, you’ll need to create an additional 
customer or vendor profile for each currency in which you do business.

3

2 Select the currency you 
want to associate with 
this profile. If the currency 
you want is not in the 
drop-down list, select 
<Add New> to create a 
new currency. 

Also, if the exchange rate 
is out-of-date, update it.

1 (Optional) Enter an 
opening balance if 
applicable. 

Once a transaction 
is recorded for a 
customer, you 
cannot enter an 
opening balance in 
this window.
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Set up foreign prices for items

By default, items in the Item List are priced in the Canada-dollar currency. What that means 
is when an item is used in a foreign transaction, the price of the item is calculated by 
multiplying the home-currency amount with the foreign currency’s exchange rate. Because 
the price is converted based on an exchange rate, there is a possibility that the price of an 
item may go up or down if the exchange rate changes. 

QuickBooks allows you to set up a fixed foreign price on items you sell frequently to one 
particular country. By doing this, the foreign price of the item will not change due to 
fluctuations in exchange rates. You can only select one other currency besides your home 
currency to assign to item prices.

To turn on foreign pricing:
1 From the Edit menu, choose s.

2 From the scroll box on the left, select Accounting.

3 In the Company s tab, select Use foreign prices on items.

4 From the "Foreign item currency" drop-down list, select the currency you want to use 
as a fixed foreign price on items. If you deal with more than one foreign currency, 
choose the currency you deal in the most.

5 Click OK.

4

Once the foreign pricing is turned 
on...
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Using the currency list

The Currency List is a list of all the currencies that are set up in QuickBooks. We’ve included 
a total of 44 currencies (including Canadian currency) in the Currency List. The list 
contains information about each currency such as its exchange rate, currency symbol, and 
hotkey.

When a foreign transaction is recorded, QuickBooks uses the exchange rate from the 
Currency List to convert the foreign amount into the home-currency amount. You should 
rarely need to make changes to the Currency List, except to add and delete currencies, and 
update exchange rates. You cannot delete your home currency.

To create a currency:
1 From the Lists menu, choose Currency List.

... you’ll see an extra field in the 
New Item window where you can 
enter a fixed foreign price for an 
item.

QuickBooks uses an item’s 
Foreign Price in transactions 
where the currency matches the 
currency that you chose in the 
foreign pricing. 

Inactive currencies are not shown in this list. There are 
more than 40 currencies defined in QuickBooks. To display 
all currencies, click the "Show All" checkbox. 

Hotkeys help you convert foreign 
amounts to your home currency quickly. 

To use them, on any form, select the 
foreign amount you want to convert, 
then type that currency’s hotkey. 
QuickBooks multiplies the foreign 
amount by its exchange rate, which gives 
you the amount in your home currency.
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2 At the bottom of the Currency List, click the Currency menu button and select New. 
The New Currency window appears.

.

3 On the New Currency window, fill in the currency options (at the very least, the 
Currency Name, Country Code, and Country fields must be filled in):

� Currency Name: the name of the currency.

� Country: the country in which the currency is used.

� Currency Code: the internationally-recognized code for the currency.

� Currency Symbol: the symbol (such as $) to represent this currency on forms.

� Hotkey: a unique letter or symbol to use by pressing the key to multiply an 
amount by the currency’s exchange rate.

� Exchange Rate: the value of one unit of the foreign currency in your home 
currency. In order to keep your foreign transactions accurate, you should update 
the exchange rate on a regular basis.

Format options

� Symbol Position: select where you want the currency symbol placed. Your options 
include Leading (in front of the dollar value) or Trailing (behind the dollar value).

� Decimal Separator: enter the symbol you want to use on forms to represent the 
decimal placeholder. The default is a period (.).

� Decimal Places: select the number of decimal places you want to use on forms. 
You can select zero through 2.

� Thousand Separator: enter the symbol you want to use on forms to represent the 
thousand placeholder. The default is a comma (,).

4 Click OK. The new currency is added to the Currency List and is available on forms that 
use it.

 

To learn about… Search the Help index for…

Creating, editing, or deleting a 
currency

� currencies, creating
� currencies, editing

Select this checkbox to make a currency inactive. This hides 
the currency from the list as opposed to deleting it entirely.

Minimizing the Currency List makes it easier to read from 
drop-down lists on forms.
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Using the currency calculator

The currency calculator is a handy way to convert a dollar amount into a foreign currency 
or vice versa.

� From the Company menu, choose Currency Calculator.

Exchange rates and how they affect your 
transactions

The exchange rates provided in QuickBooks Pro or QuickBooks Premier were accurate at the 
time your software was released. However, because currencies fluctuate in value, you should 
update the exchange rates of your currencies often—every week or possibly more 
frequently, depending on the volatility of the currency. (The easiest way to update 
exchange rates is by using the Currency List. See “Using the currency list” on page 167 for 
more information.)

Tip: An exchange rate field also appears on some forms so that you can enter the latest exchange 
rate "on the fly", without having to go to the Currency List. You should (when reconciling your 
chequing accounts, for example) update the exchange rate used for cheques and deposits to 
reflect the actual rate that was used by your bank at the time the cheques were processed or 
your deposits accepted.

It is these changes in exchange rates that can affect the profits you make from foreign sales 
and your costs for foreign purchases. Basically, as a business owner, you want to track the 
potential effect of exchange rate changes on foreign transactions that haven’t been 
completed (referred to as unrealized gains and losses) as well as the actual effect of the 
changes on transactions that have been completed (referred to as realized gains and losses). 
QuickBooks provides a report to help you track both types of gains and losses.

Unrealized gains and losses

When you create a foreign transaction, the foreign currency is worth a certain amount in 
your home currency, which is determined by its exchange rate on the day of the 
transaction. However, the exchange rate likely changes before the transaction is closed. 
Until the transaction closes, the difference between the value of the foreign currency when 
you created the transaction and its current value as of today is your unrealized gain or loss.

1 Type the dollar value you 
want to convert.2 Select the currency of the dollar 

amount you want converted.

3 Select the currency you want 
the dollar amount converted to.

A read-only field that displays 
the result of the conversion.

4 Click here to copy the converted 
amount to the clipboard. Then, 
use the paste command 
(CTRL+V) to paste the amount 
into a field on a form.
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For example, say a customer purchases an item from you for $100 US dollars, which is $130 
CDN at the time you issue the invoice. Before the customer pays you, the Canadian dollar 
falls, and the US dollar exchange rate climbs to 1.5 from 1.3. The $100 US that the customer 
owes you is now worth $150 CDN, so your unrealized gain is $20 CDN. (You won’t know 
how much money in Canadian dollars the customer actually pays you until you receive his 
or her payment and deposit it in a bank. At that point, the bank converts it to Canadian 
currency, and your gain or loss is "realized".)

Many accountants prefer you take your unrealized gains and losses on open foreign 
transactions (invoices and bills) into account when you create reports about your 
company’s net worth, as doing so gives a more accurate picture of the value of your 
company on that date. Check with your accountant to see what he or she recommends.

To determine your unrealized gains and losses and make a home 
currency adjustment:

To ensure your net worth reports show the true value of your foreign currency accounts 
(and therefore your company) at the end of a reporting period, your accountant should 
make a home-currency adjustment in the general journal.

1 Create an "Unrealized Gains and Losses" report:

a From the Reports menu, select Multicurrency, then Unrealized Gain and Loss.

b In the Exchange Gain/Loss window, update the exchange rates for the purpose of 
this report. (Note that doing so does not update the Currency List.)

c Click OK. QuickBooks summarizes open foreign transactions and the potential 
gains or losses on them.

2 Use the information in the report to create a home-currency adjustment in the General 
Journal entry to account for your gain or loss. Select the Exchange Gain/Loss expense 
account as the other account that will be affected by this entry.

In this example, the Unrealized Gains and Losses report shows a currency gain for the 
US A/R account, and a currency loss for the US A/P account. Therefore, the entries in 
the General Journal should be recorded as follows.

Insert picture of an example of a report

On reports, foreign 
amounts are 
displayed in the 
home currency. 

In this example, the 
home currency is 
Canadian; therefore, 
these amounts are in 
Canadian dollars.
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3 Create your net worth reports.

4 Reverse the General Journal entry to remove the unrealized gain or loss from your 
books.

Realized gains and losses

A gain or loss on a foreign transaction because of changes in the exchange rate becomes 
realized once the transaction is either partially paid or paid in full. When you close the 
transaction, QuickBooks compares the value of the foreign amount when the transaction 
began to its value when the transaction closed. QuickBooks enters the difference (gain or 
loss) in the Exchange Gain/Loss account (which is created automatically when 
multicurrency is turned on.)

For example, if you owe a vendor 500 French Francs, and the dollar/franc exchange rate 
changes from 0.25 when you ordered the products to 0.20 when you pay the bill, your 
realized gain is $25 CDN. That is, when you ordered the products, you owed $125 CDN, but 
you actually paid only $100 CDN because the franc fell relative to the Canadian currency. 
QuickBooks balances the transaction by assigning the $25 gain to the Exchange Gain/Loss 
account.

To determine your realized gains and losses over time, use the "Realized Gains and Losses" 
report. This detailed report shows the original amount of each foreign transaction in your 
home currency, the actual exchange rate when the transaction was closed, and the resulting 
gain or loss to you.

Select this checkbox 
to ensure these 
amounts are 
recorded as an 
adjustment to the 
home currency 
without affecting 
the foreign balance 
of that account.

You need to specify a 
customer name when a 
journal transaction is 
entered for an A/R 
account (or vendor name 
for an A/P account). 

When making home-
currency adjustments, 
create a phony customer 
or vendor to which you 
can assign unrealized 
gains & losses.
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To print a realized gains and losses report:
� From the Reports menu, select Multicurrency, then Realized Gain and Loss.

Dealing with foreign customers
QuickBooks handles customers who pay in foreign currencies in much the same way as 
customers who pay in your home currency. You create an invoice and receive payments in 
exactly the same way. The only difference is that the currency you assign to the customer 
in his or her profile becomes the currency of the transaction (see “Create foreign customers 
and vendors” on page 165).

Creating invoices for foreign customers

Before you can create an invoice for a foreign customer, you must set him or her up in the 
customer:job list and create a foreign A/R account. Then you can create an invoice as you 
normally would. As you do, you also need to:

On reports, 
foreign 
balances are 
converted to 
the home 
currency.

The price of the item is 
converted into the customer’s 
currency (US dollars) using the 
exchange rate. In this example, 
the rate for "skiing lessons" is 
$50 Canadian, but when the 
item is added to the invoice, the 
rate is converted to $33.99 US.

If you don’t want the price 
converted using the latest 
exchange rate, set up a foreign 
price. See “Set up foreign 
prices for items” on page 166.

1 Select a foreign 
customer such as 
this US customer. 
QuickBooks selects 
an A/R account that 
matches the 
currency of the 
selected customer. If 
one doesn’t exist, 
QuickBooks prompts 
you to create one.

2 Update the exchange 
rate if necessary. 
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Note: When you create an invoice for a foreign customer, and add an item that has a tax code assigned 
to it, the tax code is not brought over to the invoice.

Receiving payments from foreign customers

You receive payments from foreign customers as you normally would. As you do, you also 
need to:

Depositing foreign money
1 From the Banking menu, choose Make Deposits. The Payments to Deposit window 

appears.

2 In Currency drop-down list, select the currency in which you have received payments  
and want to deposit. You can only deposit payments from one currency at a time. 
Then, from the list of payments you’ve received, select the payment(s) you want to 
deposit.

3 Click OK. The Make Deposits window appears.

4 In the Deposit To field, select the account to which you want to deposit the payment. 
You can deposit foreign money into a home currency account (the amount is 
converted using the currency’s exchange rate, or a foreign bank account as long as it 
matches the currency of the deposit).

5 In the Exchange Rate field, update the exchange rate if necessary.

6 Fill in the remaining fields as you normally would. If you are getting cash back from a 
foreign deposit, you need to set up a Petty Cash account that matches the currency of 
the money you are depositing and account for the holdback in it.

1 Select the foreign 
customer from whom 
you are receiving the 
payment; in this case, 
it is a US customer. 
QuickBooks selects an 
A/R account that 
matches the currency 
of the selected 
customer. If one 
doesn’t exist, 
QuickBooks prompts 
you to create one.

Fill out the "Receive 
Payment" window as 
you normally would.

2 Update the 
exchange rate 
if necessary. 

The customer 
determines the currency
of the transaction, and 
seeing that this 
customer is American, 
the amounts on this 
form are in US dollars.
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Dealing with foreign vendors
Working with foreign vendors is much the same as working with vendors in your home 
currency. The steps involved in making purchases and paying bills doesn’t change. The 
only thing that is different is the currency of the transaction, which is determined by the 
vendor. See “Create foreign customers and vendors” on page 165 for instructions on how 
to create a foreign vendor.

Creating purchase orders for a foreign vendor

Before you can create a purchase order for a foreign vendor, you must set him or her up in 
the vendor list, create a foreign A/P account, and have the purchase order turned on. 

Create a purchase order for a foreign vendor as you normally would. As you do:

As you enter items on foreign purchase orders, their prices are converted to the vendor’s 
currency. If the item has a foreign price and its currency matches the vendor’s, the foreign 
price is used instead (see “Set up foreign prices for items” on page 166 for more 
information).

1 Select a foreign vendor. Because 
the currency of this vendor is US 
Dollars, for example, the currency 
of the transaction will also be US 
Dollars.

QuickBooks selects an A/P account 
that matches the currency of the 
selected vendor. If one doesn’t exist, 
it prompts you to create one.

Fill out the "Create Purchase Order" 
window as you normally would.

2 Update the exchange rate if 
necessary.
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Paying bills from foreign vendors

Often, you will receive bills in a foreign vendor’s currency and be expected to pay in the 
same currency. If you make purchases from a foreign vendor, you should consider opening 
a bank account in the vendor’s currency.

You can only pay bills in one currency at a time.

1 Open the Pay Bills window as you normally would.

2 In the A/P Account drop-down list, select the A/P account that matches the currency 
of the bill you want to pay. For example, if you are paying a bill from a US vendor, select 
your US A/P account.

 

You can only display bills in one currency at a time. The currency is 
determined by the A/P account that is selected. In this case, we’ve selected 
a US A/P account, therefore the bills listed here are from US vendors. 

Update the exchange rate.

If the exchange rate 
changes between the time 
you entered the bill from 
the time you paid the bill, 
a gain or loss is 
generated. QuickBooks 
accounts for it by making 
an entry in the Exchange 
Gain/Loss expense 
account.

Select the account from which the payment will be taken. If the bank account is not set up as foreign, 
QuickBooks calculates the amount in the home currency that is to be withdrawn using the exchange rate.   

To learn about… Search the Help index for…

Payments using your credit card credit cards
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Transferring foreign funds
You can transfer money from a home-currency bank account to a foreign bank account or 
from a foreign account to a home-currency account. However, transferring money between 
two foreign bank accounts can only be done if the currency of the accounts are the same.

1 From the Banking menu, choose Transfer Funds.  

2 With the Transfer Funds Between Accounts window open:

Fill in the rest of the window as 
you normally would.

Update the exchange 
rate to match the rate 
of exchange on the 
day of the transfer.

Select the currency 
denomination of the 
amount you want to 
transfer. 

For example, if you know 
the transfer amount in 
Canadian dollars, select 
Can$, then enter the 
Canadian amount. If you 
know the transfer amount 
in US dollars, then select 
$US to specify the amount 
in US dollars. 

Enter the amount of the 
transfer.
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QuickBooks helps you track employee information 

and compensation. With the payroll features, you 

can create pay cheques and administer vacations, 

bonuses, benefits, end-of-year payroll forms such as 

T4 and Relevé 1 slips, and more. Chapter 7

To pay your employees with QuickBooks, you must be a member of 
the QuickBooks Payroll Service.

This convenient, hassle-free service provides you with the latest tax tables and 
payroll forms whenever the federal or a provincial government changes them, 
plus a new version of the software whenever Intuit updates it. 

To sign up, from the Employees menu, select Set Up QuickBooks Payroll 
Service, then Sign up Now. For more information, turn to page 178.

Payroll and 
employees

How to pay 
employees and 
create payroll 
forms
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Payroll: before you begin...

Membership in the QuickBooks Payroll Service

Before you can use QuickBooks to pay your employees, you must become a member of the 
QuickBooks Payroll Service. Note that although some QuickBooks products allow you to use 
the payroll features for a limited time (up to three months) without becoming a member, 
you must become a member to continue to pay your employees with QuickBooks when this 
trial period expires.

Your membership in the Payroll Service ensures you will receive updated tax tables from 
Intuit whenever income tax, Employment Insurance, Canada Pension Plan / Québec 
Pension Plan, or other payroll rates or payroll forms change. The Payroll Service also helps 
you make the most of your software investment by keeping it current. After you sign up, 
you will receive all updates and upgrades that Intuit releases for your software at no 
additional charge.

To become a member of the QuickBooks Payroll Service, select Set Up QuickBooks Payroll 
Service from the Employees menu, then Sign up Now. Intuit will assist you in updating 
your QuickBooks user licence to show your membership.

When you are a member, you can get information about your membership or your current 
tax table by selecting Set Up QuickBooks Payroll Service from the Employees menu, then 
About the Payroll Service.

If you don’t use the payroll feature in QuickBooks

If you are not a member of the QuickBooks Payroll Service, you cannot turn the payroll 
features on. However, you can still see and use the Employee list. That’s because you must 
still track your payroll expenses and liabilities in QuickBooks, even if you use an accountant 
or payroll company to pay your employees rather than the QuickBooks Payroll Service. 
Otherwise, your accounts will not be correct.

With the payroll features turned off, the Employee list allows only very basic information 
about each employee — his or her name, contact information, Social Insurance Number, 
hire and release dates, and custom information you define.

To learn about… Search the Help index for…

Signing up for the QuickBooks 
Payroll Service

QuickBooks Payroll Service

To learn about… Search the Help index for…

Using an external payroll service payroll services, other than Intuit

If you have employees, but aren’t 
using QuickBooks payroll

payroll, not using
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Setting up payroll: an overview
The amount of time it takes to enter your payroll information into QuickBooks varies with 
the size of your company. Often, it can take from one to two hours.

If you have never operated a payroll system before or are using a Premier Edition of Quick-
Books, we recommend that you set up payroll outside of the EasyStep Interview. If you are 
familiar with payroll systems, you can use the EasyStep Interview to set up your employees 
and their year-to-date payroll amounts quickly.

To set up your payroll system:
1 Become a member of the QuickBooks Payroll Service. You cannot use the payroll 

features of the product unless you sign up for this service (see page 178).

2 In the Payroll & Employees preferences, check that the payroll features are turned on 
and are configured properly for your needs.

For example, you can choose how you want your Employee list sorted and what prints 
on employee pay cheques and vouchers or pay stubs.

3 Gather the information you need to set up payroll (see page 180).

4 Confirm that the payroll liability and expense accounts that QuickBooks creates for 
you meet your needs (see page 183).

5 Set up (in this order):

� Your payroll items (see “Setting up your payroll items” on page 183).

� Your employees (see “Setting up employees” on page 191).

� The employees’ year-to-date amounts (see “Summarizing amounts for this year to 
date” on page 197).

6 If you have not already done so, protect your company’s payroll data from unautho-
rized access by setting up users and permissions (see “Setting up users and passwords” 
on page 133).

To learn about… Search the Help index for…

Setting up payroll payroll setup, required information

Signing up for the QuickBooks 
Payroll Service

QuickBooks Payroll Service

Getting payroll updates payroll, updating

Setting payroll preferences preferences, payroll

Setting up users and permissions 
for a payroll system

permissions
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Collecting the information you’ll need

If you paid employees before you set up your company in QuickBooks, you’ll need to get 
information from your previous accounting package or your accountant.

Information you need Where to find it

Company

How often you pay your employees Your accountant or company records

Your policies on vacation pay and sick time Your accountant or company records

Contact information for the agencies you 
remit money to after withholding it from 
employee payments (e.g. the CCRA)

Your accountant or company records

Start date for using payroll Your company records

Tax information

Your business number Your company records or the CCRA

Current tax tables covering payroll with-
holding amounts such as EI premiums and 
CPP/QPP contributions

You can download them through 
QuickBooks after you sign up for the 
Payroll Service

Compensation, benefits, and other payroll 

items

How you pay your employees and officers: 
hourly wages, salaries, and/or commissions

Your accountant or company records

Things you add to your employees’ pay 
cheques
� Examples include bonuses, travel 

expenses, employee loans

Your accountant or company records

Things you deduct or withhold from your 
employees’ net pay.
� Examples include union dues, repay-

ments of employee loans or advances, 
health or life insurance paid by the 
employee, deductions for pension plans

Your accountant or company records

Expenses your company pays that are 
based on employee pay cheques (company 
contributions)
� Examples include health or life insurance 

paid by the company, your portion of 
Employment Insurance, etc.

Your accountant or company records
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Employees

Employee name, date of birth, and Social 
Insurance Number (SIN)

Employee

Contact information for the employee, 
including the province of employment

Employee and/or company records

Federal and provincial TD-1 forms for the 
employee, completely filled out 
(see “Entering information from employee 
TD1 forms” on page 194)

Employee

Employee’s rate of pay or salary and pay 
cheque additions, deductions, and com-
pany contributions (if any)

Pay cheques, reports, or payroll ledger

Employee’s vacation pay and accrued time Pay cheques, reports, or payroll ledger

Year-to-date amounts

Each employee’s payroll amounts from the 
beginning of the calendar year to the date 
you started using QuickBooks.
� That is, the total amount you’ve paid out 

to the employee so far this year, and
� The total amounts you withheld from 

each of the employee’s payments and 
what for.

Copies of employee pay cheques, pay 
stubs, payroll reports, payroll service, 
accountant, payroll ledger

Your payroll liability amounts from the 
beginning of the calendar year to the date 
you started using QuickBooks.
� That is, the total amounts you withheld 

from all pay cheques you issued this 
year, and

� How much you already remitted to the 
government, benefits providers, etc. as a 
result of these liabilities.

Copies of liability cheques, payroll 
reports, payroll service, accountant, 
payroll ledger

Direct Deposit

For each employee using the service:
� Direct deposit request
� Bank number(s)
� Transit number(s)
� Account number(s)

Employee’s direct deposit request form

Information you need Where to find it
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Payroll expense and liability accounts
When you turn on payroll, QuickBooks adds two accounts to your Chart of Accounts:

� Payroll Expenses (an Expense account)

� Payroll Liabilities (an Other Current Liability account)

To keep your balance sheet and your profit and loss statement accurate, QuickBooks 
associates each payroll item with the appropriate account or accounts.

Whenever you create a new payroll item, QuickBooks helps you assign it to the correct 
account or accounts by prefilling the account name to use. However, you can use a different 
account if you like. For example, an accountant for a corporation may want to create 
subaccounts of the Payroll Expenses and Payroll Liabilities accounts to report expenses for 
officer salaries separately from non-officer salaries.

It is also correct for some types of payroll items (such as a deduction for a loan repayment) 
to be associated with an account other than an expense or a liability account.

Customizing payroll accounts

You may change the names of the payroll liability account and payroll expense account 
that QuickBooks provides. If you use numbered accounts, you may change the account 
numbers QuickBooks provides.

You can also use subaccounts of Payroll Liabilities to see more detail on your balance sheet 
for payroll liabilities, and subaccounts of Payroll Expenses to see more detail on your profit 
and loss statement of your payroll expenses. For example, corporations may need to report 
expenses for officer salaries separately from those for non-officer salaries.

To learn about… Search the Help index for…

Payroll Liabilities account payroll liabilities, account

Payroll Expenses account payroll, expenses account

To learn about… Search the Help index for…

Adding new accounts accounts (managing), adding

Changing account information accounts (managing), editing

Subaccounts subaccounts
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Setting up your payroll items

The importance of payroll items

Payroll items are the building blocks of your payroll system. When you create any kind of 
payroll transaction in QuickBooks—whether it’s a pay cheque, a payroll liability payment, 
or an adjustment at setup time or later—you use payroll items to do it (in the same way that 
sales forms use service and inventory items).

There are payroll items to track employee compensation (salaries and wages), amounts you 
withhold from employee pay cheques (income tax and other liabilities), employer-paid 
expenses (such as company-paid benefits), and additions and deductions (such as bonuses 
and loan repayments). QuickBooks uses payroll items to track both the individual amounts 
on a pay cheque and accumulated year-to-date amounts for each employee. 

QuickBooks displays your payroll items on the Payroll Item list. The names of the payroll 
items are what you’ll see on pay cheques and in payroll reports. 

QuickBooks identifies payroll transactions by their use of payroll items:

� Payroll reports include only transactions that use payroll items.

� Payroll liability balances are based on transactions that use payroll items.

� Employee year-to-date amounts are based on transactions that use payroll items.

When the payroll feature is turned on, QuickBooks creates the Payroll Item list with some 
standard payroll items. You can add payroll items to this list.

About the default payroll items

When you first turn on the payroll feature, QuickBooks creates the Payroll Item list with 
some standard payroll items. These include:

To learn about… Search the Help index for…

Payroll items payroll items, defined

Payroll item 
name

Type Use for

Sick Salary Yearly Salary Accrued time (such as sick time) paid out 
to a salaried employee

Vacation Salary Yearly Salary Vacation pay paid out to a salaried 
employee who is on vacation

Sick Hourly Rate Hourly Wage Accrued time (such as sick time) paid out 
to an hourly employee
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Creating new payroll items

As you set up your payroll system, you will need to create new payroll items to match how 
you pay your employees. To create new items, use the Add New Payroll Item wizard.

To start the Add New Payroll Item wizard:
� With the Payroll Items list open, click the Payroll Item menu button, then select New.

Vacation Hourly Rate Hourly Wage Vacation pay paid out to an hourly 
employee who is on vacation or who left 
the company

VacPay - Accrual 
Paid Out

Vacation Pay A specific amount of vacation pay paid 
out to an employee, for example, when he 
or she leaves the company

VacPay - Accrued Vacation Pay Earned (but not yet paid out) vacation pay 
for an employee

VacPay - Paid Out Vacation Pay Vacation pay paid out to an employee 
who is paid out every pay period

Federal Income Tax Payroll Taxes Federal income tax withheld from the 
employee. Also includes provincial 
income tax, except in Québec.

CPP - Company Payroll Taxes Canada Pension Plan, company 
contribution

CPP - Employee Payroll Taxes Canada Pension Plan, employee 
contribution

EI - Company Payroll Taxes Employment Insurance, company 
contribution

EI - Employee Payroll Taxes Employment Insurance, employee 
contribution

QPP - Company Payroll Taxes Québec Pension Plan, company 
contribution

QPP - Employee Payroll Taxes Québec Pension Plan, employee 
contribution

Québec Income Tax Payroll Taxes Québec income tax withheld

Payroll item 
name

Type Use for
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You can limit payroll items to a maximum amount, either annually (e.g. an employee’s 
union dues cannot be more than $150 per year) or absolutely (e.g. an employee’s loan 
repayment cannot be more than $2000, the amount of the loan).

Payroll item type Use for

Yearly Salary � Compensation to employees whose annual salary is 
independent of the number of hours actually worked.

� Compensation to salaried corporate officers (with 
expenses assigned to an expense account for corporate 
officer salaries).

� Paid sick time for salaried employees.
� Vacation pay for salaried employees.

Hourly Wage � Compensation based on the number of hours worked.
� Paid sick time for hourly employees.
� Vacation pay for hourly employees.

Commission Compensation based on a percentage of another quantity 
(such as 7% of sales) or a flat amount times a quantity (such 
as $8 times units sold).

Deduction Any deduction from gross or after-tax (net) pay. Examples 
include union dues, loan repayments, and employee-paid 
insurance.
Deductions can be flat amounts or calculated on a quantity 
such as the hours the employee works.

Bonus One-time compensation awarded at the discretion of the 
employer.

Addition Any addition to gross or after-tax (net) pay. An example is a 
recurring profit-sharing payout.
Additions can be flat amounts or calculated on a quantity 
such as the hours the employee works.

Company Contribution Any company-paid benefit or expense that you want to 
track with each pay cheque. Examples include employee 
benefits such as pension plans or health and life insurance.
Company Contributions can be flat amounts or calculated 
on a quantity such as the hours the employee works.

Other Tax Miscellaneous taxes based on employee wages. These 
taxes may be paid by the company or the employee. 
Examples include payments to the Workers Compensation 
Board, the Ontario Employer Health Tax, and the Québec 
Health Services Fund.
Other Taxes can be flat amounts or calculated on a quantity 
such as the hours the employee works.
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As you create an item in the Add New Payroll Items wizard, you should:

� Confirm that the expense and liability accounts assigned to it meet your needs and 
change them, if you need to.

� Choose how to track the payroll item on T4 and, in Québec, Relevé 1 forms, if it’s 
an addition, deduction, or company contribution. If you are not sure how to tax a 
payroll item, check with the Canada Customs and Revenue Agency, your 
provincial Minister of Revenue, or your accountant.

Note: From the Tax Tracking Type drop-down menu, you can choose tracking options for T4 forms only 
(listed first), for both T4 and Relevé 1 forms (listed next), or for Relevé 1 special cases (last).

� Accept the default setting for how to track the payroll item on Record of 
Employment forms, unless you fully understand the guidelines from Human 
Resources Development Canada and the effect that changing the payroll item will 
have.

Payroll items and expenses

An expense is a debt that you pay as soon as you owe it. Common payroll expenses include 
gross pay (e.g. wages before taxes), company-paid payroll taxes (e.g. the employer’s part of 
Employment Insurance), and company-paid benefits for employees (e.g. premiums for a 
company-paid health plan).

For all payroll expenses, QuickBooks suggests using the Payroll Expenses account. When 
you run your payroll, QuickBooks keeps track of your company’s expenses for each 
employee. You can then see totals for your expenses on the Payroll Summary report 
and on the Profit and Loss Statement.

Keeping track of payroll expenses

You can break down company-paid payroll expenses by job, class, and service item. 
Expenses you can break down include:

� salary wages, hourly wages, commissions, and bonuses

� company-paid payroll taxes

� Additions, commissions, and company contributions. 

To learn about… Search the Help index for…

Changing the name of payroll 
items

payroll items, editing

Adding payroll items payroll items, adding

Adding a payroll item for a 
miscellaneous tax

payroll items, other tax
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QuickBooks can prorate an employee’s company-paid expenses in the same proportions as 
it prorates the dollar amounts of the employee’s earnings. You can also set up QuickBooks 
to prorate each addition, commission, or company contribution.

Tracking expenses by customer and job

Some businesses like to see which customers and jobs create the most work and so the most 
expenses for them. To track payroll expenses by customer and/or job, do the following:

� In QuickBooks Basic, turn on "Use customer:job tracking" in the Accounting prefer-
ences. (In QuickBooks Pro or better, this option is always enabled.)

� Turn on the following Payroll & Employees preference: “Report all payroll taxes by...”

� Review all of your commission, addition, and company contribution payroll items to 
make sure the checkbox for “Track Expenses by Job” is selected.

� When you create a pay cheque for an employee, select the correct customer:job or jobs 
from the drop-down menu for each salary or hourly wage payroll items you enter.

Tracking expenses by class

Some businesses prefer to classify expenses, such as not-for-profit organizations that need 
to do fund accounting. To track payroll expenses by class, do the following:

� Turn on “Use class tracking” in the Accounting preferences.

� Turn on the following Payroll & Employees preference: “Report all payroll taxes by....” 
Then choose whether you want to assign one class to an employee’s entire pay cheque 
or to each of the payroll items you use on the pay cheque.

� Review all of your commission, addition, and company contribution payroll items to 
make sure the checkbox for “Track Expenses by Job” is selected.

� When you create a pay cheque, either select the correct class for the pay cheque or 
assign a separate class to each payroll item on the pay cheque, according to the Payroll 
& Employee preference you chose.

Tracking expenses by service item (QuickBooks Pro and 
better only)

Some businesses track expenses by service item. (A service item is what you use on sales 
forms to charge your customers for services you provide, like labour.) To track payroll 
expenses by service item, do the following:

� Turn on the following Payroll & Employees preference: “Report all payroll taxes by...”

� Review all of your commission, addition, and company contribution payroll items to 
make sure the checkbox for “Track Expenses by Job” is selected.

� Make sure that in the record you set up for each of your employees, the checkbox for 
“Use time data to create pay cheques” on the Payroll Info tab is selected.

� On each pay cheque you write, associate the service items for the employee with the 
Customer:Job he or she worked on.



188 Chapter 7   Payroll and employees

Payroll items and liabilities

Often, you have to deduct an amount from an employee’s payment and pass it on to the 
government or another institution. For example, when you pay an employee, you hold 
back the income tax that the employee owes the government and remit that money to the 
government later.

These types of deductions are not expenses because the money you pass on comes from the 
employee, not your company. Instead, because you temporarily keep someone else’s 
money, these deductions are liabilities. Payroll items for liabilities are usually assigned to 
the Payroll Liabilities account.

When you do your payroll, QuickBooks calculates how much you owe the government or 
other agency for each tax, deduction, and company contribution payroll item and records 
it in the Payroll Liability account. With each pay cheque you write, the balance of this 
account increases.

When you pay your payroll taxes and other payroll liabilities in the Pay Liabilities window, 
QuickBooks decreases the balance of the liability account.

Combinations of expenses and liabilities

Some payroll items are a combination of liabilities and expenses. For example, the 
portion of Employment Insurance (EI) that you withhold from an employee’s pay 
cheque is a liability, while the portion that you pay is an expense.

Payroll items for company-paid taxes and company contributions are usually assigned to 
both a liability account and an expense account.

To learn about… Search the Help index for…

Tracking payroll expenses by cus-
tomer:job, class, or service item

payroll, tracking expenses
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How to set up common payroll items

This handy guide explains how to set up many different types of payroll items.

Payroll item Type
Gross 

or 
Net

Fed CPP EI QIT QPP
T4 or 
RL-1

ROE
Earn.

ROE
Hrs.

ROE
For 

or In

Advance Add’n Net n/a n/a n/a n/a n/a None N N n/a

Advance repayment Ded’n Net n/a n/a n/a n/a n/a None n/a

Alimony or mainte-
nance payment (tax 
deductible)

Ded’n Gross � N N � N None n/a

Alimony or mainte-
nance payment (not 
tax deductible)

Ded’n Net n/a n/a n/a n/a n/a None n/a

Automobile allowance 
(taxable)

Add’n Gross � � � � � Box
34/I

Y N In

Automobile expense 
reimbursement (not 
taxable)

Add’n Net n/a n/a n/a n/a n/a None N N n/a

Bonus
� Awards or bonuses
� One-time payment 

or supplemental 
wages

Bonus Gross � � � � � Box
14/A

Y N In

Canada Savings Bond Ded’n Net n/a n/a n/a n/a n/a None n/a

Charitable donation Ded’n Net n/a n/a n/a n/a n/a Box
46/N

n/a

Garnisheed wages Ded’n Net n/a n/a n/a n/a n/a None n/a

Labour-sponsored 
fund

Ded’n Gross � N N � N None n/a

Provincial Health Care 
(company-paid)

Co.
Ctrb’n

n/a � � � � � Box
40/L

N N n/a

Private Health Care 
(paid by employee)

Ded’n Net n/a n/a n/a n/a n/a None n/a

Private Health Care 
(paid by company)

Co.
Ctrb’n

n/a N N N � � None N N n/a

Registered Pension 
Plan (RPP), employee 
contribution

Ded’n Gross � N N � N Box
20/D

n/a

Registered Pension 
Plan (RPP), company 
contribution

Co.
Ctrb’n

n/a � N N � N Box
40/L

N N n/a

Registered Retirement 
Savings Plan (RRSP), 
employee contribution

Ded’n Gross � N N � N None n/a
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Registered Retirement 
Savings Plan (RRSP), 
company contribution

Co.
Ctrb’n

n/a � N N � N Box
40/L

Y N In

Reimbursement (one-
time payment)

Add’n Gross � � � � � Box
14/A

N N n/a

Union Dues Ded’n Gross � N N � N Box
44/F

n/a

Payroll Taxes

� Ontario Employer 
Health Tax

� Québec Health 
Services Fund

� Manitoba Payroll 
Tax

� Northwest Terri-
tories Payroll Tax

Other 
Tax

n/a n/a n/a n/a n/a n/a None n/a

Non-Cash 
Benefits

Housing, board, and 
lodging

Co.
Ctrb’n

n/a � � N � � Box
30/H

Y N In

Travel in designated 
area

Co.
Ctrb’n

n/a � � N � � Box
32/K

N N n/a

� Personal use of 
employer’s auto

� Auto operating 
expenses or standby 
charges

Co.
Ctrb’n

n/a � � N � � Box
34/I

N N n/a

Taxable interest Co.
Ctrb’n

n/a � � N � � Box
36/L

N N n/a

Stock option benefit Co.
Ctrb’n

n/a � � N � � Box
38/L

N N n/a

Other taxable benefit Co.
Ctrb’n

n/a � � � � � Box
40/L

N N n/a

� GST on Employee 
Benefits

� QST on Employee 
Benefits

Co.
Ctrb’n

n/a � � N � � None N N n/a

Payroll item Type
Gross 

or 
Net

Fed CPP EI QIT QPP
T4 or 
RL-1

ROE
Earn.

ROE
Hrs.

ROE
For 

or In
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Setting up employees

Generally, an employee is a person you pay on a regular and ongoing basis to perform 
services for your company, using materials and equipment you provide.

If your business is a sole proprietorship or an unincorporated partnership, owners and 
partners are not usually employees. If your company is incorporated, corporate officers who 
work in the business are usually employees.

If you’re not sure whether a person providing services for you is an employee, owner, or 
subcontractor, contact the Canada Customs and Revenue Agency or your accountant. 

To set up employees for payroll, you need to:

� (Optional but recommended) Set up your employee defaults.

� Add new employees to your Employee list, or add payroll information for employees 
already on your Employee list.

Employee defaults: entering common employee information

The employee defaults help you set up payroll for several employees quickly. You enter 
payroll information that most employees have in common. These defaults then show up 
every time you enter information for a new employee. If the information isn’t right for a 
particular employee, you can change it for him or her.

You can set up the following information as employee defaults:

� Salary or hourly wage or commission payroll items (with or without rates of pay)

� Pay period

� Class, if you’re using classes to track your employees

� Whether you want to record time data for the employee and base pay cheques on it 
(QuickBooks Pro and better only)

� Additions, deductions, and company contributions that appear on pay cheques for 
most employees

Note: The order in which you enter payroll items in the Addition, Deductions, and Company Contri-
butions area can affect how QuickBooks calculates each item and income taxes.

� The province in which your employees work and what payroll taxes they are subject to

� TD1 and, in Québec, TP-1015.3 basic amounts

� How employees will accrue time (such as sick time or time-in-lieu) and vacation pay

Use payroll only to pay employees, not subcontractors or owners.

To pay subcontractors, set them up as vendors, have them bill you, and pay them with 
the Pay Bills feature. Then you can create a T4A or (Contractor Edition) T5018 report.

To pay owners, use an owner’s draw from an equity account.
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Setting up employees

Before setting up your employees in QuickBooks, you should create the payroll items you 
need for your business (see “Setting up your payroll items” on page 183).

Also, if you’ve already set up your employee defaults (see “Employee defaults: entering 
common employee information” on page 191), QuickBooks can prefill much of the 
information when you set up individual employees.

The Employee list contains the names of all your employees. When you add or edit an 
employee, you may fill out three sections:

� Address Info: the employee’s contact information, Social Insurance Number, date of 
birth, hire and release dates, and similar information.

Note: If you do not enter an employee’s correct date of birth, QuickBooks cannot calculate Canada 
Pension Plan or Québec Pension Plan contribution amounts for him or her.

CPP contributions for an employee will be zero if he or she is not between 18 and 70. (In the year 
the employee turns 18 or 70, QuickBooks prorates the calculation according to CCRA guide-
lines.) QPP contributions for an employee will be zero if he or she is younger than 18. 

� Additional Info: custom fields for tracking any information you prefer.

The Class field is 
available only if you 
have class tracking 
turned on. 

You can turn class 
tracking on and off in 
the Accounting 
section of your 
Preferences, located 
in the Edit menu.

In QuickBooks Pro 
or better, this 
checkbox appears 
if time tracking is 
turned on.

You can turn time 
tracking on and off 
in the Preferences 
section under the 
Edit menu.

To learn about… Search the Help index for…

Setting up the employee defaults employee defaults, creating

How the order of payroll items 
affects amounts on your 
employee’s pay cheques

pay cheques, affecting amounts
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� Payroll Info: this employee’s salary or hourly wages and any additions, deductions, or 
company contributions that apply to him or her. You’ll need payroll items for most of 
this information, which you select in the Item Name column of the tables. If you have 
not already set up all the payroll items you need, QuickBooks gives you a chance to add 
them as you work.

This tab also contains four buttons for setting up other important parts of the 
employee’s payroll information:

- Payroll Taxes: the employee’s payroll deductions for income tax, Employment 
Insurance, Canada Pension Plan / Québec Pension Plan, and any other payroll 
taxes he or she might have to pay. The information from the employee’s TD1 form 
goes here (see “Entering information from employee TD1 forms” on page 194).

- Direct Deposit: the employee’s bank account number and routing number (see 
“Setting up direct deposit for employee pay cheques” on page 196).

- Accrual Hours: how the employee accrues time (such as sick days or time off in lieu 
of overtime). Use this window to track how much accrued time an employee has 
available and how much he or she has used this year. (See page 198 for important 
information about entering Accrual Hours year-to-date amounts.)

- Vacation Pay: how the employee accrues vacation pay. Use this window to track 
how much vacation pay an employee has available and how much he or she has 
used this year. (See page 198 for important information about entering Vacation 
Pay year-to-date amounts.)

QuickBooks also provides a “notepad” in which you can make notes about an employee.

To learn about… Search the Help index for…

Adding new employees employees, adding

Changing information about an 
existing employee

employees, editing

Setting up payroll information for 
an employee

employees, payroll information

How the order of payroll items 
affects amounts on your 
employee’s pay cheques

pay cheques, affecting amounts

Categorizing employees by class employees, grouping by department 
or location

Adding notes for an employee employees, notes about
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If you pay on commission (QuickBooks Pro and better)

If your employees earn commissions for items they sell, after setting them up on the 
Employee list, you should also set them up on the Sales Rep list.

When you enter an invoice, sales receipt, or estimate, select the employee’s initials from the 
Rep drop-down list on the sales form to give him or her credit for the sale. Then you will 
be able to produce reports showing sales by employee.

Pay commission employees with commission payroll items on a pay cheque, not a "regular" 
non-payroll cheque. For more information, turn to “Previewing, adjusting, and creating 
pay cheques” on page 209.

To track commission sales for owners or partners, add them to the Sales Rep list like 
employees, but pay them with an owner’s draw instead of a pay cheque.

Entering information from employee TD1 forms

The Canada Customs and Revenue Agency (CCRA) requires you, as an employer, to keep a 
current federal and provincial TD1 form on file for each of your employees. For Québec 
employees, you must keep a federal TD1 form and a provincial TP-1015.3 form on file.

TD1 and the Québec TP-1015.3 forms help employees calculate the personal tax credits they 
will claim when they file an income tax return. The totals from these forms tell QuickBooks 
how much income tax it should deduct from the pay cheques you create for an employee.

Most employees should fill in both the federal TD1 form (Personal Tax Credits Return) as 
well as the TD1 form for the province they work in. Employees who work in Québec should 
fill in a federal TD1 form and a provincial TP-1015.3 form. You can download blank TD1 
forms from the CCRA web site (http://www.ccra-adrc.gc.ca/) and blank TP-1015.3 forms 
from the Québec Minister of Revenue web site (http://www.revenu.gouv.qc.ca/).

Some employees who are paid on commission and who claim their business expenses may 
ask to use Form TD1X (Statement of Commission Income and Expenses for Payroll Tax 
Deductions). In this case, you should consult your accountant as you will have to perform 
special payroll calculations for this employee.

An employee’s TD1 and/or TP-1015.3 forms must be updated within a week of any change 
in his or her tax status.You and your employee share the responsibility for keeping these 
forms current. An employee should fill in new personal tax credit forms when:

� they are hired.

� the employee wants to change the tax credits he or she is claiming. For example, say 
that an employee becomes a student and wants to claim the student tax credit. He or 
she should complete new tax credit forms within a week of the change.

To learn about… Search the Help index for…

Paying the owner(s) of a business owners’ draws
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� the federal or provincial tax credit amounts change. In this case, QuickBooks notifies 
you that your employees' TD1 and TP-1015.3 claim amounts need to be updated, and 
you should update the forms as soon as possible.

Note: According to the CCRA, it is a serious offence to knowingly accept a Form TD1 that contains false 
information. If you think an employee is entering incorrect information, contact the CCRA.

After your employees have completed these forms, you need to copy the total claim 
amounts from them into QuickBooks. QuickBooks will then withhold the correct amounts 
of income tax from their pay cheques.

To enter an employee’s TD1 tax credit claim into QuickBooks:
1 In the employee's profile, click the Payroll Taxes button (in the Payroll Info tab).

2 From the Tax Table drop down list, choose the province or territory where the 
employee works (not where the employee lives or where your company is located).

3 In the Subject To area, do the following:

� In the Federal TD1 field, enter the total claim amount (Line 12) from the 
employee’s federal TD1 form.

� If the employee wants you to hold back extra income tax from his or her pay 
cheques (say, to avoid paying a large sum when filing a tax return in the spring), 
enter the amount to withhold from each pay cheque in the Additional Tax field. 
You can only enter a dollar amount, not a percentage.

� In the Provincial TD1 field, enter the total claim amount from the employee's 
provincial TD1 form (Line 12) or, in Québec, TP-1015.3 form (Line 20).

4 Click OK.

Tip: Often, employees only claim the basic amount. If your enter the basic amount into your Employee 
Defaults, QuickBooks will prefill it when you set up payroll for an individual employee.

To learn about… Search the Help index for…

Setting up TD1 information for an 
employee

TD1 forms, employees

Entering default TD1 information TD1 forms, employee defaults

Setting up TP-1015.3 information 
for an employee

TP-1015.3 forms
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Setting up direct deposit for employee pay cheques

After you sign up for Direct Deposit, you need to:

� Check that QuickBooks automatically created a Direct Deposit payroll item for you. 
This payroll item appears in the Payroll Item list and, for employees using the service, 
in the Employee Summary area of their Preview Pay Cheque window.

� For each employee who wants to use the service, enter information into their profile 
that tells QuickBooks where and how to deposit their pay cheques. You need the bank 
account, financial institution, and branch number of the account to receive the pay 
cheque. You can split an employee’s pay cheque between two accounts, if you want. 

To enter the information, in the employee's profile, click the Direct Deposit button (in 
the Payroll Info tab).

Before you can set up direct deposit for your employees, you must first sign 
up for this optional service.

Direct Deposit allows you to electronically deposit your employee’s pay cheques into 
their bank accounts on a day you specify. Direct deposit payments are secure, conve-
nient, and time-saving for you and your employees. 

To learn more about Direct Deposit or apply for this service, from the Employees menu, 
select Employee Services, then Direct Deposit.

This field identifies the 
employee’s financial 
institution and branch.

Its format is the five-digit 
branch number first, a 
hyphen, then the three-
digit institution number 
(for example, 00123-987).

You can get these 
numbers from a cheque 
for the account.

You can deposit an 
employee’s pay 
cheque into two 
bank accounts; for 
example, a 
Chequing and a 
Savings account.

To learn about… Search the Help index for…

Setting up employees for direct 
deposit

direct deposit, setting up employees 
for

Signing up for direct deposit direct deposit, signing up for

Branch, institution, and bank 
numbers

� institution numbers
� bank numbers
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Summarizing amounts for this year to date

Note: Skip this section if your company has not done payroll before or has not issued any pay cheques 
so far this year. You are ready to start writing pay cheques.

If you’re just starting to use QuickBooks for payroll and you’ve already issued pay cheques 
in the current calendar year, you need to:

� Enter year-to-date information to summarize your payroll transactions from January 1 
up to your QuickBooks start date. (For information about start dates, see “Determining 
a start date” on page 34.) You will need a summary of the transactions for each 
employee and also one of any payments you’ve made for your payroll liabilities.

� Enter your payroll transactions (pay cheques and liability cheques) for the period 
between your QuickBooks start date and today.

A wizard will help you enter your year-to-date (YTD) information. To start it, from the 
Employee menu, choose Enter YTD Amounts. After you’ve entered your YTD information, 
QuickBooks updates it as you issue pay cheques during the remainder of the payroll year to 
keep your payroll tax amounts correct.

Entering year-to-date summaries for each employee

For each employee (both current and former) you paid during the current calendar year, 
you must enter a summary of his or her earnings and the amounts you deducted from it. 
The summary should cover the period from January 1st of the year to the day you started 
using QuickBooks. In the summary, include gross pay, income tax, Employment Insurance, 
Canada Pension Plan or Québec Pension Plan, and any other amounts you tracked by pay 
cheque from January 1st to your QuickBooks start date.

You need to enter both the amounts you withheld from the employee’s earnings and the 
amounts that your company paid as a result of the employee’s earnings. For example, you 
must enter both the employee’s and employer’s parts of CPP/QPP and EI.

Depending on how you’ve kept your records, you can enter amounts summarized by 
month, by pay period, or for the entire year to date.

As you work though the Enter YTD wizard, it asks you to select the employee whose 
year-to-date information you want to enter. When you click Enter Summary, QuickBooks 
displays each payroll item you entered in that employee’s profile.

Filling in the Year-to-Date window:
� In the Salary and Hourly Wages area, enter payroll items for hours worked during the 

period and amounts paid out for this work. This way, hourly totals will appear on 
payroll reports and the employee's Record of Employment. Also enter any commissions 
or bonuses paid out to the employee during this period. 

� Also in the Salary and Hourly Wages area, enter vacation pay and accrued time (such 
as sick time) taken during this period and what you paid out for them. Do not include 
these amounts in your totals for regular salary or hourly wages:
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Entering accrual time year-to-date amounts:

a) In the employee’s profile, enter the amount of accrual time that the employee has 
available as of the first day of this year, not what he or she has available now. See 
“Setting up employees” on page 191.

b) In the Salary and Hourly Wages area of the Enter Year-to-Date Amounts window, 
enter:

- in the Hours for Period column, the number of accrual hours that the 
employee used this period, and

- in the Period Amount column, the total amount you paid out for those accrual 
hours.

Be sure to use the correct payroll items: Sick Salary for a salaried employee or Sick 
Hourly Rate for an hourly employee. 

c) After you finish entering year-to-date information, go back to the employee's 
profile and confirm that the accrual hours are correct. They should now take your 
year-to-date entry into account.

Entering vacation pay year-to-date amounts

a) In the employee’s profile, enter the amount of vacation pay that the employee has 
available as of the first day of this year, not what he or she has available now. See 
“Setting up employees” on page 191.

b) In the Salary and Hourly Wages area of the Enter Year-to-Date Amounts window, 
enter:

- in the Hours for Period column, the number of vacation hours that the 
employee used this period, and

In this area, enter the 
totals for salary, hourly 
wages, or vacation pay 
paid out during this 
period. 

Enter hours worked 
during the period if you 
want them to appear on 
reports. QuickBooks 
displays a message if 
hours are required.

In this area, enter totals 
for all other earnings, 
withholdings, and 
company-paid taxes or 
payroll expenses for 
this employee.

Include taxes regardless 
of whether you have 
paid them yet.

To insert a payroll item 
above another, press 
CTRL+INSERT. 

You can skip over items 
not used in this period. 

If the amount you paid 
the employee has already 
come out of your bank 
account, select this.

If you want, you can type 
a description about this 
adjustment.
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- in the Period Amount column, the total amount you paid out for those 
vacation hours.

Be sure to use the correct payroll items: Vacation Salary for a salaried employee or 
Vacation Hourly for an hourly employee. If the employee did not take vacation so 
you paid out the vacation pay owing, make the entry using VacPay Accrual Paid 
Out or VacPay Paid Out. (Only one of these payroll items appears depending on 
how you set up your employees.)

c) In the Other Employee and Company Payroll Items area of the Enter Year-to-Date 
Amounts window, enter the amount of vacation pay that the employee accrued 
this period using the VacPay Accrued payroll item.

d) After you finish entering year-to-date information, go back to the employee's 
profile and confirm that the vacation pay amount is correct. It should now take 
your year-to-date entry into account.

� In the Other Employee and Company Payroll Items area, enter totals for all other 
earnings, withholdings, company-paid contributions, and payroll expenses for this 
employee for this period. Enter all liabilities created because of compensation paid, 
even if you have already paid them or they were company expenses. For example, if 
you provide an employee benefit and track it as a payroll expense for each pay period, 
you must enter amounts for this employee in this window. Later, you will also enter 
the amounts you’ve already paid towards this liability so that QuickBooks can keep 
track of how much you still owe. You do not have to enter non-payroll adjustments 
such as reimbursements for office supplies.

� In this area, also enter all accrued taxes for this employee regardless of whether you 
have paid them yet. These include the amounts for the employee and company portion 
of CPP/QPP and EI. Enter separate amounts for the employee and company portions 
of CPP/QPP and EI. QuickBooks uses the employee amount to track employee with-
holding; it uses both amounts to track your total payroll liability.

� If you decide to track company-paid expenses, such as insurance, as a payroll expense 
for each pay period, you must enter amounts for the employee in the Other Employee 
and Company Payroll Items area of this window. Later in the wizard, you must also 
enter amounts you paid, so that QuickBooks can keep track of how much you owe.

� Also in the Other Employee and Company Payroll Items area, enter vacation pay 
earned or accrued. (See "Entering vacation pay year-to-date amounts," above.)

� Leave the Period Amount field blank if there was no amount for the payroll item you 
are entering during this period. (Do not enter $0.00.)

After you’ve entered the amounts for this period, click OK to finish. If you have another 
period to enter, click Next Period instead.

To learn about… Search the Help index for…

Entering YTD amounts for 
employees

year-to-date amounts, employee
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Should my YTD information affect my accounts?

About wage bases

A "wage base" is the portion of an employee’s earnings that’s actually used to calculate 
payroll withholding amounts. It does not include any earnings or wages that may be tax 
exempt. It’s also called taxable income, insurable earnings, or pensionable earnings.

For every government-withholding payroll item (such as income tax, CPP/QPP, and EI) in 
the lower half of the YTD Adjustment window, QuickBooks tracks the employee’s wage base 
for reports. You can view the employee’s wage bases by clicking Show Wage Bases.

Option When to choose What QuickBooks does

Do not affect accounts Most people should choose this 
option at setup.
� You need to enter all your account 

opening balances in QuickBooks as 
of your start date, and you do not 
want these amounts to change the 
balances of your accounts.

� If your start date is midyear, and 
you make an adjustment for all 
income and expense accounts, you 
do not want these amounts to 
affect that adjustment.

� Affects no balance sheet accounts 
and adds no expenses.

� Adjusts year-to-date amounts to 
print on pay cheques; to display in 
payroll reports; and to observe 
annual limits for taxes, deductions, 
and additions.

Affect liability and 
expense accounts but 
not the bank account

You may want to choose this option 
at setup if you have never used a pay-
roll liability account before, and you 
want a correct balance in the account.
This option is also appropriate after 
you start using payroll if you need to 
adjust the amount owed for a payroll 
item.

� Enters an increase in each liability 
account associated with a payroll 
item used for the period.

� Tracks an expense for each 
expense account associated with a 
payroll item used for the period.

� Enters a decrease in the Opening 
Bal Equity account for the net 
amount paid the employee during 
the period. (This adjustment keeps 
your books in balance.)

Affect liability, 
expense, and bank 
accounts

You are unlikely to want to choose 
this option at setup since it affects 
your bank account balance. 

� Enters a payment in the designated 
bank account for the net amount 
paid the employee during the 
period.

� Enters an increase in each liability 
account associated with a payroll 
item used for the period.

� Tracks an expense for each 
expense account associated with a 
payroll item used for the period.
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QuickBooks calculates wage bases for government withholding amounts in this way:

� First, it totals all salary, hourly wages, and commissions.

� Then it adds the payroll items that increase the gross amount.

� Finally, it subtracts the payroll items that decrease the gross amount.

If the year-to-date total of a wage base for a withholding amount exceeds the maximum 
annual earnings limit for that withholding amount, the wage base equals the maximum 
earnings limit. If you entered amounts for earlier periods this year, QuickBooks counts the 
wage base from the earlier periods towards the maximum.

Entering year-to-date summaries of liability payments

Note: Skip this section if your company has not made any payments for payroll withholdings (such as 
deducted income tax) this calendar year.

For this adjustment, you’ll need to know how much you paid from January 1 of this year 
up to your QuickBooks start date for each of the following:

� Income tax and other payroll withholding amounts (Employment Insurance, Canada 
Pension Plan or Québec Pension Plan, and other payroll taxes), whether withheld from 
employees or paid as a company expense.

� Each deduction you withheld and then paid (for example, for benefits such as an 
employee-paid dental plan).

� Each company contribution you paid (for example, for benefits such as a company-
paid health plan).

This adjustment is just for your payroll liabilities and your expenses for employer-paid 
payroll withholding. It is not for expenses paid directly to employees (such as salaries, 
bonuses, or hourly wages).

To learn about… Search the Help index for…

Wage bases wage base

Type the ending date 
of the period you are 
summarizing.

Type the date 
you made the 
liability 
payment.
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Making sure your payroll data is complete

Because QuickBooks bases new payroll transactions on existing ones, it’s very important 
that you enter all of your payroll data accurately. After you set up your payroll information 
in QuickBooks, you should make sure that it is complete and correct.

To learn about…
Search the Help index 
for…

Entering YTD liability payments year-to-date amounts, liability 
payments

Procedure Comments
Search the 
Help index 
for...

�

Review your Employee list. The Employee list should include 
names of all employees on your payroll 
at any time during the current calendar 
year (even if they have now left).

employees, reports 
about
lists, printing

❏

Review your employees’ dates 
of birth.

Each employee’s profile should include 
his or her date of birth. Otherwise, 
QuickBooks cannot calculate Canada or 
Québec Pension Plan amounts for that 
employee.

employees, editing ❏

Review an employee contact 
list report.

The report should include Social 
Insurance Numbers, addresses, and 
phone numbers for all employees.

employees, reports 
about

❏

Review your Payroll Item list. The Payroll Item list should list 
everything you need to track on 
a pay cheque.

payroll, reports 
about
lists, printing

❏

Review your payroll summary 
for all employees for this 
entire calendar year.

You should be able to match the 
amounts for payroll items in Quick-
Books with amounts in the payroll 
accounts of your prior payroll system.

employees, reports 
about

❏

Review your a payroll 
liabilities as of December 
31st of this year.

You should be able to match the 
amounts for payroll items in Quick-
Books with amounts on the liability 
report of your prior payroll system.

payroll, reports 
about

❏

Print a balance sheet as of 
December 31st of this year. 

It should match the balance sheet from 
your prior accounting system as of 
December 31 of this year.

balance sheet, 
reports

❏
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Managing payroll and employee information
As your business grows and changes, you will probably find it necessary to add or remove 
payroll items, hire and sometimes release employees, and track additional information 
about your payroll.

Changing payroll item information

By default, the Payroll Item list is organized by payroll item type. Earnings items (for yearly 
salaries, hourly wages, and commissions) are at the top of the list. To re-sort the list, click a 
column header. 

You can use the same payroll item for many employees. For example, you can customize 
the amount or percentage of earnings payroll items in the setup window for each employee 
to allow for different rates of pay.

You can change the information for existing payroll items, although you probably do not 
want to change whether the item is subject to income tax, how it appears in T4 and Relevé 
1 forms, or how it is mapped to Record of Employment forms. You may want to change a 
payroll item, for example, because

� The annual limit for a deduction changes.

� Your accountant wants you to assign it to a different account.

You can’t delete the payroll items for income tax and other government deductions that 
QuickBooks creates for you, but you can hide these items if you don’t use them.

Print a balance sheet as of 
December 31st of last year. 

It should match the balance sheet from 
your prior accounting system as of 
December 31 of last year.

balance sheet, 
reports

❏

Print a profit and loss state-
ment for the entire calendar 
year.

It should match the profit and loss 
statement from your prior accounting 
system for the entire calendar year.

profit and loss 
reports

❏

Procedure Comments
Search the 
Help index 
for...

�

To learn about… Search the Help index for…

Changing payroll items payroll items, editing
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What the changes to payroll items affect

Changes you make to payroll items are reflected in the new pay cheques you write. Certain 
changes can also affect how payroll amounts are classified historically on tax forms, reports, 
and pay cheque details.

Employee information and existing pay cheques are affected when you change any of the 
following information for payroll items:

� Payroll item name

� Account(s) assigned to it (liability or expense)

� Assigned box on T4 or Relevé 1 forms or its mapping to Record of Employment forms

Changing the following information affects future pay cheques only, unless you change an 
existing pay cheque so that QuickBooks recalculates it:

� Payroll taxes affected (for additions to or deductions from gross pay)

� How the payroll item is calculated on the pay cheque

Changing employee information

You can change an employee’s personal or payroll information whenever necessary. The 
changes will affect all future pay cheques you write to him or her. Changes to an employee’s 
name, address, or Social Insurance Number are reflected in previously-written pay cheques 
but do not affect the amounts of those pay cheques.

These types of information must be changed individually for each affected employee. 
Changing the associated payroll item doesn’t affect the employees who use it.

� Annual limits for a deduction.

� Rate or amount changes for a deduction, addition, company contribution, or other tax 
item.

Tip: Change the information in the employee defaults first. In many cases, QuickBooks asks if you 
want to also change the information for all matching employees.

QuickBooks also provides a notepad with which you can make notes about an employee.

To learn about… Search the Help index for…

Making payroll items inactive, 
hiding them, or showing them

lists, hiding and showing entries

Deleting payroll items payroll items, deleting

Merging payroll items lists, merging two entries

To learn about… Search the Help index for…

Changing employee information employees, editing
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Hiring and releasing employees

When you hire a new employee, add the employee to the Employee list (see “Setting up 
employees” on page 192). If you have set up employee defaults (see page 191), this 
information is copied from the defaults into the new employee profile. Then, if you need 
to, you can change any of the information for this particular employee.

When an employee leaves the company, you need to enter the employee’s release date 
into his or her profile and select the reason the employee is leaving from the Record of 
Employment code drop-down list.

Note: It’s a good idea to enter a release date for an employee only after you have written his or her final 
pay cheque. Once you enter a release date in the employee’s record, QuickBooks doesn’t 
display the employee’s name in the Select Employees To Pay window when the pay period end 
date is later than the release date.

You can’t delete a released employee if there are payroll transactions for him or her. You 
can; however, make the employee inactive to hide his or her name in the Employee list.

Preparing a Record of Employment

When an employee leaves or is terminated or laid off, you must issue him or her a Record 
of Employment (ROE) form within five calendar days. The ROE determines whether the 
former employee qualifies for Employment Insurance benefits. The employee should 
receive one copy and Human Resources Development Canada (HRDC) should receive one.

QuickBooks provides a report to help you fill in an ROE that looks the same as an ROE form 
from HRDC. However, because HRDC requires that ROE forms have a unique serial number, 
you cannot print an ROE form directly from QuickBooks or download blank ROE forms 
from the HRDC Web site. Instead, you must copy the information from QuickBooks to an 
official, blank ROE form or to HRDC software for creating these forms. You can order these 
from the HRDC Web site at http://www.hrdc-drhc.gc.ca/ae-ei/yrs/4.1_e.shtml

To prepare an ROE report:
1 From the Employees menu, choose Process Record of Employment.

� QuickBooks may ask if you want to review Payroll Item Listing report (see “Trou-
bleshooting an ROE report:”, below) to confirm that your payroll items are set up 
correctly. Click Yes to review the report or No to go on. If you click Yes, when you 
are finished with the report, close it and perform Step 1 again.

2 Choose the employee who is leaving, then click OK.

Giving an employee a raise employees, raises

Adding custom fields for an 
employee

employees, custom fields for

To learn about… Search the Help index for…
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Troubleshooting an ROE report:

QuickBooks uses payroll items to generate ROE reports. That means your payroll items must 
be set up and used properly before the report will provide the information you need. Before 
creating an ROE report, you should:

� confirm you have entered the employee’s release date in his or her profile, selected the 
reason the employee is leaving from the ROE code drop-down list, and clicked OK in 
the employee profile to save your changes.

� review the way your payroll items map to ROE forms, if you changed from the default 
settings in the payroll item wizard. (Note: Intuit recommends not changing from the 
default settings.) Create a Payroll Item Listing report (at the bottom of the Payroll Item 
list, click the Reports menu button, then select Payroll Item Listing) and look in the 
ROE Period column (you may have to scroll to the right to see it):

- Most payroll items should be mapped as "For which they are paid." This option 
means you are assigning the employee’s earnings to the pay period during which 
the employee actually did the work, even if you are paying for that work later. For 
example, an employee earns his or her salary or hourly wages when he or she does 
the work for you, not when you issue his or her pay cheque two weeks later.

Note: If you have no payroll items mapped with the "For which they are paid" option, 
QuickBooks cannot create an ROE report.

- Some payroll items can be mapped as "In which they are paid." This option means 
you are assigning the employee’s earnings to the day you issued the pay cheque, 
regardless of when the employee did the work. For example, if you give an 
employee a bonus, HRDC believes that you are not rewarding any specific hour or 
day of work — just his or her performance in general. Therefore, the employee is 
considered to have earned the bonus on the day you issue the cheque for it.

If your payroll items are not mapped to the ROE properly, in the Payroll Item Listing 
report, double-click the payroll item to change. QuickBooks starts the payroll item 
wizard. Click Next until you reach the Record of Employment Tracking screen, then 
choose the correct options for this payroll item. Click the Help button in the payroll 
item wizard for more information.

� confirm you have used the correct payroll items to pay the employee, so that he or she 
has "For which they are paid" payroll items QuickBooks can use to calculate the ROE.

To learn about…
Search the Help index 
for…

Hiring a new employee employees, adding

Releasing an employee employees, releasing

Creating a Record of Employment 
for an employee

record of employment
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Hiding, showing, or merging employees

You can’t delete an employee who has existing payroll transactions. Instead, you can hide 
an employee on the Employee list by making the employee inactive.

When you make an employee inactive, QuickBooks keeps the information for the employee 
but hides the employee’s name on the Employee list and removes it from most drop-down 
lists that use employees. However, the employee’s payroll figures still appear on payroll 
reports. You do not need to change or delete any transaction that uses the employee. You 
can make an employee active again at any time.

If the same employee appears in your Employee list twice, you can merge the two names if 
there are no payroll transactions for either instance. Merging employees is not reversible.

Contacting your employees by mail

In all QuickBooks editions except Basic, you can use your QuickBooks data in conjunction 
with prewritten Microsoft Word letters to mail your employees notices about such matters 
as accrued vacation and sick time.

To learn about… Search the Help index for…

Making employees inactive, hid-
ing them, or showing them

employees, hiding and showing

Merging employee names employees, merging two names

Deleting an unused employee employees, deleting

To learn about…
Search the Help index 
for…

Using your QuickBooks data with 
Microsoft Word letters

letters using QuickBooks data in 
Microsoft Word
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Running payroll and paying taxes

Note: Before you begin writing pay cheques, be sure that your payroll system is set up completely and 
correctly (see page 179). Also, go online to get the latest payroll update, which includes the most 
current tax information available.

Selecting employees to pay

To select which employees you want to pay:
� From the Employees menu, choose Pay Employees. 

When you’ve selected the employees you want to pay, click Create to display pay cheque 
information for the first employee.

Tip: You can pay employees in groups. For example, first select all of your salaried employees whose 
pay cheques you don’t need to review and the "Create cheque without preview" option, then click 
Create. Next select your hourly employees and the "Enter hours and preview" option, then click 
Create. The pay cheques of the hourly employees appear so you can enter their hours worked.

QuickBooks creates a pay cheque for each employee 
you select. You can sort the list by either the 
employee’s first or last name, according to the setting 
in Payroll and Employee Preferences

QuickBooks draws 
the cheque from this 
bank account.

If you print cheques, 
select this checkbox.

If you write them 
by hand, clear the 
checkbox and enter 
the number of the first 
cheque in the field.

The Pay Period Ends 
field shows the next 
date that an employee 
in the list should be paid 
according to the pay 
frequencies you set up. 
If you have not yet paid 
an employee in the list, 
the field shows today’s 
date. 

The cheque field 
defaults to today’s date.

When you create a pay cheque, 
this date changes to the next 
pay period end date.

If all your employees are salaried and 
receive a standard pay cheque for this 
pay period, select this option.

If you enter hours worked, commission bases, 
vacation pay, accrued time, or other variations 
from pay period to pay period, select this option.
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Previewing, adjusting, and creating pay cheques

When you select Enter hours and preview cheque before creating in the Select Employees 
To Pay window, then click Create, QuickBooks displays the Preview Pay Cheque window.

In the Preview Pay Cheque window, you can do all of the following:

� View the amounts QuickBooks calculated for each payroll item (including gross 
earnings, government withholding, and all other additions, deductions, and company 
contributions) for the pay cheque.

� Type or edit the number of hours worked.

� Enter accrued time or vacation pay, or prevent these from accruing on this pay cheque.

� Enter the base quantity on which to calculate commissions and other additions, deduc-
tions, or company contributions based on quantity.

� Add or delete wage, commission, bonus, addition, deduction, or company contribution 
payroll items.

Note: To suppress payment of regular salary on a bonus cheque, delete the salary item in the Preview 
Pay Cheque window (select it and press CTRL+DEL) or edit the amount of the salary to zero in 
the Rate column.

The Company Summary shows company-
paid taxes and contributions that do not 
affect the amount of the pay cheque.

The Employee 
Summary shows 
wages, commis-
sions, withheld 
amounts, and other 
additions and 
deductions that 
print on the voucher 
of the cheque.

The cheque total.

If the employee is 
paid by the hour, type 
or edit the number of 
hours worked at each 
rate of pay. 

(QuickBooks Pro fills 
in hours worked 
either from time data 
or from the last pay 
cheque.)

If a commission, 
addition, deduction, 
or company contri-
bution is based on 
quantity, enter the 
quantity here.

To prevent vacation 
pay and accrued 
hours from accruing 
on this pay cheque 
only (for example, if 
it is a commission or 
bonus pay cheque), 
select this checkbox.

QuickBooks is more accurate than printed tax tables.

You may notice differences between the calculations in QuickBooks and the CCRA’s 
printed tax tables for different wage brackets. Because QuickBooks uses a very accurate 
method to calculate withholding amounts and tax tables that are annualized (rather 
than weekly, biweekly, or monthly), it may differ from printed tables by a few dollars.
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� Edit the amount for any payroll item.

After reviewing the employee’s pay cheque, click Create to go on the next employee, or, if 
you’ve paid all your employees, return to the Select Employees to Pay window.

If you’re using direct deposit, when you click Send Direct Deposit after you’ve entered all 
of your employees’ pay cheques, QuickBooks asks if you want to send the pay cheques to 
the payroll service now. Click OK to go online and send the pay cheques.

When you pay an employee, QuickBooks does the following:

� Updates the pay period end date of the last cheque written for the employee.

� Creates a pay cheque for your employee for the net amount, showing the deductions 
in the voucher area, or a direct deposit payment to be sent to the payroll service later.

� Increases or decreases the employee’s accrued time by the number of hours and 
vacation pay by the amount entered for the pay cheque.

If you selected the Do not accrue checkbox in the Preview Pay Cheque window, you 
prevented the accrued time and vacation pay from accruing for this pay cheque only.

� Updates year-to-date balances for the employee.

� Draws the amount of the pay cheque from the bank account you chose.

If you are using direct deposit, QuickBooks does not draw the amount from your 
account until you go online and send the pay cheque to the payroll service.

� Records an increase in each affected liability account, showing the extra liability 
resulting from this payroll transaction (for both the employee’s pay cheque deductions 
and company contributions).

If you are using direct deposit, QuickBooks increases your Direct Deposit Liabilities 
account, which returns to a $0.00 balance after you go online and send the payment 
to the payroll service.

� Updates and tracks your payroll expenses in expense accounts.

� Updates any other accounts you have assigned to any payroll items used in the payroll 
transaction. 

To learn about… Search the Help index for…

Previewing and adjusting 
pay cheques

pay cheques, checking amounts in
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Reviewing and correcting pay cheques

After you’ve recorded a pay cheque, you can review it at any time. You should rarely need 
to make changes to pay cheques or void them, but you can do so if necessary (from the 
Employees menu, select Edit/Void Pay Cheques).

For example, you may want to:

� Void a pay cheque if there was a payroll error in a recent pay cheque that your 
employee has not yet cashed.

Note: If you file payroll tax forms (such as a PD7A) for the period covering a pay cheque, then void that 
pay cheque, you may have to re-file your tax forms. It may be easier to write a “regular” cheque 
(using the Write Cheques window) to the employee for the difference and adjust your payroll 
liability amounts manually, but you should consult your accountant before doing so.

� Delete a pay cheque if it is a duplicate and you haven’t printed it yet.

Printing pay cheques and pay stubs

You can print all your pay cheques at one time, but you must print them separately from 
other cheques. Set up your printer for pay cheques the same way as for other cheques.

Tip: For information about aligning pay cheques in your printer, see “Solving printing problems” on 
page 142.

If you don’t print pay cheques with vouchers, you can print pay stubs for your employees 
instead, from the same screen (the Select Employee to Pay window). Like pay cheques, pay 
stubs provide all required legal information, including:

� The employee’s full name, address, and Social Insurance Number.

� Pay period start and end dates.

� Salary or hourly rate and hours, and amount of pay for the pay period.

� Government withholding amounts (such as income tax, EI, and CPP/QPP), and other 
deductions from and additions to wages.

� Taxable company contributions, such as the taxable portion of company-paid group 
life insurance.

� (Optional) Accrued time and vacation pay used and remaining.

� Net pay.

� Year-to-date amounts for the preceding items.

To learn about… Search the Help index for…

Editing existing pay cheques pay cheques, changing

Voiding pay cheques pay cheques, voiding

Deleting pay cheques pay cheques, deleting
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To select what information appears in voucher pay cheques and pay stubs, click the Printing 
Preferences button in the Payroll & Employees preferences (from the Edit menu, select 
Preferences, select Payroll & Employees from the options on the left, and click the 
Company Preferences tab). QuickBooks prints pay stubs in portrait format. 

Employees who are set up for direct deposit should receive an Advice of Deposit form 
instead of a pay stub. 

For information on purchasing blank voucher cheques, pay stubs, or Advice of Deposit 
forms from Intuit, visit the Web site at http://www.intuitsupplies.ca/

Paying payroll liabilities and filing payroll forms
When it’s time to pay your payroll liabilities, QuickBooks shows you how much you owe 
and to whom, lets you choose which liabilities to pay, and creates the cheques for you. It 
also helps you fill in the forms to send to the government with your payment.

Some types of businesses and businesses in some regions have to complete different payroll 
forms from the ones discussed here. Be sure to discuss your business with the CCRA and 
your accountant to ensure your payroll meets all the regulations that apply to it.

To learn about… Search the Help index for…

Printing pay cheques pay cheques, printing

Printing pay stubs pay stubs

Creating direct deposit payments pay cheques, direct deposit

Step Procedure

1 Create a Payroll Liabilities report (from the Reports menu, select Employ-
ees & Payroll, then Payroll Liability Balances) to see how much you owe, 
to whom, and for what.

2 Adjust the amounts you owe, if necessary. (It usually isn’t!)

3 Use the Pay Liabilities window to create cheques for the amounts you 
owe.

4 Fill in a PD7A form to send to the CCRA along with your payment.

5 In Québec, fill in a TPZ-1015 form to send to the Minister of Revenue with 
your payment.
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Adjusting a payroll liability

In rare cases, you may find that the amount for a payroll item tracking a liability doesn’t 
match what you actually owe. For example, there may be a discrepancy due to rounding. 
You can adjust your payroll liabilities with the Liability Adjustment window.

1 From the Employees menu, choose Process Payroll Liabilities, then Adjust Payroll 
Liabilities.

2 (Optional) Click Accounts Affected to select how the adjustment will affect your 
accounts.

� If your liability and expense accounts have the wrong totals as well as your liabil-
ities (the usual case), you should choose to affect your accounts.

� If your liabilities are wrong but your liability and expense accounts have the 
correct totals, choose to not affect your accounts.

3 Click OK.

4 If you chose to affect your liability and expense accounts in Step 2 and the payroll item 
you are adjusting is used to withhold amounts from pay cheques, QuickBooks asks you 
to choose an expense account to adjust so your accounts will be balanced.

Type the name of the expense account you want to adjust, then click OK. (Most people 
choose Payroll Expenses.)

Enter the date 
you want this 
adjustment to 
affect your 
payroll liability 
account.

Enter the amount of the 
adjustment.

A positive amount increases 
what you owe. A negative 
amount reduces what you owe.

For example, if the Liability by 
Payroll Item report says that 
you owe $450 but you know 
you owe $477.89, enter the 
difference: 27.89.

Select a payroll 
item to adjust.

To learn about… Search the Help index for…

Adjusting payroll liabilities payroll liabilities, adjusting
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Creating a cheque to pay payroll liabilities

Most businesses must send a cheque to the CCRA for last month’s payroll deductions by the 
15th of the current month. Check with the CCRA or your accountant to see what’s right for 
your business. Then consider setting up a reminder note in the To Do list.

To pay your payroll liabilities:

1 From the Employees menu, choose Process Payroll Liabilities, then Pay Payroll 
Liabilities.

2 Type the date range for the liabilities you want to pay, then click OK.

Note: Check these dates carefully as QuickBooks uses them to create the PD7A report. You use this 
report to fill in a PD7A form to submit with your liability payment each month.

3 In the Pay Liabilities window, mark the payroll items you want to pay.

� These liabilities can be selected and paid only as a group: CPP Employee, CPP 
Employer, EI Employee, EI Employer, Federal Income Tax Withholding, and other 
federal withholding items.

Always use the Pay Liabilities window to write cheques for your liabilities.

Do not use the Write Cheques window! If you do, QuickBooks does not update your 
payroll liability accounts, and your payroll reports will not be accurate.

The window shows liabilities owed as of the end of last 
month that are not yet paid. Change these dates if you 
pay more than once a month.

This is the date the 
transaction affects 
your chequing 
account.

QuickBooks displays 
this date on the 
liability cheque as the 
paid-through date.

If you want, you can 
change the amount 
you’re paying in this 
column.

Click here to generate a Payroll 
Liabilities report for this period.

Select this checkbox 
to show all payroll 
liabilities for the 
period, including any 
credits and zero 
amounts.

If you use QuickBooks 
to print cheques, 
select this checkbox.

If you write cheques 
by hand, clear it.

Mark the liabilities 
you want to pay. 
QuickBooks creates 
one cheque per 
liability payee (like 
the Receiver 
General), not one 
cheque per liability.

To add a name that’s 
missing in the 
Payable To column of 
this window, edit the 
payroll item.
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4 Select whether you want to review the cheque(s), then click Create.

� After you create a cheque, the Payroll Liabilities report shows a decrease in the 
amount you owe to reflect the payment. However, the PD7A Summary report 
shows the amount you owed for the period regardless of payments you’ve made.

Creating a PD7A report

Along with your monthly payment to the CCRA, you need to submit a PD7A (Current 
Source Deductions Remittance) form. On this form, you report the federal income tax 
amounts, EI premiums, and CPP contributions you withheld from your employees’ pay 
cheques over the past month.

To help you prepare this form, QuickBooks provides a PD7A Summary report.

1 From the Reports menu, choose Employees & Payroll, then PD7A Summary.

2 Check that the dates show the correct payroll deductions period (they probably don’t!), 
and type new dates if necessary.

3 Click OK to generate the report.

4 Use the information on this report to fill in your PD7A form.

To learn about… Search the Help index for…

Paying payroll liabilities payroll liabilities, paying

Adding a name missing in the 
Payable To column

payroll items, editing

Creating a report that shows your 
payroll liabilities

payroll, reports about

Entering a discount for payroll 
liabilities

payroll liabilities, discounts

Entering a penalty for payroll 
liabilities

payroll liabilities, penalties

Entering a refund cheque for 
overpayment of payroll liabilities

payroll liabilities, refund cheque
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Creating a TPZ-1015 report

In Québec, along with your monthly payment to the Minister of Revenue, you need to 
submit a TPZ-1015 form. On this form, you report the Québec income tax amounts and 
QPP contributions you withheld from your employees’ pay cheques over the past month.

To help you prepare this form, QuickBooks provides a Québec Remittance report.

1 From the Reports menu, choose Employees & Payroll, then Québec Remittance 
Report (TPZ-1015).

2 Check that the dates show the correct payroll deductions period (they probably don’t!), 
and type new dates if necessary.

3 Click OK to generate the report.

4 Use the information on this report to fill in your TPZ-1015 form.

Gathering information for other tax forms

Your business may also be required to file other payroll forms. Though you cannot prepare 
these forms in QuickBooks, you can generate reports to help you gather the information 
you need to prepare the forms. For more information about these reports, see “Getting 
information about your payroll” on page 220.

Creating year-end T4 and Relevé 1 slips
T4 (Statement of Remuneration Paid) and Relevé 1 (RL-1) slips are end-of-year payroll 
forms that show an employee’s wages and payroll deductions for the past year. In January 
or February, you need to create these slips for your employees, the Canada Customs and 
Revenue Agency, and, in Québec, the Minister of Revenue. 

You also need to complete a T4 Summary form (which summarizes your employee’s T4 
slips) for the CCRA and, in Québec, an RLZ-1 form (which summarizes your employee’s 
Relevé 1 slips) for the Minister of Revenue. QuickBooks helps you fill in these forms, too.

Preparing year-end payroll forms

Step Procedure

1 Consult your accountant, the CCRA, and provincial guidelines about how 
to report any benefits or amounts you’re not certain about.

2 In QuickBooks, create and review a T4 slip for each employee who 
worked for you during the last year (see “Creating and reviewing year-
end payroll slips” below). Enter any adjustments you need to make.

3 For each employee, print two copies of his or her T4 slip. Give them to the 
employee by the last day of February.
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Creating and reviewing year-end payroll slips

You create both T4 and Relevé 1 slips the same way.

1 From the Employees menu, choose either Process T4s or Process Relevé 1s.

2 Choose the correct year from the drop-down list. Usually, you create year-end slips for 
the year that just ended.

3 Select the employees to create year-end slips for.

4 Click either Review T4s or Review Relevé 1s.

5 Carefully review the first employee’s slip.

6 To correct employer or employee information, click Cancel and make the changes in 
the following places:

� To correct the name, address, or business number of the employer (that is, your 
company), select Company Information from the Company menu.

� To correct the employee’s name, address, or Social Insurance Number, select 
Employee List from the Employee menu, then double-click the employee to edit.

7 To adjust the amount in a box, double-click the box, then enter the adjustment in the 
window that appears.

� (Optional) Type a description to remind you about what this adjustment is for.

� Type the adjustment, then click OK.

Note: QuickBooks adds the adjustment to the amount in the box. To reduce the amount in 
the box, put a minus sign (-) before the adjustment.

8 To approve the form (with changes, if any), click Next.

9 Repeat Steps 5 through 8 for the remaining employees.

10 On the last form, click OK.

4 If you created 70 or fewer T4 slips, file them electronically with the CCRA 
through the Internet.
If you created more than 70 slips or you do not have an Internet connec-
tion, print one T4 slip per employee and to mail to the CCRA by the last 
day of February.

5 If you printed T4 slips for the CCRA, fill in a T4 Summary form to send to 
the CCRA along with the slips.
If you E-Filed the T4 slips, you do not need to fill in a T4 Summary form.

6 In Québec, repeat Steps 2 and 3 for Relevé 1 forms.

7 In Québec, fill in an RLZ-1 form to send to the Minister of Revenue.

Step Procedure
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Printing or E-Filing year-end payroll slips

After you’ve created and reviewed year-end T4 and Relevé 1 slips for your employees (see 
“Creating and reviewing year-end payroll slips” on page 217), you can print them out. 
QuickBooks allows you to print on either blank paper or preprinted forms.

To print year-end T4 or Relevé 1 slips:
1 Confirm that the employees whose slips you want to print are selected.

2 Click Print T4s or Print Relevé 1s.

3 Choose the printer to use; whether to print on blank paper or preprinted forms; and 
whether the forms you are printing are for you, the employee, or for the government; 
then click Print.

4 Distribute the slips:

� Give each employee two copies of the T4 slip and send one copy to the CCRA. You 
may want to print another copy for your records.

Note: Although QuickBooks displays your business number when you preview T4 slips, 
QuickBooks will not print it on the employees’ copies of the T4 slips.

� Give each employee two copies of the Relevé 1 and send one copy to the Québec 
Minister of Revenue. You may want to print another copy for your records.

E-Filing year-end T4 slips with the CCRA

If you created fewer than 70 T4 slips, you can submit them to the CCRA through the 
Internet rather than through the mail. If you do, be sure to:

� install MSXML 4.0 or later on your system (available at no cost through 
http://download.microsoft.com/ ), if QuickBooks prompts you to.

� contact the CCRA for a Web Access Code and a Magnetic Media Number (also 
called a Transmitter Number), if you do not have one. You can visit their Web site 
at http://www.ccra-adrc.gc.ca/tax/business/t4internet/menu-e.html

� E-File all your T4s at once rather than in batches.

� ensure that T4s for employees with more than six ’other’ or ’special’ boxes have 
been returned to their original state (after printing their second T4 slips).

QuickBooks prints only six T4 codes per slip.

If you have an employee who requires more than six ’other’ or ’special’ boxes 
on a T4 slip, create a second slip for him or her after you print all other slips. 
The second T4 slip should show only the extra codes. For more information, 
look in the help index for T4 slips, six codes or more.
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Note: Check the business number that the CCRA issued to you. (From the Edit menu, select Prefer-
ences, then select Employees & Payroll from the list on the left and click the Company tab.) The 
business number should be in this format: your nine-digit registration number, then a two letter 
program identifier, then four more numbers (e.g. 123456789RP1234). If your business number 
does not contain the letters "RP", contact the CCRA. You cannot E-File T4 slips until your 
business number is updated.

To E-File year-end T4 slips with the CCRA:
1 Confirm that the employees whose slips you want to E-File are selected.

2 Click E-File T4s.

3 Fill in the E-File window:

� Enter your Magnetic Media number in the Transmitter Number field.

� If your company is a sole proprietorship or partnership, enter your and your 
partner’s Social Insurance Numbers in the SIN fields.

4 Click Send. 

� QuickBooks compiles an .xml file containing your T4 data. This file has the name 
'_T4Slips.xml' and is stored in your QuickBooks directory. You will need to enter 
the path to and name of this .xml file, your Business Number, and your Web Access 
Code when QuickBooks opens the CCRA Web site for you.

Filling in a T4 Summary form

Along with your employees’ T4 slips, you need to send a T4 Summary form to the CCRA. 
To help you prepare this form, QuickBooks provides a T4 Summary report.

Note: If you sent your employees’ T4 slips to the CCRA through the Internet (E-File), you do not need 
to create a T4 Summary form.

1 From the Reports menu, choose Employees & Payroll, then T4 Summary.

2 Make sure the date range is correct for your reporting period (it probably isn’t!), and 
enter new dates if necessary.

3 Click OK to generate the report.

4 Use the figures on the report to fill in your T4 Summary form.

Filling in an RLZ-1 form

In Québec, when you send your employees’ Relevé 1 slips to the Minister of Revenue, you 
also need to include an RLZ-1 form. To help you prepare this form, QuickBooks provides a 
Relevé 1 Summary report.

1 From the Reports menu, choose Employees & Payroll, then Relevé 1 Summary.

2 Make sure the date range is correct for your reporting period (it probably isn’t!), and 
enter new dates if necessary.

3 Click OK to generate the report.

4 Use the figures on the report to fill in your Relevé 1 Summary form.
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Getting information about your payroll

QuickBooks Payroll Reports

Use these QuickBooks reports to gather the payroll information you need:

Report Description

Payroll summary Shows the total wages, taxes withheld, deductions from net 
pay, additions to net pay, and employer-paid taxes and contri-
butions for each employee on your payroll. 

Payroll item detail Lists the payroll transactions on which each payroll item 
appears. For example, you could use this report to find out 
which pay cheques had deductions for disability insurance. 

Payroll detail review Provides detailed information about how QuickBooks calcu-
lates tax amounts on employee pay cheques and in year-to-
date transactions. You can use this report as a research tool to 
see exactly what numbers QuickBooks used to calculate the 
tax amounts. 

Employee earnings 
summary

Shows information similar to the payroll summary report, but 
in a different layout. 

Payroll transactions 
by payee

Lists payroll transactions, grouping them by payee. For exam-
ple, you could use this report to create a listing of the pay 
cheques your company paid to each employee. 

Payroll transaction 
detail

Shows the line item detail that appears on each payroll trans-
action.

Payroll liability bal-
ances

Lists the payroll liabilities your company owes to the agencies, 
such as the CCRA, insurance plan administrators, and labour 
unions.

Employee withhold-
ing

Shows withholding information for each employee. 

Employee Quick-
Report 

Lists chronologically the transactions related to a particular 
employee.

Payroll item listing Shows detailed information about each payroll item you use to 
track payroll-related expenses and liabilities. 

Payroll item Quick-
Report report

Lists chronologically the payroll transactions that contain a 
particular payroll item
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Finding out how much you owe for payroll liabilities

Let’s say you want to see how much you currently owe for each payroll tax for the current 
payroll period.

You can find out quickly by creating a payroll liability balances report. The report shows 
liabilities incurred during the date range specified that are still unpaid.

Finding out how much you spend on your payroll

Let’s say you want to know how much money you spend on your payroll. You can run a 
payroll summary report to see your payroll totals by employee and for the whole company 
for a single payroll period.

You can change the date 
range to cover this year 
to date, last quarter, or 
any period you want.

The adjusted gross pay 
equals gross pay minus 
deductions from gross.

The net pay is the actual 
amount of money the 
employee(s) received. 
This amount is usually 
less than gross pay due to 
taxes withheld and other 
after-tax deductions.

The gross pay includes 
commissions and 
additions to gross. This 
represents the total 
payroll expenses, not 
including the employer-
portion for employment 
taxes and other 
contributions.

For taxes and company 
contributions, the amounts 
are liabilities accrued during 
the period.
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Figuring out what wage amount each tax is based on

For each tax amount on employee paycheques, you want to check the amount of wages it 
is based on. You can generate the payroll detail report to see the amount for every wage base 
and tax transaction on paycheques.

To learn about… Search the Help index for…

payroll reports payroll, reports about
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Should I track time?
QuickBooks Pro and better provide time-tracking capability to suit your needs:

� The Stopwatch: When you’re working in QuickBooks and want to take a stopwatch 
approach (that is, turn on a timer, work, and then stop the timer), use the Stopwatch 
on the Time/Enter Single Activity window.

� The QuickBooks Pro Timer: The Timer is a separate program that runs on Windows on 
any computer. Because it’s separate, you can distribute copies of the Timer to people 
who don’t have access to QuickBooks, such as employees and subcontractors. Then you 
can merge their time data into the QuickBooks company file.

� You can also enter time data manually into QuickBooks in the Weekly Timesheet 
window or Time/Enter Single Activity window. 

Tracking time can help you make better decisions about work capacity, future hiring needs, 
and employee productivity.

Furthermore, if you track the time you, your employees, or your subcontractors spend on 
each job, you’ll be able to do the following:

� Invoice customers based on the number of hours of work done for them.

� Automatically fill in hours on pay cheques.

� When paying subcontractors, automatically fill in hours on cheques and bills.

� Track payroll costs by job, class, or type of work.

� Report hours worked by person, job, or type of work. 

� Track billable versus non-billable time.

Should I make time billable?

When you record time worked for a particular customer or job, one option is to mark it as 
billable. Then, when you invoice the customer, you can add the billable time to the invoice 
with a few clicks. After you put the time on a sales form, QuickBooks marks it as billed, so 
you won’t charge a customer twice for the same thing.

If the work done by employees is billable to customers, it becomes billable as soon as you 
record the time in QuickBooks. It doesn’t matter whether you have paid the employees yet.

Some businesses track time without making it billable. For example, if you agree to do a job 
at a fixed price, you would not invoice for time. However, you might still want to track time 
so you can decide after completing the job whether you set the right price.

Also, you can track accrued time (like sick time), which is normally not billable.
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Should I track time for subcontractors?

Most businesses don’t need to track time for subcontractors, with a few exceptions:

� On time reports, you want to see all time for a particular job, whether for an employee, 
a subcontractor, or an owner.

� Glenn’s company has only one employee now. By tracking time worked by subcon-
tractors, he’ll know what to expect when he has employees doing this type of work in 
the future.

� You want to track subcontractor time independently of the time subcontractors report 
on the bills they submit to you.

� Jill gives subcontractors copies of the Timer program and asks them to return time data 
to her weekly so she can track how many hours have been spent on her project long 
before she receives the bills.

� You want to pay subcontractors based on time worked, using the time information 
entered in QuickBooks.

� Eric tracks time for subcontractors and pays them within 30 days. On a weekly basis, 
Eric enters a bill for each subcontractor and transfers the time worked during the 
previous week.

How much detail should I track for time activities?

You track time based on activities. Each activity needs, at a minimum, the following to 
describe it:

� Name of person who did the work

� Date the work was done

� Time spent doing the work

The level of detail you include when tracking an activity depends on whether or not it’s 
billable and how much detail you want in your reports.

Describe an activity 
by specifying …

Comment

Name of person who did 
the work

Required.

Date the work was done Required; each activity can be for only one date.

Time spent doing the work Required. (If you use the Timer or the Stopwatch to time an activity, fill in 
the time spent.)

Customer (and job) the 
work is for

Required only if you plan to invoice for the time.
Even if you don’t invoice for the time: 
� Allows you to report on hours worked by customer and job.
� Allows you to track payroll expenses by customer and job.
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Choosing a method to track time

QuickBooks Pro and better come with a separate Timer program that can run on a computer 
regardless of whether QuickBooks is on the same computer. You have a choice between

� tracking time via the Timer and then transferring the time data to QuickBooks,

� using the Stopwatch on the Time/Enter Single Activity window, 

� or entering time data directly into QuickBooks manually on the Weekly Timesheet 
window or the Time/Enter Single Activity window.

Type of work (described 
by a service item from the 
Item list)

Required only if you plan to invoice for the time.
Even if you don’t invoice for the time: 
� Allows you to report on hours worked by type of work.
� Allows you to track payroll expenses by type of work.

Whether time is billable Time must be billable if you plan to invoice for the time.

Class If your company does class tracking, you can do the following:
� Filter time reports by class.
� If you are set up to split payroll expenses by class, you can assign 

classes to employee time. Then you can automatically track all payroll 
expenses by class.

Describe an activity 
by specifying …

Comment

Situation How to track time See…

You have access to QuickBooks and 
want to use a stopwatch approach to 
time tracking: turn on a timer, work, 
then stop the timer. 

Use the Stopwatch in the 
Time/ Enter Single Activity 
window in QuickBooks Pro 
or better.

� “Setting up QuickBooks to 
track time” on page 227

� “Using the Stopwatch to 
time an activity” on 
page 235

You want people who don’t have 
access to QuickBooks to track their 
own time.

Distribute copies of the 
QuickBooks Pro Timer to 
these people and have them 
give you their time data.

� “Setting up QuickBooks to 
track time” on page 227

� “Setting up and using the 
Timer” on page 229

� “Importing Timer data into 
QuickBooks” on page 234

� “” on page 245

You (and others in your company) 
have access to QuickBooks and want 
to enter time data after the work is 
done.

Enter time data directly into 
QuickBooks Pro or better, 
either on a weekly timesheet 
or as separate activities one 
at a time.

� “Setting up QuickBooks to 
track time” on page 227

� “Entering time manually into 
QuickBooks” on page 236
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Setting up QuickBooks to track time
The following list is for tasks you must do in QuickBooks to prepare for tracking time.

Your employees submit paper 
timesheets.

One person can enter every-
one’s time data directly into 
QuickBooks Pro or better on 
a weekly timesheet for each 
person.

� “Setting up QuickBooks to 
track time” on page 227

� “Entering time manually into 
QuickBooks” on page 236

Situation How to track time See…

A QuickBooks user must do this preparation before Timer users can set up 
their own Timers.

What to do Comments
Search the Help 
index for…

�

Turn on time tracking and indicate 
the first day of your work week

The weekly timesheet starts with 
the day of the week you specify.

preferences, time ❏

On the Customer:Job list, set up 
the customers and jobs for which 
time will be tracked.

� customers, adding 
new

� jobs, adding new

❏

On the Item list, set up service 
items that describe the type of 
work that will be tracked.

Service items are required only if 
you make the time billable to a 
customer or job.
Be sure to create different service 
items for subcontracted services.

� service items, 
setting up

� subcontractors, 
service items for

❏

On the Class list, set up classes for 
the work to be tracked

Class tracking is optional. classes, adding ❏

On the Payroll Item list, set up 
salary or hourly wage payroll items 
to use when paying employees for 
time tracked

Required only if you will track 
time for employees and pay 
them using the QuickBooks Pay-
roll Service

� hourly wages
� salaries

❏
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Setting up to use time tracking with payroll

As part of the payroll setup for employees, be sure 
to select the checkbox Use time data to create pay 
cheques on the employee’s Payroll Info tab.

Pay cheques will then automatically have the employees’ time data (including job, class, 
and type of work) for the period covered by the pay cheque. QuickBooks keeps track of your 
payroll expenses for hourly or salaried gross pay, employer taxes, and other payroll 
overhead by job, class, and type of work.

Viewing, editing, and printing time data

In addition to creating reports about time data, you can view, print, and edit time data as 
follows:

� View a timesheet for one person’s work during a particular week.

� Print timesheets (each with one person’s work for one week or part of a week).

� View the full text of the note entered for a particular activity.

� Edit time data.

Set up the people whose time will 
be tracked.
Each person must be on one of the 
following lists:
� Employee
� Other Name (for owners and 

partners)
� Vendor (for subcontractors)

If you plan to use time tracking to 
help with payroll for any employ-
ees, you must also set up payroll 
information for those employees. 
See:
� “Setting up to use time track-

ing with payroll” below
� “Setting up employees” on 

page 191

� employees, adding
� other names, list of 
� vendors, adding

❏

What to do Comments
Search the Help 
index for…

�

To learn about… Search the Help index for…

Viewing and printing timesheets timesheets

Adding notes about an activity to 
an invoice

invoices, time and cost

Adding notes about an activity to 
a time report

time, reports about

Editing time data time, entering
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Setting up and using the Timer

How the Timer works with QuickBooks

The QuickBooks Pro Timer is designed to track and record time data which you can then 
export to QuickBooks Pro (or better). Use the Timer when you want to gather time data 
from people who don’t have access to QuickBooks but do have access to a computer.

You can make copies of the Timer program to give to other people whose time you want to 
track in QuickBooks. When you do, photocopy the two-page Quick Reference Sheet on 
page 246 for them as well.

Note: If you distributed the Timer program that came with an earlier version of QuickBooks, replace 
those copies with the Timer program that comes with this version of QuickBooks. The newer 
version of the Timer can update data files created by the earlier version.

This flowchart shows the relationship between the Timer and QuickBooks.

The two programs share information this way:

� QuickBooks Pro or better exports lists for the Timer to use.

� The Timer imports those lists.

� The Timer records data about time activities for the jobs, then exports it.

� QuickBooks Pro or QuickBooks Premier imports the time data and makes it part of the 
company file.

Note: If you simply want to time an activity in QuickBooks—not gather time data from others—use the 
Stopwatch instead. See “Using the Stopwatch to time an activity” on page 235.
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Setting up the Timer

Before you can set up the Timer, you must first install it (see “Pro or Premier Timer 
Reference Sheet” on page 246). Also, be sure to do all the tasks on the following task list. 
The task list for setting up the Timer shows whether the QuickBooks user or the Timer user 
has to do the task (in case they are not the same person).

Exporting lists from QuickBooks for the Timer

The first step in getting the Timer ready to use is to prepare a file with the information the 
timer needs in order to work with QuickBooks Pro and Premier. The Timer must describe 
activities using the same names that are on the lists in QuickBooks.

To create an IIF file for the Timer, from the File menu in QuickBooks, select Timer, then 
Export Lists for Timer. Now follow the instructions on your screen. If the Timer will be used 
on another computer, the exported IIF file should be copied either to a 3.5-inch disk or on 
a network that both computers can access.

Task
Which user 
and which 
Help index?

Search the Help 
index for…

�

Export QuickBooks lists for the 
Timer and give the file to the 
Timer user.

QuickBooks Timer, exporting lists to ❏

Prepare Timer install disks (if the 
Timer user can’t use the Quick-
Books CD-ROM).

QuickBooks Timer, creating disks 
for

❏

Install the Timer on the user’s 
computer.

Timer See “” on page 245. ❏

Create a Timer data file for the 
QuickBooks company file that 
will be using the Timer data.

Timer data files, creating 
(search the Timer help)

❏

Import the QuickBooks lists in 
the IIF file into the Timer data 
file.

Timer lists, importing
(search the Timer help)

❏

From the Timer’s list of users, 
choose the name of the person 
whose work will be recorded in 
this Timer file.

Timer default user
(search the Timer help)

❏



Setting up and using the Timer 231

Using the Timer

After you have done the tasks described in “Setting up QuickBooks to track time” on 
page 227 and in “Setting up and using the Timer” on page 229, you are ready to track time 
with the Timer.

Recording activities in the Timer

You can use the Timer either to time an activity while you are doing it, or to record the time 
after you have finished. 

The first time you do an activity for a given customer, job, and type of work, you have to 
set up the activity in the Timer. To understand how much detail you should include in an 
activity, see “How much detail should I track for time activities?” on page 225.

Information Timer needs Source in QuickBooks

Names of possible Timer users Employee, Vendor, and Other 
Names lists

Names of customers and jobs (if time will be 
billable to a customer or job)

Customer:Job list

Type of work that the customer may be invoiced 
for (if time will be billable)

Service-type items from the Item 
list

Names of QuickBooks classes (if time will be 
assigned to classes)

Class list

To learn about… Search the Help index for…

Preparing a file of information 
from QuickBooks that the Timer 
can use

Timer, exporting lists to

You can run the 
Timer in a larger 
window that 
shows detail or 
in a very small 
one (far right). Click this button to switch 

between minimal size and 
full size.
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If you have previously set up an activity for a given customer, job, and type of work, you 
can choose the activity from a drop-down list and use it as a template for the new day’s work 
instead of setting up a similar activity for the new day.

You can add a note while timing an activity or after completing it.

Viewing and editing recorded activities

You can view a list of the activities you’ve recorded in the Timer. However, you can’t print 
this list (or anything else) in the Timer. After you export time data to QuickBooks, the 
QuickBooks user can print the list of activities.

To learn about…
Search the Timer Help (not 
the QuickBooks Help) for…

Timing an activity while you are 
doing it

� activities, setting up for timing
� activities, timing

Recording an activity after doing it activities, entering time for manually

Recording notes about an activity activities, adding notes to

To learn about…
Search the Timer Help (not 
the QuickBooks Help) for…

Viewing a list of all recorded activ-
ities within a specified date range

activities, viewing data about

Changing information about a 
recorded activity

activities, editing data about

Deleting a recorded activity activities, deleting the record of
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Viewing and changing customer information

When you import information from the lists in QuickBooks, you import customer contact 
information as well as the customer’s names. 

If a customer is on the list imported from QuickBooks, or if you already exported Timer data 
using the customer, you can’t change information about the customer. Instead, the 
QuickBooks user must change the information and give you an updated list file.

You can add a new customer to use when recording an activity. However, you cannot add 
a job for a new or existing customer. The Help topic suggests what to do instead.

Managing Timer data files

From time to time, you will need to update the lists in your Timer data to make them match 
those in the QuickBooks company file. The QuickBooks user must prepare the updated list 
file and make it available for importing into the Timer.

If you track time for more than one QuickBooks company, you must have separate Timer 
data files.

You can back up a Timer data file. To back up a Timer file, from the Timer’s File menu, select 
Backup. To use the backed up file again, from the Timer’s File menu, select Restore.

You can reduce the file size by using the Condense feature. The Condense feature in the 
Timer, unlike the one in QuickBooks, doesn’t remove or consolidate any information. 
Select Condense from the Timer’s File menu.

To learn about…
Search the Timer Help (not 
the QuickBooks Help) for…

Viewing contact information 
about a customer

customers, contact information for

Adding, editing, or deleting a cus-
tomer

� customers, adding
� customers, editing
� customers, deleting

To learn about…
Search the Timer Help (not 
the QuickBooks Help) for…

Updating the Timer’s lists of cus-
tomers, jobs, service items, and 
classes to match changes in the 
QuickBooks file

lists, updating

Backing up your Timer data onto 
a 3.5-inch disk or your hard disk

data files, backing up

Restoring a backup of Timer data 
so you can use or view it

data files, restoring from a backup 
disk
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Exporting Timer information to QuickBooks

When you are finished recording time, you need to export your recorded activities to an IIF 
file that QuickBooks can import. From the Timer’s File menu, select Export Time Activities.

Importing Timer data into QuickBooks

After the Timer user exports the data from the Timer into an IIF file (see “Exporting Timer 
information to QuickBooks” on page 234), you can import the data into the QuickBooks 
company file.

In addition to activities, QuickBooks imports any items on lists (that is, names, service 
items, classes) that are not currently on the corresponding QuickBooks lists. You can view 
reports of the imported list items.

Reducing the size of your Timer 
file

data files, condensing to save disk 
space

Creating a new Timer data file to 
use with a different QuickBooks 
company file

data files, creating for the Timer

Switching to a Timer data file for a 
different QuickBooks company

data files, opening

To learn about…
Search the Timer Help (not 
the QuickBooks Help) for…

Exporting activities to an IIF file 
that QuickBooks can read

activities, exporting to QuickBooks

To learn about…
Search the Timer Help (not 
the QuickBooks Help) for…

After importing information from the Timer, check the Timer Import Detail 
report (available only from the Import Summary window) to ensure that the 
correct payroll items are assigned to each activity.
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The time reports in QuickBooks report on all activities, including those imported from the 
Timer. To create a report similar to the Timer import detail report, you can customize a time 
by job detail report to add columns for payroll item and import date.

Using the Stopwatch to time an activity
Use the Stopwatch on the Time/Enter Single Activity window in QuickBooks Pro or better 
when you want to time an activity—simply start the Stopwatch, work, and stop it when 
you’ve completed the work.

� From the Employees menu, select Time Tracking, then Time/Enter Single Activity.

To see how much detail to include when you time an activity, see “How much detail should 
I track for time activities?” on page 225. 

To learn about…
Search the QuickBooks 
Help index for…

Importing data from a Timer file 
into the QuickBooks company file

Timer, importing timed activities 
from

Viewing a report of the imported 
Timer activities or the imported 
items on lists

Timer, reports about imported 
activities

Editing an imported activity in 
QuickBooks

time, entries

Viewing a report on activities 
exported to or recorded in Quick-
Books

time, reports about

Once recorded, the time 
shows up in both this 
window and in the Weekly 
Timesheet window.
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Entering time manually into QuickBooks

If you want to enter time data a week at a time and you generally don’t enter a lot of detailed 
notes about your activities, use the Weekly Timesheet window to enter time data manually.

If you enter a lot of detailed notes about your activities or prefer to enter time data as you 
complete each activity, use the Time/Enter Single Activity window.

When you fill in and record a Time/Enter Single Activity window, you can later view the 
information on a weekly timesheet.

Conversely, when you fill in and save a weekly timesheet, you can view Time/Enter Single 
Activity windows that each show the work on one job on one day. The two are simply 
different views of the same data, similar to views of individual cheques versus your cheque 
register.

On the weekly 
timesheet, the far-
right column shows 
whether the time is 
billable, not billable, 
or already billed.
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Paying for time worked

QuickBooks automatically transfers time data when you create pay cheques for employees 
who are set up for transferring time data. That is, it fills in the number of hours for each 
payroll item for salary or hourly wages included in the time data for the payroll period.

If customers or jobs, service items, or classes are assigned to an employee’s time activities, 
this detail is also included. For example, out of 40 hours altogether, 19 may be assigned to 
Job A, 11 to Job B, and the remaining 10 hours to Job C. QuickBooks then splits the payroll 
expenses for the employee according to how you assigned the time.

To learn about… Search the Help index for…

Blank timesheets timesheets, blank

Filling out a weekly timesheet timesheets

Entering details for a single 
activity

single activity entries

Using the Stopwatch to time an 
activity

Stopwatch

QuickBooks does not track whether you have paid workers for time or not, 
only whether you have passed time costs on to your customers.

If you pay a worker (employee, owner, or subcontractor) for time and then edit the time 
data or import new information from the Timer, QuickBooks does not track which time 
has been paid for and which has not. All it tracks is the end date of your last payment 
for time to the worker.

To avoid paying for the same time twice, make sure your worker has submitted all his 
or her time data for a period before you create a pay cheque covering that period —
that is, pay a worker only for work that takes place after the end date of your last time 
payment to him or her. If you accept late time data, print a Time by Job Detail report 
and mark the activities you are paying for.
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Paying nonemployees for time worked

Some businesses need to pay people who are not employees (such as owners, partners, or 
subcontractors) based on time worked. QuickBooks can transfer time data for a specified 
date range to your payment. That is, it can fill in the number of hours worked and the rate 
you pay for that type of work.

To pay a subcontractor or other vendor, you can either write a cheque (if you want to pay 
immediately) or enter a bill (to be paid at a later time). To pay an owner or partner (someone 
on your Other Names list), you can write a cheque.

Tip: Always set up subcontractors as vendors and use their vendor names when you track time and 
pay them. Then QuickBooks will show payments to subcontractors for time worked on reports.

Remember when you set up a subcontractor as a vendor, select the T4A tracking checkbox in 
the vendor profile so you can create reports to make it easier to create year-end T4A slips. If you 
have the Contractor edition of QuickBooks Premier, you can track T5018 data the same way.

Service items for nonemployee time data

If you plan to transfer time for nonemployees to a cheque or bill, the time data should have 
a service item assigned to it. QuickBooks uses the rate for "purchases" of the service item 
when calculating how much to pay a nonemployee for the hours worked.

� Service items for subcontractors (vendors)

When you pay a subcontractor set up as a vendor, the payment is an expense to the 
business. Therefore, you need to have at least one service item that affects an expense 
account when used in payments to the person. This service item should not be used for 
owners or partners.

When tracking time for a vendor, assign the time to a service item set up to track costs 
in an expense account.

� Service items for owners or partners

When you pay an owner or partner, the payment is a draw against equity, rather than 
an expense to the business. Therefore, you need to have at least one service item that 
affects the person’s equity account when used in payments to the person. This service 
item should not be used for vendors.

When tracking time for an owner or partner, assign the time to a service item set up to 
track costs in the person’s equity account.

To learn about… Search the Help index for…

Setting up an owner or partner � owners
� partners, setting up

Adding a name to the Vendor list vendors, adding

Setting up a vendor for T4A forms T4A forms
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Transferring nonemployee time to a cheque or bill

When you pay a nonemployee for time worked, use the Write Cheques window. (To pay 
employees, always use the payroll system!)

When you write the cheque or enter the bill, QuickBooks alerts you if there is time data for 
the payee for dates after the end period for the last-time payment to this payee. If you 
answer that you want to pay for time, you can specify the date range of the time to pay for. 
Then QuickBooks prefills the Items tab of the cheque with the service item, customer and 
job (if any), rate, number of hours, and amount.

To learn about… Search the Help index for…

Setting up a service item that 
includes both costs and income

service items, billing work by 
subcontractors or owners

QuickBooks does not track whether time is paid for.

If you pay for time and then edit the time data (or import data from the Timer), Quick-
Books does not track which time has been paid for and which has not. All it tracks is the 
end date of the last payment for time. 

If you always pay for time dated after the end date of the last payment, you will not pay 
for the same time twice. Otherwise, print a time by job detail report and mark the activ-
ities you are paying for.

To learn about… Search the Help index for…

Paying nonemployees for time 
worked

time, paying nonemployees for
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Charging customers for time worked and 
other costs

Charging your customer for the actual time and costs for a job is a two-step process:

1 Track the time and costs, assigning them to the specific job.

2 Transfer the time and costs to a sales form (with or without a markup) or to the register 
for the job.

The following table shows what you must do to track time or costs so that you can charge 
for them.

You can transfer time data to invoices and statement charges as long as the time data has a 
customer:job and service item and is currently marked as billable.

As you create an invoice, you can display the unbilled time for the job and select which time 
to include. When you record the invoice, QuickBooks marks the time you selected as billed, 
so you won’t bill for it again by mistake. (You can also charge for time as a statement charge 
instead of writing an invoice.)

To track… You must…

All expenses incurred for the job 
(QuickBooks only)
Miscellaneous costs incurred for 
this job (costs you prefer not to 
record by using items) (QuickBooks 
Pro and Premier only)

Record a bill, cheque, or credit card charge, 
using the Expenses tab or Time/Costs tab to 
identify the accounts and amounts for other 
costs incurred for this job.

Time billable to this job
(QuickBooks Pro and Premier only)

Record hours spent on this job, using the Timer, 
the Stopwatch, or entering time manually into 
QuickBooks. 
� Assign the hours to the service item that 

should be used on the invoice.
� To show the service date for each time entry 

on the invoice, customize the invoice to add a 
Service Date column.

� Be sure to mark the hours as billable.

Subcontracted services, products, 
materials, and other charges bill-
able for this job (QuickBooks Pro 
and Premier only)

Record a bill, cheque, or credit card charge, 
using the Items tab to identify goods and ser-
vices purchased for this job. Be sure to mark 
these items as billable.
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Reimbursable expenses in QuickBooks

When you have billable expenses in QuickBooks and are ready to invoice for them, click 
the Expenses button on an invoice for the customer or job. (If you are using QuickBooks 
Pro or Premier, see “Reimbursable time and costs in QuickBooks Pro and QuickBooks 
Premier” on page 242.)

QuickBooks displays the Choose Reimbursable Expenses window. It shows the expenses 
you have marked billable but have not yet billed to this customer or job. In this window 
you mark which billable expenses to add to the invoice.

After you click OK in the window, QuickBooks puts all the marked expenses on the invoice. 

Note: You can set up QuickBooks so that it assigns income for a reimbursed expense to an income 
account. If you don’t do this setup, the income cancels the original expense in the expense 
account. See “Items for reimbursable costs in QuickBooks Pro and Premier Editions” on page 53.

For a percentage markup, 
add a % sign after the 
number. QuickBooks prefills 
your preset markup 
percentage if you set one up 
in sales and customer 
preferences.

Most people use an income 
account for markup.

To make the marked expenses taxable 
on the invoice, select this checkbox.

To hide a markup on an 
invoice, be sure to select this 
checkbox.

This window is in 
QuickBooks Basic only, not 
QuickBooks Pro or Premier.

Click the 
Hide field 
only if you 
don’t ever 
want to 
charge this 
customer for 
the expense. 
(The bill is 
unaffected.)
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Reimbursable time and costs in 
QuickBooks Pro and QuickBooks Premier

In QuickBooks Pro or Premier, when you click the Time/Costs button on an invoice for a 
customer or job, it displays a window with three separate tabs, one for billable items, 
billable expenses, and billable time.

On the Items tab, you mark which billable items to add to the invoice.

On the sales form, QuickBooks Pro and Premier use the sales price, not the cost, for each 
inventory part and for each resale non-inventory part, subcontracted service, and 
reimbursable other charge item. You can change the price on the sales form. If you set up 
the item with a sales price of 0.00 because costs vary, be sure to enter a sales price on the 
sales form.

On the Expenses tab of QuickBooks Pro or Premier, you mark which billable expenses to 
add to the invoice. You may add a markup to your actual expenses.

This window shows all 
billable but not-yet-billed 
time and job costs for this 
particular job.

Each of the three tabs 
displays the dollar total for 
the lines that have a mark in 
the Use field. These amounts 
will be added to the invoice.

Select this checkbox to print 
only the overall total and a 
general description for the 
group of marked items on all 
three tabs.

To print an overall total but 
no detail for one tab alone, 
mark the lines on only one 
tab, select the checkbox, and 
click OK.

This is the total amount 
for marked items on all 
three tabs.

To use all lines on this tab, 
click Select All. To unmark 
all lines, click Clear All (the 
button name changes).

Click the Hide field only if you don’t ever 
want to charge this customer for the item.
(The bill is not affected.)

Time tab displays only 
if time tracking is on.

The Description and Rate fields show the sales 
description and rate for each item from the item setup. 
They may differ from the purchase description and rate. 
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Note: You can set up so that QuickBooks assigns income for a reimbursed expense to an income 
account. If you don’t do this setup, the income cancels the original expense in the expense 
account. (Your net income is the same in either case.) 

Finally, on the Time tab of QuickBooks Pro or Premier, you mark which billable time to add 
to the invoice.

In this window and on the sales form, QuickBooks Pro and Premier use the hourly rate for 
the service item you assigned to the activity, not the payroll rate of the employee. If the 
service item has the subcontractor checkbox marked, QuickBooks uses the sales price. You 
can change the rate on the sales form.

For a percentage markup, 
add a % sign after the 
number. QuickBooks prefills 
your preset markup 
percentage if you set one up 
in sales and customer 
preferences.

Most people use an income 
account for markup.

This total 
includes 
the 
markup.

To make the marked 
expenses taxable on the 
invoice, select this checkbox.

To hide the markup on an 
invoice, be sure to select this 
checkbox.

Click Change to specify the following:

� Whether to copy your time notes or the 
description of the service item into the 
Description field of the sales form.

� Whether to show each activity as a 
separate line or to combine all 
activities for the same service item.

The rates shown are the rates set up for 
each service item.

The Time tab shows all time that is 
billable for this job but has not yet been 
billed.
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To change how QuickBooks Pro or Premier groups and describes time activities on the sales 
form, click Change. 

After you click OK in the window, QuickBooks puts all the marked time and costs on the 
invoice. If you return to the window before recording the invoice, the items already on the 
invoice have an invoice symbol in the Use field.

The invoice symbol in the 
Use field indicates that the 
item has already been added 
to the invoice.

You can put given job costs on a sales form only once.

If you record a sales form that has actual job costs on it and then discover 
you made a mistake, the actual job costs you used previously are no longer 
available to use again. The only way you can reinstate such costs is to 
go to the original record (that is, weekly timesheet, single activity, bill, 
cheque, or credit card charge). Click the Billable field to make the cost 
billable again.

To learn about…
Search the QuickBooks 
Help index for…

Transferring time to invoices and 
statement charges

� invoices, time and cost
� statements, time and cost

Making time billable again if you 
billed for it mistakenly

time, making billed time billable 
again
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Recording the cost of work vs. invoicing for it

When you record time, you are not recording any costs. To record costs, you have to take 
additional action. (The same is true when you bill your customer for time worked: you are 
not recording its cost to you.) The following table shows how you record costs for time 
worked and what you have to do to invoice customers for work. 

Because recording time has no direct effect on costs, the reports about time show hours but 
they don’t show costs.

If you enter bills for subcontractors or if you pay subcontractors, owners, or partners for 
time worked, you must guard against making their work billable twice. 

Don’t make both a worker’s time and your payment to that worker for the 
time billable.

� If you make a subcontractor’s bill for time worked billable, you can invoice your 
customer in turn for the subcontractor’s charges. When you invoice the customer, 
open the Choose Billable Time and Costs window and select the subcontractor’s 
bill from the Expenses or Items tab (whichever you used on the subcontractor’s 
bill). This is the recommended method.

� If you pay a subcontractor, owner, or partner for time worked by using the Write 
Cheques window, you can make the service items on the cheque billable. Then, 
when you invoice your customer, open the Choose Billable Time and Costs 
window and select the time from the Items tab. 

� If you make the time itself billable, you can invoice for the time from the Time tab 
of the Choose Billable Time and Costs window. 

� If you make both the time and the bill or payment billable, you are in danger of 
invoicing the customer twice for the same work!

The work is 
done by …

You record the cost of 
the work when you …

To invoice other 
people for the work…

Employees Pay the employees. Make the time billable.

Subcontractors
(vendors)

Enter bills from the subcon-
tractors (or write cheques or 
enter credit card charges for 
the work).

On the bills, cheques, or credit 
card charges, make the items 
or expenses billable.
OR
Track the time and make the 
time billable.

Owners or 
partners

Payments to owners or part-
ners for time worked are a 
draw against equity, not an 
expense, and therefore do not 
affect net the profit.

Make the time billable.
OR
Write a cheque to pay for the 
time worked, and make the 
items on the cheque billable.
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The Timer and QuickBooks Pro 
or Premier

� Before you can use it, the Timer needs to import 
information from QuickBooks Pro or Premier.

� Then use the Timer to time your activities.

� Finally, export a file of time data for Quick-
Books Pro or Premier to import.

Installing from the QuickBooks 
Pro or Premier CD-ROM

Other users can only install the Timer from the 
QuickBooks CD-ROM, not QuickBooks too.

1 Insert the CD-ROM in your CD-ROM drive.

2 If the Installer starts automatically: Click Other 
Installation Options and choose Timer.

In the Installer does not start automatically. 
display the Run window: 

� Select Run from the Start menu.

Type the letter of your CD-ROM drive, then 
:\timer\install.exe and click OK.

3 Follow the instructions on your screen.

Installing from 3.5-inch disks
1 Insert the first Timer install disk in your 

3.5-inch disk drive.

2 Select Run from the Start menu.

3 Type the letter of your floppy drive, then 
\:install (for example, a:\install), then click OK.

4 Follow the instructions on your screen.

Starting the Timer

Click Start, then Programs, then QuickBooks Pro 
or QuickBooks Premier, then QuickBooks Pro 
Timer or QuickBooks Premier Timer.

Setting up the Timer
1 In the Open Timer File window (displayed the 

first time you start the Timer), choose Create 
New Timer File, then click OK.

2 Type a name for the Timer file and the location 
to save it, then click OK.

3 From the File menu of the Timer, choose Import 
QuickBooks Lists.

4 Select the name of the .IIF file to import from 
QuickBooks Pro or QuickBooks Premier. (You 
may have to navigate to a new drive or folder.) 
Click OK.

The person who works with QuickBooks Pro or 
QuickBooks Premier must make this IIF file 
available to you.

5 From the File menu of the Timer, choose Pref-
erences, then Default Name.

6 Choose your own name from the drop-down 
list.

7 If your time is always billable to a customer or 
job, select the checkbox, then click OK.

8 Fill in the fields you need and click OK.

For help with this window, click Help.

Pro or Premier Timer Reference Sheet
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Setting up an activity to time
1 In the main Timer window, click New Activity.

2 Fill in the fields you need and click OK.

Timing an activity
1 If the activity you want to time is not already in 

the Current Activity field, choose it from the 
drop-down list.

� If you choose from Today’s Activities, the 
Timer will add time to the time already 
shown for today.

� If you choose from Activity Templates, the 
Timer will start with zero time.

2 To start timing, click Start (or Resume).

3 To stop timing, click Stop.

Entering time manually
1 Choose the activity from the Activity Templates 

section of the drop-down list in the Current 
Activity field.

If the activity is not on the list, set it up first.

2 When the activity is in the Current Activity 
field, click Edit. 

3 In the Edit Activity window, change the date if 
you did not perform the work today. 

4 In the Duration field, type the time.

You may enter time in any of the following 
formats:

� Hours and minutes (for example, 01:30)

� Hours as decimals (for example, 1.5)

� Hours as fractions (for example, 1 1/2)

� Number of minutes (for example, 90)

No matter which format you use, the Timer 
displays hours and minutes when you tab out of 
the field.

5 Click OK to record the activity and its time.

Shrinking the Timer
� Click the Resize button (to the right of the Start 

button).

� To make the timer full size again, click the 
Resize button on the shrunken Timer.

Exporting Timer data for 
QuickBooks
1 From the File menu of the Timer, choose Export 

Time Activities.

2 In the Export Activities window, change the 
date through which to export all unexported 
activities if the date is not correct.

3 Click Export.

4 In the Create Export File window, specify a 
name, drive, and folder (or directory) for the IIF 
file you are creating. 

5 Click OK.

Using the Timer’s Help system

For onscreen help while using the Timer, press F1 or 
choose Help for this Window from the Help menu.

To find out how to use other Timer features (such as 
entering notes or viewing your activity data), 
choose Help Contents from the Help menu.

System requirements for the 
Timer

The Timer requires the following hardware and 
software:

� 486 PC (or higher) with a minimum of 8 MB 
(megabytes) of RAM (random access memory); 
16 MB is recommended.

� Hard disk with at least 8 MB of free disk space 
(plus space for your data file)

� Windows 3.1 or later

� VGA monitor or better
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What’s new in QuickBooks
The new features and improvements in QuickBooks make managing your business even 
easier.

Here’s a summary of what’s new and where to find more information. We’ve organized all 
the new features and improvements by the various QuickBooks products for your 
convenience.

QuickBooks Basic

The new QuickBooks Basic features and improvements listed below are also in QuickBooks 
Pro, Premier, and the custom editions of QuickBooks Premier.

New feature Use it to...
For more 
information...

Elimination of "uncategorized 
transactions" messages in 
sales tax reports

QuickBooks now automatically cat-
egorizes all transactions for sales 
tax reports. You no longer need to 
backtrack and categorize transac-
tions for sales tax purposes after 
you’ve entered them.

See “Uncategorized transac-
tions” on page 158.

Automated sales tax calcula-
tion and sales tax return gener-
ation

QuickBooks now automatically cal-
culates the due or refundable tax 
and generates a tax return based 
on these amounts.

See “Unfiled transactions” on 
page 158.

Batch form printing Add a batch print button to the 
Toolbar of your favorite forms so 
you can print all of your forms. For 
example, click to print all your 
invoices.

Search the Help index for 
’desktop Icon Bar, Customizing 
the Icon Bar.’

Calculate addition, deduction, 
or company contribution 
payroll items based on hours 
worked

For addition, deduction, and com-
pany contribution payroll items 
that calculate amounts based on 
the Quantity field, you can now 
choose the hours an employee has 
worked as the "quantity."

Review the payroll item you 
are interested in changing in 
the 
Payroll Item Setup Wizard.

Cut/Copy/Paste entire 
addresses

Cut/copy/paste an entire address 
rather than just one line at time. 
This also lets you export address 
lists more easily to Microsoft Excel 
now that each line of the address 
exports to a separate column in a 
spreadsheet.
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Payroll item absolute limit In previous versions of Quick-
Books, upper limits of payroll item 
amounts are reset every payroll 
year.
You can now enter a limit for a pay-
roll item which does not ever reset. 
For example, a repayment deduc-
tion for an employee loan must be 
calculated until the full amount is 
paid off (which may span over one 
year) and no further.

Review the payroll item you 
are interested in changing in 
the 
Payroll Item Setup Wizard.

Import data into QuickBooks 
from Microsoft Excel

Quickly import Microsoft Excel 
data into QuickBooks so that you 
can import your customer lists, 
vendor lists, item lists, and so on. 

Search the Help index for 
’Microsoft Excel, importing 
files into QuickBooks.’

Export reports to any work-
sheet in Microsoft Excel

Specify where your report goes 
when you export to an existing 
Excel spreadsheet. 

Search the Help index for 
’Microsoft Excel, exporting to 
reports.’

Pay stub and pay cheque 
voucher printing

Work with and print pay stub. and 
pay cheque vouchers more easily.

You will see new options for 
aligning and printing pay stubs 
or pay cheques the next time 
you open the Print Pay Stubs 
or Print Pay Cheques window. 

Price Level improvement Create and edit price levels based 
on dollar amounts and percentages 
more easily. Also, create up to 100 
price levels across two price types.

Search the Help index for 
’price levels, creating or edit-
ing a price level.’

Print Shipping Labels Print shipping labels from any of 
the forms windows.

See “Print shipping labels 
from an invoice or sales 
receipt” on page 255.

Mailing Label improvements Print labels by job when you print 
mailing labels. Also, by default, 
inactive names are excluded when 
you print mailing labels.

See “Printing features and 
improvements” on page 255.

Include a customer total bal-
ance on invoices

Add a customer or job total bal-
ance to your invoices. These are 
active fields, which mean that if 
you reprint the invoice later, the 
balance shows any changes you've 
made.

Search the Help index for 
’printing, printing customer 
balances.’

New feature Use it to...
For more 
information...
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QuickBooks Pro

The new QuickBooks Pro features and improvements listed below are also in QuickBooks 
Premier and the custom editions of QuickBooks Premier.

Record vacation hours used You can now track the number of 
vacation hours an employee has 
taken this payroll year.

Search the Help index for 
’employees, payroll informa-
tion about.’

Record of Employment form 
improvements

QuickBooks creates Record of 
Employment reports much more 
quickly.

T4 improvements It’s now easier to electronically file 
T4 slips with the CCRA. Also, 
QuickBooks now gives you the 
option to print your business 
address directly from the Print T4 
window.

See “Payroll improvements” 
on page 254.

New feature Use it to...
For more 
information...

New feature Use it to...
For more 
information...

Fixed Asset Tracking Create fixed asset items that help 
you keep track of your company's 
fixed assets (i.e., equipment, 
trucks, cash registers, computers) 
for tax purposes.

Search the Help index for 
’fixed assets, creating items to 
track.’

Easier time tracking Get alerted when invoicing a cus-
tomer with overdue time or costs, 
automatically bring timesheet 
notes and item descriptions into 
invoices, and wrap words in the 
notes portion of weekly timesheet.

Print Packing Slips Print a packing slip directly from an 
invoice.

See “Print packing slips” on 
page 256.
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QuickBooks Premier

All new QuickBooks Premier features and improvements listed below are also available in 
the custom editions of QuickBooks Premier.

QuickBooks Premier: custom editions

If you purchased the following custom editions of QuickBooks Premier, refer to the Right 
for My Business guide for information on features and improvements that are specific to 
your industry. Use this guide (Startup Guide) to learn about the standard features available 
in QuickBooks Premier.

� QuickBooks Premier: Contractor

� QuickBooks Premier: Association & Nonprofit

� QuickBooks Premier: Property Management

� QuickBooks Premier: Professional Services

� QuickBooks Premier: Retail & Repair

� QuickBooks Premier: Manufacturing & Wholesale

� QuickBooks Premier: Accountant

New feature Use it to... For more information...

Create PO from Estimate/Sales 
Order

Create a PO using the informa-
tion in either an Estimate or a 
Sales Order.

Search the Help index for 
’sales orders, creating invoice 
from.’
’estimates, creating invoice from.’

Display Qty Invoiced on Open 
Sales Order by Item Report

Include a column that shows 
the quantity invoiced when 
you generate the "Open Sales 
Orders by Item" report.

Search the Help index for ’printing 
forms.’

Time and billing improve-
ments

Search for outstanding bill-
able time or costs, then import 
the data into either an invoice 
or a sales receipt

See “Easier time tracking” on 
page 257.

Vehicle mileage tracking Track the mileage on your 
vehicle and use it to complete 
tax forms. You can also invoice 
customers for any incurred 
mileage.

Search the Help index for ’vehicle 
mileage, tracking.’
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QuickBooks Basic
The new QuickBooks 2004 Basic features and improvements listed below are also in 
QuickBooks Pro, Premier, and the custom editions of QuickBooks Premier.

Payroll improvements

Record of Employment report improvements

QuickBooks now creates Record of Employment reports much more quickly and assists you 
more in setting up payroll items for these reports.

T4 Improvements

QuickBooks assists you in formatting your business number so that you will not encounter 
errors on the CCRA Web site as you electronically file T4 slips. Also, QuickBooks now 
provides help with the filing process automatically.

Pay stub and pay cheque voucher printing

QuickBooks now offers a better format for pay stubs and more options for aligning pay stubs 
and pay cheques

Calculate pay cheque based on hours

For addition, deduction, and company contribution payroll items that calculate amounts 
based on the Quantity field, you can now choose hours the employee has worked as the 
"quantity" in the Payroll Item Setup Wizard.

Payroll item absolute limit

In previous versions of QuickBooks, upper limits of payroll item amounts are reset every 
payroll year. You can now enter a limit for a payroll item which does not ever reset. For 
example, a repayment deduction for an employee loan must be calculated until the full 
amount is paid off (which may span over one year) and no further.

Record holiday hours used
You can now track the number of vacation hours an employee has taken this payroll year 
in his or her employee profile.
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Printing features and improvements

Print shipping labels from an invoice or sales receipt

Now you can print shipping labels from either an invoice or a sales receipt.

Note: If you use QuickBooks Pro, QuickBooks Premier, or any of the QuickBooks Premier custom 
editions, you can also print shipping labels from an estimate or a sales order.

To print shipping labels from an Invoice:

1 From either an invoice or a sales receipt, click the Print drop-down button, then select 
Print Shipping Label. The Print Labels dialog box appears.

2 Make any print adjustments you want, then click Print. 

Note: Shipping labels are formatted to 3.4 inches x 4 inches. and can be purchased from Intuit. For 
purchasing information, see “Ordering QuickBooks products and services” on page 269.

Printing mailing labels for inactive names

Now, by default, QuickBooks automatically excludes inactive names when you print 
mailing labels.

To print mailing labels for inactive customers:

1 Ensure your printer is on and that the label sheets are properly loaded in the printer 

2 From the File menu, choose Print Forms, then choose Mailing Labels.

3 Select the list that you want to print from: Name, Customer Type, or Vendor Type. 

4 Select the Print labels for inactive names checkbox, then click OK.

5 Make any changes to the print settings, then click Print.

Print mailing labels for jobs

Now you can print a label for each job for a customer.

To print mailing labels for jobs:

1 Ensure your printer is on and that the sheets for the labels are properly loaded in the 
printer 

2 From the File menu, choose Print Forms, then choose Mailing Labels.

3 Select the list that you want to print from: Name, Customer Type, or Vendor Type. 

4 Select the Print labels for jobs checkbox, then click OK.

5 Make any changes to the print settings, then click Print.

To learn about… Search the Help index for…

More on printing labels printing, labels
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QuickBooks Pro
The new QuickBooks Pro features and improvements listed below are also in QuickBooks 
Premier and the custom editions of QuickBooks Premier.

Print packing slips

Not only can you now print packing slips right from an several of the forms you use in 
QuickBooks, but you can also create your own packing slip templates based on the invoice 
format you use. If you’ve ever created your own templates in QuickBooks, you already know 
how to create a packing slip template.

You can print packing slips from most of the forms you use in QuickBooks.

To print a packing slip from an invoice:

1 From the invoice you want to print a packing slip for, click the Print drop-down button, 
and select Print Packing Slip. The Print Packing Slip dialog box opens.

2 Make any print adjustments you want, then click Print. Here’s what packing slip will 
look like:

To learn about… Search the Help index for…

Printing a packing slip from a 
sales receipt

packing slip, printing from a sales 
receipt

Creating a packing slip template templates for business forms, creat-
ing

You can click Preview to see 
what the packing slip will look 
like. 

To make any adjustments to 
the packing slip, you’ll need to 
create a new template. 

The Intuit Packing Slip 
template cannot be changed.
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Easier time tracking

Tracking time and transferring it to a customer invoice is even easier:

� Get an alert when creating an invoice for a particular customer:job if the customer:job 
has any outstanding billable time or costs. This alert helps you save time, avoid under 
billing, and ensure invoice accuracy.

� Bring both timesheet notes and item descriptions automatically into an invoice. This 
option gives you more flexibility, reduces double data entry, and allows customers to 
easily see what they are being billed for.

� Choose the Notes field option for word-wrap on the weekly timesheet so that your 
notes are easier to read and review.

QuickBooks Premier
All new QuickBooks Premier features and improvements listed below are also in the custom 
editions of QuickBooks Premier.

Sales Order improvements

Create a purchase order from an estimate or sales 
order

You can create a PO converting the information in either an Estimate or a Sales Order.

To create a PO from an Estimate or Sales Order:

1 Open the Estimate or Sales Order that you want to base a new PO on.

2 Click the Create Invoice drop-down button, then select Purchase Order. You’re 
prompted to specify which items you want added to the Purchase Order.

3 Select either: 

� Create purchase order for all allowed items. This copies all the information in the 
form into the PO. If you’re converting an estimate, this information will include 
the change order memo.

To learn about… Search the Help index for…

Tracking time in QuickBooks time, tracking in QuickBooks
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� Create purchase order for selected items. This allows you to specify the items in 
the form that you want to add to the PO.

The Specify Purchase Order Quantities for Items on Estimate/Sales Order appears.

- Sort by preferred vendor: Select to sort the table by vendor.

- Item: The items or services that appear on the sales order. 

- Preferred Vendor: The name of the preferred vendor you defined in...

- On Hand: The items or services that you have in your physical inventory. 

- Qty: The number of items or services that you want to add to the PO. 

The information you selected is copied into the new purchase order.

4 Edit the purchase as necessary, then save the purchase order.

Open Sales Orders by Item report

If you quickly need to know the quantity of items you have invoiced, generate the Open 
Sales Orders by Item report and add the "Invoiced" column. In just a couple of minutes 
you’ll have the information you need to stay of top of your available stock.

To add the Invoiced column to this report:

1 On the Reports menu, select Sales, then choose Open Sales Orders by Item. The Open 
Sales Orders by Item report is generated.

2 Click Modify Report. The Modify Report: Open Sales Orders by Item dialog box opens.

3 Click the Display tab.

4 In the Columns list, scroll down to Invoiced and click it.

5 Click OK. 

Create a sales order from an estimate

You can create a sales order directly from an existing estimate.

To create a sales order from an estimate:

1 Open the estimate that you want to base a new sales order on.

2 Click the Create Invoice drop-down button, then select Sales Order. All items from the 
estimate are copied into the new sales order.

3 Edit the sales order as necessary, then save the sales order.
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Set price levels per item

Customize your prices for different customers or jobs using two types of price levels:

� Fixed percentage price levels are used to apply a fixed percentage increase or decrease 
to all your standard sales prices when setting prices for different customers or jobs.

� Per item price levels are new and can be used to set custom prices for individual items 
when setting up prices for different customers or jobs.

You can now create up to 100 price levels for different customer or jobs. Once a customer 
or job is assigned to a price level, QuickBooks automatically pulls the correct custom price 
whenever you create an invoice, sales receipt, credit memo or sales order. In addition, you 
can manually adjust the prices from the sales forms.
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accounts payable

The record of outstanding bills a business must pay. 
Called A/P for short.

accounts receivable

The record of money owed to a business, that is, 
outstanding invoices or statement charges for which 
the business has not received payment. Accounts 
receivable is called A/R for short. (Even though the 
word accounts is plural, QuickBooks uses a single 
account on the chart of accounts to track all the 
money that different people owe you.) 

accrual basis

A method of bookkeeping in which you regard 
income or expenses as occurring at the time you ship 
a product, render a service, or receive a purchase 
rather than at the time you pay or receive cash. With 
this method, the first time you enter the transaction 
into your records and the moment when you pay or 
receive cash may be two separate events. 

accrual hours

Time that your employees accrue ("earn") as they 
work. Examples include sick time and time off in lieu 
of paid overtime.

aging

The tracking of due dates and amounts of 
outstanding invoices (and of your unpaid bills). 
QuickBooks has preset accounts receivable and 
payable aging reports.

assets

Assets include what you have and what people owe 
you. Examples include: 
� cash on hand and in your chequing account
� money you are owed
� furniture
� vehicles

total assets = total liabilities + equity

balance sheet

A report that summarizes the financial position of a 
business. A balance sheet shows the value of your 
company’s assets, liabilities, and equity as of a 
particular day. It is called a balance sheet because the 
value of the assets is always exactly equal to the 
combined value of the liabilities and equity.

billable

Time worked or purchases made for a particular 
customer or job, that you want to charge back to that 
customer or job in QuickBooks.

After you put the time or purchase on a sales form, 
QuickBooks marks it non-billable, so you won’t 
charge twice for the same thing.

cash basis

A method of bookkeeping in which you regard 
income or expenses as occurring at the time you 
actually receive a payment or pay a bill. 

CCRA

Canada Customs and Revenue Agency, formerly 
Revenue Canada. 

class

Anything in your business (other than a customer or 
job) for which you need to track both income and 
expenses.

condense

To remove detail you no longer need from older 
transactions in your QuickBooks company file, with 
the result that your company file shrinks in size and 
QuickBooks performs better. 

corporation

A business organization that has been incorporated. 
A corporation is owned by its stockholders. 

Glossary of terms
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customer

Any person, business, or group that buys or pays for 
the services or products that your business or organi-
zation sells or provides

equity

The net worth of a company, equal to the total assets 
minus the total liabilities. All the equity belongs to 
the owners.

equity = assets - liabilities

inventory

The most common kinds of inventory are: 
merchandise or stock in trade; raw materials; work in 
process; finished products; and supplies that physi-
cally become a part of the item intended for sale.

item

A service you provide or a product you sell, which 
you set up on your Item list. In addition, you can 
have items for miscellaneous charges and for various 
calculations on your sales forms. 

job

A project for a particular customer.

liabilities 

Liabilities include what your company owes to other 
people or your company debts. Examples include: 
� unpaid bills or credit card accounts
� loans
� money you collect for the government, like 

income tax from employee pay cheques or 
GST/PST from customers.

maintenance release (R)

Also called an update or a patch.

A revision of QuickBooks that you download or 
install over an existing version of QuickBooks.
Maintenance releases are offered free of charge 
throughout the year (some shipping and handling 
charges may apply) and can include bug fixes, latest 
payroll or legal requirements, and feature additions. 

When we publish a maintenance release, a number is 
associated with it (for example, R4, R5 etc.). This 
number is important when it comes time to install a 
newer version of QuickBooks, as it is a way for Quick-
Books to determine which maintenance release you 
have installed.To see what version and release you 
currently have installed on your computer, press 
CTRL+1 with QuickBooks open.

multicurrency

A feature that, when turned on, gives you the ability 
to deal in foreign currencies. 

multi-user mode

More than one person can access your company file 
at the same time.

net profit

The sum remaining after all expenses have been met 
or deducted, synonymous with net earnings and net 
income or net loss.

online banking

Doing bank transactions through the Internet.

partnership

An unincorporated company owned by two or more 
persons.

patch

See maintenance release.

payroll taxes

A blanket term for all deductions you withhold from 
an employee’s pay cheque and remit to a level of 
government. Examples are income tax deductions, 
Employment Insurance premiums, and Canada or 
Québec Pension Plan contributions.

payment item

A type of item on your Item list. You can set up a 
different payment item for each method of payment.

Use payment items on cash sales receipts only when 
you need to show two or more kinds of payments on 
the same receipt.
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profit and loss statement

This report shows how your cash position changed 
over a period of time. It shows the amount of cash 
earned from profit, where you received additional 
cash, and where your cash was spent. 

progress invoice

One of a series of invoices all based on the same 
estimate for the same job. Use progress invoices 
when you want to invoice for the job in phases—that 
is, by milestone or by percentage complete.

QuickBooks keeps track of the amount you have 
already invoiced and the amount not yet invoiced. 

QuickReport

A report that shows a list of transactions you are 
likely to want to see for the name you have selected. 
The particular report depends not only on the name 
you select but also where you select it.

realized gains and losses

For transactions that involve foreign currencies, the 
difference between what the foreign currency was 
worth when the customer paid you and what it was 
worth when you converted it to your home currency 
(by depositing it into your financial institution) or, if 
you haven’t converted the foreign currency to your 
home currency, what it is worth today. Contrasts 
with "unrealized gains and losses".

reconcile accounts

An analysis explaining the difference between a 
company’s book balance of cash and it’s bank 
statement balance.

reimbursed expenses

Expenses you have incurred on behalf of a customer, 
and for which you have requested reimbursement.

restore

To expand a company file from a compressed backup 
into a functioning company file again.

retained earnings account

An equity account that QuickBooks automatically 
adds to your chart of accounts when you set up a new 
QuickBooks company. QuickBooks uses the account 
to track profits from earlier periods that have not 
been distributed to owners. At the beginning of a 
new fiscal year, QuickBooks automatically transfers 
net income into your Retained Earnings account.

sales tax

A tax you collect from a customer when he or she 
pays for the sale. There are several types of sales tax 
in Canada: the Goods and Services Tax (GST), the 
Harmonized Sales Tax (HST), and provincial sales 
taxes such as the Québec Sales Tax.

single-user mode

Only one person can access your company file at any 
time.

sole proprietorship

An unincorporated company owned by one person.

start date

The date QuickBooks will have complete infor-
mation about your company finances. The start date 
can be in the past if you enter historical records; it 
can be the current date; or it can be some day in the 
future if you prefer to enter information gradually. 

time tracking

Keeping a record of the hours that you, your 
employees, or your subcontractors work so that you 
can then pass the expense on to your customers.

trial balance

In traditional accounting, a document that adds up 
all the debits and credits so that mistakes can be 
traced if debits don’t equal credits. Because Quick-
Books always adds correctly, you do not need to do a 
trial balance. Nevertheless, QuickBooks provides a 
trial balance report if you want to see your data in 
this format.
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unrealized gains and losses

For transactions that involve foreign currencies, the 
difference between what the foreign currency was 
worth when the customer paid you and what it was 
worth when you received it or, if you haven’t 
received it, what it is worth today. Contrasts with 
"realized gains and losses".

Many accountants prefer you take your unrealized 
gains and losses into account when you create 
reports about your company’s net worth.

upgrade

The process by which you promote an earlier version 
of QuickBooks to a newer version. For example, if 
you currently have QuickBooks 2000 and you 
bought QuickBooks 2002, you would be upgrading to 
the QuickBooks 2002 version.

update

(noun) A newer release for the version of QuickBooks 
that you’re currently using. This is also referred to as 
a maintenance release and it typically contains bug 
fixes. (verb) The process of converting the format of 
an existing company file so that it can be opened 
with a newer version of QuickBooks.

version (v)

An annual release of QuickBooks which is available 
through stores. Versions include enhancements and 
new features. (For example, QuickBooks version 
2001, 2002, etc.)

wage base

The total amount of employee wages or earnings on 
which a payroll tax is calculated.

zero rated

Under the GST, certain goods and services are taxed 
at a rate of 0% instead of the usual 7%. These items 
are called zero rated.

Zero-rated items are not tax exempt. If you sell a 
zero-rated item, you charge your customers 0% GST 
on it. This means that you do not collect any GST to 
remit to the government. However, because the item 
is taxable, you can claim input tax credits (the GST 
you paid on the materials you needed to produce the 
item) for it.
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Intuit Product Support

Web-based support

QuickBooks.ca (http://www.quickbooks.ca) is the official site for Canadian QuickBooks 
users. Visit to get answers to many QuickBooks questions, important QuickBooks updates 
and information about special offers.

If you have an Internet connection, you can access the QuickBooks Web site within 
QuickBooks. On the Help menu, select QuickBooks.ca.

Telephone support

Intuit offers telephone support packages.

To sign up for one of these packages, see “Ordering QuickBooks products and services” on 
page 269.

Data recovery

If your QuickBooks data file becomes damaged, data recovery is available for a fee. See 
“QuickBooks product support” on page 270 for contact information.

Password removal

If you forget your password, password removal is available for a fee. See “QuickBooks 
product support” on page 270 for contact information.

Solving problems on your own

Note: We recommend you back up your data on new, formatted disks or to the Internet before you start. 
For more information, see “Backing up your company data” on page 117.

Guidelines for solving typical problems

Use the following examples as a guide to solving the problems you are having.

Try the procedure again

Start at the beginning. Examine windows where you filled in fields to be sure you are asking 
the program for what you want.

For example, if invoices you just entered are not showing on your Profit and Loss statement. 
You should ask questions such as:

� Does the date of the report include those invoices?
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� Do the invoices appear if you change the report from Cash to Accrual basis?

� Does this problem occur with only invoices for one particular customer?

� Have you changed any filters on the report? (Try to create a new report from scratch to 
see if the problem is solved.)

Try a related procedure

For example, if you have a printing problem:

� Ensure the printer is working by trying to print something else. If you have trouble 
printing cheques, try printing a report. If you can’t print one of the sales forms, try 
printing a similar form.

� If you can’t print from QuickBooks, try printing from another program such as 
Microsoft’s Notepad. If nothing prints from Notepad, you know the problem is related 
to the printer, not the software. Check the printer connections, the printer driver, the 
print queue, and so forth.

Think about what has changed

If something used to work but no longer works, think about what’s changed.

� Have you changed or added other programs on your computer recently?

� Have you added a new printer?

� Have you moved the QuickBooks company file to a new location?

� Have you changed a setting in the Preferences window?

If the program “hangs” or locks up on you

There can be a number of reasons why your system freezes while using QuickBooks or any 
program. Try restarting your computer to see if that solves the problem. If restarting doesn’t 
help, go through the following list of questions and take any related action:

� Does your computer system (and network) meet the minimum requirements necessary 
for QuickBooks? (See “Hardware and software requirements” on page 2.)

� Are you making the best use of available system resources by shutting down other 
programs that may be running? (Check for programs that may be running in the back-
ground without your knowledge.)

� Do you have enough hard disk space available? (This is particularly common for those 
working in a multi-user, peer-to-peer network situation.)

� Do you have any conflicts with sound or video drivers?

Note: If you encounter system freezes while using QuickBooks, you may want to call for technical 
support. See “QuickBooks product support” on page 270. But first see “Speaking with a Product 
Support Representative”, below.
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Using the QuickBooks utilities

A technical support representative may ask you to run the Verify Data or Rebuild Data 
utility to recover damaged transactions. The Verify utility detects most data errors; the 
Rebuild utility attempts to correct data errors, but some errors cannot be corrected.

Because Rebuild can cause additional problems to your data file that can increase the 
difficulty of recovering your data, we do not recommend running Rebuild on your own.

Note: The Rebuild utility requires that you back up your company first. If a technical support represen-
tative asks you to run Rebuild, you will need to have formatted disks on hand for the backup.

Speaking with a Product Support Representative

Be prepared when you call

If you need to call for assistance, you can speed up the time it takes to get an answer by 
doing the following before you call:

� Activate your license key for your version of QuickBooks and have your license key 
available. To display your license key, choose My License Information from the Help 
menu.

� If you subscribe to a QuickBooks Service Plan, have your Customer Number ready.

� Be at your computer with QuickBooks running. 

� Make notes of the windows you opened and the tasks you did prior to encountering 
the problem. Know the exact wording of any message that appeared on the screen.

� Have a pencil and paper handy to take notes.

� If your company file is set up for multiple users who have access to different areas of 
QuickBooks, you'll need to have access to most of the software. You might also want to 
switch to single-user mode.

� Have the following information available:

� Model of computer, amount of memory (RAM) and available hard disk space

� Accessory manufacturer, type, and model (monitor and printer, for example)

� Operating system type and version

� Network configuration and software version
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Contacting Intuit

Ordering QuickBooks products and services

QuickBooks activation

QuickBooks delivery, billing, and account inquiries

If about... Try... Or call...

Ordering QuickBooks 
products and services
� QuickBooks services
� Payroll service plans
� Support service plans
� Point-of-sale software

Visiting www.intuit.ca 1-888-333-8580
Mon. - Fri., 9 am - 8 pm 
Eastern Standard Time

Ordering QuickBooks supplies
� Cheques
� Business forms & 

statements
� Other small business 

supplies

Visiting www.intuitsupplies.ca 1-877-445-3233 (English)
1-877-422-8911 (French)
Mon. - Fri., 9 am - 8 pm
Eastern Standard Time

If about... Try... Or call...

Activating QuickBooks 2004 From the File menu, choose 
Activate QuickBooks, then 
follow the onscreen instructions.

1-888-333-8580
Mon. - Fri., 9 am - 8 pm 
Eastern Standard Time

If about... Call...

Billing inquiries
� General billing inquiries
� Updating credit card infor-

mation
� Updating banking informa-

tion
Other service inquiries
� Order and shipping status
� Exchanges
� Replacement CDs

1-888-333-8580
Mon. - Fri., 9 am - 7 pm 
Eastern Standard Time
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QuickBooks product support

If about... Try... Or call...

QuickBooks technical 
support or how to use 
QuickBooks

QuickBooks in-product help
� Many windows in QuickBooks have an 

“Ask a help question” area at the top. 
Type your question there, then click Ask 
for the answer.

� For information about common tasks in a 
window, click the How do I menu at the 
top.

� For information about the fields or con-
trols in a window, open the window 
where you are having problems, then 
press the F1 key on your keyboard or 
choose Help on this window from the 
Help menu.

� For Help on a specific subject, search the 
Help Index within the Help menu

QuickBooks Coach
� This interactive tutorial lets you practice 

common tasks without affecting any data 
in your company file. To start the Coach, 
from the Help menu, choose QuickBooks 
Coach, then either Start QuickBooks 
Coach or the specific module you want.

QuickBooks Knowledge Base
� This database has hundreds of fre-

quently asked questions (FAQs) and arti-
cles with answers to tips and common 
problems. You can visit it online at 
http://knowledgebase.quickbooks.ca/.

QuickBooks Auto-reply email. 
� This e-mail address is directed to an 

automated response system that will 
reply with information on the most com-
mon QuickBooks 2004 known issues and 
work-arounds. To use the auto-response 
system, just send a completely BLANK e-
mail to the quickbookshelp@intuit.com. 
You will receive a response within two 
minutes.

1-877-772-9158
Mon. - Fri., 8 am - 8 pm 
Eastern Standard Time
(product support 
membership fees apply)



Index 271

Symbols
.AIF, 106

.QBA, 106

.QBB, 106

.QBW, 106

.QBX, 106

Numbers
3.5 floppy disk(s), 121

8846 forms, gathering information for, 216

943 forms, gathering information for, 216

A
account numbers

chart of accounts, 63

accountant’s review feature, 102–104

accountants, 20

accounting
accrual, 22
cash basis, 22

accounting software
transferring data to and from QuickBooks, 101

accounts
account numbers for, 63
affecting during payroll setup, 200
creating, 66
editing, 63
foreign, 164
opening balance for, 66
payroll, 182
Quicken, equivalent of, 87

tax lines, assigning to, 139

accounts (types)
accounts payable, 24
accounts receivable, 24
asset, 24
balance sheet, 23
bank, 24
credit card, 24
equity, 25
fixed asset, 24
liability, 24
long term liability, 24
non-posting, 23
other asset, 24
other current asset, 24
other current liability, 24

accounts (working with)
alphabetical order, 63
automatically-created accounts, 23
items, choosing for, 44
names, changing, 63
numerical, 63
opening balances

changing, 63
payroll, 182
reconciling, 128
reorganizing order of, 63

accounts payable
account for, 24
converting from Quicken, 85
historical transactions, 64

accounts receivable
account for, 24
after converting from Quicken, 84
historical transactions, 64

accrual basis bookkeeping
adjustment during setup, 67
defined, 22

accuracy of QuickBooks payroll compared to printed 
tax tables, 209

Index
If you don’t find the topic you are looking for here, try the QuickBooks Help. From the QuickBooks 
Help menu, choose Help Index, enter the keyword, and press Display.
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activating QuickBooks, 13

activities
detail, how much to track, 225
editing or viewing Timer data about, 232
exporting from the Timer, 234
importing into Pro or Premier from the Timer, 234
invoicing for, 243
recording in the Timer, 231
recording time manually in Pro or Premier, 236
single, recording, 237
timing with the Stopwatch, 235

additions, payroll item for, 185

adjusting
income and expense accounts, 67
item prices or rates, 60
liabilities for GST/PST, 156
liabilities for payroll items, 213

administrator, 134

advisor, 20

alignment
adjusting for printing, 143

alphabetical order for accounts and lists, 63

amortization of loans, only in Quicken, 90

archiving, see condensing data

assets
accounts for, 24
balance sheet, viewing on, 31
current, accounts for, 24
defined, 31

audit trail, 136

autoload printer feature, aligning forms with, 144

Automatic Update
turn off, 73

awards, paying to employees, 189

B
backing up, 117–124

recommended routine, 118
restoring backups, 124
testing your backups, 122
to a tape, 120
to CD-ROM, 119
to floppy disk(s), 121

to Zip drive, 120
with QuickBooks Backup Service, 121

backing up data
overview, 117

backup, searching for, 123

bad debt, adjusting GST or PST owed, 156

balance sheet accounts
types of, 24

balance sheet, described, 31

bank accounts
description, 24
reconciling, 128

benefits for employees, payroll item for, 185

billable status
deciding whether to make time billable, 224
making billed time billable again, 244

bills
paying foreign vendors, 175

blank timesheets, 228, 237

bonus, payroll
payroll item for, 185

bonuses, paying to employees, 189

bookkeepers, 20

bookkeeping methods
accrual basis, 22
cash basis, 22

bookkeeping software, transferring data to and from 
QuickBooks, 101

books, closing, 135

business number, 149

business segments, tracking, 21, 28

C
calculating payroll taxes, slight discrepancies, 209

calculating, sales forms, on, by using items, 49

calendar year, 139

Canada Customs and Revenue Agency
GST and, 148
income tax and, 137
payroll liabilities and, 212
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Canada Pension Plan
calculations and employee’s date of birth, 192
payroll items for, 184

capital investments, 69

cash basis bookkeeping, 22

cash flow forecast reports, 33

cash vs. accrual
choosing, 22
reporting, 141

categories in Quicken, equivalent of, 87

CD
update QuickBooks, 75

CD-ROM, 119
installing QuickBooks from, 3
installing Timer from, 8, 246

changing
how dates display, 75
Internet connections, 71

chart of accounts
adding accounts, 63
automatically-created accounts, 23
described, 23
numerical, 63
reorganizing, 63

checking accounts
reconciling, 128

checklist for setting up payroll, 180–181

cheques
alignment adjustments for, 143
pay stubs, printing, 211
payroll

printing, 211
reviewing and correcting, 211
writing, 210

chequing accounts, historical transactions and, 65

classes
adding, 21, 29
compared to jobs, customer types, and job types, 

30
employees, grouping by, 193

payroll expenses, tracking by, 187
turning on preference for, 21, 29
uses for, in QuickBooks, 21, 28

closing books or period, 135

columns
changing on forms, 116

columns, changing for reports, 113

combining names after converting from Quicken, 82

commissions
employee template, adding to, 191
employees on, 194

company
backing up to a tape, 120, 121
backing up to CD-ROM, 119
backing up to Zip drive, 120
backing up with QuickBooks Backup Service, 121
backup up, 117
data file, described, 20
described, 20
multicurrency and, 162
passwords, 133
restoring data, 124
sample, 110
searching for lost file, 10
setting up, 38
setup, preparing for, 37
testing, 122

company contributions
employee template, adding to, 191
employees, individual, setting up for, 193
payroll item for, 185

company file
finding, 9

company files, 21

compensation
one-time payment, 189
payroll items for, 185

condensing data, 124
how it affects reports, 127
summary transactions, 126
when using Payroll Service, 125
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connecting
QuickBooks to the Internet, 70

connection
changing for the Internet, 71

construction industry, standard categories, tracking, 
28

construction industry, tracking standard categories, 
21

consultants, 20

contacting technical support, 265

converting
MYOB data, 90–99
Quicken data, 78–90

corporations
described, 35
officer salaries, 185

CPP (Canada Pension Plan), payroll items for, 184

creating
foreign invoices, 172
PO from estimate/sales order, 257
sales order from an estimate, 258

credit cards
accounts, 24
reconciling, 128

currency list, 167

currency, see multicurrency

current assets, accounts for, 24

custom fields
filtering reports for, 114
for employees, 192
for items, 52

customers
foreign, 172
opening balances

changing, 41
payroll expenses, tracking by, 187
products and materials purchased for, 54
tax codes for, 152

customizing reports, 113

D
data

audit trail of, 136
backing up overview, 117
backing up to a tape, 120
backing up to CD-ROM, 119
backing up to floppy disk(s), 121
backing up to QuickBooks Backup Service, 121
backing up to Zip drive, 120
condensing, 124
exporting, 100
exporting from the Timer, 234
files, 21
importing from other software, 100
refreshing, 133
restoring, 124
Timer, importing into Pro or Premier, 234
transferring to and from QuickBooks, 101

dates
changing how they display, 75
report ranges, 114
start date, 34

deductions, payroll
employee template, adding to, 191
employees, individual, setting up for, 193
payroll item for, 185

defaults
accounts created, 23
employee, for payroll, 191

delivery charges, item for on invoice, 48

departments, tracking, 21, 28

deposits
direct, 196

descriptions of file types, 106

direct deposit, 196

disable, Automatic Update, 73

discount items
creating, 52
description, 49
using on sales forms, 58

discrepancies between QuickBooks and printed tax 
tables, 209

disk space required, 2

disks
saving disk space, 124

downloading
transactions, 132
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duplicate names, after converting from Quicken, 82

E
EasyStep Interview, 38

turning on GST/PST tracking, 149

E-filing
t4 forms, 218

EI (Employment Insurance), payroll items for, 184

employee defaults, 191
TD1 information in, 191, 194
TP-1015.3 information in, 191, 194

employees
adding, 206
benefits for, 185
bonuses for, 189
categorizing, 193
commissions, 194
custom fields, 192
defaults, 191
deleting, 207
direct deposit for, 196
duplicate names, 207
editing information about, 193
hiding, 207
merging names, 207
notes about, 193
paying, 208, 210
payroll information

changing, 193
setting up, 191
year-to-date summaries, 197

preferences for, 179
raises, 205
releasing, 205, 206
removing from list, 207
setting up, 192
sharing QuickBooks on a network, 133
tracking time for, 237

Employment Insurance, payroll items for, 184

equity
accounts, 25

created by QuickBooks, 68
setting up, 68

balance sheet, viewing on, 31
redistributing during setup, 68
retained earnings from, 68
sole proprietorships, in, 69
transferring from Opening Bal Equity, 68, 84

errors in payroll tax calculations, 209

estimate
create PO from, 257
creating sales order from, 258

exchange rates, 162
how they affect transactions, 169
see also multicurrency, 162
updating, 169

expense accounts
opening balances, 67
uncategorized, 67

expenses, payroll, 186

exporting
data, 100, 101
lists for use in Timer, 230
Timer data for use by Pro or Premier, 234
vs. other methods of transferring data, 101

F
F1 key for help, 110

federal income tax, payroll items for, 184

federal payroll taxes
employees, setting up for, 193
paying, 215

fields
adding to forms, 115
changing on forms, 116
custom for employees, 192
filtering reports with, 114

file types, 106

file types described, 106
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files
backing up overview, 117
backing up to a tape, 120
backing up to CD-ROM, 119
backing up to floppy disk(s), 121
backing up to Zip drive, 120
backing up with QuickBooks Backup Service, 121
condensing, 124
restoring, 124
testing backing up, 122

filing payroll tax forms, 212
PD7A, 215
Relevé 1, 216
T4, 216
TPZ-1015, 216

filtering reports, 114

find
company file, 9

finding your backup file, 123

firing an employee, 205

fiscal year, 118, 139
adjusting for mid-year QuickBooks start date, 67

flowcharts, 107

fonts
forms, 116

fonts, changing on reports, 113

foreign currency, see multicurrency

forms
described, 108
printing, alignment, 143

freight charges
item for on invoice, 48

G
garnisheed wages, payroll item for, 189

Goods and Services Tax see GST/PST, 149

group items
compared to subitems, 50
creating, 52
description, 49
uses of, 57
using to hide details, 57

GST Payable account, 156
adjusting, 156

GST/PST
adjusting liabilities, 156
amount owed as of start date, 66
applying to sales, 153
business number, 149
codes, setting up, 152
customer tax codes, 152
how QuickBooks calculates, 148
liabilities, 150
liability reports, 154
locking after paying, 135, 156
paying liabilities, 154
preferences, 149
purchases including, 153
refunds for overpayments, 155
sales including, 153
tax codes, setting up, 152
tracking, 149
turning on in EasyStep Interview, 149
what you owe, 154
Zero Rated tax code, about, 152

H
hardware requirements

for QuickBooks, 2
for Timer, 247

help
how-do-I menus, 110
index, 110
onscreen, 110

hiding
items in lists, 108

hiding and showing
details on sales forms, using group items, 57
employees, 207
items, 61

historical transactions, 64
entering for payroll, 65

hours worked
entering on pay cheques, 209
recording manually in Pro or Premier, 236
recording with the Stopwatch, 236
recording with the Timer, 231
viewing on timesheets, 228
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how-do-I menus, 110

I
Icon bar, 107

IIF file format, 100

importing
activities from the Timer, 234
Pro or Premier lists into Timer, 230

inactive names
print labels for, 255

income accounts
choosing for items, 44
opening balances, 67
uncategorized, 67

income statement, described, 32

income tax
form, 36, 139
preparing information, 140
QuickTax, 140
reports about, 141
setting up and tracking, 137

industry information, 110

installing
QuickBooks, 3
what happens during, 4

international business, see multicurrency

Internet
changing your connection, 71
connecting QuickBooks to, 70
requirements, 70
setting up a connection, 71
updating QuickBooks from

updating
QuickBooks from the Internet, 72

Intuit
activating QuickBooks, 13
phone numbers, 269–270
technical support, 266
Web sites, 269–270

inventory assembly items vs. groups, 50

inventory part items
description, 48

investment tracking, only in Quicken, 90

invoices
payment items on, 59

item
set price level per, 259

items
about, 66
accounts, how affected by, 44
benefits of setting up, 42
changing prices, 60
custom fields for, 52
deleting, 61
editing, 61
foreign prices, 166
GST/PST codes for, 152
hiding, 61
inventory assembly, 48, 50
list of, 46
non-inventory part, 48, 52
open sales order by, report, 258
other charge, 48, 52
payroll, 183–204
prices, changing, 60
reimbursable costs, for, 53
service, 47, 52
subitems, 50, 52
types

restrictions on changing, 61
table of, 47

J
jobs

compared to classes, customer types, and job 
types, 30

opening balances, changing, 41
payroll expenses, tracking by, 187
print mailing labels for, 255
products and materials purchased for, 54
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L
labels

print for jobs, 255
print inactive names, 255
shipping, print, 255

liabilities
accounts for, 24
adjusting for payroll item, 213
adjusting GST/PST, 156
balance sheet, viewing on, 31
defined, 31
GST/PST, 150, 154
payroll, see payroll liabilities

line items
defined, 56
see also items

lists
activating inactive entries, 61
alphabetizing, 63
described, 108
exporting, 101
exporting for use in Timer, 230
item, 46
reorganizing, 63
sorting, 47
updating for Timer, 233

loan amortization, only in Quicken, 90

locations, tracking, 21, 28

locking sales tax after paying, 135, 156

login, 134

long term liability accounts, 24

lost company file, 10

M
Macintosh

converting Quicken for, 80

manually update QuickBooks, 73

margins
adjusting alignment when printing forms, 143
adjusting for reports, lists, and graphs, 143

markup
item prices, 60

maximum number of users, 18

memorizing reports, 113

memory required to run QuickBooks, 2

merging
employee records, 207
names after converting from Quicken, 82
payroll items, 204

midyear setup, 67

miscellaneous charges
items for, 52
reimbursable charges, 55

modifying your Internet connection, 71

mortgage amortization, only in Quicken, 90

multicurrency
adding foreign prices to items, 166
an overview, 162
creating

currencies, 167
foreign accounts, 164
POs for foreign vendors, 174

currency calculator, 169
depositing foreign money, 173
exchange rates, 162, 169
foreign customers

creating, 165
invoicing, 172
payments from, 173

foreign vendors
creating, 165
paying, 175
POs for, 174

home-currency adjustments, 170
items, adding a foreign price to, 166
printing

realized gains & losses report, 172
unrealized gains & losses report, 170

realized gains & losses, 171
setting up, 162–166
transferring funds, 176
unrealized gains & losses, 169
using, 162–176

multiple users
and Windows 2000, 2
maximum number of, 18, 134
network requirements, 3
setting up for, 18
update QuickBooks for, 74
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multi-user mode, 133

MYOB
converting your data to QuickBooks, 90–99
setting up your payroll in QuickBooks, 92–99

N
names, Quicken conversion and, 82

navigators, 107

net worth, 25

network requirements, for multiple users, 3

networks
how QuickBooks works on, 132
maximum number of users, 18
setting up QuickBooks on, 18
sharing QuickBooks on, 133

non-inventory part items
creating, 52
description, 48

non-posting accounts on chart of accounts, 23

notes, adding to Timer activities, 232

number format in reports, 113

numbers
changing how numbers display, 75
for accounts, 63

numerical accounts on chart of accounts, 63

O
officer salaries, 185

online accounts
downloading transactions, 132
PIN/password, 130
reconciling, 131
re-enabling after converting, 83

online banking
converting from Quicken, 80

going online, 131
setting up, 130

online banking, converting from Quicken, 83

online payment
going online, 131
setting up, 130

online registration, for QuickBooks, 269

onscreen help, 110
how-do-I menus, 110

open sales orders by item report, 258

Open Window list, 107

Opening Bal Equity account, 68
adjusting balance during setup, 68
described, 68

opening balance
for accounts, 66

opening balances
balance sheet accounts, changing, 63
customer or job, changing, 41
entering in EasyStep Interview, 36

other asset accounts, 24

other charge items
creating, 52
description, 48

other current asset accounts, 24

other current liability accounts, 24

Other Names list, after Quicken conversion, 81

other tax items, 185

Other, on reports, 115

overpayments
GST/PST liability, refund cheque for, 155
payroll liability, refund cheque for, 215

owner’s draws, 69

owner’s equity, 69

owners
commission sales, 194
paying, 191

owners/partners, paying for time worked, 238
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P
packing slips

print, 256

partial payment on invoice, 59

partners
commission sales, 194

partnerships
described, 35
income and expenses, tracking by partner, 21, 29
time worked, paying partners for, 238

passwords, 133
changing, 135
close books or period with, 135
deleting, 135

pay cheques
direct deposit and, 196

pay cheques see payroll cheques

pay stubs, printing, 211

paying
employees, 210
foreign vendors, 175
GST/PST liabilities, 154
nonemployees (subcontractors), 238
payroll liabilities, 212, 215

payment items
creating, 52
description, 49
using on sales forms, 59

payments
partial on invoice, 59

payroll
accounts, 182
checklist for setting up, 180–181
condensing payroll data, 125
customizing accounts for, 182
employee template, adding to, 191
employees, individual, setting up for, 193
expenses, 186
historical transactions, entering, 197–202
MYOB

setting up in QuickBooks, 92–99
paying employees, 208
preferences for, 179
reports, 221
service for, 178

setting up, 179
subaccounts, 182
tracking expenses, 188
turning on or off, 178

payroll cheques
deleting, 211
editing, 211
historical, entering, 197
printing, 211
printing pay stubs, 211
voiding, 211
writing, 210

payroll expenses
class, tracking by, 187
customer, tracking by, 187
job, tracking by, 187
reports, 186
service item, tracking by (Pro and Premier only), 

187

payroll forms
PD7A, 215
Record of Employment, 205
Relevé 1 forms, 216
Relevé 1, printing, 218
RLZ-1.S-V report, 219
T4 forms, 216
T4 forms, E-filing, 218
T4 forms, printing, 218
T4 Summary report, 219
TPZ-1015 report, 216

payroll items, 183–204
additions, 185
bonus, 185
changes, effects of, 204
company contributions, 185
created by QuickBooks, 183
creating new, 184
deductions, 185
displayed by QuickBooks, 183
editing, 203–204
examples of common items, 189
hourly wages, 185
liabilities, adjusting, 213
merging, 204
officer salaries, 185
order of, effect on amounts and gross pay, 192, 

193
other tax items, 185
reports, 222
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salaries, 185
showing, 204
vacation, 184

payroll liabilities
adjusting, 213
discounts for, 215
how QuickBooks tracks, 188
paying, 212, 215
PD7A, 215
penalties, 215
Relevé 1 forms, 216
Relevé 1 forms, printing, 218
report, 221
RLZ-1.S-V report, 219
T4 forms, 216
T4 forms, E-filing, 218
T4 forms, printing, 218
T4 Summary report, 219
TPZ-1015 report, 216
year-to-date summaries for setup, 201

payroll reports, 220

Payroll Service, 178

payroll tax forms
other, 216

payroll taxes
employees, setting up for, 193
historical, 197
on employee defaults, 191
other, payroll items for, 185
paying, 212, 215
payments, entering year-to-date summaries, 201
PD7A forms, filing, 215
refunds for overpayments, 215
Relevé 1 forms, 216
Relevé 1 forms, printing, 218
RLZ-1.S-V report, filing, 219
T4 forms

filing, 216
T4 forms, E-filing, 218
T4 forms, printing, 218
T4 Summary report, filing, 219
tax forms, filing, 212
TPZ-1015 report, 216

PD7A forms, filing, 215

phone numbers
Intuit, 269–270
ordering cheques and other supplies, 269
ordering software and other products, 269

PIN/password for online accounts, 130

POs for foreign vendors, 174

preferences
employee, 179
GST/PST, 149
multicurrency, 163
payroll, 179
users, 18
using classes, turning on, 21, 29, 41

previous versions of QuickBooks, upgrading from, 16

price level
set per item, 259

price level, set per item, 259

price levels
setting up for items, 45

prices of items, changing, 60

printing
alignment, adjusting, 143
files to disk, compared to other methods of 

transferring data, 101
labels for inactive names, 255
mailing labels for jobs, 255
margin issues, 143
packing slips, 256
pay stub reports, 211
payroll cheques, 211
realized gains & losses report, 172
Relevé 1 forms, 218
shipping labels, 255
T4 forms, 218
timesheets, 228
troubleshooting, 142
unrealized gains & losses, 170

prior liability payments, 201

problems
printing, solving, 142
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problems, solving before you call Intuit, 266

procedures, finding, 110

product activation, 13

product lines, tracking by, 21, 29

professional advisor, 20

profit and loss statement, described, 32

provincial sales tax see GST/PST

PST
Payable account, 156
tracking, 149

PST Payable account
adjusting, 156

purchase order
create estimate/sales order from, 257

Q
QPP (Quebec Pension Plan), payroll items for, 184

Quebec income tax, payroll item for, 184

Quebec Pension Plan
calculations and employee’s date of birth, 192
payroll items for, 184

QuickBooks, 2
activating, 13
Administrator, 134
and your industry, 110
company files, 21
comparing with Quicken, 87
dates, changing format, 75
disk space required for, 2
file types, 106
installing, 3
multiple users, 18
network, sharing on, 133
numbers, changing format, 75
Payroll Service, 178
reinstalling, 7
sample company, 110
technical support, 270
transferring data, 100
update problem, fix, 11
updating, 72
updating from a CD, 75
updating from Web site, 74

updating multiple users, 74

QuickBooks Backup Service, 121

QuickBooks file types, 106

QuickBooks Payroll Service
direct deposit, 196

Quicken, 78–89
accounts payable, converting, 81, 85
accounts receivable, after conversion, 84
categories, equivalent of, 87
comparing with QuickBooks, 87
converted data, differences, 88–89
converted data, fine-tuning, 81
converting

to QuickBooks, 78–83
converting from, 81
for Macintosh, converting from, 80
setting preferences, 83

QuickStatement for online accounts, 131

QuickTax, 140

R
RAM required to run QuickBooks, 2

rates
items, changing, 60

realized gains and losses, 171

reconciling
accounts, 128
canceling before completing, 128
online accounts, 131
skipped months, 128
transactions added earlier, 128

Record of Employment report, preparing, 205

Record of Employment report, troubleshooting, 205

Record of Employment, payroll items and, 186

refreshing data, 133

refund cheques
GST/PST, 155
payroll liability, 215

registering QuickBooks, 269

registers
described, 109
entering transactions in, 65
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reimbursable expenses
items for, 53
miscellaneous charges, items for, 55
QuickBooks, 241
QuickBooks Pro, 242–243

reinstalling QuickBooks, 7

release date for an employee, 205

Relevé 1 forms, 216
printing, 218
tracking information in QuickBooks, 186

reorganizing
accounts on chart of accounts, 63
columns on forms, 116
fields on forms, 116
lists, 63

reorganizing transactions in reports, 113

Rep field in New Employee window, 194

Report Finder, 112

reports
changing the scope of the information, 114
condensing data & how it affects reports, 127
customizing, 113
date ranges, 114
descriptions of

payroll, 220–222
payroll item detail, 222
payroll liabilities, 221
payroll summary, 221

filtering, 114
finding the report you want, 112
fonts on, 113
GST/PST liability, 154
memorizing, 113
open sales orders by item, 258
“Other” on, 115
realized gains & losses, 171
saving the customization and filtering, 113
trial balance, 4
unrealized gains & losses, 169

requirements, hardware and software, 2

requirements, networks, 3

restoring company data, 124

retained
earnings, adjusting for during setup, 68
transactions, 126

retained earnings
account, 68
description, 25

RLZ-1.S-V report, 219

routing number formats, 196

S
salaries

employee, changing, 205
employee, entering, 193
officer, payroll item for, 185
payroll item for, 185
removing from bonus check, 209
year-to-date, entering for setup, 197

sales
commission tracking, 194
foreign customers, 172
forms described, 108

sales order
create PO from, 257
creating from estimate, 258
open by items, report, 258

sales tax
applying to sales, 153
business number, 149
codes, setting up, 152
historical data, 66
how QuickBooks calculates, 148
liabilities, 150
liability reports, 154
locking after paying, 135, 156
paying liability, 154
preferences, 149
reimbursable expenses, 241, 243
tracking, 149
turning on in EasyStep Interview, 149
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what you owe, 154

sales tax codes
customer, 152
item, setting up, 152
Zero Rated, about, 152

sample company, 110

search
file, 123

search for your backup file
backup file, 123

searching for lost company file, 10

security
passwords, 133, 135

service businesses
benefits of setting up items, 42

Service for Payroll, 178

service items
creating, 52
description, 47
tracking payroll expenses by (Pro and Premier 

only), 187

setting
price levels per item, 259

setting up
an Internet connection, 71
employee defaults, 191
employee payroll information, 191
employee year-to-date payroll summaries, 197
foreign accounts, 164
foreign customers, 165
foreign vendors, 165
multicurrency, 162–166
MYOB payroll in QuickBooks, 92–99
payroll, 179
your business, 38

sharing QuickBooks on a network, 133

shipping charges
item for on invoice, 48

shipping labels
printing, 255

sick time
accrual period and hours, entering on employee 

defaults, 191
employees, setting up for, 193
entering, 193

year-to-date, entering, 197

single activities
entering details about in QuickBooks, 237
timing, 235

software requirements, for QuickBooks, 2

sole proprietorships, 69

sole proprietorships, description, 35

sorting
lists, 47

spreadsheets
transferring data to and from QuickBooks, 101

start date, 34
choosing, 34
GST/PST liabilities, 150

statement of cash flows, 33

statements
reconciling, 128

step-by-step instructions, finding, 110

Stopwatch
timing activities with, 235
when to use, 226

subaccounts
adding to chart of accounts, 63
payroll, 182

subaccounts, payroll, 182

subclasses, 21, 29

subcontractors
deciding whether to track time for, 225
paying, 191
services performed by, 54
T4A forms for, 238
time worked, paying for, 238

subitems
compared to group items, 50
creating, 52

subtotal items
creating, 52
description, 49
using on sales forms, 57

subtotals on reports, 113

summary transactions, 126

supplemental wages, 189

support
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contacting technical, 270

T
T4 forms, 216

E-filing, 218
filing, 216
prepare, 216
printing, 218
tracking information in QuickBooks, 186

T4 Summary
prepare, 216
report, 219

T4A forms, setting up, 238

tape drive, 120

tax codes
adjustments, 156
customer, 152
for items, 152
items for, 185
paying GST/PST liability, 154
Zero Rated, about, 152

tax forms
Form 8846, 216
Form 943, 216
payroll, 212
PD7A, 215
Relevé 1 forms, 216
Relevé 1, printing, 218
RLZ-1.S-V report, 219
T4 and T4 Summary, preparing, 216
T4 forms, 216
T4 Summary report, 219
T4, E-filing, 218
T4, printing, 218
TPZ-1015 report, 216

tax lines, assigning to accounts, 139

taxes
preparing information, 140
QuickTax, 140
reports about, 141

TD1 forms
employee defaults and, 191, 194

technical support
phone numbers and Web sites, 269–270

templates, for payroll, 191

testing
testing backing up, 122

time tracking, 237
deciding whether to make time billable, 224
options for tracking, 226
recording time manually in Pro or Premier, 236
recording time with the Stopwatch, 235

time, paying nonemployees for, 238

Timer
data

backing up, restoring, or condensing, 233
exporting to Pro or Premier, 234
files, creating, 230
importing into Pro or Premier, 234

hardware requirements, 247
installing, 8
installing from CD, 246
lists

exporting from Pro or Premier, 230
importing from Pro or Premier, 230
updating to match changes in Pro or Premier, 

233
recording activities in, 231
setting up, 229
when to use, 226

timesheets
blank, 228, 237
filling out, 237
viewing, 228

titles, changing
forms, 116

TP-1015.3
employee defaults and, 191, 194

TPZ-1015 report, 216

tracking
GST/PST, 149
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payroll expenses, 188

transactions
audit trail, 136
deleted during condensing, 125
downloading, 132
historical, 64
retained, 126
sorting

in reports, 113
summary, created during condensing process, 126

transferring
data between other software and QuickBooks, 100
foreign funds, 176

trial balance, 4

troubleshooting
printing problems, 142
problems, 266

turning on
audit trail, 136
class tracking, 21, 29
numerical accounts on chart of accounts, 63
payroll, 178

types
customer

compared to classes, jobs, and job types, 30
item

restrictions on changing, 61
table of, 47

job
compared to classes, jobs, and customer types, 

30

U
uncategorized

expenses, 67
account, adjusting at setup, 67

income, 67
account, adjusting at setup, 67

unrealized gains & losses report, 169

updating
automatically, turn off, 73
exchange rates, 169
problems with, 11
QuickBooks, 72
QuickBooks automatically, 73

QuickBooks for multiple users, 74
QuickBooks from a CD, 75
QuickBooks from Web site, 74
QuickBooks manually, 73

US dollar, see multicurrency

users
and Windows 2000, 2
auditing, 136
login, 134
maximum number of, 18, 134
multiple, 18
passwords, 133
setting up, 18, 134

V
vacation pay

employees, setting up for, 193
entering, 193
payroll item, 184
year-to-date, entering, 197

vacation time
accrual period and hours, entering on employee 

defaults, 191

vendors
foreign, 174
paying subcontractors, 191
T4A forms for, 238
time worked, paying for, 238

version
information, accessing, 12, 262

voiding, pay cheques, 211

W
wage bases

employee year-to-date setup, viewing, 200
viewing on reports, 222

wages
employee

changing hourly rates or salary, 205
entering hourly rates, 193
entering salary, 193

garnisheed, payroll item for, 189
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hourly, payroll item for, 185
officer salary, payroll item for, 185
salary, payroll item for, 185
supplemental, 189
year-to-date, entering for setup, 197

Web sites
connecting QuickBooks to, 70
updating QuickBooks from, 74

Windows
converting Quicken to QuickBooks, 78–89
software requirements for QuickBooks, 2
software requirements for Timer, 247

Windows 2000 and multiple users, 2

windows within QuickBooks, 107

word processors
transferring data to and from QuickBooks, 101

write-offs, adjusting GST or PST Payable account, 156

writing, payroll cheques, 210

Y
year-to-date amounts

payroll, entering, 197–202

Z
Zero Rated tax code, 152

Zip drive, 120
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